Basic Administration Guide

Update 2 and later for
ESX Server 3.5, ESX Server 3i version 3.5, VirtualCenter 2.5

This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.

EN-000029-07
You can find the most up-to-date technical documentation on the VMware Web site at:

http://www.vmware.com/support/

The VMware Web site also provides the latest product updates.

If you have comments about this documentation, submit your feedback to:

docfeedback@vmware.com
# Contents

About This Book  13

## Getting Started

1  VMware Infrastructure Components  19
   Two Approaches to Managing Virtual Machines  20
   Components of VMware Infrastructure  21
   VMware Infrastructure Client Interfaces  24
   Optional VirtualCenter Components  24
   VirtualCenter Modules  26
   Managed Components  26
   Functional Components  28
   Access Privileges Components  29

2  Using this Document  31
   Getting Started  32
   Virtual Machine Management  33
   System Administration  33
   Appendices  34

3  Starting and Stopping the VMware Infrastructure Components  35
   ESX Server  35
   VirtualCenter Server  36
      Verifying That VirtualCenter Server Started  37
      Restarting the VirtualCenter Server  37
      Stopping the VirtualCenter Server  38
   VI Client  38
      Starting the VI Client and Logging In  38
      Stopping the VI Client and Logging Out  39
Basic System Administration

4 Using the VI Client 45
   About the VI Client 45
      Menu Bar 47
      Pop-Up Menus 49
      Console Menu 50
      Navigation Bar 51
      Inventory View Tabs 53
         Getting Started Tabs 56
         Using the Tutorial 57
      Toolbar 57
      Status Bar, Recent Tasks, and Triggered Alarms 58
      Panel Sections 58
   Sorting and Filtering Lists 59
   Using Custom Attributes 61
   Selecting and Viewing Objects 63
      Selecting Objects 63
      Monitoring Objects 65
      Performing Actions on Objects 65
   Managing VirtualCenter Modules 67

5 System Configuration 69
   Host Configuration for ESX Server and VirtualCenter 69
      Hardware Tab 70
      Software Tab 71
      ESX Server Network Configuration 72
      ESX Server Storage Configuration 72
      Viewing Security Configuration Information 73
      Viewing ESX Server Command Information 74
   VirtualCenter Configuration 74
      Configuring VirtualCenter Communication 76
         Configuring the Port That VirtualCenter Server Uses 77
         Configuring VirtualCenter Communication over a Web Connection 78
   Virtual Machine Configuration 79
   Working with Active Sessions 81
## Contents

About SNMP and VMware Infrastructure 83  
About MIB Files 83  
  VMWARE-ROOT-MIB 84  
  VMWARE-ENV-MIB 84  
  VMWARE-PRODUCTS-MIB 85  
  VMWARE-RESOURCES-MIB 86  
  VMWARE-TC-MIB 88  
  VMWARE-TRAPS-MIB 89  
  VMWARE-VMINFO-MIB 90  
  VMWARE-VMKERNEL-MIB 92  
Using SNMP with VirtualCenter Server 93  
Using SNMP with ESX Server 3 94  
  Configuring the ESX Server Agent from the Service Console 95  
  Configuring SNMP Trap Destinations for ESX Server 3 96  
Using SNMP with ESX Server 3i 96  
  Configuring SNMP Management Client Software 97  
  Configuring SNMP Security for ESX Server 3 97  
  SNMP Diagnostics 98  
Using SNMP with Guest Operating Systems 99  
System Log Files 99  
  Viewing System Log Entries 99  
  External System Logs 101  
  Configuring Syslog on ESX Server Hosts 102  
  Exporting Diagnostic Data 103  
  Collecting Log Files 104  

### 6 Managing the VI Client Inventory 107  
Understanding VI Client Objects 108  
Adding an Inventory Object 110  
Moving Objects in the Inventory 111  
Removing an Inventory Object 112  
Working with Files in the Datastore Browser 113  
  About Copying Virtual Machine Disks 114  
Performing an Initial Datacenter Consolidation 114
Virtual Machine Management

7 Consolidating the Datacenter  117
   About Datacenter Consolidation 118
   Consolidation Prerequisites  118
   First Time Use  119
   About Consolidation Services 119
   Specifying Consolidation Settings 120
   Finding Physical Systems  120
      Specifying Scope  121
      Supplying System-level Administrator Credentials 122
   Viewing Analysis Results  122
      About the Confidence Metric 123
   Consolidating Candidates  123
      About Disk Resizing  124
   Viewing Consolidation Tasks  125
   Troubleshooting Consolidation  125
      Disable Consolidation  126
      Disable the Collector Service 126
      Uninstall Guided Consolidation 126

8 Managing Hosts in VirtualCenter  127
   About Hosts  128
   Understanding Host States  129
   Adding a Host  129
   Connecting or Disconnecting a Host  132
   Reconnecting Hosts After Changes to the VirtualCenter SSL Certificate  133
   Removing a Host from a Cluster  133
   Removing a Host from VirtualCenter  135
   Monitoring Host Health Status  137
      Resetting Sensors  138
      Refreshing Health Status Data  138
   Host Advanced Configuration Options  138

9 Importing and Exporting Virtual Machines  139
   About OVF  140
   Importing a Virtual Appliance  140
   Exporting a Virtual Machine  141
10 Creating Virtual Machines 143
   Using the New Virtual Machine Wizard 144
      Performing Additional Configuration Before Completion 144
   Creating Typical Virtual Machines 145
   Creating Custom Virtual Machines 148
   Mapping a SAN LUN 153
   Installing a Guest Operating System 154
   Installing and Upgrading VMware Tools 155
      Displaying the VMware Tools Properties Dialog Box 162
      VMware Tools Upgrades 163
      Custom VMware Tools Installation 165
      WYSE Multimedia Support 165
         Installing WYSE Multimedia Support with VMware Tools 166
         Installing WYSE Multimedia Support as part of a VMware Tools Upgrade 166

11 Managing Virtual Machines 169
   Changing Virtual Machine Power States 169
      Understanding Virtual Machine Power States 170
      Understanding Transitional Power States 172
      Manually Powering a Virtual Machine On and Off 172
      Using Suspend and Resume 173
      Scheduling a Power State Change for a Virtual Machine 174
   Adding and Removing Virtual Machines 175
      Adding Existing Virtual Machines to VirtualCenter 175
      Removing Virtual Machines from VirtualCenter 175
      Returning a Virtual Machine or Template to VirtualCenter 176
   Starting and Shutting Down Virtual Machines 177

12 Configuring Virtual Machines 179
   Virtual Machine Properties Editor 179
      Changing the Hardware Configuration of a Virtual Machine 180
      Changing Virtual Machine Options 186
      Changing Virtual Machine Resource Settings 192
         CPU Resources 192
         Advanced CPU Settings 193
         Memory Resources 194
         Disk Resources 196
Adding New Hardware 196
Legacy Virtual Machines 201
Upgrading Virtual Hardware 202

13 Working with Templates and Clones 203
   Understanding Templates 203
   Creating Templates 204
   Editing a Template 206
   Deploying Virtual Machines from Templates 207
   Deleting Templates 209
   Regaining Templates 210
   Cloning Virtual Machines 210
   Creating a Scheduled Task to Clone a Virtual Machine 212

14 Customizing Guest Operating Systems 215
   Preparing for Guest Customization 216
       Virtual Hardware Requirements for Guest Customization 216
       Windows Requirements for Guest Customization 217
       Linux Requirements for Guest Customization 218
   Customizing a Windows Guest Operating System 218
   Customizing a Linux Guest Operating System 222
   Using the Customization Specification Wizard 224
   Using the Clone Virtual Machine Wizard 228
   Completing a Guest Operating System Customization 229
       Completing Linux Guest Operating System Customization 229
       Completing Windows Guest Operating System Customization 229

15 Migrating Virtual Machines 231
   About Migration 232
   Cold Migration 232
   Migrating a Suspended Virtual Machine 233
   Migration with VMotion 233
       Host Configuration for VMotion 234
           Shared Storage 234
           VMotion Networking Requirements 235
   For more information on host networking configuration, see the ESX Server
       3 Configuration Guide or the ESX Server 3i Configuration Guide. 235
About CPU Compatibility 235
    About CPU Families and Feature Sets 237
    About Enhanced VMotion Compatibility 238
    EVC Requirements 238
    Creating an EVC Cluster 239
    Enabling EVC on an Existing Cluster 240
    About CPU Compatibility Masks 241
Virtual Machine Configuration Requirements for VMotion 242
    Swapfile Location Compatibility 242
    Migrating Virtual Machines with Snapshots 243
Using the Migrate Virtual Machine Wizard 243
    About Migration Compatibility Checks 246
Migration with Storage VMotion 248
    Storage VMotion Requirements and Limitations 248
    Storage VMotion Remote Command-Line Syntax 249
        Determining the Path to a Virtual Machine Configuration File 250
        Determining the Path to a Virtual Disk File 250
    Storage VMotion Command-Line Examples 251

16 Using Snapshots 253
    Understanding Snapshots 253
        Relationship Between Snapshots 254
        Snapshots and Other Activity in the Virtual Machine 255
    Taking a Snapshot 255
        Changing Disk Mode to Exclude Virtual Disks from Snapshots 256
Using the Snapshot Manager 257
    Restoring a Snapshot 259
        Parent Snapshot 259
        Revert to Snapshot Command 260

System Administration

17 Managing Users, Groups, Permissions, and Roles 265
    Access Elements 266
    Access Rules 266
        Hierarchical Inheritance 267
        Multiple Permission Settings 267
        Tasks Requiring Settings on Multiple Objects 268
Basic System Administration

Users 269
Groups 271
Permissions 271
Roles 272
  Creating Roles 275
  Cloning Roles 276
  Editing Roles 277
  Removing Roles 277
  Renaming Roles 278
Access Permissions 278
  Assigning Access Permissions 279
  Adjusting the Search List in Large Domains 282
  Changing Access Permissions 283
  Removing Access Permissions 284

18 Setting Up and Monitoring Performance Statistics and Resource Maps 285
Statistics Collection 285
  About Collection Intervals and Collection Levels 286
    Collection Level Scenarios 288
    Using Collection Levels Effectively 289
    How statistical data is stored in the database 289
    Configuring Statistics Collection Intervals 291
Performance Charts 293
  Viewing Charts 293
  Saving Chart Data to a File 295
  Customizing Chart Views 295
Resource Maps 297
  About VMotion Resource Maps 298
  Map Elements and Icons 298
  Viewing Maps 299
  Printing Maps 300
  Exporting Maps 300

19 Managing Tasks, Events, and Alarms 301
Managing Tasks 301
  Understanding Tasks 302
  Viewing and Performing Tasks 303
  Managing Scheduled Tasks 305
  Rescheduling a Scheduled Task 308
Removing a Scheduled Task 308
Canceling a Task 309
Managing Events 311
  Viewing All Event Messages 311
  Viewing Selected Event Messages 313
  Sorting and Filtering Event Messages 314
  Exporting Event Messages 315
Managing Alarms 316
  Understanding Alarms 317
  Preparing for Email Message SMTP Alarm Notification 319
  Preparing for SNMP Alarm Notification 320
  Creating Alarms 321
  Editing Alarms 326
  Removing Alarms 327

Appendixes

A Defined Privileges 331
  Alarms 332
  Datacenter 333
  datastore 333
  Extensions 334
  Folders 334
  Global 335
  Host CIM 337
  Host Configuration 337
  Host Inventory 339
  Host Local Operations 341
  Network 341
  Performance 342
  Permissions 342
  Resource 343
  Scheduled Task 344
  Sessions 345
  Tasks 345
Virtual Machine Configuration 346
Virtual Machine Interaction 348
Virtual Machine Inventory 350
Virtual Machine Provisioning 350
Virtual Machine State 352

B Installing the Microsoft Sysprep Tools 353

C Performance Chart Metrics 357
  CPU 358
    Virtual Machine 359
    Host 360
    Resource Pool 360
    Cluster 361
    Disk 361
    Host and Virtual Machine 361
  Memory 362
    Virtual Machine 362
    Host 364
    Resource Pool 366
    Cluster 368
  Cluster Services 369
    Cluster 370
  Network 370
    Host and Virtual Machine 370
  System 371

Index 373
About This Book

This manual, Basic System Administration, describes how to start and stop the VMware® Infrastructure Client (VI Client) components, build your VMware Infrastructure environment, monitor and manage the information generated about the components, and set up roles and permissions for users and groups using the VMware Infrastructure environment. This manual also provides information for managing, creating, and configuring virtual machines in your datacenter.

In addition, this manual provides brief introductions to the various tasks you can perform within the system as well as cross-references to the documentation that describes all the tasks in detail.

Basic System Administration covers both VMware ESX Server 3.5 and VMware ESX Server 3i, version 3.5. For ease of discussion, this book uses the following product naming conventions:

- For topics specific to ESX Server 3.5, this book uses the term “ESX Server 3.”
- For topics specific to ESX Server 3i version 3.5, this book uses the term “ESX Server 3i.”
- For topics common to both products, this book uses the term “ESX Server.”
- When the identification of a specific release is important to a discussion, this book refers to the product by its full, versioned name.
- When a discussion applies to all versions of ESX Server for VMware Infrastructure 3, this book uses the term “ESX Server 3.x.”
Basic System Administration

**Intended Audience**

The information presented in this manual is written for system administrators who are experienced Windows or Linux system administrators and who are familiar with virtual machine technology and datacenter operations.

**Document Feedback**

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to:

docfeedback@vmware.com

**VMware Infrastructure Documentation**

The VMware Infrastructure documentation consists of the combined VMware VirtualCenter and ESX Server documentation set.

**Abbreviations Used in Figures**

The figures in this book use the abbreviations listed in Table 1.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>database</td>
<td>VirtualCenter database</td>
</tr>
<tr>
<td>datastore</td>
<td>Storage for the managed host</td>
</tr>
<tr>
<td>dsk#</td>
<td>Storage disk for the managed host</td>
</tr>
<tr>
<td>host#</td>
<td>VirtualCenter managed hosts</td>
</tr>
<tr>
<td>SAN</td>
<td>Storage area network type datastore shared between managed hosts</td>
</tr>
<tr>
<td>tmplt</td>
<td>Template</td>
</tr>
<tr>
<td>user#</td>
<td>User with access permissions</td>
</tr>
<tr>
<td>VC</td>
<td>VirtualCenter</td>
</tr>
<tr>
<td>VM#</td>
<td>Virtual machines on a managed host</td>
</tr>
</tbody>
</table>

**Technical Support and Education Resources**

The following sections describe the technical support resources available to you. To access the current versions of this book and other books, go to:

Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to:

http://www.vmware.com/support

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to:

http://www.vmware.com/support/phone_support.html

Support Offerings

Find out how VMware support offerings can help meet your business needs. Go to:

http://www.vmware.com/support/services

VMware Education Services

VMware courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. For more information about VMware Education Services, go to:

http://mylearn1.vmware.com/mgrreg/index.cfm
Getting Started
This chapter introduces VMware Infrastructure components and the operations that you use when managing your virtual machines through ESX Server or VirtualCenter Server.

This chapter contains the following topics:

- “Two Approaches to Managing Virtual Machines” on page 20
- “Components of VMware Infrastructure” on page 21
- “VMware Infrastructure Client Interfaces” on page 24
- “Optional VirtualCenter Components” on page 24
- “VirtualCenter Modules” on page 26
- “Managed Components” on page 26
- “Functional Components” on page 28
- “Access Privileges Components” on page 29
Two Approaches to Managing Virtual Machines

VMware Infrastructure Client (VI Client) is a flexible, configurable solution for managing your virtual machines. There are two primary methods for managing your virtual machines:

- Directly through an ESX Server host (a single or standalone host) that can manage only those virtual machines, and their resources, installed on it.
- Through a VirtualCenter Server that manages multiple virtual machines and their resources distributed over many ESX Server hosts.

The figure below illustrates the components in an ESX Server Virtual Infrastructure.

**Figure 1-1. VMware Infrastructure Components with an ESX Server Host**
The figure below illustrates the components in a VirtualCenter Server Virtual Infrastructure.

**Figure 1-2. VMware Infrastructure Components with a VirtualCenter Server**

<table>
<thead>
<tr>
<th>VI Client</th>
<th>VI Client</th>
<th>VI Client</th>
<th>VI Client</th>
<th>VI Client</th>
</tr>
</thead>
</table>

- **VirtualCenter License Server**
- **VirtualCenter Server**
- **VC database**

- **VirtualCenter Agent**
- **ESX Server host**
- **VM**

- **datastore**
- **shared datastore**

**Components of VMware Infrastructure**

To run your VMware Infrastructure environment, you need the following items:

- **ESX Server** – A virtualization platform used to create the virtual machines as a set of configuration and disk files that together perform all the functions of a physical machine.

  Through ESX Server, you run the virtual machines, install operating systems, run applications, and configure the virtual machines. Configuration includes identifying the virtual machine’s resources, such as storage devices.

  The server provides bootstrapping, management, and other services that manage your virtual machines.

  Each ESX Server has a *VI Client* available for your management use. If your ESX Server is a registered host with the VirtualCenter Server, a VI Client that accommodates the VirtualCenter features is available.
- **VirtualCenter** – A service that acts as a central administrator for VMware ESX Server hosts that are connected on a network. VirtualCenter directs actions on the virtual machines and the virtual machine hosts (the ESX Server hosts).

- **VirtualCenter Server** – The working core of VirtualCenter. VirtualCenter Server is a single Windows Service and is installed to run automatically. As a Windows Service, the VirtualCenter Server runs continuously in the background, performing its monitoring and managing activities even when no VI Clients are connected and even if nobody is logged on to the computer where it resides. It must have network access to all the hosts it manages and be available for network access from any machine where the VI Client is run.

  VirtualCenter Server can be installed in a Windows virtual machine on an ESX Server host, allowing it to take advantage of the high-availability afforded by VMware HA. See the *Installation Guide* for details on setting up this configuration.

- **VirtualCenter modules** – Applications that provide additional features and functionality to VirtualCenter. Typically, modules consist of a server component and a client component. After the server component of a module is installed, it is registered with the VirtualCenter server and the client component is available to VirtualCenter clients for download (see “Managing VirtualCenter Modules” on page 67). After a module is installed on a VirtualCenter client, it might alter the interface by adding views, tabs, toolbar buttons, or menu options related to the added functionality.

  Modules leverage core VirtualCenter capabilities, such as authentication and permission management, but can have their own types of events, tasks, metadata, and privileges.

  Modules require VirtualCenter, but they can be installed anytime after VirtualCenter has been installed. Modules and VirtualCenter can be upgraded independent of each other.

- **VirtualCenter database** – A persistent storage area for maintaining status of each virtual machine, host, and user managed in the VirtualCenter environment. The VirtualCenter database can be remote or local to the VirtualCenter Server machine.

  The database is installed and configured during VirtualCenter installation.

  If you are accessing your ESX Server host directly through a VI Client, and not through a VirtualCenter Server and associated VI Client, you do not use a VirtualCenter database.
Datastore – The storage locations for the virtual machine files specified when creating virtual machines. Datastores hide the idiosyncrasies of various storage options (such as VMFS volumes on local SCSI disks of the server, the Fibre Channel SAN disk arrays, the iSCSI SAN disk arrays, or Network Attached Storage (NAS) arrays) and provide a uniform model for various storage products required by virtual machines.

VirtualCenter agent – On each managed host, software that collects, communicates, and executes the actions received from the VirtualCenter Server. The VirtualCenter agent is installed the first time any host is added to the VirtualCenter inventory.

Host agent – On each managed host, software that collects, communicates, and executes the actions received through the VI Client. It is installed as part of the ESX Server installation.

VirtualCenter license server – A server that stores software licenses required for most operations in VirtualCenter and ESX Server, such as powering on a virtual machine.

VMware Infrastructure supports multiple modes of licensing. Not all modes of licensing require a license server. VirtualCenter and features that require VirtualCenter, such as VMware VMotion™, require a license server.

For more information on VirtualCenter and ESX Server 3 licensing, see the Installation Guide. For more information on ESX Server 3i licensing, see the Setup Guide for your ESX Server 3i product.

For complete information on installing these components, see the Installation Guide. For complete information on configuring ESX Server 3, see the ESX Server 3 Configuration Guide. For complete information on configuring ESX Server 3i, see the ESX Server 3i Configuration Guide.
VMware Infrastructure Client Interfaces

VMware Infrastructure Client interface options include:

- **VMware Infrastructure Client (VI Client)** – A required component and the primary interface for creating, managing, and monitoring virtual machines, their resources, and their hosts. It also provides console access to virtual machines.

  VI Client is installed on a Windows machine with network access to your ESX Server or VirtualCenter Server installation. The interface displays slightly different options depending on which type of server you are connected to. While all VirtualCenter activities are performed by the VirtualCenter Server, you must use the VI Client to monitor, manage, and control the server. A single VirtualCenter Server or ESX Server host can support multiple, simultaneously connected VI Clients.

- **Virtual Infrastructure Web Access (VI Web Access)** – A Web interface through which you can perform basic virtual machine management and configuration and get console access to virtual machines. It is installed with your ESX Server host. Similar to the VI Client, VI Web Access works directly with a host or through VirtualCenter. See the [VI Web Access Administrator's Guide](#) for additional information.

- **VMware Service Console** – A command-line interface for configuring an ESX Server 3 host. For an ESX Server 3i host, use the Remote CLI.

- **Remote Command-Line Interface (Remote CLI)** – A command-line interface for configuring an ESX Server host. The Remote CLI can also be used to perform Storage VMotion operations on both ESX Server 3i and ESX Server 3 version 3.5 hosts.

Optional VirtualCenter Components

Optional VirtualCenter components are packaged and installed with the base product, but require a separate license. Optional features include:

- **VMotion** – A feature that enables you to move running virtual machines from one ESX Server host to another without service interruption. It requires licensing on both the source and target host. The VirtualCenter Server centrally coordinates all VMotion activities.

- **VMware HA** – A feature that enables a cluster with High Availability. If a host goes down, all virtual machines that were running on the host are promptly restarted on different hosts in the same cluster.
When you enable the cluster for HA, you specify the number of hosts you would like to be able to recover. If you specify the number of host failures allowed as 1, HA maintains enough capacity across the cluster to tolerate the failure of one host. All running virtual machines on that host can be restarted on remaining hosts. By default, you cannot power on a virtual machine if doing so violates required failover capacity. See Resource Management Guide for more information.

- **VMware DRS** – A feature that helps improve resource allocation and power consumption across all hosts and resource pools. VMware DRS collects resource usage information for all hosts and virtual machines in the cluster and gives recommendations (or migrates virtual machines) in one of two situations:
  - Initial placement – When you first power on a virtual machine in the cluster, DRS either places the virtual machine or makes a recommendation.
  - Load balancing – DRS tries to improve resource utilization across the cluster by performing automatic migrations of virtual machines (VMotion) or by providing a recommendation for virtual machine migrations.

VMware DRS includes experimental distributed power management (DPM) capabilities. When DPM is enabled, the system compares cluster- and host-level capacity to the demands of virtual machines running in the cluster. Based on the results of the comparison, DPM recommends (or automatically implements) actions that can reduce the power consumption of the cluster.

- **VMware Infrastructure SDK package** – APIs for managing virtual infrastructure and documentation describing those APIs. The SDK also includes the VirtualCenter Web Service interface, Web Services Description Language (WSDL), and example files. This is available through an external link. To download the SDK package, see http://www.vmware.com/support/developer.
VirtualCenter Modules

VirtualCenter modules extend the capabilities of VirtualCenter by providing additional features and functionality. Some modules are packaged separately from the base product and require separate installation. Modules and the base product can be upgraded independently of each other. VMware modules include:

- **VMware Update Manager** – Enables administrators to apply updates and patches across ESX Server hosts and all managed virtual machines. This module provides the ability to create user-defined security baselines which represent a set of security standards. Security administrators can compare hosts and virtual machines against these baselines to identify and remediate systems that are not in compliance.

- **VMware Converter Enterprise for VirtualCenter** – Enables users to convert physical machines, and virtual machines in a variety of formats, to ESX Server virtual machines. Converted systems can be imported into the VirtualCenter inventory.

Managed Components

VirtualCenter monitors and manages various components of your virtual and physical infrastructure. Some components are available for organizing potentially hundreds of virtual machines and other objects. They can be renamed to represent their purposes; for example, they can be named after company departments or locations or functions. The managed components are:

- **Virtual Machines and Templates** – A virtualized x86 personal computer environment in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same managed host machine concurrently. Templates are a designated type of virtual machine.

- **Hosts** – The primary component upon which all virtual machines reside. If the VMware Infrastructure Client is connected to a VirtualCenter Server, all hosts managed by that VirtualCenter Server are available for management. If the VMware Infrastructure Client is connected directly to an ESX Server host, only that host is available for management.

**NOTE**  When VirtualCenter refers to a host, this means the physical machine on which the virtual machines are running. All virtual machines within the VMware Infrastructure environment run on ESX Server or hosts. The term **host** in this manual means the ESX Server host that has virtual machines on it.
Resource pools – A structure that allows delegation of control over the resources of a host. Resource pools are used to compartmentalize all resources in a cluster. You can create multiple resource pools as direct children of a host or cluster and configure them. Then delegate control over them to other individuals or organizations. The managed resources are CPU and memory from a host or cluster. Virtual machines execute in, and draw their resources from, resource pools.

Clusters – A collection of ESX Server hosts with shared resources and a shared management interface. When you add a host to a cluster, the host’s resources become part of the cluster’s resources. The cluster manages the resources of all hosts. See the Resource Management Guide.

Datastores – Virtual representations of combinations of underlying physical storage resources in the datacenter. These physical storage resources can come from the local SCSI disk of the server, the Fibre Channel SAN disk arrays, the iSCSI SAN disk arrays, or Network Attached Storage (NAS) arrays.

Networks – Networks that connect virtual machines to each other in the virtual environment or to the physical network outside.

Folders – Containers used to group objects and organize them into hierarchies. This is not only convenient but also provides a natural structure upon which to apply permissions.

There are three types of folders, each of which can contain other folders (of the same type) and exactly one other type of object. These objects are:

- Datacenters
- Virtual machines (which include templates)
- Compute resources (which include hosts and clusters)

The datacenter folders form a hierarchy directly under the root node and allow users to group their datacenters in any convenient way. Within each datacenter is one hierarchy of folders with virtual machines and templates and one hierarchy of folders with hosts and clusters.
Datacenters – Unlike a folder, which is used to organize a specific object type, a datacenter is an aggregation of all the different types of objects needed to do work in virtual infrastructure: hosts, virtual machines, networks, and datastores.

Within a datacenter there are four separate hierarchies.

- Virtual machines (and templates)
- Hosts (and clusters)
- Networks
- Datastores

Because it is not possible to put networks or datastores into folders, the Networks and Datastores hierarchies are always flat lists.

Datacenters act as the namespace boundary for these objects. You cannot have two objects (for example, two hosts) with the same name in the same datacenter, but you can have two objects with the same name in different datacenters.

Functional Components

The functional components monitor and manage tasks in the VMware Infrastructure environment. The functional components are available through a navigation button bar in the VI Client. The options are:

- **Inventory** – A view of all the monitored objects in VirtualCenter. Monitored objects include datacenters, resource pools, clusters, networks, datastores, templates, hosts, and virtual machines.

- **Scheduled tasks** – A list of activities and a means to schedule those activities. This is available through VirtualCenter Server only.

- **Events** – A list of all the events that occur in the VirtualCenter environment. Use the Navigation option to display all the events. Use an object-specific panel to display only the events relative to that object.

- **Admin** – A list of environment-level configuration options. The Admin option provides configuration access to Roles, Sessions, Licenses, Diagnostics, and System Logs. When connected to an ESX Server host, only the Roles option appears.

- **Maps** – A visual representation of the status and structure of the VMware Infrastructure environment and the relationships between managed objects. This includes hosts, networks, virtual machines, and datastores. This is available only through VirtualCenter Server.
Various information lists are generated and tracked by your VMware Infrastructure Client activity:

- **Tasks** – These activities are scheduled or initiated manually. Tasks generate event messages that indicate any issues associated with the task.
- **Events** – Messages that report VMware Infrastructure activity. Event messages are predefined in the product.
- **Alarms** – Specific notifications that occur in response to selected events. Some alarms are defined by product default. Additional alarms can be created and applied to selected inventory objects or all inventory objects.
- **Logs** – Stored reference information related to selected event messages. Logs are predefined in the product. You can configure whether selected logs are generated.

### Access Privileges Components

Each user logs on to a VirtualCenter Server or a host through the VI Client. Each user is identified to the server as someone who has rights and privileges to selected objects, such as datacenters and virtual machines, within the VMware Infrastructure environment. VirtualCenter Server itself has full rights and privileges on all hosts and virtual machines within the VMware Infrastructure environment. The server passes on only those actions and requests from a user that the user has permission to perform.

The server grants access to each VMware Infrastructure Client object, datacenter, folder, or virtual machine. To do this, you assign a role and a user (or group) to each object.

Individual permissions are assigned through the VI Client by pairing a user and a role and assigning this pair to a VMware Infrastructure Client object:

- **Users and Groups** – For VirtualCenter, users and groups are created and maintained through the Windows domain or Active Directory database. Users and groups are registered with VirtualCenter, or created and registered with an ESX Server, through the process that assigns privileges.

- **Roles** – A set of access rights and privileges. There are selected default roles. You can also create roles and assign combinations of privileges to each role.
Basic System Administration describes the tasks you must complete to configure the VMware Infrastructure Client (VI Client) and virtual machines. Before using the information in Basic System Administration, read the Introduction to VMware Infrastructure for an overview of system architecture and the physical and virtual devices that make up a VMware Infrastructure system.

This chapter summarizes the information contained in this manual on the following topics:

- VMware Infrastructure components
- Administration tools
- System configuration
- Virtual machine management and configuration
- Access and permissions management
- System administration and management
Getting Started

The introductory discussion spans seven chapters and describes the system components, system management tools, and the basic tasks you must complete to configure your VMware Infrastructure Client. The introductory part contains the following chapters:

- **Using this Document** – Summarizes the contents of this guide so that you can find the information you need.
- **VMware Infrastructure Components** – Introduces you to the VMware Infrastructure components and operations you use when managing your virtual machines through ESX Server or VirtualCenter Server.
- **Starting and Stopping the VMware Infrastructure Components** – Describes how to start and stop each of the VMware Infrastructure components. This includes the ESX Server, VirtualCenter Server, VMware Infrastructure Client, Virtual Infrastructure Web Access, VirtualCenter host agent, VirtualCenter license server, and the VMware Service Console.
- **Using the VI Client** – Describes the specific layout and navigation of the VI Client.
- **System Configuration** – Contains information for configuring administration options, VirtualCenter Server settings, and managing host configuration options. It also includes some basic system configuration information, such as how to access and configure log files and set up SNMP.
- **Managing the VI Client Inventory** – Describes how to perform tasks with objects in your VMware Infrastructure environment. This includes folders, datacenters, clusters, resource pools, networks, and datastores. These objects are used to manage or organize the monitored and managed hosts and virtual machines.
- **Managing Hosts in VirtualCenter** – Describes how to perform managed host-related tasks.
Virtual Machine Management

The virtual machine management discussion consists of seven chapters that provide a basic understanding of virtual machines and how to manage, configure, and customize them. The virtual machine management part contains the following chapters:

- **Creating Virtual Machines** – Describes how to create virtual machines by using the New Virtual Machine wizard and by cloning existing virtual machines.
- **Managing Virtual Machines** – Describes virtual machine tasks, including adding a virtual machine to and removing it from the VI Client and powering on and off virtual machines.
- **Configuring Virtual Machines** – Describes how to edit and configure your existing virtual machines. It also discusses advanced virtual machine configuration options.
- **Using Snapshots** – Explains how to capture the entire state of the virtual machine using the snapshots feature.
- **Working with Templates and Clones** – Describes creating templates and using virtual machine templates to create and provision new virtual machines.
- **Migrating Virtual Machines** – Describes the process of migrating or moving a virtual machine from one host to another.
- **Customizing Guest Operating Systems** – Explains how to customize the identity and network settings of your virtual machine’s guest operating system so that it is ready to begin work immediately in your target environment.

System Administration

The system administration part contains the following chapters:

- **Managing Users, Groups, Permissions, and Roles** – Describes how to manage access to VMware Infrastructure inventory objects. It explains how to configure users, groups, roles, and permissions.
- **Setting Up and Monitoring Performance Statistics and Resource Maps** – Describes the performance monitoring pieces of the VMware Infrastructure Client data presented in the VI Client. It also describes the VMware Infrastructure Client Maps feature.
- **Managing Tasks, Events, and Alarms** – Describes how to create, configure, and use tasks, events, and alarms.
Appendixes

Basic System Administration provides these four appendixes with specialized information you might find useful when configuring your VMware Infrastructure environment:

- **Defined Privileges** – Includes tables with the permissions and roles that are available with the VMware Infrastructure system.

- **Installing the Microsoft Sysprep Tools** – Describes how to install the Microsoft Sysprep tools on your VirtualCenter Server machine. Installing the Sysprep tools is a requirement if you plan to customize a Windows guest operating system.

- **Performance Chart Metrics** – Includes tables with the measurement options for each resource monitored on a host.
Starting and Stopping the VMware Infrastructure Components

This chapter includes information on how to start and stop each one of the major VMware Infrastructure components, ESX Server and VirtualCenter Server.

This chapter contains the following topics:

- “ESX Server” on page 35
- “VirtualCenter Server” on page 36
- “VI Client” on page 38
- “VI Web Access” on page 40
- “VMware Service Console” on page 41

ESX Server

When you install ESX Server, it starts itself through the installation reboot process. If your ESX Server is shut down, you must manually restart it.

To start your ESX Server

On the physical box where ESX Server is installed, press the power button until the power on sequence begins.

The ESX Server boots, discovers its virtual machines, and proceeds with its normal ESX Server functions.

You have the option to power off or restart (reboot) any ESX Server host using the VI Client. ESX Server 3 hosts can also be powered off from the service console. Powering off a managed host disconnects it from the VirtualCenter Server but does not remove it from the inventory.
To reboot or shut down your ESX Server

1. Shut down all virtual machines running on the ESX Server host.
2. If connected to a VirtualCenter Server, display the inventory's Hosts & Clusters panel. Select the appropriate root folder (by default labeled Hosts & Clusters) or subfolder.
3. Select the appropriate ESX Server in the inventory panel.
4. From the main or right-click pop-up menu, choose Reboot or Shut Down, as appropriate.
   - If Reboot is selected, the ESX Server shuts down and reboots.
   - If Shut Down is selected, the ESX Server shuts down. You must manually power the system back on.
5. Provide a reason for the shut down.
   This information is added to the log.

To manually stop an ESX Server 3 host

1. Log in to the ESX Server service console.
   See “Connecting to the Service Console” on page 42 for information on accessing the service console.
2. Execute the shutdown command.
   For example:
   : shutdown -h now
   ESX Server 3 gracefully shuts down. When it is finished, a message indicates that it is safe to power off your system.
3. Press the power button until the machine powers off.

VirtualCenter Server

VirtualCenter manages multiple hosts that can contain multiple virtual machines. To perform any activities with the VirtualCenter, you must use the VMware Infrastructure Client.

The VirtualCenter Server starts when you start the Windows machine on which it is installed. It also restarts when this machine is rebooted.
The following sections discuss starting and stopping elements related to VirtualCenter:

- “Verifying That VirtualCenter Server Started” on page 37
- “Restarting the VirtualCenter Server” on page 37
- “Stopping the VirtualCenter Server” on page 38

**NOTE** When VirtualCenter is installed, all users in the local machine’s Administrators group are assigned the Administrator role with full privileges in the VirtualCenter environment. A VirtualCenter Administrator must set permissions for all other VirtualCenter users. See “Assigning Access Permissions” on page 279 for additional information.

### Verifying That VirtualCenter Server Started

VirtualCenter is a service, so proceed to your Windows services list and verify that the service started.

**To verify that the VirtualCenter Server is running**

1. Go to the Services display for your version of Windows. For example, select **Control Panel > Administrative Tools > Services**. Click **VMware Infrastructure Server**.
   The Status column indicates whether the service started.

2. Right-click the VMware Infrastructure Server and choose **Properties**. In the VMware VirtualCenter Services Properties dialog box, click the **General** tab and view the service status.

### Restarting the VirtualCenter Server

The VirtualCenter Server service starts when the machine on which it is installed is booted. If you have manually stopped the VirtualCenter Server service or must start it for any reason, perform the steps below.

**To restart the VirtualCenter Server through Windows Services**

1. Go to the Services display for your version of Windows. For example, select **Control Panel > Administrative Tools > Services**. Click **VMware Infrastructure Server**.

2. Right-click VMware Infrastructure Server, choose **Start**, and wait for startup to complete.

3. Close the Properties dialog box.
Stopping the VirtualCenter Server

The VirtualCenter Server is a Windows service. You can use the Windows interface to select the service and stop it.

You should not have to stop the VirtualCenter Server. It is best for the VirtualCenter Server to have continuous operation. Continuous operation ensures that all monitoring and task activities are performed as expected.

**To stop the VirtualCenter Server**

1. Go to the Services display for your version of Windows.
   - For example, select **Start > Control Panel > Administrative Tools > Services**. Click VMware VirtualCenter Service.
2. Right-click the VMware VirtualCenter Server, choose **Stop**, and wait for it to stop.
3. Close the Properties dialog box.

VI Client

The VMware Infrastructure Client is used to log in to either a VirtualCenter Server or an ESX Server host. Each server supports multiple VI Client sessions. The VI Client can be installed on any machine that has network access to the VirtualCenter Server or an ESX server host.

By default, administrators are allowed to log in to a VirtualCenter Server. Administrators here are defined to be either:

- Members of the local Administrators group if the VirtualCenter Server is not a domain controller.
- Members of the domain Administrators group if the VirtualCenter Server is a domain controller.

Starting the VI Client and Logging In

The VI Client is the interface to ESX Server hosts and the VirtualCenter Server. When you start the VI Client, it has a single opening page. When you log in, the VI Client displays only the features and functions that are appropriate to the type of server you logged on to.
To start a VI Client session

1. Log in to your Windows system.

2. The first time you start the VI Client, log in as the administrator.
   a. If the managed host is not a domain controller, log in as either `<local host name>\<user>` or `<user>`, where `<user>` is a member of the local Administrators group.

   b. If the managed host is a domain controller, you must log in as `<domain>\<user>`, where `<domain>` is the domain name for which the managed host is a controller and `<user>` is a member of that domain’s Domain Administrators group. This practice of running on a domain controller is not recommended.

3. Launch the VI Client.
   Double-click a shortcut or choose the application through Start > Programs > VMware > VMware Infrastructure Client.

4. Log in to the server.
   Enter or choose the server name, your user name, and your password for that server. Click Login to continue.

   **NOTE** Only previously typed servers appear in the Server drop-down menu.

   If this is the first time you have logged on to the VirtualCenter Server, an empty Inventory screen appears. Add a datacenter and host to begin monitoring and managing your virtual machines through the VMware Infrastructure Client. See “Managing the VI Client Inventory” on page 107 for additional information.

Stopping the VI Client and Logging Out

When you no longer must view or alter the activities that VirtualCenter is performing, log out of the VI Client.

To stop a VI Client session

Click the close box (X) in the corner of the VI Client window, or choose File > Exit.

The VI Client shuts down. The VI Client is logged off the server. The server continues to run all its normal activities in the background. Any scheduled tasks are saved and performed by the VirtualCenter Server.

**NOTE** Closing a VI Client does not stop the server.
VI Web Access

VI Web Access is the Web interface through which you can manage your virtual machines. VI Web Access is installed when you install ESX Server. As with the VI Client, VI Web Access can either be used to connect directly to an ESX Server host or to VirtualCenter. The functionality of VI Web Access is a subset of VI Client functionality.

The VI Web Access console provides a remote mouse-keyboard-screen (MKS) for the virtual machines. You can interact with a guest operating system running in a virtual machine and connect remotely to the virtual machine's mouse, keyboard, and screen.

For information on how to use VI Web Access to configure virtual machines for ESX Server and VirtualCenter, see the Virtual Infrastructure Web Access Administrator's Guide.

VI Web Access uses a Web interface and an internet connection to access your ESX Server or VirtualCenter Server.

To log in to VI Web Access

1. Launch your Web browser.
2. Enter the URL of your ESX Server or VirtualCenter Server installation:
   https://<host or server name>/ui
   The VI Web Access login page appears.

   The login page contains fields for your user name and password. This user name and password are the same credentials you would use if you connected using the VI Client. Also, the same permissions are used to determine if a user can view and manipulate objects. VI Web Access does not have its own concept of users or permissions.
3 Type your user name and password, and click Log In.

The VI Web Access home page appears.

After your user name and password are authorized by VI Web Access, the VI Web Access home page appears. The VI Web Access home page contains:

- Details about virtual machines on the server to which you are connected.
- The option to access the details page for a virtual machine where you find information about virtual devices, configuration options, and a summary of recent events.

To log out of VI Web Access

Click the Log Out link found at the corner of every page. You are prompted to confirm that you want to log out.

NOTE If you are using any remote client devices through VI Web Access, they are disconnected when you log out.

VMware Service Console

In previous versions of ESX Server, the service console was one of the interfaces to ESX Server hosts. Starting with ESX Server 3, many of the commands are deprecated. The service console is typically used only in conjunction with a VMware technical support representative.

ESX Server 3i does not have a service console. Some service console commands are available for ESX Server 3i through the Remote CLI.

The VMware Infrastructure SDK is used for scripted manipulation of your VMware Infrastructure instead. The VMware Infrastructure Client is the primary interface to all non-scripted activities, including configuring, monitoring, and managing your virtual machines and resources.

Using DHCP for the Service Console

The recommended setup is to use static IP addresses for the service console of an ESX Server 3 host. You can set up the service console to use DHCP, if your DNS server is capable of mapping the service console's host name to the dynamically generated IP address.
If your DNS server cannot map the host's name to its DHCP-generated IP address, you must determine the service console's numeric IP address yourself. Another caution against using DHCP is that the numeric IP address might change as DHCP leases run out or when the system is rebooted. For this reason, VMware does not recommend using DHCP for the service console unless your DNS server can handle the host name translation.

**CAUTION** Do not use dynamic (DHCP) addressing when sharing the network adapter assigned to the service console with virtual machines. ESX Server 3 requires a static IP address for the service console when sharing a network adapter.

### Connecting to the Service Console

Whether you use the service console locally or through a remote connection, you must log in using a valid user name and password.

If you have direct access to the computer where ESX Server 3 is running, you can log in to the physical console on that computer.

**To log in to the ESX Server 3 service console**

Press **Alt-F2** to get to the log in screen.

Depending on the security settings for your ESX Server 3 computer, you might be able to connect remotely to the service console using SSH or Telnet. For more information on the security settings, see the ESX Server 3 Configuration Guide.

### Using Commands on the Service Console

The service console runs a modified version of Linux, and many of the commands available on Linux or UNIX are also available on the service console. Detailed usage notes for most service console commands are available as manual or man pages.

**NOTE** ESX Server 3i does not have a service console. However, many of the functions provided by the service console are available through the Remote CLI. See the Remote Command-Line Interface Installation and Reference for more information on using and installing the Remote CLI.
To view the man page for a particular command

At the service console command line, type the `man` command followed by the name of the command for which you want to see information, for example:

```
: man <command>
```

For additional information on commands, see the following resources:

- For more detailed information on ESX Server 3 related commands, see the *ESX Server 3 Configuration Guide*.
- For more information on Linux commands, consult a Linux reference book.
Using the VI Client

This chapter describes the specific layout and navigation of the VI Client. It also contains information for configuring admin options, VirtualCenter Server settings, managing host configuration options, and managing modules.

This chapter contains the following topics:

- “About the VI Client” on page 45
- “Sorting and Filtering Lists” on page 59
- “Using Custom Attributes” on page 61
- “Selecting and Viewing Objects” on page 63
- “Managing VirtualCenter Modules” on page 67

About the VI Client

The VMware Infrastructure Client adapts to the connected server. When the VI Client is connected to a VirtualCenter Server, the VI Client displays all the options available to the VMware Infrastructure environment, based on the licensing you have configured and the permissions of the user. When the VI Client is connected to an ESX Server host, the VI Client displays only the options appropriate to single host management.

The default VMware Infrastructure Client layout is a single window with a menu bar, a navigation bar, a toolbar, a status bar, a panel section, and pop-up menus.
The VI Client areas are covered in the following sections:

- “Menu Bar” on page 47
- “Pop-Up Menus” on page 49
- “Console Menu” on page 50
- “Navigation Bar” on page 51
- “Inventory View Tabs” on page 53
- “Toolbar” on page 57
- “Status Bar, Recent Tasks, and Triggered Alarms” on page 58
- “Panel Sections” on page 58
Menu Bar

The menu bar provides access to all commands and operates in a manner consistent with other Windows applications. The tables below list all the menu items available from these five menus. The menu items available vary depending upon whether the VI Client is connected to a VirtualCenter Server or an ESX Server host. The menu bar options are:

- **File Menu** – Similar to the File menu in most applications with two exceptions:
  - A print menu item is not available on the File menu. To print, use the Print Screen mechanism in Windows to take a copy of the VI Client window or export the VirtualCenter data to another format and print from another application.
  - A save menu item is not available. The VI Client is similar to a browser. Most user manipulations are persistent in the display of the VirtualCenter data.

In Table 4-1, an asterisk (*) indicates items that are available only when connected to VirtualCenter Server.

**Table 4-1. File Menu Items**

<table>
<thead>
<tr>
<th>File &gt;</th>
<th>New &gt;</th>
<th>Virtual Machine</th>
<th>Add Host*</th>
<th>Cluster*</th>
<th>Resource Pool</th>
<th>Folder*</th>
<th>Datacenter*</th>
<th>Alarm*</th>
<th>Scheduled Task*</th>
<th>Add Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt;</td>
<td>Export &gt;</td>
<td>Export Events*</td>
<td>Export List</td>
<td>Export Maps*</td>
<td>Export Diagnostic Data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File &gt;</td>
<td>Report &gt;</td>
<td>Host Summary</td>
<td>Performance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File &gt;</td>
<td>Virtual Appliance &gt;</td>
<td>Import</td>
<td>Export</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File &gt;</td>
<td>Print Maps &gt;</td>
<td>Print Settings</td>
<td>Print Preview</td>
<td>Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File &gt;</td>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Edit Menu** – Displays menu items relevant to the selected object.

**Table 4-2. Edit Menu Items**

<table>
<thead>
<tr>
<th>Edit &gt;</th>
<th>Rename</th>
<th>Remove</th>
<th>Customization Specifications</th>
<th>Client Settings</th>
</tr>
</thead>
</table>
- **View Menu** – Controls which panels are visible. This provides a menu item for selecting one of the navigation buttons.

  In Table 4-3, an asterisk (*) indicates items that are available only when connected to VirtualCenter Server.

  **Table 4-3. View Menu Items**

<table>
<thead>
<tr>
<th>View &gt;</th>
<th>Main Toolbar</th>
<th>Toolbar</th>
<th>Status Bar</th>
<th>Inventory</th>
<th>Scheduled Tasks*</th>
<th>Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration</td>
<td>Maps*</td>
<td>Filtering</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

  When connected to the VirtualCenter Server, the View > Inventory menu parses the inventory object views into groups.

  **Table 4-4. View Menu > Inventory Items**

  | View > | Inventory > | Hosts & Clusters | Virtual Machines & Templates | Networks | Datastores |

  - **Inventory Menu** – Displays menu items relevant to the selected object in the inventory panel.

    In Table 4-5, an asterisk (*) indicates items that are available only when connected to VirtualCenter Server.

  **Table 4-5. Inventory Menu Items**

<table>
<thead>
<tr>
<th>Inventory &gt;</th>
<th>Datacenter &gt;</th>
<th>New Folder</th>
<th>New Cluster</th>
<th>Add Host</th>
<th>Add Alarm</th>
<th>Add Permission</th>
<th>Remove</th>
<th>Rename</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory &gt;</td>
<td>Virtual Machine &gt;</td>
<td>Power On</td>
<td>Power Off</td>
<td>Suspend</td>
<td>Reset</td>
<td>Shut Down Guest</td>
<td>Standby Guest</td>
<td>Restart Guest</td>
</tr>
<tr>
<td>Inventory &gt;</td>
<td>Templates* &gt;</td>
<td>Power On</td>
<td>Power Off</td>
<td>Suspend</td>
<td>Reset</td>
<td>Shut Down Guest</td>
<td>Restart Guest</td>
<td>Snapshot</td>
</tr>
</tbody>
</table>
Table 4-5. Inventory Menu Items (Continued)

<table>
<thead>
<tr>
<th>Inventory &gt;</th>
<th>Host &gt;</th>
<th>New Virtual Machine</th>
<th>Connect*</th>
<th>Disconnect*</th>
<th>Enter Maintenance Mode</th>
<th>Shut Down</th>
<th>Reboot</th>
<th>Report Summary</th>
<th>Report Performance</th>
<th>Advanced Settings</th>
<th>Remove*</th>
<th>Relocate VM Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory &gt;</td>
<td>Cluster* &gt;</td>
<td>Add Host</td>
<td>New Virtual Machine</td>
<td>New Resource Pool</td>
<td>Edit Settings</td>
<td>Remove</td>
<td>Rename</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory &gt;</td>
<td>Datastore* &gt;</td>
<td>Browse Datastore</td>
<td>Rename</td>
<td>Remove</td>
<td>Refresh</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory &gt;</td>
<td>Network* &gt;</td>
<td>Remove</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory &gt;</td>
<td>Permission &gt;</td>
<td>Add</td>
<td>Delete</td>
<td>Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory &gt;</td>
<td>Alarm* &gt;</td>
<td>Properties</td>
<td>Remove</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory &gt;</td>
<td>Scheduled Task* &gt;</td>
<td>Run</td>
<td>Remove</td>
<td>Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Administration Menu** – Displays configuration options that apply across the VMware Infrastructure environment.

In Table 4-6, an asterisk (*) indicates items that are available only when connected to VirtualCenter Server.

Table 4-6. Administration Menu Items

<table>
<thead>
<tr>
<th>Administration &gt;</th>
<th>Custom Attributes*</th>
<th>VirtualCenter Management Settings*</th>
<th>Role</th>
<th>Session*</th>
<th>Edit Message of the Day*</th>
<th>Export Diagnostic Data*</th>
<th>Consolidation Settings</th>
</tr>
</thead>
</table>

- **Plugins** – Displays options for managing VirtualCenter plugins.

- **Help Menu** – Displays the online help options, links to the VMware Web site, and product version information.

**Pop-Up Menus**

Pop-up menus provide direct access to many of the menu items. Pop-up menus are available from most objects in both the inventory panel and the information panel.

**To view a pop-up menu**

Right-click the selected object or press Shift+F10.
Console Menu

The console of a powered-on virtual machine is available through a connected server.

**To view the virtual machine console**

Click the Inventory Navigation button, click a powered-on virtual machine in the Inventory panel, and click the Console tab in the Information panel.

**To pop out the virtual machine console**

Click the pop-out icon in the navigation bar.

A copy of the Console window separates from the VI Client. Additional menus appear. Additional menu items are available from the pop-out Console window.

**Additional Console menu**

The message line indicates the number of active connections to this virtual machine.

All connections to the virtual machine see the same display information. The message line indicates if others are viewing the virtual machine.

The pop-out virtual machine Console has the following menu items. The embedded Console has similar menu items but does not include all of the external Console menu items.

**Table 4-7. Virtual Machine Pop-Out Console Menu Items**

<table>
<thead>
<tr>
<th>File &gt;</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>View &gt;</td>
<td>Autofit Window</td>
</tr>
<tr>
<td>VM &gt;</td>
<td>Power On</td>
</tr>
</tbody>
</table>
Navigation Bar

The navigation bar provides shortcut buttons that load the matching toolbar and panel into the VI Client window. The navigation bar combines and displays associated tasks and information. When a button has been selected, it remains selected to indicate the current view. The buttons represent the VI Client functional areas. Depending upon whether the VI Client is connected to a VirtualCenter Server or an ESX Server host, the listed buttons vary.

Each navigation bar button has a primary information panel and associated tabs. The Inventory button has an inventory panel from which you can select objects. Each selected object has its own set of associated information panel tabs. This information is in one of the following two sets of panels:

Navigation bar provides shortcuts to generalized areas of related activities. The options are **Inventory** and **Administration**, when the VI Client is connected to an ESX Server host or a VirtualCenter Server. When the VI Client is connected to a VirtualCenter Server additional options are available: **Scheduled Tasks, Events, Consolidation** and **Maps**. The **Inventory** button also has additional drop-down menu items (Hosts & Clusters, Virtual Machines & Templates, Networks, and Datastores).

**Figure 4-2. Navigation bar shortcuts**

<table>
<thead>
<tr>
<th>Navigation Bar</th>
<th>View Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inventory</strong></td>
<td><strong>View &gt; Inventory &gt; Hosts and Clusters</strong> (or <strong>Virtual Machines and Templates, Networks, or Datastores</strong>).</td>
</tr>
</tbody>
</table>

To view the Inventory button options

Click the arrow on the Inventory navigation bar button to see the inventory group options. Choose **View > Inventory > Hosts and Clusters** (or **Virtual Machines and Templates, Networks, or Datastores**).

See “Managing the VI Client Inventory” on page 107 for information on the differences between the Inventory button views.
- **Inventory button** – A view of all the monitored objects in VirtualCenter. Monitored objects include datacenters, resource pools, clusters, networks, datastores, templates, hosts, and virtual machines.

  The Inventory button displays an inventory panel and an information panel. The information panel contains several tabs. The set of tabs that is displayed varies depending upon the inventory object selected in the inventory panel.

  There are four different Inventory button views:

  - **Hosts and Clusters** – displays the inventory hierarchy of all inventory objects except templates, networks, and datastores.
  - **Virtual Machines and Templates** – displays the list of virtual machines and templates.
  - **Networks** – displays the list of networks.
  - **Datastores** – displays the list of datastores.

  All four of the Inventory options are divided into two subpanels, the inventory panel and the information panel. This Inventory option displays all the objects contained within VirtualCenter, such as folders, datacenters, hosts, clusters, resource pools, and virtual machines. When connected to an ESX Server host the inventory option displays all the objects contained within the host, such as host, resource pools, and virtual machines. Through selecting objects in either of the two subpanels, you perform and specify actions.

  There are four different inventory views. Each relates to some of the eight different inventory objects: hosts, clusters, folders, datacenters, virtual machines and templates, resource pools, networks, and datastores.

  All four views have the (single) root node. You can place folders and datacenters below the root node. Below datacenters the hierarchy is split up into networks, datastores, virtual machine and templates, and hosts, clusters, and resource pools.

- **Scheduled Tasks button** – A list of activities and a means to schedule those activities. This is available through VirtualCenter Server only.

  The Scheduled Tasks and Events buttons, available only when connected to a VirtualCenter Server, display a single information panel.

- **Events button** – A list of all the events that occur in the VirtualCenter environment. Use the Navigation option to display all the events. Use an object-specific panel to display only the events relative to that object.
Chapter 4 Using the VI Client

- **Admin button** – A list of environment-level configuration options. The Admin option provides configuration access to Roles, Sessions, Licenses, Diagnostics, and System Logs. When connected to an ESX Server only, the Roles option appears.

  The Admin button displays a set of tabbed information panels. Selected configuration options are available through these tabs.

- **Maps button** – A visual representation of the status and structure of the VMware Infrastructure environment. This includes hosts, networks, virtual machines, and datastores. This is available through VirtualCenter Server only.

  The Maps button, available only when connected to a VirtualCenter Server, displays an inventory panel and a topology panel.

- **Consolidation** – A means to consolidate your datacenter and build your VirtualCenter inventory by importing physical systems as virtual machines. Guided consolidation offers a quick, automated way of populating a new virtual environment. For details, see “Consolidating the Datacenter” on page 117.

**To change the look of the navigation bar**

Right-click the navigation bar and choose the appropriate option.

**Inventory View Tabs**

You can access the general display of data and activity through the information panel of the VI Client window. The information panel is the visual center of your monitoring activities. Through the information panel, you can view status, resource usage, and performance information about your hosts, virtual machines, and datacenters. In the information panel, you can also view scheduled tasks, available templates, and a list of events.

When the VI Client is connected to a VirtualCenter Server a Maps option is also available. See “Setting Up and Monitoring Performance Statistics and Resource Maps” on page 285 for information on the Maps feature.

When an object is removed from the inventory, its log and event history remains until purged through the aging processes. Data is kept for a specified window of time. As the time window shifts, older data is purged.

- **Admin tabs** – A subset of the Admin button. The Admin tabs are a set of panels that display configuration-oriented information pertaining to the serve that the VI Client is connected to. The tab options are Roles and System Logs. When the VI Client is connected to a VirtualCenter Server, a Sessions and Licenses tab is also available.
**Inventory tabs** – A subset of the Inventory button. The Inventory tabs are a set of panels that display task-oriented information pertaining to the selected inventory object. Each inventory object has its own set of tabs. The tab options are: Getting Started, Summary, Datacenters, Virtual Machines, Hosts, DRS Recommendations, Resource Allocation, Performance, Configuration, Tasks & Events, Alarms, Console, Permissions, and Maps.

When you click the Inventory button in the navigation bar, an information panel appears on the right side of the screen. When you select an object (host, virtual machine, folder, datacenter, cluster, resource pool) from the inventory panel, the information panel displays tabs corresponding to the selected object. This data remains until you click another Inventory button.

**NOTE**  You can use either the navigation bar or the information panel tabs to view events information.

Table 4-8 lists the available panels and their source mapping.

<table>
<thead>
<tr>
<th>Panel Name</th>
<th>Client Connected To</th>
<th>Button, Tab, or Toggle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>ESX Server</td>
<td>navigation bar button</td>
<td>Lists selected configuration options and information.</td>
</tr>
<tr>
<td></td>
<td>VirtualCenter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarms</td>
<td>VirtualCenter</td>
<td>inventory panel tab</td>
<td>Lists the configured alarms for the selected object.</td>
</tr>
<tr>
<td>Alarms</td>
<td>VirtualCenter</td>
<td>toggle button</td>
<td>Lists the triggered alarms for the selected object.</td>
</tr>
<tr>
<td>Configuration</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Provides access to configuring the selected host.</td>
</tr>
<tr>
<td></td>
<td>VirtualCenter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Console</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Displays a remote console to interact directly with the virtual machine. Through the remote console you can take selected actions upon the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>VirtualCenter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Datacenters</td>
<td>VirtualCenter</td>
<td>inventory panel tab</td>
<td>Lists the datacenters organized under the selected folder.</td>
</tr>
<tr>
<td>Datastores</td>
<td>Virtual Center</td>
<td>navigation bar button: Datastores</td>
<td>Provides access for managing datastores.</td>
</tr>
<tr>
<td>Events</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Lists the event messages that report on the status of the selected object.</td>
</tr>
</tbody>
</table>
### Table 4-8. Inventory View Tabs (Continued)

<table>
<thead>
<tr>
<th>Panel Name</th>
<th>Client Connected To</th>
<th>Button, Tab, or Toggle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>VirtualCenter</td>
<td>inventory panel tab</td>
<td>Provides information about the type of object selected and links to actions you can perform on that object. See “Getting Started Tabs” on page 56.</td>
</tr>
<tr>
<td>Hosts</td>
<td>VirtualCenter</td>
<td>inventory panel tab</td>
<td>Lists the hosts assigned to the selected inventory object.</td>
</tr>
<tr>
<td>Inventory</td>
<td>VirtualCenter</td>
<td>navigation bar button: Hosts &amp; Clusters</td>
<td>Provides access for managing all the inventory objects.</td>
</tr>
<tr>
<td>Licenses</td>
<td>VirtualCenter</td>
<td>admin panel tab</td>
<td>Lists the licenses configured in the license server.</td>
</tr>
<tr>
<td>Maps</td>
<td>VirtualCenter</td>
<td>navigation bar button</td>
<td>Displays relationships between the selected inventory objects.</td>
</tr>
<tr>
<td>DRS Recommendations</td>
<td>VirtualCenter</td>
<td>inventory panel tab</td>
<td>Lists the migrations suggested or completed for the selected cluster, and lists suggested or completed power management suggestions.</td>
</tr>
<tr>
<td>Networks</td>
<td>Virtual Center</td>
<td>navigation bar button: Networks</td>
<td>Provides access for managing networks.</td>
</tr>
<tr>
<td>Performance</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Displays the performance charts for the selected host or virtual machine resources. The charts for datacenters and hosts display combined charts that show the usage of each resource.</td>
</tr>
<tr>
<td>Permissions</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Lists the users and groups that have permissions on the selected object and at what level the permission was assigned.</td>
</tr>
<tr>
<td>Resource Allocation</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Lists the distribution of the selected host’s resources: CPU, memory.</td>
</tr>
<tr>
<td>Roles</td>
<td>ESX Server</td>
<td>admin panel tab</td>
<td>Provides access for configuring user roles.</td>
</tr>
<tr>
<td>Scheduled Tasks</td>
<td>VirtualCenter</td>
<td>navigation bar button</td>
<td>Provides access for creating and managing scheduled tasks.</td>
</tr>
<tr>
<td>Sessions</td>
<td>VirtualCenter</td>
<td>admin panel tab</td>
<td>Lists the VI Client sessions connected to the VirtualCenter Server.</td>
</tr>
<tr>
<td>Summary</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Displays a collection of data for the selected object.</td>
</tr>
</tbody>
</table>
Getting Started Tabs

Getting Started tabs are available for each type of inventory object. They provide a description of the type of object selected, shortcuts to actions you can perform on that object, and links to sections of the Tutorial (see “Using the Tutorial” on page 57) that pertain to that type of object.

In the case where VirtualCenter is newly installed and no inventory objects have been added, the Getting Started tabs guide you through the steps of adding items to the inventory and setting up the virtual environment.

To disable Getting Started tabs:

- Click the Close Tab link to disable Getting Started tabs for the type of object selected.
- Select Edit > Client Settings and click Remove All Tabs to disable Getting Started tabs for all inventory objects.

To restore Getting Started tabs:

Select Edit > Client Settings and click Restore All Tabs to restore Getting Started tabs for all inventory objects.

---

Table 4-8. Inventory View Tabs (Continued)

<table>
<thead>
<tr>
<th>Panel Name</th>
<th>Client Connected To</th>
<th>Button, Tab, or Toggle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Logs</td>
<td>ESX Server</td>
<td>admin panel tab</td>
<td>Lists selected log files for the servers.</td>
</tr>
<tr>
<td></td>
<td>VirtualCenter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tasks</td>
<td>VirtualCenter</td>
<td>toggle button</td>
<td>Lists the recent tasks for the selected object.</td>
</tr>
<tr>
<td>Tasks &amp; Events</td>
<td>VirtualCenter</td>
<td>inventory panel tab</td>
<td>Lists the tasks completed and the event messages that report on the status of the selected object.</td>
</tr>
<tr>
<td>Templates</td>
<td>Virtual Center</td>
<td>navigation bar button</td>
<td>Provides access for managing templates.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>button: Virtual Machines &amp; Templates</td>
<td></td>
</tr>
<tr>
<td>Virtual Machines</td>
<td>ESX Server</td>
<td>inventory panel tab</td>
<td>Lists the virtual machines assigned to the selected datacenter or host and group. To access, click the Virtual Machines tab and the virtual machines in the group are displayed.</td>
</tr>
<tr>
<td></td>
<td>VirtualCenter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---
Using the Tutorial

The tutorial provides an introduction to virtualization. It is designed to help new users understand the basic concepts of virtualization and to recognize the components that comprise a virtual environment.

Getting Started tabs contain links to tutorial pages. The tutorial is also accessible through the Help menu (Help > Tutorial).

Toolbar

The toolbar provides buttons for the most commonly used actions.

To view or hide a toolbar

Choose View > Main Toolbar to toggle the display of the main toolbar.

Choose View > Toolbar to toggle the display of the toolbar.

Different toolbar buttons are displayed depending on the navigation task and inventory object selected. Some toolbar options might be dimmed depending on the object selected.

To change the look of the toolbar

Right-click the toolbar and choose the appropriate option.
Status Bar, Recent Tasks, and Triggered Alarms

The status bar appears at the bottom of the window. It contains icons to view triggered alarms or recent tasks. The Tasks button displays any currently running or recently completed active tasks. Included is a progress bar indicating the percentage complete of each task. The recent tasks and the triggered alarm panels display across the bottom of the VI Client window.

To hide or view the status bar
Choose View > Status bar.

To hide or view recent tasks or triggered alarms
Click the Tasks or Alarms icons in the status bar.

Panel Sections

In the body of the VI Client page is a panel section. In most views, there is a left and a right panel: the inventory panel and the information panel. These panels can be resized.

- **Inventory panel** — Displays a hierarchical list of VMware Infrastructure objects when the Inventory or Maps button is selected from the navigation bar.

- **Information panels** — Display lists and charts. Depending on the navigation button or Inventory button item selected, the information panel is divided into tabbed elements.

To select an object
Single-click the appropriate object in either the inventory panel or on the information panel.
To close or open a panel
Click the arrow in the panel menu bar.
When the panel is hidden, the panel menu bar is a strip along the side of the VI Client window.

To resize a panel
Click a resizing panel side and drag it to an appropriate size.
Your choices for the panels are persistent across VI Client sessions. If you run multiple VI Client sessions using different user names, the settings from the last session to quit determine the values for the next VI Client session.

Sorting and Filtering Lists
Sort any list in the VI Client by clicking the column label heading. A triangle in the column head shows the sort order as ascending or descending.
You can also filter a list, sorting and including only selected items. A filter is sorted by a keyword. Choose the columns you want to include in the search for the keyword.

To sort a list
Click a column heading to sort the list by entries in that column. The current selection does not change.

To change between ascending and descending order
Click the triangle in the column heading.

To choose items in a list
Click an individual item. Press Shift-click or Ctrl-click to choose multiple items. All lists can be sorted.

To view or remove columns in a list
Right-click the column header and choose the column name from the list.
To filter the list view

1. Click the arrow to view a list of attributes from which to choose. Type text directly into the filtering field to specify search criteria.

   The Filter field does not support boolean expressions or special characters and is not case sensitive.

2. Click **OK** to display only those virtual machines that match the criteria. Click **Clear** to change the filter.

**NOTE** There is a one second interval between keystrokes. If you type in the text and wait for one second, the search starts automatically. You don’t have to click **OK** or **Enter**.

The list is updated based on whether filtering is on or off. For example, if you are in the Virtual Machines tab, you have filtered the list, and the filtered text is “powered on”, you see a list only of virtual machines whose state is set to powered on. If the state of any of these virtual machines changes to something else, they are removed from the list. New virtual machines that are added are also being filtered. Filtering is persistent for the user session.

To remove a filter

Click **Clear**, or delete the entry in of the filtering field and click **OK**.

The VI Client displays the full list of available items.

To choose columns to search for the filtering keyword

Right-click in the **contains** field, and select or deselect the appropriate column names.

Filtering is inclusive, not exclusive. If the keyword is found in any of the selected columns, the line item is included in the list.

To export a list

1. Select the list to export.

2. Choose **File > Export > Export List**.

3. Type a filename, select a file type in the dialog box, and click **Save**.

   A file is stored in the specified filename, file type, and location.
Using Custom Attributes

Attributes are the resources that are monitored and managed for all the managed hosts and virtual machines in your VMware Infrastructure environment. Attributes’ status and states appear on the various inventory panels.

Custom attributes can be used to associate user-specific meta-information with virtual machines and managed hosts. After you create the attributes, set the value for the attribute on each virtual machine or managed host, as appropriate. This value is stored with VirtualCenter and not with the virtual machine or managed host. Then use the new attribute to filter information about your virtual machines and managed hosts. If you no longer need the custom attribute, remove it. A custom attribute is always a string.

For example, suppose you have a set of products and you want to sort them by sales representative. Create a custom attribute for sales person name, Name. Add the custom attribute, Name, column to one of the list views. Add the appropriate name to each product entry. Click the column title Name to sort alphabetically.

The custom attributes feature is available only when connected to a VirtualCenter Server.

To add a custom attribute

1. Choose Administration > Custom Attributes.
   This option is not available when connected only to an ESX Server.
2. Add a custom attribute and click Add.

![Custom Attributes](image)

The attribute is added to the list of virtual machine characteristics.
3 To change the attribute name, click in the **Name** field and type the name you want to assign to the attribute.

4 Enter the values for the custom attribute.

a Select the object (one level up the hierarchy) that contains the objects to which you want to apply the attribute.

For example, if you want to enter attribute values for managed hosts, select the datacenter and the Hosts tab for a list of hosts.

b For each managed host or virtual machine, click the new attribute's column.

In the information panel, the new attribute is added to the header.

c Type the attribute value that is appropriate for each managed host or virtual machine.

You can also edit custom attributes and add annotations for a virtual machine or host from the Summary tab for the object. Annotations can be used to provide additional descriptive text or comments for an object.

**To edit custom attributes and annotations for a virtual machine or host**

1 Select the virtual machine or host in the inventory.

2 Click the **Summary** tab for the virtual machine or host.

3 In the **Annotations** box, click the **Edit** link.

The Edit Custom Attributes dialog box is displayed.
4 To add an attribute:
   a Click Add.
   b In the Name text box, type the name of the attribute.
   c In the Type drop-down list, select the attribute type: Virtual Machine, Host, or Global.
   d In the Value text box, type the value you want to give to the attribute for the currently selected object.
   e Click OK.
   After you have defined an attribute on a single virtual machine or host, it is available to all objects of that type in the inventory. However, the value you specify is applied only to the currently selected object.
5 To edit the value of an attribute that has already been defined, double-click the Value field for that attribute and enter the new value.
6 To add annotations, enter text in the Notes text box.
7 Click OK to save your changes.

Selecting and Viewing Objects

This section describes common Windows procedures that affect the VMware Infrastructure Client. Navigation topics are discussed in the following sections:

- “Selecting Objects” on page 63
- “Monitoring Objects” on page 65
- “Performing Actions on Objects” on page 65

Selecting Objects

VirtualCenter objects are datacenters, networks, datastores, resource pools, clusters, hosts, and virtual machines. Selecting an object does the following:

- Allows you to view the status of the object.
- Enables the menus so you can choose actions to take on the object.
To select an object

1. Click the appropriate navigation bar option such as Inventory, Scheduled Tasks, Events, Admin, or Maps.
2. If you select Inventory, browse through the hierarchy in the inventory panel until you see the icon for an object. Click it.

When an object is selected, the object label in the inventory panel backfills and the information panel updates its display to reflect the data for the selected object.

To view an object menu

Select the appropriate object and choose the appropriate action from the menu bar. Alternatively, right-click the object.

A pop-up menu with the object’s available actions appears.

For each type of object, such as datacenter, host, or virtual machine, a corresponding set of tabs appears in the information panel. For example:

- If you select a managed host in the inventory panel while connected to VirtualCenter, the information panel displays Summary, Virtual Machines, Resource Allocation, Performance, Configuration, Tasks & Events, Alarms, Permissions, and Maps tabs.
- If you select the inventory panel while connected to an ESX Server, the information panel displays Summary, Virtual Machines, Resource Allocation, Performance, Configuration, Users & Groups, System Logs, Events and Permissions tabs.
- If you select a datacenter, the information panel displays Virtual Machines, Hosts, Tasks & Events, Alarms, Permissions, and Maps tabs.

The inventory panel and information panel share a single selection list. Selecting an object in one panel deselects any other object in the other panel.

Menu actions, from either the menu bar or a pop-up menu, apply to the currently selected object. If no object is selected, no menu actions are available. A pop-up menu can appear only for a selected object. See “Pop-Up Menus” on page 49 for additional information on the pop-up menu options.

To change the name of an object

Select an item and press F2 or click the text of the selected item. Type the new name.
Monitoring Objects

VI Client monitors VirtualCenter or ESX Server activities. For a host to be monitored by VirtualCenter, it must be registered with the VirtualCenter Server. See “Adding a Host” on page 129 for information on adding objects to your VirtualCenter Server. If an ESX Server host is not registered with a VirtualCenter Server, you can connect to the host directly, also using the VI Client.

To check the status of an object

1. Start the VI Client.
2. Click the appropriate button in the navigation bar.
   - If you click the Inventory or Maps button, navigate through the inventory panel lists to view individual objects such as hosts, datacenters, and virtual machines.
   - If you click the Scheduled Tasks, Events, or Admin button, the information panel displays the scheduled tasks, events, or administrative wizard appropriate to the choice.
3. Click the object to view it.
   When you select an object, the object label in the inventory panel is shown in blue and the information panel updates its display to reflect the object’s data.
4. Click the appropriate tab in the information panel.
   The data corresponding to the object and tab selected is shown. Click through the tabs to view the information about the object, as needed.

Performing Actions on Objects

This section describes only the basic process for performing tasks in the VMware Infrastructure Client. This section does not describe specific settings and conditions. See the chapter or book specific to the task you want to perform for additional information.

To view an object, you must have the necessary permission assigned for that object. The type of action you can take on an object depends upon the specific privileges assigned to your user name and group.
There are three methods for taking actions upon objects in VirtualCenter:

- Selecting the action from the menu bar at the top of the VirtualCenter window. See “Menu Bar” on page 47.
- Selecting the action from the object’s pop-up menu or button. The procedure listed below describes how to choose the action from the object menu or button.
- Scheduling the action through the Scheduled Tasks panel. See “Managing Scheduled Tasks” on page 305 to information on scheduling tasks.

To perform an action on a VMware Infrastructure object

1. Start the VMware Infrastructure Client.
2. Connect to the appropriate server.
3. To select an object you want to view or upon which you want to perform an action, select the appropriate inventory view, browse through the hierarchy in the inventory panel until you see its icon, and click it.

   An object can be selected in the inventory panel or the information panel.

   If the object is not in the view:
   - Verify you are logged on to the correct server.
   - Add the host to VirtualCenter control, if needed. See “Managing Hosts in VirtualCenter” on page 127 for information.
4. After an object is selected:
   - Choose a menu item from the main menu.
   - Right-click the object and choose from the pop-up menu.
5. Follow the prompts.

Depending on the action you selected, either the view in the information panel changes or a wizard prompts you for information to complete the transaction.
Managing VirtualCenter Modules

After the server component of a module is installed and registered with the VirtualCenter server, its client component is available to VirtualCenter clients. Client component installation and enablement are managed through the Plugin Manager dialog box (Plugins > Manage Plugins). The Plugin Manager enables users to do the following:

- View available modules that are not currently installed on the client.
- View installed modules.
- Download and install available modules.
- Enable and disable installed modules.

**To open the Manage Plugins dialog box:**

1. Launch the VirtualCenter client and log in to a VirtualCenter server.
2. Select Plugins > Manage Plugins.

The Available tab displays modules that are available to be installed. The Installed tab displays currently installed modules.

**To install modules:**

1. Select the Available tab in the Plugin Manager dialog box.
2. Click Download and Install for the module you want.
3. Follow the prompts in the installation wizard.
4. After installation is complete, verify that the module is listed under the Installed tab and that it is enabled.

**To disable and enable modules:**

1. Select the Installed tab in the Plugin Manager dialog box.
2. Select Enable to enable a module, or deselect Enable to disable it.

Disabling a module in does not remove it from the client. You must uninstall the module to remove it.

**To remove modules:**

Modules can be removed through the operating system’s Add/Remove Programs control panel. Consult your operating system’s documentation for instructions on how to use the Add/Remove Programs control panel.
This chapter includes basic system configuration information, such as how to access and configure log files, configure firewalls, and set up SNMP. Some topics have extensive information discussed in separate chapters or books. Where this occurs, references are provided.

Some of the topics in this chapter are typically one-time configuration tasks, though the settings can be altered when needed.

This chapter contains the following topics:

- “Host Configuration for ESX Server and VirtualCenter” on page 69
- “VirtualCenter Configuration” on page 74
- “Configuring VirtualCenter Communication” on page 76
- “Virtual Machine Configuration” on page 79
- “Working with Active Sessions” on page 81
- “About SNMP and VMware Infrastructure” on page 83
- “System Log Files” on page 99

**Host Configuration for ESX Server and VirtualCenter**

ESX Server hosts are configured and managed through the VMware Infrastructure Client. Some host-related configuration is specific to VirtualCenter. Other host configuration applies to standalone hosts as well as VirtualCenter registered hosts.
The ESX Server 3 Configuration Guide describes the tasks you must complete to configure ESX Server 3 host networking, storage, and security. The ESX Server 3i Configuration Guide describes these tasks for an ESX Server 3i host. In addition, these guides provide overviews, recommendations, and conceptual discussions to help you understand these tasks. They explain how to deploy an ESX Server host to meet your needs. Before using the information in the ESX Server 3 Configuration Guide or the ESX Server 3i Configuration Guide, read the Introduction to VMware Infrastructure for an overview of system architecture and the physical and virtual devices that make up a VMware Infrastructure system.

This section summarizes the host configuration options and the contents of the ESX Server 3 Configuration Guide and ESX Server 3i Configuration Guide so that you can find the information you need.

Select a host and the Configuration tab for the host. The configuration tab displays all of the configuration options available.

**Hardware Tab**

The hardware tab displays the following configuration options:

- **Health Status (ESX Server 3i only)** – Displays the status of hardware components such as processors, memory, and storage. (SEE UPDATE)

- **Processors** – Displays the host's processor information such as type, speed, manufacturer. The properties dialog box allows you to enable or disable Hyperthreading.

- **Memory** – Displays the host’s memory configuration, including total memory available, amounts for the host’s system, amounts for the virtual machines, and amounts for the ESX Server 3 service console. On an ESX Server 3 host, the properties dialog box allows you to set the amount dedicated to the service console.

- **Storage (SCSI, SAN, NFS)** – Displays the storage volumes configured for the host and details about each storage device. This includes volume labels, file system type, block size, extents, and capacity. The Refresh, Remove, Add Storage, and Properties dialog boxes allow you to change volume properties, add extents, manage paths, add disk or LUN datastores, and add network file system (NFS) datastores.

- **Networking** – Displays current networks attached to the host. The Refresh, Add Networking, Remove, and Properties dialog boxes allow you to configure ports and network adapters, and define connection types to the host’s virtual machines and VMkernel. On an ESX Server 3 host, you can also define connections to the service console.
Storage Adapters – Displays storage adapter configuration, such as device type, SAN identification, LUN identification, path, and capacity. The Rescan, Hide LUNs, and Properties dialog boxes allow you to scan for new storage devices or VMFS volumes, hide the LUN information for each selected storage adapter, and view VMotion configuration status.

Network Adapters – Displays network adapter information, including device type, speed, vSwitch, and network identification.

Software Tab
The software tab displays the following configuration options:

Licensed Features – Displays the current status of licensing for the currently selected host. This includes license sources, license type, and licensing for add-ons such as VMotion or HA. The Edit dialog boxes allow you to specify license source, license types, and licensing for additional features.

Time Configuration – Allows you to set the time on the ESX Server host and configure NTP services.

DNS and Routing – Displays DNS and routing information. This includes host name and domain, DNS servers connected to the host, search domains, and default gateways. The Properties dialog box allows you to specify these identification items.

Virtual Machine Startup/Shutdown – Displays a list of virtual machines on the host and their startup or shutdown status. The Properties dialog box allows you to configure when to power on and power off each resident virtual machine. Options include starting or stopping at selected times relative to the host powering off or powering on.

Virtual Machine Swapfile Location – Allows you to select the default swapfile location for virtual machines located on this host. You can choose to store virtual machine swapfiles with the other virtual machine files, or to place the swapfiles on a separate datastore. You can override this default setting for individual virtual machines by editing the virtual machine settings. See “Changing Virtual Machine Options” on page 186.

Security Profile – Displays the firewall information for incoming and outgoing connections. The Properties dialog box allows you to define remote access conditions. This includes Secure Shell, SNMP, and several associated clients, servers, and agent incoming and outgoing communication ports and protocols. Most services are not available on ESX Server 3i hosts.
- **System Resource Allocation** – Displays the host's resource allocation settings. This includes memory and CPU usage. The Edit dialog boxes allow you to configure amounts of CPU shares and memory shares are reserved for host use. The Simple/Advanced toggled dialog box allows you to configure the host's resource pools CPU and memory reserved shares for selected host functions.

  See the *Resource Management Guide* for complete information on configuring and using your virtual machine resources.

- **Advanced Settings** – Displays a list of settings that VMware recommends you use only when directed to by VMware technical support.

**ESX Server Network Configuration**

The networking chapters of the *ESX Server 3 Configuration Guide* and the *ESX Server 3i Configuration Guide* provide you with a conceptual understanding of physical and virtual network concepts, a description of the basic tasks you must complete to configure your ESX Server host's network connections, and a discussion of advanced networking topics and tasks. The networking section contains the following chapters:

- **Networking** – Introduces you to network concepts and guides you through the most common tasks you must complete when setting up the network for the ESX Server host.

- **Advanced Networking** – Covers advanced networking tasks such as setting up MAC addresses, editing virtual switches and ports, and DNS routing. In addition, it provides tips on making your network configuration more efficient.

- **Networking Scenarios and Troubleshooting** – (In the *ESX Server 3 Configuration Guide* only) Describes common networking configuration and troubleshooting scenarios.

**ESX Server Storage Configuration**

The ESX Server storage chapters of the *ESX Server 3 Configuration Guide* and the *ESX Server 3i Configuration Guide* provide you with a basic understanding of storage, a description of the basic tasks you perform to configure and manage your ESX Server host's storage, and a discussion of how to set up raw device mapping. The storage section contains the following chapters:

- **Introduction to Storage** – Introduces you to the types of storage you can configure for the ESX Server host.

- **Configuring Storage** – Explains how to configure local SCSI storage, Fibre Channel storage, and iSCSI storage. It also addresses VMFS storage and network-attached storage.
Managing Storage – Explains how to manage existing datastores and the file systems that comprise datastores.

Raw Device Mapping – Discusses raw device mapping, how to configure this type of storage, and how to manage raw device mappings by setting up multipathing, failover, and so forth.

Viewing Security Configuration Information

The ESX Server security chapters of the ESX Server 3 Configuration Guide and ESX Server 3i Configuration Guide discuss safeguards VMware has built into ESX Server and measures you can take to protect your ESX Server host from security threats. These measures include using firewalls, leveraging the security features of virtual switches, and setting up user authentication and permissions. The security section contains the following chapters:

Security for ESX Server Systems – Introduces you to the ESX Server features that help you ensure a secure environment for your data and gives you an overview of system design as it relates to security.

Securing an ESX Server Configuration – Explains how to configure firewall ports for ESX Server hosts and VMware VirtualCenter, how to use virtual switches and VLANs to ensure network isolation for virtual machines, and how to secure iSCSI storage.

Authentication and User Management – Discusses how to set up users, groups, permissions, and roles to control access to ESX Server hosts and VirtualCenter. It also discusses encryption and delegate users.

Service Console Security – (In the ESX Server 3 Configuration Guide only) Discusses the security features built into the service console and shows you how to configure these features.

Security Deployments and Recommendations – Provides some sample deployments to give you an idea of the issues you must consider when setting up your own ESX Server deployment. This chapter also tells you about actions you can take to further secure virtual machines.
Viewing ESX Server Command Information

The *ESX Server 3 Configuration Guide* and *ESX Server 3i Configuration Guide* include appendixes that provide specialized information you might find useful when configuring an ESX Server host:

- **ESX Server Technical Support Commands** – (In the *ESX Server 3 Configuration Guide* only) Covers the ESX Server 3 configuration commands that can be issued through a command line shell such as SSH. While these commands are available for your use, you should not consider them an API upon which you can build scripts. These commands are subject to change and VMware does not support applications and scripts that rely on ESX Server 3 configuration commands. This appendix provides you with VMware Infrastructure Client equivalents for these commands.

- **Using vmkfstools** – Covers the *vmkfstools* utility, which you can use to perform management and migration tasks for virtual disks and VMFS volumes.

VirtualCenter Configuration

Sets of properties and settings dialog boxes make adjustments to the corresponding VirtualCenter environment.

**To view the VMware VirtualCenter Configuration**

Select **Administration > VirtualCenter Management Server Configuration**.

Changes to this setting apply to the current VirtualCenter Server only. If you log out and log in to another VirtualCenter Server, the settings are specific to that VirtualCenter Server.

The dialog box tabs display and allow you to configure:

- **License Server** – Specify the license server and whether a host license server is superseded when the host is added to the VirtualCenter inventory. Specify the VirtualCenter Server license edition.

  See the *Installation Guide* for ESX Server 3, or the *Setup Guide* for your ESX Server 3i product for more information on license configuration.

- **Statistics** – Specify the collection intervals, statistics collection thread limit, and statistics collection level. Specifies the number of threads used for collecting performance statistics from managed hosts.

  Specifies the level of detail for performance statistics collection. Legal values are minimal, typical, and full. The default is full.
Specifies how often, in seconds, VirtualCenter checks if any scheduled tasks are ready to be executed or alarms should be triggered. The default is 5 seconds.

Verifies that all users and groups known to VirtualCenter currently exist in Windows. For example, if user Smith is assigned permissions and in the domain the user's name is subsequently changed to Smith2, VirtualCenter concludes that Smith no longer exists and removes permissions for that user.

See “About Collection Intervals and Collection Levels” on page 286.

- **Runtime Settings** – View the unique runtime settings for the VirtualCenter installation. This includes the VirtualCenter unique ID number and the VirtualCenter TCP/IP port number.

Generates unique MAC addresses and UUIDs for virtual machines. In some cases, it is possible to have more than one VirtualCenter running in the same company. Each of these VirtualCenter Servers must have its own unique identification. By default, an ID value is generated randomly. However, this value is editable. The only requirement is that it be a unique number from 0 to 63.

Specifies the port through which a VirtualCenter client sends data to the VirtualCenter Server.

See “Configuring VirtualCenter Communication” on page 76.

- **Active Directory** – Specify the active directory timeout, maximum number of users and groups to display in the Add Permissions dialog box, and the frequency for performing a synchronization and validation of VirtualCenter's known users and groups.

Specifies the maximum number of users and groups the VirtualCenter stores from the selected domain. To specify no maximum limit, enter zero (0).

Specifies, in seconds, the maximum time VirtualCenter allows the search to run on the selected domain. Searching very large domains can take a very long time. This value must be greater than zero (0).

See Chapter 17, “Managing Users, Groups, Permissions, and Roles,” on page 265.

- **Mail** – Specify the SMTP server and mail account.

See “Managing Events” on page 311.

- **SNMP** – Specify the SNMP receiver URLs, ports, and community strings.

See “About SNMP and VMware Infrastructure” on page 83.
Basic System Administration

- **Web Service** – Specify the HTTP and HTTPS ports for the Web Service to use. You can also specify whether you want to maintain compatibility with the VirtualCenter 1.x version of the SDK Web Service.

  See “Configuring VirtualCenter Communication” on page 76.

- **Timeout Settings** – Specify the VI Client connection timeout values for normal operations and long operations. Timeout normal specifies how long, in seconds, the VirtualCenter client waits for a response from the VirtualCenter Server before timing out. The default is 30 seconds. Timeout long specifies how long, in seconds, the VirtualCenter client waits for a response from the VirtualCenter Server for long operations. The default is 120 seconds.

  See “Starting the VI Client and Logging In” on page 38.

- **Logging Options** – Specify the degree of detail and extent of logs collected during normal VirtualCenter operations. Specifies verbose logging when set to 1. Used for advanced debugging and troubleshooting. Use this field only when directed by VMware technical support.

  See “System Log Files” on page 99.

- **Database** – Specify the password required to access the VirtualCenter database and the maximum number of database connections to be created.

- **SSL** – Specify whether you want the VirtualCenter server and VirtualCenter clients to verify the SSL certificates of the remote host when establishing remote connections. VMware recommends enabling the Check host certificates option.

- **Advanced Settings** – Specify advanced settings. It is highly recommended that you do not change these settings without contacting VMware technical support.

### Configuring VirtualCenter Communication

The VirtualCenter Server and ESX Server receives data transmissions from the VI Client on port 902. Ensure this is properly configured prior to connecting your VI Client to your VirtualCenter Server or ESX Server.

**NOTE**  The procedures described here are not available for communication with an ESX Server. ESX Server only uses port 902. You cannot change the port number ESX Server uses to communicate with either a VI Client or the VirtualCenter Server. See the *ESX Server 3 Configuration Guide* or the *ESX Server 3i Configuration Guide* for complete information on security, communication, and port configuration with an ESX Server host.
If a firewall is preventing the VI Client from connecting to the VirtualCenter Server, you have three options for correcting this:

- Reconfigure your firewall to allow the VI Client to communicate through port 902 on the VirtualCenter Server or ESX Server. See the instructions for your firewall.

- Use some port other than 902 (and if necessary, configure your firewall to open this other port). The VI Client and the VirtualCenter Server must both be configured to use the same port.

  See “Configuring the Port That VirtualCenter Server Uses” on page 77 for information on changing this port number in your VirtualCenter Server.

- If neither of the preceding options is possible and your firewall allows Web traffic to pass to the server, you can connect the VI Client to the VirtualCenter Server using a standard Web connection.

  **CAUTION** If you use this option to open a communication channel between your VirtualCenter Server and VI Client, the VirtualCenter console does not work.

  See “Configuring VirtualCenter Communication over a Web Connection” on page 78 for information on setting up the Web site port.

### Configuring the Port That VirtualCenter Server Uses

There is a default port number assigned, 902. This procedure applies only to communication between a VI Client and a VirtualCenter Server. Do not use this to attempt to change the port number for communication between a VI Client and an ESX Server.

**NOTE** Changing the port number is a very rare operation.

#### To change the default port number

1. Start the VI Client and log in to the VirtualCenter Server.
   
   See “Using the VI Client” on page 45.

2. Choose Administration > VirtualCenter Management Server Configuration.

3. Click the Runtime Settings option.
4 Enter the port number your VI Client is using to communicate with the VirtualCenter Server. Click the Finish option. Click the Finish button.
   The port must be less than 64000.
5 To accept the changes, restart the VirtualCenter Server.
   See “VirtualCenter Server” on page 36.

Configuring VirtualCenter Communication over a Web Connection

One alternative to connecting the VirtualCenter Server and VI Client on opposite sides of a firewall is through a standard Web connection.

**CAUTION** If you use this option to open a communication channel between your VirtualCenter Server and VI Client, the VirtualCenter console does not work.

To enable your VI Client to connect with the VirtualCenter Server across a firewall using a Web tunnel, change the Web site port address on your VirtualCenter Server.

**To open a Web port between the VirtualCenter Server and the VI Client using IIS**

1 On the VirtualCenter Server, install Internet Information Services (IIS) Manager.
   Typically, this is installed by default with the Microsoft Windows operating system.
2 Enable IIS.
   For example, choose Start > Control Panel > Administrative Tools > Internet Services Manager. Select Internet Information Services.
3 From the IIS manager, open the Windows dialog box.
4 Expand the <server_name>. Right-click on Default Web Site. Choose Properties > Web Site tab.
5 Set the port value for the VirtualCenter service.
6 In the Web Site Description block, enter the value of the TCP Port or, if allowed, the SSL port.
   A value of 80 is the default nonsecure TCP Web site port. A value of 443 is the default secure SSL Web site port.
7. **(See Update)** Set the dll directory.
   a. If needed, create the directory:
      ```
      C:\inetpub\wwwroot\vpx\n      ```
   b. Set the permissions for this directory to allow execution.
   c. Copy the file VmdbHttpProxy.dll to this directory.
      The file is in `\Program Files\VMware\Infrastructure\VirtualCenter\Server\`

8. Verify that the change has been applied.

9. Stop and restart the default Web site.

10. Each time you update the VirtualCenter version, repeat this process.
    When you start the VI Client, enter the VirtualCenter Server Web site address as listed in the Server field.
    - If you are using the secure Web port or any other nondefault port, use the full name: `http:<server name>:<port>`.
      For example, `http:vcserver:443`.
    - If you are using the default nonsecure Web site port, any of the following combinations work: `http:<server name>`, `<server name>:80`, or `http:<server name>:80`.

**Virtual Machine Configuration**

Sets of properties and settings dialog boxes make adjustments to the corresponding virtual machine element.

**To view the resources of a virtual machine**

Select a virtual machine. Click the **Summary** tab. See the **Resources** section of the Summary tab.

Listed are the current CPU and memory usage, in addition to the datastores and networks associated with the selected virtual machine.

See the **Resource Management Guide** for complete information on configuring and using your virtual machine resources.
To view the virtual machines on a host
Select a host. Click the Virtual Machines tab.
This is a list of all the virtual machines running on the selected managed host and the percentage of resources allocated to the virtual machine.

To view the configuration of a virtual machine
See the chapters in “Virtual Machine Management” on page 115 for complete information about creating virtual machines and editing the configuration of virtual machines.

Select a virtual machine and choose Edit Settings.
This displays the Virtual Machine Properties dialog box. From this dialog box you can edit the following virtual machine configuration items:

- **Hardware** – Adds or removes the hardware elements to your virtual machine:
  - Memory
  - CPU
  - Floppy drive
  - CD/DVD drive
  - Network adapter
  - SCSI controller
  - Hard disk
  - Serial port
  - Parallel port
  - SCSI device

- **Options** – Lists some general virtual machine settings, actions to take during a power state change, and actions taken for debugging during a process.
  - **General** – Contains virtual machine name, virtual machine configuration file path and name, virtual machine working location, guest operating system, and version of the guest operating system installed.
  - **VMware Tools** – Contains power control settings for the virtual machine’s toolbar power icons and a run scripts option specifying if and when to run a VMware Tools script.
  - **Power Management** – Allows you to specify the virtual machine’s response when the guest operating system is on standby.
Advanced – Options under this heading control advanced virtual machine options as follows:

- **General** – Contains settings for acceleration, logging, debugging. Also allows you to set advanced virtual machine configuration parameters.
- **CPUID Mask** – Contains settings for configuring CPUID masks for increasing VMotion compatibility.
- **Boot Options** – Contains options for setting boot delay and forcing the virtual machine to enter BIOS setup on boot.
- **Paravirtualization** – Allows you to turn on VMI paravirtualization.
- **Fibre Channel NPIV** – Contains settings for configuring N-Port ID Virtualization identifiers.
- **Virtualized MMU** – Allows you to configure whether virtual machines make use of hardware page table virtualization capabilities.
- **Swapfile Location** – Allows you to set the location in which the virtual machine swapfile is stored.

**Resources** – Modifies the resource shares on the managed host of a virtual machine.

- **CPU** – Allows you to specify the CPU resource allocation shares, reservation, and limit for the selected virtual machine.
- **Memory** – Allows you to specify the memory resource allocation shares, reservation, and limit for the selected virtual machine.
- **Disk** – Allows you to specify the disk resource allocation shares and shares value for the selected virtual machine.
- **Advanced CPU** – Allows you to specify the hyperthreading and scheduling affinity for the CPU running the selected virtual machine.
- **Advanced Memory** – Allows you to set low-level options for distribution of virtual machine memory to NUMA (nonuniform memory access) memory nodes. This page appears only if the virtual machine’s host supports NUMA memory architecture.

**Working with Active Sessions**

When your VI Client is connected to a VirtualCenter Server, you can view the list of users logged on to the server. This is not available when your VI Client is connected to an ESX Server host.
To view the users that are currently logged on to a VirtualCenter Server

From the VI Client connected to a VirtualCenter Server, click the Admin button in the navigation bar. Then click the Sessions tab.

To terminate an active session

1. From the VI Client connected to a VirtualCenter Server, click the Admin button in the navigation bar. Then click the Sessions tab.
2. Right-click the session to close. Choose Terminate.
3. To confirm the termination, click OK.

To send a message to all users logged on to an active session

1. From the VI Client connected to a VirtualCenter Server, click the Admin button in the navigation bar. Then click the Sessions tab.
2. Type into the Message of the day field.
3. Click the Change button.
   The text is sent as a notice message to all active session users and to new users when they log in.
About SNMP and VMware Infrastructure

Simple Network Management Protocol (SNMP) allows management programs to monitor and control a variety of networked devices. Managed devices run SNMP agents, which can provide information to a management program in at least one of the following ways:

- In response to a get operation, which is a specific request for information from the management system.
- By sending a notification, which is an alert sent by the SNMP agent to notify the management system of a particular event or condition.

VirtualCenter Server, ESX Server 3i, and ESX Server 3 each have an SNMP agent. The agents provided with each product have differing capabilities.

About MIB Files

Management Information Base (MIB) files define the information that can be provided by managed devices. The MIB files contain object identifiers (OIDs) and variables arranged in a hierarchy. Currently, VMware provides the MIB files listed in Table 5-1 for use with VI3.

Table 5-1. VMware MIB Files

<table>
<thead>
<tr>
<th>MIB File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware-Root-MIB.mib</td>
<td>Contains VMware's enterprise OID and top level OID assignments.</td>
</tr>
<tr>
<td>VMware-Env-MIB.mib</td>
<td>Defines variables and trap types used to report hardware environment status. (ESX Server 3i hosts only)</td>
</tr>
<tr>
<td>VMware-Products-MIB.mib</td>
<td>Defines OIDs to uniquely identify each SNMP agent on each VMware platform.</td>
</tr>
<tr>
<td>VMware-Resources-MIB.mib</td>
<td>Defines variables used to report information on resource usage of the VMkernel, including memory, CPU, and disk utilization.</td>
</tr>
<tr>
<td>VMware-System-MIB.mib</td>
<td>The VMware-System-MIB.mib file is obsolete. Use the SNMPv2-MIB to obtain information from sysDescr.0 and sysObjectID.0.</td>
</tr>
<tr>
<td>VMware-Tc-MIB.mib</td>
<td>Defines common textual conventions used by VMware MIB files.</td>
</tr>
<tr>
<td>VMware-Traps-MIB.mib</td>
<td>Defines virtual machine power-related traps sent by ESX Server and traps sent by VirtualCenter.</td>
</tr>
</tbody>
</table>
VMWARE-ROOT-MIB

The VMWARE-ROOT-MIB.mib file defines VMware's enterprise OID and top level OID assignments.

Table 5-2 lists the identification mapping for VMWARE-ROOT-MIB.mib.

Table 5-2. Definition Mapping for VMWARE-ROOT-MIB.mib

<table>
<thead>
<tr>
<th>Label</th>
<th>Identification Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmware</td>
<td>enterprises 6876</td>
</tr>
<tr>
<td>vmwSystem</td>
<td>vmware 1</td>
</tr>
<tr>
<td>vmwVirtMachines</td>
<td>vmware 2</td>
</tr>
<tr>
<td>vmwResources</td>
<td>vmware 3</td>
</tr>
<tr>
<td>vmwProductSpecific</td>
<td>vmware 4</td>
</tr>
<tr>
<td>vmwTraps</td>
<td>vmware 50</td>
</tr>
<tr>
<td>vmwOID</td>
<td>vmware 60</td>
</tr>
<tr>
<td>vmwExperimental</td>
<td>vmware 700</td>
</tr>
</tbody>
</table>

VMWARE-ENV-MIB

The VMWARE-ENV-MIB.mib defines variables and trap types used to report on the state of physical components of the host computer. The variables and traps defined in this file are used only by ESX Server 3i hosts.

VMWARE-ENV-MIB.mib defines a single trap, vmwEnvHardwareEvent, which is sent when an ESX Server 3i host has detected a material change in the physical condition of the hardware.

Table 5-3 lists the variables defined in VMWARE-ENV-MIB.mib.
Table 5-3. Variable Definitions in VMWARE-ENV-MIB

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmwEnv</td>
<td>vmwProductSpecific 20</td>
<td>Defines the OID root for this MIB module.</td>
</tr>
<tr>
<td>vmwEnvNumber</td>
<td>vmwEnv 1</td>
<td>Number of conceptual rows in vmwEnvTable.</td>
</tr>
<tr>
<td>vmwEnvLastChange</td>
<td>vmwEnv 2</td>
<td>The value of sysUptime when a conceptual row was last added to or deleted from vmwEnvTable.</td>
</tr>
<tr>
<td>vmwEnvTable</td>
<td>vmwEnv 3</td>
<td>This table is populated by monitoring subsystems such as IPMI.</td>
</tr>
<tr>
<td>vmwEnvEntry</td>
<td>vmwEnvTable 1</td>
<td>One entry is created in the table for each physical component reporting its status to ESX Server 3i.</td>
</tr>
<tr>
<td>vmwEnvIndex</td>
<td>vmwEnvEntry 1</td>
<td>A unique identifier for the physical component. This identifier does not persist across management restarts.</td>
</tr>
<tr>
<td>vmwSubsystemType</td>
<td>vmwEnvEntry 2</td>
<td>The type of hardware component that is reporting its environmental state.</td>
</tr>
<tr>
<td>vmwHardwareStatus</td>
<td>vmwEnvEntry 3</td>
<td>The last reported status of the component.</td>
</tr>
<tr>
<td>vmwEventDescription</td>
<td>vmwEnvEntry 4</td>
<td>A description of the last reported event for this hardware component.</td>
</tr>
<tr>
<td>vmwHardwareTime</td>
<td>vmwEnvEntry 5</td>
<td>The value of sysUptime when vmwHardwareStatus was reported.</td>
</tr>
</tbody>
</table>

VMWARE-PRODUCTS-MIB

The VMWARE-PRODUCTS-MIB.mib file defines OIDs to uniquely identify each SNMP agent on each VMware platform. The identification mappings for this file are listed in Table 5-4.

Table 5-4. Identification Mappings for VMWARE-PRODUCTS-MIB.mib

<table>
<thead>
<tr>
<th>Label</th>
<th>Identification Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>oidESX</td>
<td>vmwOID 1</td>
</tr>
<tr>
<td>vmwESX</td>
<td>vmwProductSpecific 1</td>
</tr>
<tr>
<td>vmwEmbeddedESX</td>
<td>vmwProductSpecific 2</td>
</tr>
<tr>
<td>vmwVC</td>
<td>vmwProductSpecific 3</td>
</tr>
<tr>
<td>vmwServer</td>
<td>vmwProductSpecific 4</td>
</tr>
</tbody>
</table>
VMWARE-RESOURCES-MIB

The VMWARE-RESOURCES-MIB.mib file defines variables used to report information on resource usage. Table 5-5 lists the identification mappings defined in this file.

Table 5-5. Identification Mappings for VMWARE-RESOURCES-MIB

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Subtree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>vmwCPU</td>
<td>vmwResources 1</td>
<td>Defines the root OID for the subtree of variables used to report CPU information.</td>
</tr>
<tr>
<td>numCPUs</td>
<td>vmwCPU 1</td>
<td>The number of physical CPUs present on the system.</td>
</tr>
<tr>
<td>cpuTable</td>
<td>vmwCPU 2</td>
<td>A table of CPU usage by each virtual machine.</td>
</tr>
<tr>
<td>cpuEntry</td>
<td>cpuTable 1</td>
<td>An entry in cpuTable that records CPU usage for a single virtual machine.</td>
</tr>
<tr>
<td>cpuVMID</td>
<td>cpuEntry 1</td>
<td>The identification number allocated to the virtual machine by the VMkernel.</td>
</tr>
<tr>
<td>cpuShares</td>
<td>cpuEntry 2</td>
<td>The share of the CPU allocated to the virtual machine by the VMkernel.</td>
</tr>
<tr>
<td>cpuUtil</td>
<td>cpuEntry 3</td>
<td>Amount of time the virtual machine has been running on the CPU (in seconds).</td>
</tr>
<tr>
<td>Memory Subtree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>vmwMemory</td>
<td>vmwResources 2</td>
<td>Defines the root OID for the subtree of variables used to report memory information.</td>
</tr>
<tr>
<td>memSize</td>
<td>vmwMemory 1</td>
<td>Amount of physical memory present on the host (in KB).</td>
</tr>
<tr>
<td>memCOS</td>
<td>vmwMemory 2</td>
<td>Amount of physical memory used by the service console (in KB). This variable does not apply to ESX Server 3i hosts, which do not have a service console.</td>
</tr>
<tr>
<td>memAvail</td>
<td>vmwMemory 3</td>
<td>The amount of free physical memory available on the host.</td>
</tr>
<tr>
<td>memTable</td>
<td>vmwMemory 4</td>
<td>A table of memory usage by each virtual machine.</td>
</tr>
<tr>
<td>memEntry</td>
<td>memTable 1</td>
<td>An entry in memTable that records memory usage by a single virtual machine.</td>
</tr>
</tbody>
</table>
### Table 5-5. Identification Mappings for VMWARE-RESOURCES-MIB (Continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memVMID</td>
<td>memEntry 1</td>
<td>The identification number allocated to the virtual machine by the VMkernel.</td>
</tr>
<tr>
<td>memShares</td>
<td>memEntry 2</td>
<td>The shares of memory allocated to the virtual machine by the VMkernel.</td>
</tr>
<tr>
<td>memConfigured</td>
<td>memEntry 3</td>
<td>The amount of memory the virtual machine was configured with (in KB).</td>
</tr>
<tr>
<td>memUtil</td>
<td>memEntry 4</td>
<td>The amount of memory currently used by the virtual machine (in KB).</td>
</tr>
</tbody>
</table>

#### Disk Subtree

<table>
<thead>
<tr>
<th>vmwHBATable</th>
<th>vmwResources 3</th>
<th>A table used for reporting disk adapter and target information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>hbaEntry</td>
<td>vmwHBATable 1</td>
<td>A record for a single HBA connected to the host machine.</td>
</tr>
<tr>
<td>hbaIdx</td>
<td>hbaEntry 1</td>
<td>Index for the HBA table.</td>
</tr>
<tr>
<td>hbaName</td>
<td>hbaEntry 2</td>
<td>A string describing the disk. Format: (&lt;\text{devname}#&gt;:&lt;\text{tgt}&gt;:&lt;\text{lun}&gt;).</td>
</tr>
<tr>
<td>hbaVMID</td>
<td>hbaEntry 3</td>
<td>The identification number allocated to the running virtual machine by the VMkernel.</td>
</tr>
<tr>
<td>diskShares</td>
<td>hbaEntry 4</td>
<td>Share of disk bandwidth allocated to this virtual machine.</td>
</tr>
<tr>
<td>numReads</td>
<td>hbaEntry 5</td>
<td>Number of reads to this disk since the disk module was loaded.</td>
</tr>
<tr>
<td>kbRead</td>
<td>hbaEntry 6</td>
<td>Kilobytes read from this disk since the disk module was loaded.</td>
</tr>
<tr>
<td>numWrites</td>
<td>hbaEntry 7</td>
<td>Number of writes to this disk since the disk module was loaded.</td>
</tr>
<tr>
<td>kbWritten</td>
<td>hbaEntry 8</td>
<td>Number of kilobytes written to this disk since the disk module was loaded.</td>
</tr>
</tbody>
</table>

#### Net Subtree

<table>
<thead>
<tr>
<th>vmwNetTable</th>
<th>vmwResources 4</th>
<th>A table used for reporting network adapter statistics.</th>
</tr>
</thead>
<tbody>
<tr>
<td>netEntry</td>
<td>vmwNetTable 1</td>
<td>A record for a single network adapter on the virtual machine.</td>
</tr>
<tr>
<td>netIdx</td>
<td>netEntry 1</td>
<td>Index for the network table.</td>
</tr>
</tbody>
</table>
Table 5-5. Identification Mappings for VMWARE-RESOURCES-MIB (Continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>netName</td>
<td>netEntry 2</td>
<td>A string describing the network adapter.</td>
</tr>
<tr>
<td>netVMID</td>
<td>netEntry 3</td>
<td>The identification number allocated to the running virtual machine by the VMkernel.</td>
</tr>
<tr>
<td>ifAddr</td>
<td>netEntry 4</td>
<td>The MAC address of the virtual machine's virtual network adapter.</td>
</tr>
<tr>
<td>netShares</td>
<td>netEntry 5</td>
<td>Share of network bandwidth allocated to this virtual machine. This object has not been implemented.</td>
</tr>
<tr>
<td>pktsTx</td>
<td>netEntry 6</td>
<td>The number of packets transmitted on this network adapter since the network module was loaded. See SMIv2 version for 64 bit packets.</td>
</tr>
<tr>
<td>kbTx</td>
<td>netEntry 7</td>
<td>The number of kilobytes sent from this network adapter since the network module was loaded. See SMIv2 version for 64 bit packets.</td>
</tr>
<tr>
<td>pktsRx</td>
<td>netEntry 8</td>
<td>The number of packets received on this network adapter since the network module was loaded. See SMIv2 version for 64 bit packets.</td>
</tr>
<tr>
<td>kbRx</td>
<td>netEntry 9</td>
<td>Kilobytes received on this network adapter since the network module was loaded. See SMIv2 version for 64 bit packets.</td>
</tr>
</tbody>
</table>

VMWARE-TC-MIB

The VMWARE-TC-MIB.mib file provides common textual conventions used by VMware MIB files.

VMWARE-TC-MIB.mib defines the following integer values for VmwSubsystemTypes:

- unknown(1)
- chassis(2)
- powerSupply(3)
- fan(4)
- cpu(5)
VMware, Inc. 89

Chapter 5  System Configuration

- memory(6)
- battery(7)
- temperatureSensor(8)
- raidController(9)
- voltage(10)

VMWARE-TC-MIB.mib defines the following integer values for VmwSubsystemStatus:

- unknown(1)
- normal(2)
- marginal(3)
- critical(4)
- failed(5)

VMWARE-TRAPS-MIB

VMWARE-TRAPS-MIB.mib defines traps used by ESX Server and VirtualCenter. All notifications defined in this file are sent by VMware agents using the SNMPv1 trap format. Table 5-6 lists the traps.

**Table 5-6. Traps Defined in VMWARE-TRAPS-MIB**

<table>
<thead>
<tr>
<th>Trap</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmPoweredOn</td>
<td>This trap is sent when a virtual machine is powered on from a suspended or powered off state.</td>
</tr>
<tr>
<td>vmPoweredOff</td>
<td>This trap is sent when a virtual machine is powered off.</td>
</tr>
<tr>
<td>vmHBLost</td>
<td>This trap is sent when a virtual machine detects a loss in guest heartbeat. VMware Tools must be installed in the guest operating system in order for this value to be valid.</td>
</tr>
<tr>
<td>vmHBDetected</td>
<td>This trap is sent when a virtual machine detects or regains the guest heartbeat. VMware Tools must be installed in the guest operating system in order for this value to be valid.</td>
</tr>
<tr>
<td>vmSuspended</td>
<td>This trap is sent when a virtual machine is suspended.</td>
</tr>
<tr>
<td>vpxdTrap</td>
<td>This trap is sent when an entity status has changed.</td>
</tr>
</tbody>
</table>
VMWARE-TRAPS-MIB.mib also defines variables used by these traps. Table 5-7 lists the variables defined in this file.

**Table 5-7. Variables Defined in VMWARE-TRAPS-MIB**

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ESX Server Trap Variables</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>vmID</td>
<td>vmwTraps 101</td>
<td>The ID of the affected virtual machine generating the trap. If there is no virtual machine ID (for example, if the virtual machine has been powered off), the vmID is -1.</td>
</tr>
<tr>
<td>vmConfigFile</td>
<td>vmwTraps 102</td>
<td>The configuration file of the virtual machine generating the trap.</td>
</tr>
<tr>
<td><strong>VirtualCenter Server Trap Variables</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>vpxdTrapType</td>
<td>vmwTraps 301</td>
<td>The trap type of the VirtualCenter trap.</td>
</tr>
<tr>
<td>vpxdHostName</td>
<td>vmwTraps 302</td>
<td>The name of the affected host.</td>
</tr>
<tr>
<td>vpxdVMName</td>
<td>vmwTraps 303</td>
<td>The name of the affected virtual machine.</td>
</tr>
<tr>
<td>vpxdOldStatus</td>
<td>vmwTraps 304</td>
<td>The prior status.</td>
</tr>
<tr>
<td>vpxdNewStatus</td>
<td>vmwTraps 305</td>
<td>The new status.</td>
</tr>
<tr>
<td>vpxdObjValue</td>
<td>vmwTraps 306</td>
<td>The object value.</td>
</tr>
</tbody>
</table>

**VMWARE-VMINFO-MIB**

The VMWARE-VMINFO-MIB.mib file defines variables for reporting virtual machine information. Table 5-8 lists the variables defined in this file.

**Table 5-8. Identification Mappings for VMWARE-VMINFO-MIB**

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmTable</td>
<td>vmwVirtMachines</td>
<td>A table containing information on the virtual machines that have been configured on the system.</td>
</tr>
<tr>
<td>vmEntry</td>
<td>vmTable 1</td>
<td>The record for a single virtual machine.</td>
</tr>
<tr>
<td>vmIdx</td>
<td>vmEntry 1</td>
<td>An index for the virtual machine entry.</td>
</tr>
<tr>
<td>vmDisplayName</td>
<td>vmEntry 2</td>
<td>The display name for the virtual machine.</td>
</tr>
<tr>
<td>vmConfigFile</td>
<td>vmEntry 3</td>
<td>The path to the configuration file for this virtual machine.</td>
</tr>
<tr>
<td>vmGuestOS</td>
<td>vmEntry 4</td>
<td>The guest operating system running on the virtual machine.</td>
</tr>
</tbody>
</table>
### Table 5-8. Identification Mappings for VMWARE-VMINFO-MIB (Continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmMemSize</td>
<td>vmEntry 5</td>
<td>The memory (in MB) configured for this virtual machine.</td>
</tr>
<tr>
<td>vmState</td>
<td>vmEntry 6</td>
<td>The virtual machine power state (on or off).</td>
</tr>
<tr>
<td>vmVMID</td>
<td>vmEntry 7</td>
<td>An identification number assigned to running virtual machines by the VMkernel. Powered-off virtual machines to not have this ID.</td>
</tr>
<tr>
<td>vmGuestState</td>
<td>vmEntry 8</td>
<td>The state of the guest operating system (on or off).</td>
</tr>
<tr>
<td>hbaTable</td>
<td>vmwVirtMachines 2</td>
<td>A table of disk adapters visible to a virtual machine.</td>
</tr>
<tr>
<td>hbaEntry</td>
<td>hbaTable 1</td>
<td>Record for a single HBA.</td>
</tr>
<tr>
<td>hbaVmIdx</td>
<td>hbaEntry 1</td>
<td>A number corresponding to the virtual machine’s index in the vmTable.</td>
</tr>
<tr>
<td>hbaIdx</td>
<td>hbaEntry 2</td>
<td>The virtual machine’s virtual SCSI adapter number.</td>
</tr>
<tr>
<td>hbaNum</td>
<td>hbaEntry 3</td>
<td>The device number for the HBA.</td>
</tr>
<tr>
<td>hbaVirtDev</td>
<td>hbaEntry 4</td>
<td>The virtual device type for this HBA.</td>
</tr>
<tr>
<td>hbaTgtTable</td>
<td>vmwVirtMachines 3</td>
<td>The table of SCSI targets visible to a virtual machine.</td>
</tr>
<tr>
<td>hbaTgtEntry</td>
<td>hbaTgtTable 1</td>
<td>Record for a single SCSI target.</td>
</tr>
<tr>
<td>hbaTgtVmIdx</td>
<td>hbaTgtEntry 1</td>
<td>A number corresponding to the virtual machine’s index in the vmTable.</td>
</tr>
<tr>
<td>hbaTgtIdx</td>
<td>hbaTgtEntry 2</td>
<td>The virtual SCSI target number.</td>
</tr>
<tr>
<td>hbaTgtNum</td>
<td>hbaTgtEntry 3</td>
<td>The SCSI target description.</td>
</tr>
<tr>
<td>netTable</td>
<td>vmwVirtMachines 3</td>
<td>A table of network adapters seen by a virtual machine.</td>
</tr>
<tr>
<td>netEntry</td>
<td>netTable 1</td>
<td>A record for a single network adapter.</td>
</tr>
<tr>
<td>netVmIdx</td>
<td>netEntry 1</td>
<td>A number corresponding to the virtual machine’s index in the vmTable.</td>
</tr>
<tr>
<td>netIdx</td>
<td>netEntry 2</td>
<td>Index for this table.</td>
</tr>
<tr>
<td>netNum</td>
<td>netEntry 3</td>
<td>The device number for the network adapter.</td>
</tr>
<tr>
<td>netName</td>
<td>netEntry 4</td>
<td>The device name for the network adapter.</td>
</tr>
</tbody>
</table>
Basic System Administration

Table 5-9. Identification Mappings for VMWARE-VMKERNEL-MIB

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>netConnType</td>
<td>netEntry 5</td>
<td>Connection type (user or monitor device).</td>
</tr>
<tr>
<td>floppyTable</td>
<td>vmwVirtMachines 5</td>
<td>A table of floppy drives visible to a virtual machine.</td>
</tr>
<tr>
<td>floppyEntry</td>
<td>floppyTable 1</td>
<td>A record for a single floppy device.</td>
</tr>
<tr>
<td>fdVmIdx</td>
<td>floppyEntry 1</td>
<td>A number corresponding to the virtual machine's index in the vmTable.</td>
</tr>
<tr>
<td>fdIdx</td>
<td>floppyEntry 2</td>
<td>Index for the floppy table. Gives the order of the floppy device on the virtual machine.</td>
</tr>
<tr>
<td>fdName</td>
<td>floppyEntry 3</td>
<td>The device number or name for the floppy device.</td>
</tr>
<tr>
<td>fdConnected</td>
<td>floppyEntry 4</td>
<td>Indicates whether the floppy device is connected.</td>
</tr>
<tr>
<td>cdromTable</td>
<td>vmwVirtMachines 6</td>
<td>A table of CD-ROM drives visible to a virtual machine.</td>
</tr>
<tr>
<td>cdromEntry</td>
<td>cdromTable 1</td>
<td>A record for a single CD-ROM drive.</td>
</tr>
<tr>
<td>cdVmIdx</td>
<td>cdromEntry 1</td>
<td>A number corresponding to the virtual machine's index in the vmTable.</td>
</tr>
<tr>
<td>cdromIdx</td>
<td>cdromEntry 2</td>
<td>Index for the CD-ROM table. Gives the order of CD-ROM devices on the virtual machine.</td>
</tr>
<tr>
<td>cdromName</td>
<td>cdromEntry 3</td>
<td>The device number or name for the CD-ROM device.</td>
</tr>
<tr>
<td>cdromConnected</td>
<td>cdromEntry 4</td>
<td>Indicates whether the CD-ROM device is connected.</td>
</tr>
</tbody>
</table>

**VMWARE-VMKERNEL-MIB**

The VMWARE-VMKERNEL-MIB.mib file defines variables used to report the VMkernel state. Table 5-9 lists the variables defined in this file.

Table 5-9. Identification Mappings for VMWARE-VMKERNEL-MIB

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>esxVMKernel</td>
<td>vmwESX 1</td>
<td>The root OID for VMkernel variables.</td>
</tr>
<tr>
<td>vmkLoaded</td>
<td>esxVMKernel 1</td>
<td>Indicates whether the VMkernel has been loaded. Note that if the value of this variable is No, then all other variables reported for ESX Server 3 are invalid.</td>
</tr>
</tbody>
</table>
Using SNMP with VirtualCenter Server

The SNMP agent included with VirtualCenter Server can be used to send traps when an alarm is triggered on the VirtualCenter Server. The VirtualCenter SNMP agent functions only as a trap emitter, and does not support other SNMP operations, such as get. All traps sent by the VirtualCenter Server SNMP agent are SNMP version 1 traps.

The SNMP enterprise trap type for VMware VirtualCenter is 201. It sends no generic traps.

To use the VirtualCenter SNMP traps, you must do the following:

- Configure the SNMP settings on VirtualCenter Server.
- Configure your management software to accept traps from VirtualCenter Server.

To configure SNMP settings on VirtualCenter Server

1. In the VI Client connected to VirtualCenter Server, choose Administration > VirtualCenter Management Server Configuration.

   The VirtualCenter Management Server Configuration dialog box is displayed.

2. Select SNMP to display the SNMP page.

3. In the Receiver URL text box, enter the DNS name or IP address of the SNMP receiver.

4. In the adjacent text box, enter the port number of the SNMP receiver.

   If the port value is left empty, the default value of 162 is used.

5. In the Community String text box, enter the community identifier.

6. To enable additional SNMP receivers, select the appropriate check box, and repeat Steps 3 through 5 for that receiver.

7. Click OK to close the dialog box and save the settings.

The traps sent by VirtualCenter Server are typically sent to other management programs. You must configure your management server to interpret the SNMP traps sent by VirtualCenter Server.
To configure your management program to interpret VirtualCenter SNMP traps

1  (SEE UPDATE) Copy the MIB files to the location required by your management software. To interpret VirtualCenter Server traps, only the following MIB files are needed:
   - VMWARE-ROOT-MIB.mib
   - VMWARE-TRAPS-MIB.mib

The MIB definition files can be found at C:\Program Files\VMware\Infrastructure\VirtualCenter Server\MIBS when the default installation directory is used.

2  Modify your management program to include and interpret the VMware MIBs.

   See your management program documentation for information on adding MIB definitions to your program.

Using SNMP with ESX Server 3

ESX Server 3 ships with two SNMP agents. The first is an SNMP agent based on Net-SNMP with enhancements to support data specific to ESX Server 3. The second agent is identical to that which ships with ESX Server 3i, and can be used and configured in the same manner. See “Using SNMP with ESX Server 3i” on page 96 for more information on this agent.

The Net-SNMP-based agent is compiled for version 5.0.9.2.30E.19 of Net-SNMP. That version of Net-SNMP is installed in the ESX Server 3 service console by default. Background information on Net-SNMP is available at net-snmp.sourceforge.net.

(SEE UPDATE) The ESX Server 3 Net-SNMP-based agent can be used with any management software that can load and compile a management information base (MIB) in SMIv1 format and can understand SNMPv1 trap messages. The ESX Server 3 Net-SNMP-based agent supports both traps and SNMP gets.

The Net-SNMP-based agent reports the following sysObjectID:

SNMPv2-MIB::sysDescr.0 = STRING: VMware ESX Server 0 VMware, Inc. 0 0 i686

SNMPv2-MIB::sysObjectID.0 = OID: SNMPv2-SMI::mib-2.6786.4.1

You can choose to use SNMP with or without any ESX Server MIB items.

The VMware-specific MIB modules are installed when you install ESX Server 3. By default on a fresh install, ESX Server components are enabled in SNMP, and VMware traps are on by default. You must configure a trapsink to receive SNMP traps.
Configuring the ESX Server Agent from the Service Console

(SEE UPDATE) The following procedures must be performed after installing or upgrading third-party management applications.

To enable or disable VMware MIBs on ESX Server 3

1. Log in to the service console as the root user.
2. Edit the /etc/snmp/snmpd.conf configuration file.
3. Add or remove the following line to enable or disable VMware MIB items:
   ```
   dlmod SNMPESX /usr/lib/vmware/snmp/libSNMPESX.so
   ```

To start the ESX Server 3 SNMP agent automatically

You can set the SNMP daemon to start whenever ESX Server 3 boots by logging in as the root user on the service console and running the `chkconfig` command:

```bash
chkconfig snmpd on
```

To start the ESX Server 3 SNMP agent manually

If you must start the SNMP agent manually, log in as root in the service console and run the following command:

```bash
/etc/rc.d/init.d/snmpd start
```

By default, the agent starts and runs as background processes.

To enable and disable traps on ESX Server 3

1. Edit the `config.xml` file.
   
The configuration parameter `snmp/generateTraps` in the `/etc/vmware/hostd/config.xml` file determines whether to generate a trap.
   
   By default, a trap is generated.

2. To disable traps, add the following entry to the file:
   ```xml
   <plugins>
     <snmpsvc><generateTraps>false</generateTraps></snmpsvc>
   </plugins>
   ```

3. To re-enable traps, remove the entry from the file.

4. Restart `vmware_hostd` to see the change take effect.
Configuring SNMP Trap Destinations for ESX Server 3

VMware traps are generated to the destinations specified in the configuration file.

To configure traps

1. Log in to the service console as the root user.
2. Modify the /etc/snmp/snmpd.conf file.
3. Using a text editor, add the following line, replacing mercury.solar.com with the name of the host on your network that will receive traps.

   trapsink example.com

   Repeat this line to specify more than one destination.
4. Add the following line, replacing public with a community name of your choice:

   trapcommunity public.

   Only one instance of this line is allowed.
5. Save your changes.

Using SNMP with ESX Server 3i

ESX Server 3i ships with an SNMP management agent different from that which runs in the service console of ESX Server 3. Currently, this SNMP agent supports only SNMP traps, not GETS. This agent is off by default. To use this agent, you must enable the SNMP service, specify at least one community, and configure a trap destination using the Remote CLI command vicfg-snmp.

Table 5-10 lists the command options and syntax for the vicfg-snmp command. You must target the vicfg-snmp command directly to the ESX Server 3i host. You cannot use this command with a VirtualCenter Server. For more information on installing and using the Remote CLI, see the Remote Command-Line Interface Installation and Reference.

Table 5-10. vicfg-snmp Command Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--communities</td>
<td>Specifies communities separated by commas.</td>
</tr>
<tr>
<td>--disable</td>
<td>Stops the SNMP service.</td>
</tr>
<tr>
<td>-c</td>
<td>The settings specified using this flag overwrite any</td>
</tr>
<tr>
<td></td>
<td>previous settings.</td>
</tr>
<tr>
<td>-D</td>
<td></td>
</tr>
</tbody>
</table>
Configuring SNMP Management Client Software

To use your SNMP management software with the ESX Server 3 or ESX Server 3i agents, take the steps needed to accomplish the following:

- In your management software, specify the ESX Server machine as an SNMP-based managed device.
- Set up appropriate community names in the management software. These must correspond to the values set in the master SNMP agent’s configuration file, for example, rocommunity, trapcommunity, and trapsink.
- Load the ESX Server MIBs into the management software so you can view the symbolic names for the ESX Server variables. You can find the MIB files on ESX Server 5.5 in the /usr/lib/vmware/snmp/mibs directory.

Configuring SNMP Security for ESX Server 3

The ESX Server SNMP package takes the simplest approach to SNMP security in the default configuration. It sets up a single community with read-only access. This is denoted by the rocommunity configuration parameter in the configuration file for the snmpd daemon, snmpd.conf. You should change this file.

Other enhancements to the SNMP security mechanism allow an administrator to set up a more elaborate permissions scheme. See the snmpd.conf(5) man page for details.
SNMP Diagnostics

You can use the following tools to diagnose problems with SNMP configuration.

- Type `vicfg-snmp -T` at the Remote CLI to prompt the ESX Server 3i agent to send a test trap.
- The SNMPv2-MIB file provides a number of counters to aid in debugging SNMP problems. Table 5-11 lists some of these diagnostic counters.

<table>
<thead>
<tr>
<th>Variable</th>
<th>ID Mapping</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>snmpInPkts</td>
<td>snmp 1</td>
<td>The total number of messages delivered to the SNMP entity from the transport service.</td>
</tr>
<tr>
<td>snmpInBadVersions</td>
<td>snmp 3</td>
<td>The total number of SNMP messages that were delivered to the SNMP entity and were for an unsupported SNMP version.</td>
</tr>
<tr>
<td>snmpInBadCommunityNames</td>
<td>snmp 4</td>
<td>The total number of community-based SNMP messages delivered to the SNMP entity that used an invalid SNMP community name.</td>
</tr>
<tr>
<td>snmpInBadCommunityUses</td>
<td>snmp 5</td>
<td>The total number of community-based SNMP messages delivered to the SNMP entity that represented an SNMP operation that was not allowed for the community named in the message.</td>
</tr>
<tr>
<td>snmpInASNParseErrs</td>
<td>snmp 6</td>
<td>The total number of ASN.1 or BER errors encountered by the SNMP entity when decoding received SNMP messages.</td>
</tr>
<tr>
<td>snmpEnableAuthenTraps</td>
<td>snmp 30</td>
<td>Indicates whether the SNMP entity is permitted to generate authenticationFailure traps. The value of this object overrides any configuration information. It therefore provides a means of disabling all authenticationFailure traps.</td>
</tr>
<tr>
<td>snmpSilentDrops</td>
<td>snmp 31</td>
<td>The total number of Confirmed Class PDUs delivered to the SNMP entity that were silently dropped because the size of a reply containing an alternate Response Class PDU with an empty variable-bindings field was greater than either a local constraint or the maximum message size associated with the originator of the request.</td>
</tr>
<tr>
<td>snmpProxyDrops</td>
<td>snmp 32</td>
<td>The total number of Confirmed Class PDUs delivered to the SNMP entity that were silently dropped because the transmission of the message to a proxy target failed in a manner other than a time-out such that no Response Class PDU could be returned.</td>
</tr>
</tbody>
</table>
Using SNMP with Guest Operating Systems

To use SNMP to monitor guest operating systems or applications running in virtual machines, install the SNMP agents you normally would use for that purpose in the guest operating systems. No special configuration is required on ESX Server.

The virtual machine uses its own virtual hardware devices. You should not install agents intended to monitor hardware on the physical computer in the virtual machine.

System Log Files

In addition to lists of events and alarms, VMware Infrastructure components generate assorted logs. These logs contain additional information about activities in your VMware Infrastructure environment.

The following sections discuss system log files:

- “Viewing System Log Entries” on page 99
- “External System Logs” on page 101
- “Configuring Syslog on ESX Server Hosts” on page 102
- “Exporting Diagnostic Data” on page 103
- “Collecting Log Files” on page 104

Viewing System Log Entries

The following two procedures describe how to access and view system logs.

To view system log entries

1. From the VI Client connected to either a VirtualCenter Server or an ESX Server, display the administration panel and view the system log tab.

2. Click the Admin button in the navigation bar. Click the System Logs tab.
3 From the drop-down list, choose the log and entry you want to view.

To search and list selected items

1 With the log you want to filter displayed, choose View > Filtering to refer to the filtering options.
2 Enter text into the data field. Click Clear to empty the data field.
External System Logs

VMware technical support might request several files to help resolve any issues you have with the product. This section describes the types and locations of log files found on various VI3 component systems.

**NOTE** On Windows systems, several log files are stored in the Local Settings directory, which is located at \Documents and Settings\<user name>\Local Settings\. This folder is hidden by default. To view its contents, open My Computer, choose Tools > Folder Options, click the View tab, and choose Show Hidden Files and Folders.

Table 5-12 lists log files associated with ESX Server systems.

<table>
<thead>
<tr>
<th>Table 5-12. ESX Server System Logs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component</strong></td>
</tr>
<tr>
<td>ESX Server 2.x Service log</td>
</tr>
<tr>
<td>ESX Server 3.x Service log</td>
</tr>
<tr>
<td>VI Client Agent log</td>
</tr>
<tr>
<td>Virtual Machine Kernel Core file</td>
</tr>
<tr>
<td>Syslog log</td>
</tr>
<tr>
<td>Service Console Availability report</td>
</tr>
<tr>
<td>VMkernel Messages</td>
</tr>
<tr>
<td>VMkernel Alerts and Availability report</td>
</tr>
<tr>
<td>VMkernel Warning</td>
</tr>
<tr>
<td>Virtual Machine log file</td>
</tr>
<tr>
<td>Virtual Machine Configuration file</td>
</tr>
</tbody>
</table>

Table 5-13 lists log files associated with the VI Client machine.
Configuring Syslog on ESX Server Hosts

All ESX Server hosts run a syslog service (syslogd), which logs messages from the VMkernel and other system components to a file. On an ESX Server 3 host, you can configure syslog behavior by editing the /etc/syslog.conf file. On an ESX Server 3i host, you can use the VI Client or the Remote CLI command vicfg-advcfg to configure the following options:

- Log file path – Specifies a datastore path to a file in which syslogd logs all messages.
- Remote host – Specifies a remote host to which syslog messages are forwarded. You can also specify the port on which the remote host receives messages.

To configure syslogd on an ESX Server 3i host

1. Select the host in the VI Client inventory.
2. Click the Configuration tab to display it.
3. Click Advanced Settings.
4. Select Syslog in the tree control.
5. In the Syslog.Local.DatastorePath text box, enter the datastore path for the file to which syslog will log messages.

The datastore path should be of the form [datastorename]/path/to/file, where the path is relative to the root of the volume backing the datastore. For example, the datastore path [storage1]/var/log/messages would map to the path /vmfs/volumes/storage1/var/log/messages.

If no path is specified, the default path is /var/log/messages.

Table 5-13. VI Client System Logs

<table>
<thead>
<tr>
<th>Component</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>VI Client Installation log</td>
<td>Temp directory on the VI Client machine. Example: C:\Documents and Settings&lt;user name&gt;\Local Settings\Temp\vmmsi.log</td>
</tr>
<tr>
<td>VI Client Service log</td>
<td>\vpx directory in the temp directory on the VI Client machine. Example: C:\Documents and Settings&lt;user name&gt;\Local Settings\Temp\vpx\viclient-x.log x(=0, 1, ... 9)</td>
</tr>
</tbody>
</table>
6 In the Syslog.RemoteHostname text box, enter the name of the remote host to which syslog data will be forwarded.

If no value is specified, no forwarding takes place.

In order to receive the forwarded syslog messages, your remote host must have a syslog service installed and correctly configured. Consult the documentation for the syslog service installed on your remote host for information on configuration.

7 In the Syslog.Remote.Port text box, enter the port on the remote host to which syslog data will be forwarded.

By default, this option is set to 514, which is the default UDP port used by syslog. Changes to this option take effect only if Syslog.RemoteHostname is configured.

8 Click OK.

Changes to the syslog options take effect immediately.

See the Remote Command-Line Interface Installation and Reference for more information on installing and using the Remote CLI.

Exporting Diagnostic Data

There is an option for exporting all or part of your log file data.

To export diagnostic data

1 From the VI Client connected to a VirtualCenter Server or ESX Server, choose Administration > Export Diagnostic Data.

2 If the VI Client is connected to VirtualCenter Server, specify the host whose logs you want to export and the location for storing the log files.
If the VI Client is connected to an ESX Server, specify the location for the log files.

1. Choose Administration. Click Server Settings > Logging Options.
2. Choose Verbose from the pop-up menu.
3. Click OK.

To collect VMware Infrastructure log files

Choose from the options:

- To view the viclient-*.log files, change to the directory, %temp%.
- If you are running the VI Client on the VirtualCenter Server machine, download the log bundle.
To collect ESX Server VMkernel files

- If the VMkernel fails, normally an error message appears for a period of time and then the virtual machine reboots.
- If you specified a VMware core dump partition when you configured your virtual machine, the VMkernel also generates a core dump and error log.

More serious problems in the VMkernel can freeze the machine without an error message or core dump.

To collect ESX Server log files using the Service Console

Run the following script on the service console:

```
/usr/bin/vm-support
```

This script collects and packages all relevant ESX Server 3 system and configuration information and ESX Server log files. This information can be used to analyze the problem you are encountering.

The resulting file has the following format:

```
esx--<date>--<unique-xnumber>.tgz
```
Managing the VI Client Inventory

This chapter describes how to manage the objects in your VMware Infrastructure environment. This includes folders, datacenters, clusters, resource pools, networks, and datastores. These objects are used to help manage or organize the monitored and managed hosts and virtual machines.

**NOTE** The views and capabilities displayed vary depending on whether the VI Client is connected to a VirtualCenter Server or an ESX Server host. Unless indicated, the process, task, or description applies to all kinds of VI Client connections.

This chapter describes how to add or remove inventory objects. Included is a reference to the documentation that describes these items and related activities in detail.

Each object in the VMware Infrastructure Client has its place in the overall hierarchy. An object’s position is determined by the object’s functionality.

This chapter contains the following topics:

- “Understanding VI Client Objects” on page 108
- “Adding an Inventory Object” on page 110
- “Moving Objects in the Inventory” on page 111
- “Removing an Inventory Object” on page 112
- “Working with Files in the Datastore Browser” on page 113
- “Performing an Initial Datacenter Consolidation” on page 114
Understanding VI Client Objects

There are several ways to get insight into the relationships between different objects:

- **Viewing through the Maps feature** – shows the inventory object relationships in graphical form.

- **Clicking an object in the inventory** – provides a list of tabbed content that lists related objects.

  For example, a datastore has a virtual machine tab that lists the virtual machines that use the datastore. There is also a host tab that list the hosts that can access the datastore.

- **Viewing Inventory > Hosts and Clusters** – provides a view of the set of virtual machines that run on a particular host, cluster, or resource pool. Each object has a tab that displays all the virtual machines associated or contained within it.

  However, the Hosts and Clusters view is not a complete list of available virtual machines and templates. Only the **Inventory > Virtual Machines and Templates** option displays all the virtual machine and templates. Through this view you can organize virtual machines into arbitrary folder hierarchies.

The VMware Infrastructure Client objects are as follows:

- **Root folder** – In VirtualCenter Server only. Child objects are datacenters or subfolders. The root folder is set as a default for every VirtualCenter Server. You can change the name, but not add or remove it.

- **Folders** – In VirtualCenter Server only. Child objects are datacenters, hosts, clusters, virtual machines, templates, or subfolders.

- **Datacenters** – In VirtualCenter Server only. Child objects are folders, clusters, or hosts.

  A datacenter contains clusters, hosts, and virtual machines. All actions taken upon managed hosts and virtual machines are applied within their datacenter. Within a datacenter, you can monitor and manage virtual machines separately from their hosts and use VMotion.

- **Clusters** – In VirtualCenter Server only. Child objects are hosts, virtual machines, or resource pools.
If your system is licensed, you can enable the following cluster features:

- **VMware HA** – Allows VirtualCenter to migrate and restart a virtual machine when a host fails. VMware HA is not listed as an inventory object itself, but it allows the cluster object to be seen.

- **VMware DRS** – Monitors the VirtualCenter environment, makes initial placement recommendations, makes virtual machine migration recommendations, makes distributed power management recommendations, and enables VirtualCenter to automatically place and migrate virtual machines on hosts to attain the best use of cluster and power resources. VMware DRS is not listed as an inventory object itself, but it allows the cluster object to be seen.

- **Enhanced VMotion Compatibility (EVC)** – Allows VirtualCenter to enforce VMotion compatibility between all hosts in the cluster by forcing hosts with to expose a common set of CPU features to virtual machines.

  See the Resource Management Guide for comprehensive information on using VMware Infrastructure Client clusters.

- **Hosts** – Child objects are virtual machines or resource pools. Hosts are ESX Server systems. The term host refers to the virtualization platform that is the host to the virtual machines. Host is the default top structure for a standalone ESX Server machine.

  When the VirtualCenter Server is connected to the VMware Infrastructure Client, all ESX Server systems registered with VirtualCenter are referred to as hosts. ESX Server systems directly connected to the VMware Infrastructure Client are referred to as standalone hosts.

  See the ESX Server 3 Configuration Guide or ESX Server 3i Configuration Guide for comprehensive information on configuring your ESX Server system.

- **Resource pools** – Child objects are virtual machines or resource pools. Resource pools are available on ESX Server hosts as well as through VirtualCenter Servers.

  A VMware Infrastructure Client resource pool is used to allocate host-provided CPU and memory to the virtual machines resident to the host.

  See the Resource Management Guide for comprehensive information on using resource pools.
- **Virtual machines** – Located within a host, virtual disks on a datastore, associated within a cluster or resource pool. Can be listed as a child object to hosts, clusters, or resource pools. Can be moved between hosts or clusters. When adding to a cluster or resource pool, you must specify or have in the cluster or resource pool a designated target host.

- **Templates** – A template is a master copy of a virtual machine that can be used to create and provision new virtual machines.

- **Networks** – In VirtualCenter Server only. Child object to datacenters. Networks are discovered when hosts are added to the VMware Infrastructure environment. See the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide* for comprehensive information on configuring ESX Server networks.

- **Datastores** – In VirtualCenter Server only. Child object to datacenters. Datastores are discovered when hosts are added to the VMware Infrastructure environment. This includes the discovery of datastores that are local to the managed host as well as datastores on the SAN or NAS. See the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide* for comprehensive information on configuring ESX Server datastores.

### Adding an Inventory Object

Each inventory object can be added only to its corresponding hierarchical parent. Only permissible objects are listed on the parent menus. These pairings are as follows:

**To add an inventory object**

1. From a VI Client, display the appropriate inventory view.
2. Select the appropriate parent icon in the inventory panel. From the pop-up menu, choose `New <object>` where `<object>` is a folder, datacenter, cluster, resource pool, host, or virtual machine.
If the new object is a folder or datacenter, a new icon is added to the inventory. For example, a new datacenter is added to the hierarchy. Type in a useful name.

If the object is a cluster, resource pool, host, or virtual machine, a wizard appears. Answer the prompts and click Finish.

For additional information, see the appropriate manual:

- **Cluster** – See the Resource Management Guide.
- **Host** – See “Managing Hosts in VirtualCenter” on page 127.
- **Virtual machine** – See “Managing Virtual Machines” on page 169.

### Moving Objects in the Inventory

Some objects can be manually moved between folders, datacenters, resource pools, and hosts.

**To move an object using drag-and-drop**

1. From a VI Client, display the appropriate inventory view.
2. Select the object to be moved from the appropriate inventory view by clicking it. A box is displayed around it. This indicates the object is selected.
3 Drag the moving object to the target object.

- **If the moving object is allowed to move to the target**, the target object is displayed with a box around it, indicating it is selected.
- **If the moving object is not allowed to move to the target**, a naught sign (zero with a slash) appears, and the object is not moved.

The inventory objects can be moved as follows:

- **Root folder, root host (ESX Server), networks, and datastores** — Cannot be moved.
- **Folders** — Can be moved within a datacenter.
- **Datacenter** — Can be moved to folders at a sibling or parent level.
- **Cluster** — Can be moved between folders and within datacenters at a sibling or parent level.
- **Host** — When managed by a VirtualCenter Server, if a host is in a cluster, all virtual machines on the host must be shut down and the host must be placed into maintenance mode before it can be moved from the cluster. A host can be moved between clusters and datacenters.
- **Resource pools** — Can be moved to other resource pools and folders.
- **Virtual machines** — Can be moved to other resource pools, clusters, folders, datacenters, or hosts. When adding to anything other than a host, you must specify a target host.

4 Correct the conditional situation, if needed.

When you release the mouse button after dragging the object moves to the new location or an error message indicates what needs to be done to permit the move.

### Removing an Inventory Object

When you remove an object (such as a folder, datacenter, cluster, or resource pool), VirtualCenter removes all child inventory objects (such as datacenters, clusters, hosts, and virtual machines contained within the object). All the associated tasks and alarms are also removed. Assigned processor and migration licenses are returned to available status. Virtual machines that were on a managed host remain on the host, but are no longer managed by VirtualCenter.

**NOTE** The remove option does not delete virtual machines from its datastore.
To remove an inventory object

1. From a VI Client, display the appropriate inventory view.
2. Select the object. From the pop-up menu, choose **Remove**.
3. To confirm that you want to remove the object, click **Yes** and follow the prompts, as needed.

When confirmed, VirtualCenter removes all clusters, hosts, and virtual machines within the datacenter from the managed inventory. In addition, all the associated tasks, alarms, and events are also removed. Assigned processor and migration licenses are returned to available status. Virtual machines that were on the managed host remain on the host. The root folder cannot be removed.

**Working with Files in the Datastore Browser**

The Datastore Browser allows you to manage the contents of datastores in the VI Client inventory. You can use the Datastore Browser to do the following:

- View or search the contents of a datastore.
- Add a virtual machine or template stored on a datastore to the VI Client inventory.
- Copy or move files from one location to another, including to another datastore.
- Upload a file from the client computer to a datastore.
- Download a file from a datastore to the client computer.
- Delete or rename files on a datastore.

The Datastore Browser operates in a manner similar to file system applications like Windows Explorer. It supports many common file system operations, including copying, cutting, and pasting files. The Datastore Browser does not support drag-and-drop operations.

For detailed instructions on using the Datastore Browser, see the VI Client online help.
About Copying Virtual Machine Disks

You can use the Datastore Browser to copy virtual machine disk files between hosts. Disk files are copied as-is, without any format conversion. Disks copied from one type of host to a different type of host might require conversion before they can be used on the new host.

You can download virtual disks from a datastore to local storage, but you cannot upload virtual disks from local storage to a datastore, because the disk format cannot be verified during the upload.

Performing an Initial Datacenter Consolidation

VirtualCenter includes a feature that enables you to build your inventory by importing physical systems into VirtualCenter as virtual machines. This feature offers a quick, automated way of populating a new virtual environment. For details, see “Consolidating the Datacenter” on page 117.
Virtual Machine Management
This chapter describes the Guided Consolidation feature, a feature recommended for smaller IT environments to get set up and running with VMware Infrastructure. This feature enables you to consolidate physical systems in your datacenter by converting them to virtual machines and importing them into VirtualCenter.

This chapter contains the following topics:

- “About Datacenter Consolidation” on page 118
- “Consolidation Prerequisites” on page 118
- “First Time Use” on page 119
- “About Consolidation Services” on page 119
- “Specifying Consolidation Settings” on page 120
- “Finding Physical Systems” on page 120
- “Viewing Analysis Results” on page 122
- “Consolidating Candidates” on page 123
- “Viewing Consolidation Tasks” on page 125
- “Troubleshooting Consolidation” on page 125
About Datacenter Consolidation

Access the Guided Consolidation feature by clicking the Consolidation navigation button.

Guided Consolidation, recommended for smaller IT environments, enables you to streamline your datacenter by moving business applications spread across multiple disparate physical systems, into a centrally managed virtual environment. In the virtualized environment, the physical systems that run your business applications are transformed into virtual machines. Multiple virtual machines can be hosted on a single physical system, enabling more efficient use of computing resources. Consolidating your datacenter involves the following process:

- **Find** – You search for and select the physical systems in your datacenter that you want analyzed. See “Finding Physical Systems” on page 120.

- **Analyze** – Selected physical systems are analyzed and performance data on each selected system is collected. Generally, the longer the duration of the analysis phase the higher the confidence in the VirtualCenter’s recommendations. See “Viewing Analysis Results” on page 122.

- **Consolidate** – Performance data is compared to the resources available on the virtual machine host systems. The selected physical systems are converted to virtual machines and imported into VirtualCenter on the recommended hosts where they are managed along with other components of your virtual environment. See “Consolidating Candidates” on page 123.

Use the consolidation feature to start building your virtual environment, or to further consolidate your datacenter as it grows. If you are using the Consolidation feature for the first time, see “Consolidation Prerequisites” on page 118.

Consolidation Prerequisites

Before you use the Consolidation feature, ensure that the following prerequisites are met:

- At least one datacenter inventory object exists. See “Adding an Inventory Object” on page 110.

- At least one host is registered with VirtualCenter. See “Adding a Host” on page 129.
Consolidation services require local administrator privileges on the VirtualCenter server. Specifically, the collector service must be run with local administrator privileges. Additionally, the account used must also be granted the Logon as service privilege. If Active Directory is deployed on your network, the credentials used to run consolidation services must also have sufficient privileges to query the Active Directory database. Supply VirtualCenter with your credentials before you begin a consolidation project. See “Specifying Consolidation Settings” on page 120.

Consolidation services also require administrator access to the systems selected for analysis. Specifically, the collector service uses these credentials to connect to and retrieve configuration and performance data from the physical systems under analysis. See “Supplying System-level Administrator Credentials” on page 122.

**First Time Use**

The first time you use the Consolidation feature, you are prompted to specify consolidation settings (see “Specifying Consolidation Settings” on page 120). A wizard steps you through the process of specifying these settings. You can change these settings at any time by selecting Administration > Consolidation Settings > Credentials tab.

**About Consolidation Services**

Consolidation services are installed together with VirtualCenter Server. Consolidation services include the following:

- VMware Capacity Planner Service – Discovers domains and systems within domains. Collects performance data on systems selected for analysis. It is referred to as the collector service in this document.

- VMware Converter Enterprise Service – Converts physical systems to virtual machines. VirtualCenter provides this service with information about the destination and other parameters, and VMware Converter Enterprise Service handles the conversion operation. This service can be installed the same machine as the VirtualCenter Server, or on a separate machine.

See “Consolidation Prerequisites” on page 118 for information about the user privileges required by each service for proper functioning.

**To view active consolidation services**

Select Administration > Consolidation Settings > Service Status tab.
Specifying Consolidation Settings

Consolidation settings enable you to specify the credentials necessary to run Consolidation services and to specify default system-level credentials (see “Consolidation Prerequisites” on page 118).

To specify consolidation settings

1. Select Administration > Consolidation Settings > Credentials tab.
2. Click Change in one of the following areas:
   - **Service Credentials** – Used to run the collector service on the VirtualCenter Server. Ensure that this account has administrator privileges on the VirtualCenter server and, if Active Directory is deployed, that they also have the necessary privileges to query Active Directory. Furthermore, this account must be granted the user right to Log on as a service. This is accomplished through the Local Security Policy utility (Start > Administrative Tools > Local Security Policy).
   - **Default Credentials** – Used to access systems that are selected for analysis but for which no administrator credentials are specified.
3. Enter a domain-qualified user name (for example, DOMAIN\username) and password.
4. Confirm the password and click OK.

Finding Physical Systems

Finding physical systems involves the following process:

- “Specifying Scope” on page 121
- “Supplying System-level Administrator Credentials” on page 122

**NOTE** Information about discovered systems is cached, and a very large cache can negatively impact VirtualCenter performance. It is recommended that you do not run Guided Consolidation over more than 20,000 systems without clearing the cache. For information about disabling Guided Consolidation, and about clearing the cache, see “Troubleshooting Consolidation” on page 125.

To find physical systems in your datacenter

1. In the VI Client toolbar, click **Consolidation** to display the Consolidation view.
2. In the Getting Started tab click **Analyze physical computers for consolidation**, or in the Analysis tab, click **Start Analysis**.
The Add to Analysis dialog box is displayed. If this is the first time you are using this feature, see “First Time Use” on page 119.

3 Select the systems you want to analyze. See “Specifying Scope” on page 121 for details about using the Add to Analysis dialog box.

4 Click **Add to Analysis**. The Set Authentication dialog box is displayed. See “Supplying System-level Administrator Credentials” on page 122 for details about using the Set Authentication dialog box.

5 Specify authentication credentials and click **OK**. The selected systems are analyzed and results are displayed in the Analysis tab. Proceed to “Viewing Analysis Results” on page 122.

### Specifying Scope

The Add to Analysis dialog box enables you find systems on your network and select the ones you want to analyze. You can specify the systems you want to analyze by computer name, IP address or range of IP addresses, or file name. You can also search for all systems within a domain, then select the ones you want to analyze. If there are many systems in the domain and you are having trouble finding the ones you want, you can filter the list by computer name, IP address, domain, or by systems under analysis.

**NOTE** Up to 100 systems can be simultaneously analyzed.

Also, the first time a domain is selected, it might take some time for VirtualCenter to discover and list the systems it finds. After that, the list is cached so that subsequent searches take less time.

### To manually specify systems to consolidate

1 Select **Manually specify the computers to consolidate**.

2 Do one of the following:

   - Enter computer names or IP addresses. Separate multiple entries with commas.

   - Enter an IP range. Multiple ranges are not permitted.

   - Enter the fully-qualified path to a text file that contains a list of computer names or IP addresses. Each computer name or IP address must be on a separate line in the file. The file must be accessible to the VI Client.
To find systems in a domain
1. Select a domain from the **Domain** drop-down menu.
2. Optionally filter the list by selecting filters and entering your criteria into the text field. You can turn filters on and off by clicking the down arrow to the left of the text box.
3. Optionally sort the list by clicking on a column heading.
4. Select the systems you want to analyze.
5. Click **Add to Analysis**. You might be asked for administrator authentication credentials (see “Supplying System-level Administrator Credentials” on page 122).

**Supplying System-level Administrator Credentials**
VirtualCenter requires administrator access to the systems selected for analysis before it can begin to analyze them. You can specify credentials on a system-by-system basis, and you can specify default credentials that VirtualCenter can use when credentials have not been explicitly specified. Default credentials can be specified at any time through Consolidation Settings (“Specifying Consolidation Settings” on page 120).

To specify credentials for a specific system
1. In the Set Authentication dialog box, enter a domain-qualified user name (for example, **DOMAIN\username**) and password.

   You access the Set Authentication dialog box during the Add to Analysis phase, or after systems have been added to analysis by selecting systems in the Analysis tab and clicking **Set Authentication**.

2. Click **OK**.

**Viewing Analysis Results**
Analysis results are displayed in the Analysis tab. When analysis is complete, the following information is displayed:

- **Physical Computer** – Displays the host name of the physical system being analyzed or imported.
- **CPU Info** – Displays the number of CPUs and their clock speed.
- **Memory Info** – Displays the amount of RAM on the system.
- **Status** – Displays the progress of the analysis.
- **Confidence** – Indicates the degree to which VirtualCenter is able to gather performance data about the system and how good a candidate the system is based on the available data.

- **CPU Usage** – Displays the system’s average CPU usage over time.

- **Memory Usage** – Displays the system’s average memory usage over time.

After reviewing analysis results, you can proceed by creating a consolidation plan. See “Consolidating Candidates” on page 123.

**About the Confidence Metric**

One important metric displayed in the Analysis tab is the **Confidence** metric. During the analysis phase, performance data about each selected system is collected. This data is compared to host resources to determine a **recommendation** for each candidate. The recommendation indicates how well suited, based on the collected data, a candidate is to a particular virtual machine host system. **Confidence** refers to the reliability of the recommendation and it is a function of the duration of the analysis. Recommendations based on longer periods of analysis – and therefore more performance data – receive a higher level of confidence.

**NOTE**  After 24 hours of analysis, VirtualCenter indicates a high level of confidence in its recommendations. However, this can be misleading if a system’s workload varies significantly over weeks or months. To ensure a high level of confidence in a recommendation, allow the duration of the analysis phase to encompass an amount of time that includes representative peaks and troughs in the systems’ workload. Analysis can run up to one month.

**Consolidating Candidates**

After you have analyzed your datacenter, you are ready to convert candidates to virtual machines. In this phase, you select the systems you want to convert. VirtualCenter selects appropriate destinations and configuration parameters for each resultant virtual machine. If more than one virtual machine host is available, you can select the host you want.

**NOTE**  It is highly recommended that you virtualize one candidate at a time. Consolidating multiple candidates simultaneously could cause all virtualization operations to fail if the host does not contain an adequate amount of storage space.
To convert systems using VirtualCenter recommendations

1. In the Analysis tab, select the systems you want to consolidate and click Plan Consolidation.
   
   A dialog box is displayed.

2. Select a system.

3. Optionally change the name displayed in the Physical Computer column by double-clicking it and entering a new name. Your entry will be used as the name for the resultant virtual machine.

4. Optionally change destinations, if alternative destinations are available, by clicking in the Destinations column and selecting from the drop-down menu.
   
   The number of stars displayed in the Destination Rating column indicate the degree to which the host system can comfortably accommodate the estimated resource needs of the resultant virtual machine.

5. Click Consolidate.
   
   A conversion task is instantiated. You can view task progress in the Recent Tasks pane. You view additional information about the task in the Tasks tab. See “Viewing Consolidation Tasks” on page 125.

To convert systems manually

1. In the Analysis tab, right-click on a system and select Convert to Virtual Machine > Manually. The menu option is available only if the VMware Converter Enterprise Client is installed and enabled on your VI Client. You can verify whether VMware Converter Enterprise Client is installed and enabled through the Plugin Manager (Plugins > Plugin Manager > Installed tab).
   
   The Import Wizard is displayed.

2. Complete the wizard to manually specify virtual machine properties.

About Disk Resizing

During the conversion process, physical disks are typically resized to conserve space on the datastore while providing room for growth on the resultant virtual disk.

The following formula is used to resize converted disks:

\[
\text{amount of space used on physical disk} \times 1.25 = \text{resultant virtual disk size}
\]

Virtual disks can not be smaller than 4GB.
**Viewing Consolidation Tasks**

A task is created for each system being converted. Recent tasks are displayed in the Recent Tasks pane. The Tasks tab lists all consolidation tasks. You can view detailed information about a task by selecting it. Information about events related to the selected task are displayed in the Task Details pane.

You can filter the list of tasks by entering criteria in the search field and selecting any combination of the following:

- Name
- Target
- Status
- Initiated by
- Start Time
- Complete Time

**Troubleshooting Consolidation**

Guided Consolidation tasks are resource intensive. If you notice a negative impact on VirtualCenter, consider the following:

- Guided Consolidation caches information about discovered systems, and a very large cache can negatively impact VirtualCenter performance. Do not run Guided Consolidation against more than 20,000 systems.
- Up to 100 systems can be simultaneously analyzed. If you select more than 100 systems, systems will be added, in the order they appear, until the maximum number of systems is reached.

Use the following options to remedy performance issues:

- Disable consolidation and continue to run the collector service. This method prevents consolidation tasks from starting, but does not stop the collector service from gathering data.
- Disable consolidation, and stop and disable the collector service. This method prevents consolidation tasks from starting, and stops the collector service from gathering data. The collected data is not destroyed and can be used if the service is started again.
- Uninstall the collector service. This method removes Guided Consolidation, and the data it has collected will no longer be usable.
Basic System Administration

**Disable Consolidation**

To disable consolidation

1. Select Administration > VirtualCenter Management Server Configuration.
2. Select Advanced Settings.
3. Click Add Row.
4. Enter the following in the **Key** field:
   
   `dontStartConsolidation`

5. Enter the following in the **Value** field:

   `true`

6. Restart the VirtualCenter Server.

   The collector service is still active and will continue to periodically probe systems that are being analyzed.

**Disable the Collector Service**

To disable the collector service

1. Open the Services control panel.
2. Stop the VMware Capacity Planner Service.
3. Disable the VMware Capacity Planner Service.

**Uninstall Guided Consolidation**

To uninstall Guided Consolidation

1. Open the Add or Remove Programs control panel.
2. Remove VMware Capacity Planner for VirtualCenter.
3. (Optional) Remove VMware Converter Enterprise for VirtualCenter.
Managing Hosts in VirtualCenter

This chapter describes how to manage hosts using VirtualCenter. For information on configuration management of ESX Server hosts, see the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide*.

**NOTE** The views and capabilities displayed vary depending on whether the VI Client is connected to a VirtualCenter Server or an ESX Server host. Unless indicated, the process, task, or description applies to all kinds of VI Client connections.

This chapter contains the following topics:

- “About Hosts” on page 128
- “Understanding Host States” on page 129
- “Adding a Host” on page 129
- “Connecting or Disconnecting a Host” on page 132
- “Reconnecting Hosts After Changes to the VirtualCenter SSL Certificate” on page 133
- “Removing a Host from VirtualCenter” on page 135
- “Monitoring Host Health Status” on page 137
- “Host Advanced Configuration Options” on page 138
About Hosts

A host is a virtualization platform, an ESX Server system, that supports virtual machines. A VirtualCenter managed host is an ESX Server host that is registered with VirtualCenter. The task of managing a host is accomplished through the VMware Infrastructure Client. This VI Client can be connected either directly to an ESX Server host or indirectly to hosts through a connection to a VirtualCenter Server.

When ESX Server hosts are connected to the VI Client directly, you manage them individually as standalone hosts. Most of the host configuration and virtual machine configuration features still apply. Features that require multiple hosts, such as migration with VMotion of a virtual machine from one host to another, are not available through the standalone host connection.

When ESX Server hosts are managed by VirtualCenter, they are added to the VMware Infrastructure environment through a VI Client connected to a VirtualCenter Server. Managed hosts are hierarchically placed in datacenters, folders, or clusters under the root node folder.

**CAUTION** If an ESX Server host is connected with a VirtualCenter Server and you attached a VI Client to manage the ESX Server host directly, you receive an error message but are allowed to proceed. This might result in conflicts on the host, especially if the host is part of a cluster. This action is strongly discouraged.

All virtual machines on managed hosts are discovered and imported into VirtualCenter. When you add multiple managed hosts, the VirtualCenter Server identifies any naming conflicts that exist between virtual machines and alerts the system administrator, who can then rename virtual machines as necessary. Configure the virtual machine display names. The name can be up to 80 characters long and may contain alphanumeric characters and the underscore (_) and hyphen (-) characters. The name must also be unique across all virtual machines within a virtual machine group. Names are case-insensitive: the name “my_vm” is identical to “My_Vm”.

When the VirtualCenter Server connects to a managed host, it does so as a privileged user. The individual VMware Infrastructure Client user does not necessarily need to be an administrative user on the managed host. See “Assigning Access Permissions” on page 279 for information on setting up VMware Infrastructure Client users.
Understanding Host States

Actions taken upon a managed host require that the managed host be in a specific state. Whenever an operation is performed on a managed host, the host state changes. While the state is in transition, the state field displays a term that describes the transition.

**NOTE** Disconnecting a managed host differs from removing the managed host from the VirtualCenter Server. Disconnecting a managed host does not remove it from the VirtualCenter Server; it temporarily suspends all VirtualCenter Server monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter Server inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter Server inventory.

Adding a Host

Virtual machines exist on managed hosts within the network. Hosts are added to the VMware Infrastructure environment. The VirtualCenter Server discovers and adds all the virtual machines contained within that managed host to the VMware Infrastructure environment.

If you are connecting your VI Client to an ESX Server directly, the procedures in this section do not apply.

**NOTE** When adding or removing hosts, make sure NFS mounts are active. If NFS mounts are unresponsive, the operation fails. (SEE UPDATE)

**To add a host to the VirtualCenter Server**

1. Ensure a communication channel through a firewall, if needed.
   
   If any managed host in the VirtualCenter environment is behind a firewall, ensure that the managed host can communicate with the VirtualCenter Server and with all other hosts on port 902 or another configured port. See the *Installation Guide for ESX Server 3* or the *Setup Guide* for your ESX Server 3i product, and the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide* for additional information.

2. Click the **Inventory** button in the navigation bar. Expand the inventory as needed, and click the appropriate datacenter, folder, or cluster.

3. Select the appropriate datacenter or cluster, and choose **New Host** from the main or pop-up menu.
4 Enter the managed host connection settings.

a Type the name of the managed host in the Host name field.

b Enter the Username and Password for a user account that has administrative privileges on the selected managed host.

VirtualCenter uses the root account to log in to the system and then creates a special user account. VirtualCenter then uses this account for all future authentication.

5 To confirm the Host Summary information, click Next.

6 If you are adding the host to a cluster:
a Specify what should happen to the resource pools on the host.
   
   The options are:
   
   - Put all the host’s virtual machines into the cluster’s root resource pool.
   - Create new resource pool for the host’s virtual machines. The default resource pool name is derived from the host’s name. Type over the text to supply your own name.

b Click Next.

See the Resource Management Guide for more information on clusters.

7 If you are adding the host to a datacenter:

a Identify the location of the host’s virtual machines.

b Select from the list of inventory objects displayed in the Selection box.

8 To confirm completing the Add Host wizard, click Finish.

When the dialog box is complete and you click Next, VirtualCenter does the following:

- Searches the network for the specified managed host and identifies all the virtual machines on the managed host. If you click Cancel, the host is removed from the VirtualCenter inventory.

- Connects to the managed host. If the wizard cannot connect to the managed host, the managed host is not added to the inventory.

- Verifies that the managed host is not already being managed. If it is already being managed by another VirtualCenter Server, VirtualCenter displays a message. If the wizard can connect to the managed host but for some reason cannot remain connected to the VirtualCenter Server, the host is added, but is in a disconnected state. This occurs, for example, if the host is already being managed by another VirtualCenter Server.
Reads the number of processors on the managed host and allocates the appropriate number of licenses. The number of processors is stored in the VirtualCenter database and is verified upon each managed host reconnection and VirtualCenter startup.

**NOTE** Newer processors have two CPU cores in each processor package. Systems with dual-core processors must use ESX Server 2.5.2 or later. VirtualCenter licenses are issued by pairs of processor packages, not by processor cores. Therefore, if the system is using two dual-core processors or two single-core processors, the system requires a single 2-processor VirtualCenter license.

Verifies that the managed host version is supported. If it is not, and the managed host version can be upgraded, VirtualCenter prompts you to perform an upgrade.

Imports existing virtual machines.

**Connecting or Disconnecting a Host**

You have the option to disconnect and reconnect a managed host that is being managed by a particular VirtualCenter Server. This section describes how to reconnect a managed host.

**NOTE** Disconnecting a managed host differs from removing the managed host from VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it temporarily suspends all VirtualCenter monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter inventory.

**To connect or disconnect a managed host**

1. From the VI Client connected to a VirtualCenter Server, click the **Inventory button** in the navigation bar. Expand the inventory as needed, and click the appropriate managed host.

2. Select the appropriate managed host icon in the inventory panel, and choose **Connect** or **Disconnect** from the pop-up menu.

3. When disconnecting, confirm the action. Click **Yes**.

When the managed host's connection status to VirtualCenter is changed, the statuses of the virtual machines on that managed host are updated to reflect the change.
If the managed host is disconnected, the word “disconnected” is appended to the object name in parentheses, and the object is dimmed. All associated virtual machines are similarly dimmed and labeled.

Reconnecting Hosts After Changes to the VirtualCenter SSL Certificate

The VirtualCenter Server uses an SSL certificate to encrypt and decrypt host passwords stored in the VirtualCenter database. If the certificate is replaced or changed, the VirtualCenter Server cannot decrypt host passwords, and therefore cannot connect to managed hosts.

If the VirtualCenter Server fails to decrypt a host password, the host is disconnected from the VirtualCenter Server. You must reconnect the host and supply the login credentials, which will be encrypted and stored in the database using the new certificate. See “Connecting or Disconnecting a Host” on page 132.

Removing a Host from a Cluster

Hosts can be removed from a cluster by selecting them from either the inventory or list views and dragging them to a new location within the inventory (either to a folder as a standalone host or to another cluster). When a host is removed from a cluster, the resources it provides are deducted from the total cluster resources. The virtual
machines deployed on the host are either migrated to other hosts within the cluster or remain with the host and are removed from the cluster, depending on their current state. Hosts can be removed from a cluster only if all of the virtual machines on it are powered off, and the host is placed into maintenance mode.

See the Resource Management Guide for complete cluster information.

To remove a host from a cluster

1. From the VI Client connected to a VirtualCenter Server, display the inventory.
2. To remove the VirtualCenter agent from the managed host, ensure that the managed host is in a connected state.
3. Power off all virtual machines on the host, or migrate the virtual machines to a new host using VMotion.
4. Select the appropriate managed host icon in the inventory panel, and choose Enter Maintenance Mode from the pop-up menu. Click Yes.

The host icon changes and the term “maintenance mode” is added to the name in parentheses.
5 Move the host:
   a Select the host icon in the inventory panel, and drag it to the new location.
      The host can be moved to another cluster or another datacenter. When the new
      location is selected, a blue box surrounds the cluster or datacenter name.
   b Release the mouse button.
      VirtualCenter moves the host to the new location.

6 Select the host, and from the pop-up menu choose Exit Maintenance Mode.

7 Restart any virtual machines, as needed.

**Removing a Host from VirtualCenter**

Removing a managed host from VirtualCenter breaks the connection and stops all
monitoring and managing functions of that managed host and of all the virtual
machines on that managed host. The managed host and its associated virtual machines
are removed from the inventory. Historical data remains in the VirtualCenter database.

**NOTE** If at all possible, remove managed hosts while they are connected. Removing a
disconnected managed host does not remove the VirtualCenter agent from the
managed host.

Removing a managed host differs from disconnecting the managed host from
VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it
temporarily suspends all VirtualCenter monitoring activities. The managed host and its
associated virtual machines remain in the VirtualCenter inventory.

Removing a managed host from VirtualCenter does not remove the virtual machines
from the managed host or datastore. It removes only VirtualCenter’s access to the
managed host and virtual machines on that managed host.

The figure below illustrates the process for removing a managed host from
VirtualCenter. In the example here, notice the lost link between the VirtualCenter
Server and the removed managed host, while the managed host files remain on the
datastore.
**To remove a managed host**

1. From the VI Client connected to a VirtualCenter Server, display the inventory.

2. To remove the VirtualCenter agent from the managed host, ensure that the managed host is in a connected state.

   The managed host can be in a connected or disconnected state when you remove it. However, removing a managed host while it is disconnected does not remove the VirtualCenter agent from the managed host.

3. Power off all virtual machines on the host, or migrate the virtual machines to a new host using VMotion.

4. **If the host is part of a cluster**, select the appropriate managed host icon in the inventory panel and choose **Enter Maintenance Mode** from the pop-up menu. Confirm placement. Click **Yes**.
5 Select the appropriate managed host icon in the inventory panel, and choose **Remove** from the pop-up menu.

![Remove Compute Resource](image)

6 Click **Yes** to remove the managed host. Click **No** to keep the managed host.

If you click **Yes**, VirtualCenter removes the managed host and associated virtual machines from the VirtualCenter environment. VirtualCenter then returns all associated processor and migration licenses to available status.

**Monitoring Host Health Status**

The host health monitoring tool allows you to monitor the health of a variety of host hardware components including:

- CPU processors
- Memory
- Fans
- Temperature
- Voltage
- Software components

The host health monitoring tool presents data gathered using Systems Management Architecture for Server Hardware (SMASH) profiles. The information displayed depends on the sensors available on your server hardware.

**To monitor the health of a host**

1 Log in to a VirtualCenter Server using the VI Client, and select the host in the inventory.

2 Click the **Configuration** tab and click **Health Status**.

The sensor data is displayed in a tree. The root of the tree displays the overall host health status.
If a component is functioning normally, the status indicator is green. The status indicator changes to yellow or red if a system component violates a performance threshold or is not functioning properly. Generally, a yellow indicator signifies degraded performance. A red indicator signifies that a component stopped operating or exceeded the highest threshold.

The Reading column displays the current values for the sensors. For instance, the column displays rotations per minute (RPM) for fans and degrees Celsius for temperature.

You can set an alarm to trigger based on the overall health status of the host. For more information, see “Creating Alarms” on page 321.

**Resetting Sensors**

Some host hardware sensors display data that is cumulative over time. You can reset these sensors to clear the data in them and begin collecting new data.

**To reset sensors**

1. Log in to a VirtualCenter Server using the VI Client, and select the host in the inventory.
2. On the host Configuration tab, click **Health Status**.
3. Click **Reset Sensors**.

**Refreshing Health Status Data**

The VI Client refreshes the data from host health sensors automatically every few minutes. You can also refresh data manually.

**To refresh health status data**

1. Log in to a VirtualCenter Server using the VI Client, and select the host in the inventory.
2. On the host Configuration tab, click **Health Status**.
3. Click **Refresh**.

**Host Advanced Configuration Options**

See the Resource Management Guide for complete information on configuring and using the resource allocation features, which include VMware HA and VMware DRS.

See the ESX Server 3 Configuration Guide or ESX Server 3i Configuration Guide for complete information on configuring ESX Server hosts.
Importing and Exporting Virtual Machines

The VMware Infrastructure Client (VI Client) allows you to import and export virtual appliances stored in Open Virtual Machine Format (OVF). An appliance is a pre-configured virtual machine that typically includes a preinstalled guest operating system and other software.

Importing virtual appliances allows you to add pre-configured virtual machines to your Virtual Center or ESX Server inventory. Importing a virtual appliance is similar to deploying a virtual machine from a template. However, you can import a virtual appliance from any local file system accessible from the VI Client machine, or from a remote Web server. The local file systems can include local disks (such as C:), removable media (such as CDs or USB keychain drives), and shared network drives.

Exporting virtual machines allows you to create virtual appliances that can be imported by other users. You can use the export function to distribute pre-installed software as a virtual appliance, or as a means of distributing template virtual machines to users, including users who cannot directly access and use the templates in your VirtualCenter inventory.

This chapter discusses the following topics:

- “About OVF” on page 140
- “Importing a Virtual Appliance” on page 140
- “Exporting a Virtual Machine” on page 141
About OVF

OVF is a file format that allows for exchange of virtual appliances across products and platforms. The OVF format offers the following advantages:

- OVF files are compressed, allowing for faster downloads.
- The VI Client validates a OVF file before importing it, and ensures that it is compatible with the intended destination server. If the appliance is incompatible with the selected host, it cannot be imported and an error message is displayed.

Importing a Virtual Appliance

You can import a virtual appliance stored in OVF format from a local file system accessible to the VI Client machine, or from a Web URL.

**NOTE** To import a virtual machine that was created by another VMware product and is not in OVF format, use the VMware Converter Enterprise module. See the VMware Converter Enterprise for VirtualCenter documentation for more information.

**To import a virtual appliance**

1. In the VI Client, choose *File > Virtual Appliance > Import*. The Import Virtual Appliance wizard is displayed.
2. Select one of the following options:
   - **Import from File** – Browse your file system for an appliance.
   - **Import from URL** – Specify a URL to an appliance located on the internet. Example: `http://vmware.com/VMTN/appliance.ovf`
   - **Import from VMware Virtual Appliance Marketplace** – Select from VMware appliances available on the VMware Virtual Appliance Marketplace Web site.
3. Click *Next*. The Virtual Appliance Details page is displayed.
4. Click *Next*.
5. If license agreements are packaged with the appliance, the End User License Agreement page is displayed. Agree to accept the terms of the licenses and click *Next*. 
6 (Optional) Edit the name and select a datacenter.

A default name might be provided. You can optionally edit the name. The name can be up to 80 characters long and can contain alphanumeric characters and the underscore (_) and hyphen (-) characters. It should also be unique within the virtual machine folder. Names are case-sensitive. (SEE UPDATE)

7 Click Next.

8 On the Host/Cluster/Resource Pool page, select the host, cluster, or resource pool (if applicable) in which you want to run the virtual machine and click Next.

9 If you selected a cluster or a resource pool on the previous page, and DRS is disabled or is in manual mode, the Specific Host page appears. Select the host on which you want to run this virtual machine, and click Next.

10 Choose a datastore for the virtual machine, and click Next.

    The virtual machine configuration file and virtual disk files are stored on the datastore. Choose a datastore large enough to accommodate the virtual machine and all of its virtual disk files.

11 If your infrastructure contains multiple networks, map each network specified in the OVF file to a network in your infrastructure.

12 Click Next.

13 Review your settings and click Finish.

    The progress of the import task is displayed in the VI Client Status panel.

**Exporting a Virtual Machine**

You can export a virtual machine to OVF format to make it available to other users to import into their inventory.

**To export a virtual machine**

1 In the VI Client inventory, select the virtual machine you want to export.

2 Choose File > Virtual Appliance > Export.

3 In the Directory text box, enter the location to store the exported virtual machine.
4 To create a new folder for the OVF file, select **Make New Folder**.

5 (Optional) Enter a description of the virtual machine in the **Description** text box.

By default, the text from the **Notes** pane on the virtual machine’s Summary tab appears in this text box.

6 Click **OK**.

The progress of the export task is displayed in the VI Client Status panel.
The VMware Infrastructure Client (VI Client) enables you to deploy and manage virtual machines. The VI Client provides several ways to create virtual machines:

- **Importing** – You can import a virtual machine stored in OVF format. See Chapter 9, “Importing and Exporting Virtual Machines,” on page 139.

- **Consolidate** – You can consolidate existing physical systems by converting them to virtual machines and importing those into VirtualCenter. See “Consolidating the Datacenter” on page 117.

- **Create New** – You can manually configure entirely new virtual machines. See “Using the New Virtual Machine Wizard” on page 144.

- **Clone** – You can create exact replicas of existing virtual machines. See Chapter 13, “Working with Templates and Clones,” on page 203.

- **Deploy from Templates** – You can create virtual machines from templates that provide a base configuration which you can customize. See Chapter 13, “Working with Templates and Clones,” on page 203.

For each type of creation process, a wizard guides you through the steps to produce a complete and working virtual machine.

**NOTE**  After you create a virtual machine, you must install the guest operating system and VMware Tools. None of the creation processes described above installs guest operating systems for you. Also, check the installation notes for your guest operating system before you install it. You can find this information in the Guest Operating System Installation Guide.
This chapter contains the following topics:

- “Using the New Virtual Machine Wizard” on page 144
- “Installing a Guest Operating System” on page 154
- “Installing and Upgrading VMware Tools” on page 155

You must have the appropriate privileges before you can create virtual machines. Consult your VirtualCenter administrator if you are not sure whether you have the necessary privileges.

### Using the New Virtual Machine Wizard

You can access the New Virtual Machine wizard from many different locations. The instructions in this chapter see one method of starting the wizard. In most contexts, the right-click pop-up menu for the following GUI objects includes an option that enables you to launch the New Virtual Machine wizard:

- Resource pools
- Clusters
- Hosts
- Virtual machine folders

As with the VI Client as a whole, the New Virtual Machine wizard is context sensitive and its screens and configuration options change depending on your host environment and your selections. Only those screens and options that are applicable to the current context are enabled; items that are not applicable to the context are either removed or disabled.

After you launch the New Virtual Machine wizard, you must choose one of the following paths:

- **Typical** — This path shortens the process by skipping some choices that rarely need changing from their defaults. See “Creating Typical Virtual Machines” on page 145.

- **Custom** — The custom path provides more flexibility and options. See “Creating Custom Virtual Machines” on page 148.

### Performing Additional Configuration Before Completion

The final wizard screen for each path enables you to review your configuration selections and optionally open the Virtual Machine Properties dialog box to set further configuration options, such as adding additional disks, before instantiating the virtual machine.
To open the Virtual Machine Properties dialog box from the New Virtual Machine wizard, select the **Edit the virtual machine settings before completion** check box and click **Next**. For information about the Virtual Machine Properties dialog box, see “Virtual Machine Properties Editor” on page 179.

### Creating Typical Virtual Machines

The typical path is abbreviated because some assumptions are made about the virtual machine configuration. If you want to fully customize your virtual machine, see “Creating Custom Virtual Machines” on page 148.

**To create a new virtual machine through the typical path**

1. From the VirtualCenter client, click **Inventory** in the navigation bar and expand the inventory as needed.
2. In the inventory list, select the managed host to which you want to add the new virtual machine.
   
   The Summary tab for the host appears.
3. Choose **File > New > Virtual Machine**.
   
   The New Virtual Machine wizard appears.
4. Select **Typical**, and click **Next**.
5. Type a virtual machine name, and click **Next**.
   
   The name you enter in the **Virtual Machine Name** field is the name that is listed in the VirtualCenter client inventory. It is also used as the name of the virtual machine's files. The name can be up to 80 characters long and may contain alphanumeric characters and the underscore (_) and hyphen (-) characters. This name must be unique within the folder. Names are case-insensitive: the name "my_vm" is identical to "My_Vm".
6. Select a folder or the root of a datacenter, and click **Next**.
7. If the resource pool option is available, expand the tree until you locate the resource pool in which you want to run the virtual machine, highlight it, and click **Next**.

   Resource pools allow you to manage your computing resources within a host or hosts by setting them up in a meaningful hierarchy. Virtual machines and child resource pools share the resources of the parent resource pool. For more information on resource pools, see the *Resource Management Guide*. 

VMware, Inc.
8 Select a datastore in which to store the virtual machine files, and click **Next**.

You should choose a datastore large enough to hold the virtual machine and all of its virtual disk files. For ESX Server hosts, the **Datastore** is configured on that host, including VMFS, NAS, and iSCSI volumes.

9 Under **Guest Operating System**, select the operating system family (Microsoft Windows, Linux, Novell NetWare, Solaris, or Other), select the version from the drop-down menu, and click **Next**. If you select **Other**, enter a display name for your operating system. You can change this name after the virtual machine has been created by opening the Virtual Machine Properties dialog box and editing the **Options** tab > **Advanced** > **General** > **Configuration Parameters** > **guestOSAltName** parameter.

This is the operating system for your virtual machine. Your choice should be based on your planned use of the virtual machine. The selected guest operating system affects the supported devices and number of virtual CPUs available for the virtual machine.

*See the Guest Operating System Installation Guide for details.*

The wizard does not install the guest operating system for you. The New Virtual Machine wizard uses this information to select appropriate default values, such as the amount of memory needed.

10 Select the number of virtual processors in the virtual machine from the drop-down menu, and click **Next**.

Licensing for VMware Virtual SMP™ is required to power on multiple-CPU virtual machines. See the *Installation Guide for ESX Server 3*, or the *Setup Guide* for your ESX Server 3i product, more information on licensing.

**Note** The Virtual CPUs page does not appear if the host is single-processor or the guest operating system does not support SMP (for example, NetWare and Windows NT 4.0).

11 Configure the virtual machine’s memory size by selecting the number of megabytes.

The minimum, recommended, maximum for best performance, and maximum sizes are based on the guest operating system. Regardless of the guest operating system, the minimum memory size is 4MB. The maximum depends on the host, but for ESX Server 3.5 and ESX Server 3i version 3.5 it is 65532MB (64GB minus 4MB). The memory size must be a multiple of 4MB.
The colored triangles along the slider represent these amounts as indicated by the key on the wizard. You can also drag the slider or select the number using the up and down arrows. The maximum for best performance represents the threshold above which the host's physical memory is insufficient to run the virtual machine at full speed. This value fluctuates as conditions on the host change (as virtual machines are powered on or off, for example).

12 Click Next.

13 Choose the networks to connect to and their options by selecting how many network adapters (NICs) you want to connect to, the names of the networks, and whether you want to connect to them at power on.

The Network drop-down menu lists the port groups that are configured for virtual machine use on the host. If no virtual machine port groups are configured, a warning dialog box appears, and you are not allowed to configure any virtual network cards.

**NOTE** Exercise caution when you configure a virtual machine to connect to multiple networks. Because virtual machines share their physical network hardware with the host, the accidental or malicious bridging of two networks by a virtual machine can occur. Minimum Spanning Tree protocol cannot protect against these occurrences.

14 Click Next.

15 Specify the size of the virtual disk.

Enter the disk size in megabytes (MB) or gigabytes (GB). The default is 4GB. The available space on the selected VMFS volume is listed. You can configure a disk from as small as 1MB to as large as 2TB (2048GB), using a whole number of MB or GB.

The virtual disk should be large enough to hold the guest operating system and all of the software that you intend to install with room for data and growth.

You cannot change the virtual disk's maximum capacity later, but you can install additional virtual disks later by using the Virtual Machine Properties dialog box.

For example, you need about 1GB of actual free space on the file system containing the virtual disk to install Windows Server 2003 and applications, such as Microsoft Office, inside the virtual machine.
16 Click Next.

17 On the Ready to Complete New Virtual Machine page, review your selections and specify the following option:

**Edit the virtual machine settings before submitting the creation task**

Check this option if you want to open the Virtual Machine Properties dialog box to set further configuration options, such as adding additional disks (see “Performing Additional Configuration Before Completion” on page 144).

**NOTE** Before you can use your new virtual machine, you must first partition and format the virtual drive, install a guest operating system, then install VMware Tools. Typically, the operating system's installation program handles partitioning and formatting the virtual drive.

See “Installing a Guest Operating System” on page 154 and “Installing and Upgrading VMware Tools” on page 155.

### Creating Custom Virtual Machines

This section describes the steps taken when you select the custom path in the New Virtual Machine wizard.

To create a new virtual machine through the custom path

1. From the VirtualCenter client, click **Inventory** in the navigation bar, and expand the inventory as needed.

2. In the inventory list, select the managed host to which you want to add the new virtual machine.

3. Choose **File > New > Virtual Machine**.

   The New Virtual Machine wizard appears.

4. Select Custom, and click **Next**.

5. Type a virtual machine name, and click **Next**.

   The name you enter in the **Virtual Machine Name** field is the name that is listed in the VirtualCenter client inventory. It is also used as the name of the virtual machine's files. The name can be up to 80 characters long and may contain alphanumeric characters and the underscore ( _ ) and hyphen ( - ) characters. This name should be unique across the entire datacenter and must be unique within the folder. Names are case-insensitive: the name "my_vm" is identical to "My_Vm".

6. Select a folder or the root of a datacenter, and click **Next**.
Chapter 10 Creating Virtual Machines

7 If the resource pool option is available, expand the tree until you locate the resource pool in which you want to run the virtual machine, highlight it, and click Next.

Resource pools allow you to manage your computing resources within a host or hosts by setting them up in a meaningful hierarchy. Virtual machines and child resource pools share the resources of the parent resource pool. For more information on resource pools, see the Resource Management Guide.

8 Select a datastore in which to store the virtual machine files, and click Next.

Choose a datastore large enough to hold the virtual machine and all of its virtual disk files. For ESX Server hosts, the Datastore is configured on that host, including VMFS, NAS, and iSCSI volumes.

9 Under Guest operating system, select the operating system family (Microsoft Windows, Linux, Novell NetWare, Solaris, or Other).

10 Choose the version from the drop-down menu.

This is the operating system for your virtual machine. Your choice should be based on your planned use of the virtual machine. The selected guest operating system affects the supported devices and number of virtual CPUs available for the virtual machine.

The wizard does not install the guest operating system for you. The New Virtual Machine wizard uses this information to select appropriate default values, such as the amount of memory needed.

11 Click Next.

12 Select the number of virtual processors in the virtual machine from the drop-down menu, and click Next.

NOTE The Number of Virtual CPUs page does not appear if the host is single-processor or the guest operating system does not support SMP (for example, Netware and Windows NT 4.0).

13 Configure the virtual machine’s memory size by selecting the number of megabytes.

The minimum, recommended, and maximum sizes are based on the guest operating system. Regardless of the guest operating system, the minimum memory size is 4MB. The maximum depends on the host, but for ESX Server 3.5 and ESX Server 3i version 3.5 it is 65532MB (64GB minus 4MB). The memory size must be a multiple of 4MB.
14 Click Next.

15 Choose the networks to connect to and their options by selecting how many NICs you want to connect to, the names of the networks, and whether you want to connect to them at power on.

If you do not want the virtual network adapter to connect when the virtual machine is powered on, deselect the Connect at Power On check box.

The Network drop-down menu lists the port groups that are configured for virtual machine use on the host. If no virtual machine port groups are configured, a warning dialog box appears, and you are not allowed to configure any virtual network cards.

**NOTE** Exercise caution when you configure a virtual machine to connect to multiple networks. Because virtual machines share their physical network hardware with the host, the accidental or malicious bridging of two networks by a virtual machine can occur. Minimum Spanning Tree protocol cannot protect against these occurrences.

16 Click Next.

17 Choose the type of SCSI adapter you want to use with the virtual machine.

Two IDE adapters and a SCSI adapter are installed in the virtual machine. The IDE adapter is always ATAPI. For the SCSI adapter, you can choose between a BusLogic or LSI Logic SCSI adapter.

In the Select I/O Adapter Types page, the default for your guest operating system is already selected. Older guest operating systems default to the BusLogic adapter. The LSI Logic adapter has improved performance, works better with non-disk SCSI devices, and is included with Windows Server 2003.

You can download the driver from the LSI Logic Web site. See the Guest Operating Installation Guide for details about the driver and the guest operating system you plan to install in this virtual machine.

**NOTE** The choice of SCSI adapter does not affect whether your virtual disk is an IDE or SCSI disk.

18 Select the type of disk, and click Next.

You can store virtual machine data in a new virtual disk, an existing virtual disk, or a mapped storage area network (SAN) logical unit number (LUN).

A virtual disk comprises one or more files on the file system that appear as a single hard disk to the guest operating system. These disks are portable among hosts.
Mapping a SAN LUN gives your virtual machine direct access to that SAN, allowing you to use existing SAN commands to manage storage for the disk.

You also have the option of creating your virtual machine without a disk.

See the SAN Configuration Guide for details about SAN LUN configuration.

- If you choose to create a new virtual disk, go to Step 19.
- If you choose to use an existing virtual disk, go to Step 24.
- If you choose to create a mapped SAN LUN, go to “Mapping a SAN LUN” on page 153.
- If you choose to create a virtual machine without a disk, go to Step 23.

19 **If you chose to create a new virtual disk**, you must select the size of the virtual disk, specify a datastore location for the disk, and click Next.

Enter the disk size in megabytes (MB) or gigabytes (GB). The default is 4GB. The available space on the selected VMFS volume is listed. You can configure a disk from as small as 1MB to as large as 2TB (2048GB), using a whole number of MB or GB.

The virtual disk should be large enough to hold the guest operating system and all of the software that you intend to install with room for data and growth.

You cannot change the virtual disk’s maximum capacity later, but you can install additional virtual disks later by using the Virtual Machine Properties dialog box.

For example, you need about 1GB of actual free space on the file system containing the virtual disk to install Windows Server 2003 and applications, such as Microsoft Office, inside the virtual machine.

You can locate the virtual disk on the same datastore as the virtual machine or select a datastore in another location. Use the Browse button to locate a datastore. The Browse for Datastore dialog box appears.

20 Select The Virtual device node and disk mode for the virtual disk.

21 If you select Independent disk mode, choose one of the following:
   a  **Persistent** — Changes are immediately and permanently written to the disk.
   b  **Nonpersistent** — Changes to the disk are discarded when you power off or revert to the snapshot.

22 Click Next.
23 On the Ready to Complete New Virtual Machine page, review your selections and specify the following option:

**Edit the virtual machine settings before submitting the creation task**

Check this option if you want to open the Virtual Machine Properties dialog box to set further configuration options, such as adding additional disks (see “Performing Additional Configuration Before Completion” on page 144).

**NOTE** Before you can use your new virtual machine, you must first partition and format the virtual drive, install a guest operating system, then install VMware Tools. Typically, the operating system's installation program handles partitioning and formatting the virtual drive.

See “Installing a Guest Operating System” on page 154 and “Installing and Upgrading VMware Tools” on page 155.

24 If you chose to use an existing virtual disk, click Browse and navigate to the virtual disk you want to use. Click Next.

25 Select which virtual device node should be used by your virtual disk.

26 If you select Independent mode, choose one of the following:
   a Persistent – Changes are immediately and permanently written to the disk.
   b Nonpersistent – Changes to the disk are discarded when you power off or revert to the snapshot.

27 Click Next.

28 On the Ready to Complete New Virtual Machine page, review your selections and specify the following option:

**Edit the virtual machine settings before submitting the creation task**

Check this option if you want to open the Virtual Machine Properties dialog box to set further configuration options, such as adding additional disks (see “Performing Additional Configuration Before Completion” on page 144).

**NOTE** Before you can use your new virtual machine, you must first partition and format the virtual drive, install a guest operating system, then install VMware Tools. Typically, the operating system's installation program handles partitioning and formatting the virtual drive.

See “Installing a Guest Operating System” on page 154 and “Installing and Upgrading VMware Tools” on page 155.
Mapping a SAN LUN

For virtual machines running on an ESX Server host, instead of storing virtual machine data in a virtual disk file, you can store the data directly on a SAN LUN. This is useful if you are running applications in your virtual machines that must know the physical characteristics of the storage device.

When you map a LUN to a VMFS volume, VirtualCenter creates a file that points to the raw LUN. Encapsulating disk information in a file allows VirtualCenter to lock the LUN so that only one virtual machine can write to it.

NOTE This file has a .vmdk extension, but the file contains only disk information describing the mapping to the LUN on the ESX Server system. The actual data is stored on the LUN.

You cannot deploy a virtual machine from a template and store its data on a LUN; you can only store its data in a virtual disk file.

To map a SAN LUN

1. From the Select a Disk page, select Mapped SAN LUN.
2. Click Next.
3. Select a LUN for the raw disk.
4. Click Next.
5. Select a datastore onto which to map the LUN.
6. Click Next.
7. Select a compatibility mode, either physical or virtual.

- Physical compatibility mode allows the guest operating system to access the hardware directly. Physical compatibility is useful if you are using SAN-aware applications in the virtual machine. However, a LUN configured for physical compatibility cannot be cloned, made into a template, or migrated if the migration involves copying the disk.

- Virtual compatibility mode allows the virtual machine to use VMware snapshots and other advanced functionality. Virtual compatibility allows the LUN to behave as if it were a virtual disk, so you can use features like disk modes. When you clone the disk, make a template out of it, or migrate it (if the migration involves copying the disk), the contents of the LUN are copied into a virtual disk (.vmdk) file.

Subsequent screens offer different options, depending on your choice.
8 On the Specify Advanced Options page, you can change the virtual device node and click Next.

9 On the Ready to Complete New Virtual Machine page, review your selections. Click Finish to complete your virtual machine, or optionally perform additional configuration (see “Performing Additional Configuration Before Completion” on page 144).

Installing a Guest Operating System

A new virtual machine is like a physical computer with a blank hard disk. Before you can use it, you must partition and format the virtual disk and install an operating system. The operating system's installation program might handle the partitioning and formatting steps for you.

Installing a guest operating system inside your virtual machine is essentially the same as installing it on a physical computer. The basic steps for a typical operating system are described below. See Guest Operating System Installation Guide for more information on individual guest operating systems.

**NOTE** It is sometimes necessary to change the boot order in the virtual machine's BIOS settings. However, sometimes a virtual machine's boot sequence progresses too quickly for a user to open a console to the virtual machine and enter BIOS setup. If this happens, you can modify the virtual machine's properties to slow its boot sequence, or force it to enter BIOS setup. See “Changing Virtual Machine Options” on page 186. For prior versions of VirtualCenter that do not contain these options in the GUI, you can use Ctrl+Alt+Insert (or Ctrl+Alt+Delete for non-Windows systems) to soft-reset the virtual machine.

To install a guest operating system

1 Start VMware VirtualCenter.

2 Insert the installation CD-ROM for your guest operating system, or create an ISO image file from the installation CD-ROM. Use the Virtual Machine Settings editor to connect the virtual machine’s CD-ROM drive to the ISO image file and power on the virtual machine.

**NOTE** You might need to change the boot order in the virtual machine BIOS so that the virtual machine attempts to boot from the CD/DVD device before trying other boot devices. To do so, press F2 when prompted during virtual machine startup.

Using an ISO image is faster than using a CD-ROM.
To power on your virtual machine, click the **Power On** button.

When a virtual machine is powered on, a green right arrow is displayed next to the virtual machine icon in the inventory list, and the options in the **Commands** panel change as shown in the following image:

4 Follow the instructions provided by the operating system vendor.

To customize a guest operating system, see “Customizing Guest Operating Systems” on page 215.

**Installing and Upgrading VMware Tools**

VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating system and improves management of the virtual machine. Installing VMware Tools in the guest operating system is vital. Although the guest operating system can run without VMware Tools, you lose important functionality and convenience.

When you install VMware Tools, you install:

- The VMware Tools service (*VMwareService.exe* on Windows guests or *vmware-guestd* on Linux and Solaris guests). This service synchronizes the time in the guest operating system with the time in the host operating system. On Windows guests, it also controls grabbing and releasing the mouse cursor.

- A set of VMware device drivers, including an SVGA display driver, the *vmxnet* networking driver for some guest operating systems, the BusLogic SCSI driver for some guest operating systems, the memory control driver for efficient memory allocation between virtual machines, the sync driver to quiesce I/O for Consolidated Backup, and the VMware mouse driver.

- The VMware Tools control panel, which lets you modify settings, shrink virtual disks, and connect and disconnect virtual devices.
- A set of scripts that helps you to automate guest operating system operations. The scripts run when the virtual machine's power state changes if you configure them to do so.

- The VMware user process (VMwareUser.exe on Windows guests or vmware-user on Linux and Solaris guests), which enables you to copy and paste text between the guest and managed host operating systems.

  On Linux and Solaris guests, this process controls grabbing and releasing the mouse cursor when the SVGA driver is not installed.

  The VMware Tools user process is not installed on NetWare operating systems. Instead, the vmwtool program is installed. It controls the grabbing and releasing of the mouse cursor. It also allows you copy and paste text.

You can optionally install WYSE Multimedia Redirector, which improves streaming video performance in Windows guest operating systems running on WYSE thin client devices.

Configure the guest operating system before installing or reinstalling VMware Tools. This enables VMware tools to determine the correct mouse configuration and module configuration.

**NOTE** If the guest operating system is installed but not correctly configured when you install VMware Tools, the VMware Tools installation does not work correctly. This can cause the guest operating system to crash.

VMware Tools has the following limitations:

- Shrink disk is not supported.

- For Microsoft Windows NT, the default scripts for suspend and resume do not work.

- The mouse driver installation fails in X windows versions earlier than 4.2.0.

This section includes the following information:

- “Displaying the VMware Tools Properties Dialog Box” on page 162

- “VMware Tools Upgrades” on page 163

**NOTE** If you do not have VMware Tools installed in your virtual machine, you cannot use the shutdown or restart options. You can use only the Power options. If you want to shut down the guest operating system, shut it down from within the virtual machine console before you power off the virtual machine.
The installers for VMware Tools for Windows, Linux, Solaris, and NetWare guest operating systems are built into ESX Server as ISO image files. An ISO image file looks like a CD-ROM to your guest operating system and even appears as a CD-ROM disc in Windows Explorer. You do not use an actual CD-ROM disc to install VMware Tools, nor do you need to download the CD-ROM image or burn a physical CD-ROM of this image file.

When you choose to install VMware Tools, VMware VirtualCenter temporarily connects the virtual machine’s first virtual CD-ROM disk drive to the ISO image file that contains the VMware Tools installer for your guest operating system. You are ready to begin the installation process.

**NOTE** If you are using a WYSE thin client device and want to install WYSE Multimedia Support along with VMware Tools, see “Custom VMware Tools Installation” on page 165. You must use the custom installation path in order to install WYSE Multimedia Support.

**To install or upgrade VMware Tools on a Windows Guest**

1. Open a console to the virtual machine.
2. Power on the virtual machine.
3. After the guest operating system starts, right-click the virtual machine and choose Install VMware Tools.
4. From inside the virtual machine, click OK to confirm that you want to install VMware Tools and launch the InstallShield wizard.
   - If you have autorun enabled in your guest operating system (the default setting for Windows operating systems), a dialog box appears.
   - If autorun is not enabled, run the VMware Tools installer. Click Start > Run and enter D:\setup.exe, where D: is your first virtual CD-ROM drive.
5. Follow the onscreen instructions.
   - On Windows Server 2003, the SVGA driver is installed automatically, and the guest operating system uses it after it reboots.
   - After you install VMware Tools, Windows 2000 and Windows XP guest operating systems must be rebooted to use the new driver.
To install or upgrade VMware Tools on a Linux guest from X with the RPM installer

1. Open a console to the virtual machine.
2. Power on the virtual machine.
3. After the guest operating system starts, right-click the virtual machine and choose Install VMware Tools.
   The remaining steps take place inside the virtual machine.
4. Do one of the following:
   - If you see a VMware Tools CD icon on the desktop, double-click it, and after it opens, double-click the RPM installer in the root of the CD-ROM.
   - If you see a file manager window, double-click the RPM installer file.
   In some Linux distributions, the VMware Tools CD icon might fail to appear.
   In this case, continue install VMware Tools from the command line.
5. When prompted, enter the root password and click OK.
   The installer prepares the packages. (See Update)
6. Click Continue when the installer presents a dialog box that shows Completed System Preparation.
   A dialog box appears with a progress bar. When the installer is done, VMware Tools is installed. There is no confirmation or finish button.
7. In an X terminal, as root (su –), run the following file to configure VMware Tools:
   `vmware-config-tools.pl`
   Respond to the questions the installer displays on the screen. Press Enter to accept the default value.
8. When done, exit from the root account:
   `exit`
9. In an X terminal, open the VMware Tools Properties dialog box:
   `vmware-toolbox &`
To install or upgrade VMware Tools on a Linux guest with the tar installer or RPM installer

1. Open a console to the virtual machine.

2. Power on the virtual machine.

3. After the guest operating system starts, right-click the virtual machine and choose Install VMware Tools.

   The remaining steps take place inside the virtual machine.

4. As root (su -), mount the VMware Tools virtual CD-ROM image and change to a working directory (for example, /tmp), as follows.

   ```
   mount /dev/cdrom /mnt/cdrom
   cd /tmp
   
   NOTE Some Linux distributions automatically mount CD-ROMs. If your distribution uses automounting, do not use the `mount` and `umount` commands described in this procedure. You still must untar the VMware Tools installer to /tmp.
   
   Some Linux distributions use different device names or organize the /dev directory differently. Modify the following commands to reflect the conventions used by your distribution:
   
   ```
   mount /dev/cdrom /mnt/cdrom
   cd /tmp
   ```
   
   ```
   NOTE If you have a previous installation, delete the previous `vmware-tools-distrib` directory before installing. The default location of this directory is:
   
   `/tmp/vmware-tools-distrib`
5 Uncompress the installer and unmount the CD-ROM image.

Depending on whether you are using the tar installer or the RPM installer, do one of the following:

- For the tar installer, at the command prompt, enter:
  ```
tar zxpf /mnt/cdrom/VMwareTools-5.0.0-<xxxx>.tar.gz
umount /dev/cdrom
```
  Where `<xxxx>` is the build/revision number of the Workstation release.

- For the RPM installer, at the command prompt, enter:
  ```
rpm -Uhv /mnt/cdrom/VMwareTools-5.0.0-<xxxx>.i386.rpm
umount /dev/cdrom
```
  Where `<xxxx>` is the build/revision number of the Workstation release.

**NOTE** If you attempt to install an rpm installation over a tar installation—or the reverse—the installer detects the previous installation and must convert the installer database format before continuing.

6 Depending on whether you are using the tar installer or the RPM installer, do one of the following: (SEE UPDATE)

- For the tar installer, run the VMware Tools tar installer:
  ```
cd vmware-tools-distrib
./vmware-install.pl
```
  Respond to the configuration questions on the screen. Press Enter to accept the default value.

- For the RPM installer, configure VMware Tools:
  ```
vmware-config-tools.pl
```
  Respond to the questions the installer displays on the screen. Press Enter to accept the default value.

7 Log off the root account.

    exit

8 Start your graphical environment.

9 In an X terminal, open the VMware Tools Properties dialog box:

    vmware-toolbox &
To install or upgrade VMware Tools on a Solaris guest

1. Open a console to the virtual machine.
2. Power on the virtual machine.
3. After the guest operating system starts, right-click the virtual machine and choose **Install VMware Tools**.
   The remaining steps take place inside the virtual machine.
4. Log in as root (su –) and, if necessary, mount the VMware Tools virtual CD-ROM image, as follows.
   Usually, the Solaris volume manager—vold—mounts the CD-ROM under /cdrom/vmwaretools. If the CD-ROM is not mounted, restart the volume manager using the following commands:
   ```
   /etc/init.d/volmgt stop
   /etc/init.d/volmgt start
   ```
5. After the CD-ROM is mounted, change to a working directory (for example, /tmp) and extract VMware Tools, as follows:
   ```
   cd /tmp
gunzip -c /cdrom/vmwaretools/vmware-solaris-tools.tar.gz | tar xf
   ```
6. Run the VMware Tools tar installer:
   ```
   cd vmware-tools-distrib
   ./vmware-install.pl
   ```
   Respond to the configuration questions on the screen. Press Enter to accept the default value.
7. Log off of the root account.
   ```
   exit
   ```
8. Start your graphical environment.
9. In an X terminal, open the VMware Tools Properties dialog box:
   ```
   vmware-toolbox &
   ```
To install VMware Tools in a NetWare virtual machine

1. Open a console to the virtual machine.
2. Power on the virtual machine.
3. After the guest operating system starts, right-click the virtual machine and choose **Install VMware Tools**.
   The remaining steps take place inside the virtual machine.
4. Load the CD-ROM driver so the CD-ROM device mounts the ISO image as a volume.
   Do one of the following:
   - In the system console for a NetWare 6.5 virtual machine, enter:
     
     ```
     LOAD CDDVD
     ```
   - In the system console for a NetWare 6.0 or NetWare 5.1 virtual machine, enter:
     
     ```
     LOAD CD9660.NSS
     ```
   When the driver finishes loading, you can begin installing VMware Tools, as described in the next step.
5. In the system console, enter the following command:
   
   ```
   vmwtools:\setup.ncf
   ```
   When the installation finishes, the message **VMware Tools for NetWare are now running** appears in the Logger Screen (NetWare 6.5 and NetWare 6.0 guests) or the Console Screen (NetWare 5.1 guests).

**Displaying the VMware Tools Properties Dialog Box**

Use the VMware Tools Properties dialog box to configure VMware Tools inside your virtual machine. Instructions for displaying this dialog box vary, depending on the guest operating system.

Use this dialog box to configure such things as time synchronization between host and guest, notifications of VMware Tools updates (for Windows and Linux guests only), and specifying which scripts to run when the virtual machine’s power state changes.

For instructions on using the VMware Tools Properties dialog box, click the **Help** button inside the dialog box.

**To display the VMware Tools Properties dialog box on Windows guests**

Open a console to the virtual machine and double-click the **VMware Tools** icon in the system tray from inside the guest operating system.
To display the VMware Tools Properties dialog box on Linux and Solaris guests

Open a console to the virtual machine and then open a terminal window and enter the command:

```
/usr/bin/vmware-toolbox &
```

To display the VMware Tools dialog box on NetWare 5.1 or higher guests

Choose Novell > Settings > VMware Tools for NetWare.

VMware Tools Upgrades

You can upgrade VMware Tools manually, or you can configure virtual machines to automatically check for and install newer versions of VMware Tools (see “Changing Virtual Machine Options” on page 186). The following are required for automatic upgrades:

- Virtual machines must have a version of VMware Tools shipped with ESX Server 3.0.1 or greater installed.
- Virtual machines must be hosted on an ESX Server 3.0.1 or greater, and the VirtualCenter server must be version 2.0.1 or greater.
- Virtual machines must be running a Linux or Windows guest OS that is supported by ESX Server 3.0.1 or greater and VirtualCenter 2.0.1 or greater.
- Virtual machines must be powered on.

To manually upgrade VMware Tools:

1. Launch the VI client and log in to the VirtualCenter server.
2. Select the Inventory > Hosts and Clusters view.
3. Select the host or cluster that contains the virtual machines you want to upgrade.
4. Select the Virtual Machines tab.
5. Select the virtual machines you want to upgrade and power them off.
6. Right-click your selections and select Install/Upgrade Tools.
7. (Optional) Enter command-line options in the Advanced field (see “Command-Line Options (SEE UPDATE)” on page 164).
8. Click OK.

VMware Tools can also be manually upgraded from within the virtual machine’s operating system by opening the VMware Tools Properties dialog box (double-click the icon in the system tray) and clicking Upgrade in the Options tab.
To configure virtual machines to automatically upgrade VMware Tools:

1. Open the Virtual Machine Properties dialog box for the virtual machine you want to upgrade.

2. Select Options tab > VMware Tools.

3. Select the Check and upgrade Tools before each power-on option under Automatic VMware Tools Upgrade.

4. Click OK.

The next time the virtual machine is powered on, it checks the ESX Server host for a newer version of VMware Tools. If one is available, it is installed and the guest operating system is restarted (if required).
Custom VMware Tools Installation

You can use a custom VMware Tools installation path to install optional drivers or other software that might improve the performance of particular virtual machines, such as WYSE Multimedia Support.

To perform a custom VMware Tools installation on a Windows Guest

1. Open a console to the virtual machine.
2. Power on the virtual machine.
3. After the guest operating system starts, right-click the virtual machine and choose Install VMware Tools.
4. From inside the virtual machine, click OK to confirm that you want to install VMware Tools and launch the InstallShield wizard.
   - If you have autorun enabled in your guest operating system (the default setting for Windows operating systems), a dialog box appears.
   - If autorun is not enabled, run the VMware Tools installer. Click Start > Run and enter D:\setup.exe, where D: is your first virtual CD-ROM drive.
5. Click Next.
   The Setup Type page is displayed.
6. Select Custom, and click Next.
   The Custom Setup page is displayed.
7. Click the red X next to each optional feature you want to install, and select This feature will be installed on local hard drive.
8. Click Next.
   A progress bar is displayed showing the progress of the installation.
9. Click Finish.

WYSE Multimedia Support

If you are using a WYSE thin client device to conduct remote desktop sessions using VMware VDI, installing WYSE Multimedia Support in the guest operating system improves the performance of streaming video. WYSE Multimedia Support allows streaming video to be decoded on the client rather than on the host, thereby conserving network bandwidth.
WYSE Multimedia Support is supported on the Windows 2003 and Windows XP guest operating systems only. WYSE Multimedia Support is installed as part of a VMware Tools installation or upgrade.

Installing WYSE Multimedia Support with VMware Tools

When you install VMware Tools in a Windows 2003 or Windows XP guest operating system for the first time, you can install WYSE Multimedia Support at the same time by choosing a custom installation path.

To install WYSE Multimedia Support as part of a first-time installation of VMware Tools

Follow the instructions for the custom installation path as described in “Custom VMware Tools Installation” on page 165. On the Custom Setup page, select WYSE Multimedia Redirector for installation.

Installing WYSE Multimedia Support as part of a VMware Tools Upgrade

For virtual machines that already have VMware Tools installed, WYSE Multimedia Support can be installed as part of a VMware Tools upgrade using the Windows Add or Remove Programs feature.

To install WYSE Multimedia Support using Add or Remove Programs

1. Open a console to a powered-on virtual machine.
2. In the virtual machine, choose Start > Settings > Control Panel > Add or Remove Programs.
3. In the list of programs, select VMware Tools and click Change.
   The VMware Tools Installation wizard is displayed.
4. Click Next.
   The Program Maintenance page is displayed.
5. Select Modify and click Next.
   The Custom Setup page is displayed.
6. Click the red X next to WYSE Multimedia Redirector and select This feature will be installed on local hard drive.
Chapter 10 Creating Virtual Machines

7 Click Next.

8 Click Modify to begin the installation.
   A progress bar is displayed showing the progress of the installation.

9 Click Finish.

For virtual machines on ESX Server 3.0.1 or later hosts managed by VirtualCenter 2.0.1 or later, WYSE Multimedia Support can be installed as part of a VMware Tools upgrade started from the VI Client.

To install WYSE Multimedia Support as part of a VMware Tools Upgrade

1 Right-click a powered-on virtual machine and choose Upgrade VMware Tools.

2 In the Advanced text box, type `setup.exe /s /v"INSTALL_WYSE=1"`.

3 Click OK.
This chapter describes virtual machine tasks, including adding and removing virtual machines and powering virtual machines on and off.

**NOTE** The views and capabilities displayed vary depending on whether the VI Client is connected to a VirtualCenter Server or an ESX Server host. Unless indicated, the process, task, or description applies to both kinds of VI Client connections.

This chapter contains the following topics:

- “Changing Virtual Machine Power States” on page 169
- “Adding and Removing Virtual Machines” on page 175
- “Starting and Shutting Down Virtual Machines” on page 177

**Changing Virtual Machine Power States**

The power state of a virtual machine indicates whether the virtual machine is active and functional. There are three basic states: on, off, and suspend. To achieve the on state, you can power on the machine, reset the machine, or resume activity from a suspended state. To achieve the off state, you can power off the machine or suspend all virtual machine activity. Each virtual machine power state change has a different effect on the guest operating system in the virtual machine.
There are also several access points for making changes to these power states. You can change a power state change by:

- Selecting the virtual machine and the power option from the **Inventory > Virtual Machine** menu.
- Selecting **Power on** from the **Commands** area.
- Selecting the power option from the pop-up menu.
- Scheduling a power state change through the **Scheduled Tasks** button in the navigation bar.

The power state topics are covered in the following sections:

- “Understanding Virtual Machine Power States” on page 170
- “Understanding Transitional Power States” on page 172
- “Manually Powering a Virtual Machine On and Off” on page 172
- “Using Suspend and Resume” on page 173
- “Scheduling a Power State Change for a Virtual Machine” on page 174

### Understanding Virtual Machine Power States

The basic power state options include:

- **Power on** – Powers on the virtual machine and boots the guest operating system if the guest operating system is installed.
- **Power off** – Powers off the virtual machine. The virtual machine does not attempt to shut down the guest operating system gracefully.
- **Suspend** – Pauses the virtual machine activity. All transactions are frozen until you issue a resume command.
- **Resume** – Allows virtual machine activity to continue and releases the Suspended state.
- **Reset** – Shuts down the guest operating system and restarts it. This operation depends on the operating system being shut down. If shutdown is not automatic for that operating system, VMware Tools must be installed.
The following power options perform extra functions in addition to the basic virtual machine power operations. VMware Tools must be installed in the virtual machine to perform these functions:

- **Shut down guest** – Shuts down the guest operating system gracefully.
- **Standby guest** – Suspends the guest operating system and run VMware tools suspend scripts.
- **Restart guest** – Shuts down and restarts the guest operating system without powering off the virtual machine.

Toolbar power buttons perform as follows:

- **Power off** – Powers off the virtual machine. A power off operation displays a confirmation dialog box indicating that the guest operating system might not shut down properly.
- **Power on** – Powers on a virtual machine when a virtual machine is stopped, or resumes the virtual machine and runs a script when it is suspended and VMware Tools is installed and available. Resumes the virtual machine and does not run a script when VMware Tools is not installed.
- **Suspend** – Suspends the virtual machine without running a script when VMware Tools is not installed, or runs a script, and suspends the virtual machine when VMware Tools is installed and available.
- **Reset** – Resets the virtual machine when VMware Tools is not installed, and restarts the guest operating system when VMware Tools is installed and available. A reset operation displays a confirmation dialog box indicating that the guest operating system is not shut down properly.

**NOTE** The specific form of the power state action can be modified to include guest operating system shutdowns or not and to include running scripts or not.

To configure power operation settings choose host > **Configuration** > **Virtual Machine startup/shutdown**.
Understanding Transitional Power States

Actions taken on a virtual machine require that the virtual machine be in specific power states. Whenever a power operation is performed on a virtual machine, the virtual machine power state changes and all other commands are locked out until the first command is completed.

The figure below illustrates states, transitions, and state-changing commands for virtual machines.

Figure 11-1. Virtual Machine Power State Changes

Manually Powering a Virtual Machine On and Off

Before changing any power state on a virtual machine, you must have added the virtual machine to your VMware Infrastructure environment. See "Adding and Removing Virtual Machines" on page 175.

To manually change the power state of a virtual machine

1. Click the Inventory button in the navigation bar.
2. Expand the inventory as needed, and select a virtual machine.
3. Use the power state buttons in the toolbar, or right-click on the virtual machine and select an power state option

**NOTE** Power Off is like turning off the electricity to a physical machine and always shuts down the virtual machine. Shut Down Guest attempts to gracefully shut down the virtual machine.
Using Suspend and Resume

The suspend and resume feature is most useful when you want to save the current state of your virtual machine and pick up work later with the virtual machine in the same state.

After you resume and do additional work in the virtual machine, you cannot return to the state the virtual machine was in at the time you suspended. To preserve the state of the virtual machine so you can return to the same state repeatedly, take a snapshot. See “Using Snapshots” on page 253 for more information.

The speed of the suspend and resume operations depends on how much data changed while the virtual machine was running. In general, the first suspend operation takes a bit longer than subsequent suspend operations do.

When you suspend a virtual machine, a file with a .vmss extension is created. This file contains the entire state of the virtual machine. When you resume the virtual machine, its state is restored from the .vmss file.

To suspend a virtual machine

1. If your virtual machine is running in full screen mode, return to window mode by pressing the Ctrl-Alt key combination.

2. Click Suspend on the VMware Infrastructure Client toolbar.

   When VMware Infrastructure Client completes the suspend operation, it is safe to exit VMware Infrastructure Client.

3. Choose File > Exit.

To resume a virtual machine that you have suspended

1. Start VMware Infrastructure Client, and select a virtual machine that you have suspended.

2. Click the Power On button on the VMware Infrastructure Client toolbar, or choose the Power On option from the pop-up menu or the Commands window.

   **NOTE** Applications you were running at the time you suspended the virtual machine are running, and the content is the same as it was when you suspended the virtual machine.
Scheduling a Power State Change for a Virtual Machine

Depending upon your permissions, you can create a scheduled task to change the power state of the virtual machine in the VI Client.

To create a scheduled task that changes the power state

1. Click the Scheduled Tasks button in the navigation bar.
   
   The list of scheduled tasks appears.

2. Right-click and choose New Scheduled Task, or choose File > New > Scheduled Task.
   
   The Select a Task to Schedule window appears.

3. Select Change the power state of a virtual machine, and click OK.
   
   The Change a Virtual Machine's Power State wizard appears and displays the Select Virtual Machine page.

4. Select the virtual machine whose state you want to change.
   
   The Select a Power Operation page appears.

5. Select a Power Operation option, and click Next.

6. If you selected a Power On operation, the Select Host page appears. Select the host which will power on the virtual machine.

7. Click Next.
   
   The Schedule the Task screen appears.

8. Name the task, give a description, and specify the timing of the task.
   
   To display to the calendar, select Later, and click the drop-down arrow to choose a date from the displayed calendar. A red circle indicates today's date and a dark circle indicates the scheduled date.

9. Click Next.

10. Click Finish.

   VMware Infrastructure Client adds the new task to the scheduled task list and completes it at the designated time. When you create a scheduled task, VirtualCenter verifies that you have the correct permissions to perform the actions on the relevant datacenters, hosts, and virtual machines. Once the task is created, the task is performed even if you no longer have permission to perform the task.
Adding and Removing Virtual Machines

Virtual machines can be added to the VirtualCenter Server inventory through their managed hosts. They can be removed from VirtualCenter Server control and optionally from their managed host’s storage.

The following sections discuss adding and removing virtual machines:
- “Adding Existing Virtual Machines to VirtualCenter” on page 175
- “Removing Virtual Machines from VirtualCenter” on page 175
- “Returning a Virtual Machine or Template to VirtualCenter” on page 176

Adding Existing Virtual Machines to VirtualCenter

When you add a managed host to VMware Infrastructure Client, it discovers all the virtual machines on that managed host and adds them to the VirtualCenter inventory. If a managed host is disconnected, the already discovered virtual machines continue to be listed in the inventory.

If a managed host is disconnected and reconnected, any changes to the virtual machines on that managed host are identified, and VMware Infrastructure Client updates the list of virtual machines. For example, if node3 is removed and node4 is added, the new list of virtual machines adds node4 and shows node3 as orphaned.

Removing Virtual Machines from VirtualCenter

Removing Virtual Machines from inventory unregisters them from the host and VirtualCenter. Virtual machine files remain at the same storage location and the virtual machine can be reregistered using the datastore browser.

Removing Virtual Machines from disk, on the other hand, purges the virtual machine and its files.

To remove a virtual machine from VirtualCenter but not the datastore

1. From the VI Client, click the Inventory button in the navigation bar.
2. Expand the inventory as needed, and click the appropriate virtual machine.
3. Make sure that the virtual machine is powered off.
4. Select the virtual machine in the inventory panel.
Choose **Inventory > Virtual Machine > Remove**, or right-click on the virtual machine and select Remove from Inventory.

To confirm that you want to remove the virtual machine from the inventory, click **OK**.

VirtualCenter Server removes references to the virtual machine and no longer tracks its condition.

**NOTE** The **Remove from Inventory** command removes the virtual machine only from VirtualCenter inventory. It does not remove the virtual machine from its datastore.

### To remove a virtual machine from VirtualCenter and the datastore

**CAUTION** This procedure deletes all the files for the selected virtual machine, including the configuration file and the virtual disk files. If other virtual machines share disks with the virtual machine you want to delete (target), remove the shared disks from the target before deleting it. See “Changing the Hardware Configuration of a Virtual Machine” on page 180.

1. From the VI Client, click the Inventory button in the navigation bar.
2. Expand the inventory as needed, and click the appropriate virtual machine.
3. Make sure that the virtual machine is powered off.
4. Right-click on the virtual machine and select **Delete from Disk**.
5. Click **OK** in the confirmation dialog box.

VirtualCenter deletes the virtual machine from its datastore.

### Returning a Virtual Machine or Template to VirtualCenter

If you have removed a virtual machine or template from a VirtualCenter server but did not remove it from the managed host’s datastore and you want to return it to VirtualCenter, use the Datastore Browser.

**To return a virtual machine or template to VirtualCenter**

1. Right-click on the datastore and choose **Browse Datastore**.
   
The Datastore Browser dialog box is displayed.
2. Navigate to the virtual machine or template that you want to add to inventory.
3 Right-click on the virtual machine or template and choose **Add to Inventory**.

4 Follow the steps in the **Add to Inventory** wizard to finish adding the virtual machine or template.

**Starting and Shutting Down Virtual Machines**

You can configure your virtual machine to start up and shut down automatically, or you can disable this function. You can also set the default timing as well as the startup order for specified virtual machines when the system host starts.

**To configure virtual machine startup and shutdown**

1 Select the **Inventory** button.

2 Select a host machine.

3 Click the **Configuration** tab.

   Configuration information for the host appears.

4 Click the **Virtual Machine Startup/Shutdown** link.

   The virtual machine startup and shutdown information appears.
Click **Properties**.

The Virtual Machine Startup and Shutdown dialog box appears.

If you want to allow virtual machines to start and stop automatically, click the check box at the top of the dialog box and enter a time in seconds for the default startup delay and the default shutdown delay.

If you want the operating system to start after a brief delay, specify a delay time in the Default Startup Delay box.

This allows time for VMware Tools or the booting system to run scripts.

Click the check box if you want the operating system to boot immediately after VMware Tools starts.

Next, specify the order in which the virtual machines start when the system starts. Use the **Move Up**, **Move Down**, and **Edit** buttons to rearrange the virtual machines in the display.

Virtual machines listed under Manual Startup do not automatically start up or shut down. In order to automatically start up or shut down a virtual machine, you must move it so that it is listed under either Automatic Startup or Any Order.

The virtual machines are stopped in reverse order.

Click **OK** to exit the dialog box when you are through changing the system settings.
This chapter describes the Virtual Machine Properties editor and the Add Hardware wizard. These allow you to edit and configure your virtual machines. It also discusses advanced virtual machine configuration options. These activities can be performed during the virtual machine creation process or after you create the virtual machine and install the guest operating system. Some operations can be performed while the virtual machine is powered on; others only when the virtual machine is powered off. This chapter also describes legacy virtual machines and how to upgrade them to the current virtual machine hardware version. You must have sufficient permission to perform the activities described in this chapter.

This chapter contains the following topics:

- “Virtual Machine Properties Editor” on page 179
- “Adding New Hardware” on page 196
- “Legacy Virtual Machines” on page 201
- “Upgrading Virtual Hardware” on page 202

**Virtual Machine Properties Editor**

The Virtual Machine Properties Editor allows you to change nearly every characteristic that you choose when you created the virtual machine. This section describes how to use this editor.

**To edit an existing virtual machine configuration**

1. From the VI Client, click Inventory in the navigation bar.
2. Expand the inventory as needed, and select the virtual machine you want to edit.
3 (Optional) Power off the virtual machine.

Most of the properties of a virtual machine can be changed only while it is powered off, but you can open the properties editor regardless of the power state. Many of the controls are read-only if the virtual machine is not powered off.

4 To display the Virtual Machine Properties dialog box, click the Edit Settings link in the Commands panel.

The Virtual Machine Properties dialog box is displayed. There are three tabs: **Hardware**, **Options**, and **Resources**.

5 Select a tab and proceed to one of the following sections:

- “Changing the Hardware Configuration of a Virtual Machine” on page 180
- “Changing Virtual Machine Options” on page 186
- “Changing Virtual Machine Resource Settings” on page 192

### Changing the Hardware Configuration of a Virtual Machine

This section describes how to change the configuration of existing virtual hardware devices in a virtual machine.

You can add, edit, or remove hardware from your virtual machine using this wizard. The status of the device, such as edited or adding, is displayed in parentheses next to the hardware listing. The selected guest operating system determines the devices that are available to be added to a given virtual machine. The devices that can be added are:

- Serial port
- Parallel port
- Floppy drive
- DVD/CD-ROM drive
- Ethernet adapter
- Hard disk
- SCSI device

**To change the DVD/CD-ROM drive configuration**

1 Click the **Hardware** tab.

2 Click the DVD/CD-ROM drive in the Hardware list.

3 Make changes as needed to the device status, connection, or virtual device node for the virtual machine to use.
If you do not want the CD-ROM drive connected when the virtual machine starts, deselect **Connect at power on**.

Select the Use physical drive radio button to connect the virtual machine’s drive to a physical drive on the host computer.

You can access a client CD-ROM device or host CD-ROM device. There are two types of DVD/CD-ROM access:

a Use Pass-through (raw) mode only for remote client device access.

b Use ATAPI emulation to access a host CD-ROM device.

The local or host CD-ROM device is accessed through emulation mode. Pass-through mode is not functional for local host CD-ROM access. You can write or burn a remote CD only through pass-through mode access, but in emulation mode you can only read a CD-ROM from a host CD-ROM device.

If you elected to use a physical drive, choose the drive to use from the drop-down list.

Alternatively, select **Use ISO Image** to connect the virtual machine’s drive to an ISO image file.

If you selected **Use ISO Image**, click **Browse** to navigate to the file.

Under Virtual device node, use the drop-down menu to choose the device node the drive uses in the virtual machine.

Click **OK** to save your changes and close the dialog box.

**To change the floppy drive configuration**

1 Click the **Hardware** tab.

2 Click the floppy drive in the **Device** list.

3 Under Device Status, select **Connect at power on** to connect this virtual machine to the floppy drive when the virtual machine is powered on.

4 Under Connection, select **Use physical drive** to use a physical drive, choose **Client or Host**, and choose the drive from the list.

5 To use a floppy image, select **Use existing floppy Image** or **Create a new floppy image**, and browse to the floppy image.

6 Click **OK** to save your changes and close the dialog box.
To change the SCSI device configuration

1. Click the Hardware tab.
2. Select the SCSI device in the hardware list.
3. To connect this virtual machine to the server’s SCSI device when the virtual machine is powered on, select Connect at power on.
4. Under Connection, select the physical device you want to use.
   - Under Virtual device node, select the virtual device node where you want this device to appear in the virtual machine.
5. Click OK to save your changes and close the dialog box.

To change the virtual disk configuration

You can add disks and extend disks even while the virtual machine is running. To change disk mode, the virtual machine must be powered off.

1. Click the Hardware tab.
2. Click the appropriate Hard Disk in the Hardware list.
3. If the virtual machine is powered on, you can do any of the following:
   - Change disk size.
   - Add new disk.
4. If the virtual machine is powered off, you can do any of the following:
   - Change disk size.
   - Add new disk.
   - Change the virtual device node.
   - Turn on or off Independent mode. Disks running in Independent mode are unaffected by snapshots. Choose Persistent or Nonpersistent mode to determine the persistence of changes.
5. Click OK to save your changes and close the dialog box.

**NOTE** The Manage Paths feature for RDM disks is not available for virtual machines on legacy hosts running versions of ESX Server prior to release 3.0.
To change the memory configuration

1 Click the **Hardware** tab.
2 Click **Memory** in the Hardware list.
3 Adjust the amount of memory allocated to the virtual machine.
   (SEE UPDATE) The range of memory supported is 128MB to 16384MB and is not limited to the physical memory of the host where the virtual machine resides.
4 Click **OK** to save your changes and close the dialog box.

To change the virtual Ethernet adapter (NIC) configuration

1 Click the **Hardware** tab.
2 Click the appropriate NIC in the Hardware list.
3 To connect the virtual NIC when the virtual machine is powered on, select **Connect at power on**.
4 Under Network connection, use the drop-down menu to choose the network label you want the virtual machine to use.
5 Click **OK** to save your changes and close the dialog box.

To change the parallel port configuration

1 Click the **Hardware** tab.
2 Click the appropriate Parallel port in the **Hardware** list.
3 Deselect the **Connect at power on** check box if you do not want the parallel port device to be connected when the virtual machine powers on.
   The default setting is **Connect at power on**.
4 Under Connection, select a radio button to indicate a physical parallel port or to connect the virtual parallel port to a file.
   a If you select **Use physical parallel port**, choose the port from the drop-down menu.
   b If you select **Use output file**, browse to the file location.
5 Click **OK** to save your changes and close the dialog box.
To change the SCSI controller configuration

You can change the SCSI controller configuration for a virtual machine on an ESX Server host only.

CAUTION Changing the SCSI controller type might result in a virtual machine boot failure.

You can also specify whether the SCSI bus is shared. Depending on the type of sharing, virtual machines can access the same virtual disk simultaneously on the same server or any server.

1. Click the Hardware tab.
2. Click the appropriate SCSI Controller in the Device list.
3. Select the SCSI controller type in the list.

CAUTION Changing the SCSI controller type might result in a virtual machine boot failure.

4. Select the type of sharing in the SCSI Bus Sharing list:
   - None – Virtual disks cannot be shared by other virtual machines.
   - Virtual – Virtual disks can be shared by virtual machines on same server.
   - Physical – Virtual disks can be shared by virtual machines on any server.
5. Click OK to save your changes and close the dialog box.

To change the serial port configuration (See Update)

1. Click the Hardware tab.
2. Click the appropriate Serial port in the Hardware list.
3. If you selected Use physical serial port, use the drop-down menu to choose the port on the host computer that you want to use for this serial connection.
4. If you selected Use output file, browse to the location of the file on the host that you want to use to store the output of the virtual serial port.
If you selected Use named pipe, use the default pipe name or enter another pipe name of your choice in the Pipe Name list.

For a serial pipe for a virtual machine on an ESX Server host for Linux host, enter /tmp/<socket> or another UNIX socket name of your choice.

Then decide whether you are connecting two virtual machines or connecting a virtual machine to an application on the host.

If you are connecting two virtual machines, you must configure a serial port as a named pipe in two virtual machines: a server virtual machine and a client virtual machine.

a For the server virtual machine, select Server in the Near end list.
b For the client virtual machine, select Client in the Near end list.
c Select A virtual machine in the Far end list.

If you are connecting to an application on the host, do the following:

a Select Server or Client in the Near end list. In general, select Server if you plan to start this end of the connection first.
b Select An application in the Far end list.

By default, the serial port is connected when you power on the virtual machine. You might deselect the Connect at power on check box (optional).

Under I/O Mode, decide whether to configure this serial port to use interrupt mode or polled mode.

Polled mode is of interest primarily to developers who are using debugging tools that communicate over a serial connection.

Polled mode causes the virtual machine to consume a disproportionate share of processor (or CPU) time. This makes the host and other guests run sluggishly. To maintain best performance for applications on the host, select the Yield CPU on poll check box. This forces the affected virtual machine to use interrupt mode, which yields processor (or CPU) time if the only task it is trying to do is poll the virtual serial port.

Click OK to save your changes and close the dialog box.
To change the virtual processor or CPU configuration

If the virtual machine is on an ESX Server host and you have Virtual SMP for ESX Server, which supports symmetric multiprocessors (SMP), you can configure a virtual machine to have up to four virtual processors or CPUs. Virtual SMP can use two-way or four-way SMP. Virtual machines can not have more virtual CPUs than the actual number of logical CPUs on the host—that is, the number of physical processor cores if hyperthreading is disabled or two times the number of physical processor cores if hyperthreading is enabled. For more information about using SMP, consult the VMware Knowledge Base.

**NOTE** Not all guest operating systems support SMP, and some that do require reinstallation if the number of CPUs changes.

(SEE UPDATE) Changing the number of processors an imported virtual machine uses is not supported.

1. Click the Hardware tab.
2. Click Virtual Processor or CPU in the Hardware list.
3. Select the number of virtual processors for the virtual machine.
   You must have VMware Virtual SMP for ESX Server if you want more than one virtual processor or CPU for the virtual machine. If you do not have VMware Virtual SMP for ESX Server, the virtual machine can have only one virtual processor or CPU.
4. Click OK to save your changes and close the dialog box.

**Changing Virtual Machine Options**

You can change the following settings in the Options tab:

- **General Options** — Virtual machine display name and type of guest operating system. (Read-only) location of virtual machine and its configuration file.
- **VMware Tools** — Power Controls behavior, VMware Tools scripts and automatic updates.
- **Power Management** — Virtual machine Suspend behavior.
- **Advanced > General** — Acceleration, logging, debugging and statistics.
- **Advanced > CPUID Mask** — Nx flag and advanced identification mask options.
- **Advanced > Boot Options** — Virtual machine boot options.
- **Advanced > Paravirtualization** — VMI paravirtualization enablement.
■ **Advanced > Fibre Channel NPIV** — Virtual node and port world wide names (WWNs).

■ **Advanced > Virtualized MMU** — Settings for enabling Hardware Page Table Virtualization.

■ **Advanced > Swapfile Location** — Swapfile location.

### To change general settings

1. Click the **Options** tab.
2. Select **General Options** in the **Settings** list.
   
   The virtual machine name is displayed in the Virtual machine name field.

   Changing the name does not change the name of any virtual machine files or the associated directory.
3. Select an operating system and version.
4. Click **OK** to save your changes and close the dialog box.

### To change VMware Tools options

**NOTE** VMware Tools options cannot be changed while the virtual machine is powered on.

1. Click the **Options** tab.
2. Select **VMware Tools** in the **Settings** list.

   The stop button on the toolbar can be configured to power off the virtual machine, shut down the guest operating system, or use the system default. The pause button on the toolbar can be configured to suspend the virtual machine or use the system default. The reset button on the toolbar can be configured to reset the virtual machine, restart the guest operating system, or use the system default.
3. Select the actions you want from the drop-down menus under **Power Controls**.
4. (Optional) Configure VMware Tools scripts to run when you change the virtual machine's power state by selecting options under **Run VMware Tools** scripts.

**NOTE** For ESX Server virtual machines, there are no scripts for resuming and suspending virtual machines.

5. (Optional) Configure VMware Tools to check for and install updates before each power on by selecting the **Check and upgrade Tools before each power on** option under **Automatic VMware Tools Upgrade**.
6 (Optional) Configure the guest operating system to synchronize time with the host by selecting the **Synchronize guest time with host** option.

7 Click **OK** to save your changes and close the dialog box.

**To change power management settings**

1 Click the **Options** tab.

2 Select **Power Management** in the **Settings** list.
   Guest Power Management allows you to determine how the virtual machine responds when the guest operating system is placed on standby.

3 Under **Guest Power Management**, select either **Suspend the virtual machine** or **Put the guest operating system in standby mode and leave the virtual machine powered on**.

4 (Optional) If you chose to leave the virtual machine on, select **Wake on LAN for virtual machine traffic on** your virtual machine network by selecting the check box.
   Not all guest operating systems support Wake on LAN. Only the following types of NICs support Wake on LAN:
   - Flexible (VMware Tools required).
   - vmxnet
   - Enhanced vmxnet
   Options are disabled if they are not supported.

5 Click **OK** to save your changes and close the dialog box.

**To change advanced virtual machine settings**

1 Click the **Options** tab.

2 Select **Advanced > General** in the **Settings** list.
   a To disable acceleration, select the **Disable acceleration** check box.

   You can enable and disable acceleration while the virtual machine is running.
   In rare instances, you might find that when you install or run software inside a virtual machine, the virtual machine appears to hang. Generally, the problem occurs early in the program’s execution. In many cases, you can get past the problem by temporarily disabling acceleration in the virtual machine.
This setting slows down virtual machine performance, so use it only for getting past the problem with running the program. After the program stops encountering problems, deselect **Disable acceleration.** You might then be able to run the program with acceleration.

b To enable logging mode, select the **Enable logging** check box.

c To enable debugging mode, select an option from the **Debugging and Statistics** section. Debugging information and statistics can be helpful to VMware technical support in resolving issues.

d To set advanced configuration parameters, click **Configuration Parameters.** Generally, you should only change these settings if you intend to use experimental features or when instructed to do so by a VMware technical support representative.

3 Select **Advanced > CPUID Mask.**

   a Specify whether you want to hide the host's CPU Nx flag from the guest operating system.

      Hiding the Nx flag prevents the guest operating system from making use of this CPU feature, but enables the virtual machine to be moved to hosts that do not include the Nx feature. When the Nx flag is visible, the guest operating system can make use of the feature, but the virtual machine can be moved only to hosts with the Nx capability.

   b Click **Advanced** to access the CPU Identification Mask dialog box. An explanation of the symbols in this dialog box is available by clicking **Legend.**

      **NOTE** The virtual machine must be powered off before you can change this setting.

4 Select **Advanced > Boot Options.**

   a Specify the duration in milliseconds you want to delay entering the boot sequence when the virtual machine is powered on or restarted.

   b Select the option under Force BIOS Setup to have the virtual machine enter BIOS setup when it boots.

      These options are useful when you need to enter the virtual machine's BIOS setup because sometimes the console attaches to the virtual machine after the boot sequence passes the point where you can enter BIOS.
Select Advanced > Paravirtualization. Select Support VMI Paravirtualization to enable VMI Paravirtualization to enable it, or deselect it to disable this feature.

VMI is a paravirtualization standard that enables improved performance for virtual machines capable of utilizing it. Currently, this feature is available only for those versions of the Linux guest operating system which support VMI paravirtualization.

**NOTE** Enabling paravirtualization utilizes one of the virtual machine's six virtual PCI slots. Also, enabling paravirtualization can limit how and where the virtual machine can be migrated. Consider the following before enabling this feature:

- These hosts support VMI paravirtualization: ESX Server 3.5 and greater, ESX Server 3i version 3.5 and greater, and Workstation 6.0 and greater. Hardware version 4 virtual machines with paravirtualization enabled that are created on ESX Server hosts can be migrated to VMware Server and Workstation hosts without loss of functionality.
- A virtual machine with paravirtualization enabled and that is powered off can be moved manually to a host that does not support paravirtualization. However, this can result in reduced performance.
- A virtual machine with paravirtualization enabled and that is powered on or in a suspended power state can not be migrated to a host that does not support paravirtualization.
- Automated VirtualCenter DRS migrations of virtual machines with paravirtualization enabled to hosts that do not support paravirtualization are not allowed.

Select Advanced > Fibre Channel NPIV Settings.

N-port ID virtualization (NPIV) provides the ability to share a single physical Fibre Channel HBA port among multiple virtual ports, each with unique identifiers. This allows control over virtual machine access to LUNs on a per-virtual machine basis.

Each virtual port is identified by a pair of world wide names (WWNs): a world wide port name (WWPN) and a world wide node name (WWNN). These WWNs are assigned by the VirtualCenter Server.

NPIV support is subject to the following limitations:

- NPIV must be enabled on the SAN switch. Contact the switch vendor for information about enabling NPIV on their devices.
- NPIV is supported only for virtual machines with RDM disks. Virtual machines with regular virtual disks continue to use the WWNs of the host's physical HBAs.
The physical HBAs on the ESX Server host must have access to a LUN using its WWNs in order for any virtual machines on that host to have access to that LUN using their NPIV WWNs. Ensure that access is provided to both the host and the virtual machines.

The physical HBAs on the ESX Server host must support NPIV. If the physical HBAs do not support NPIV, the virtual machines running on that host will fall back to using the WWNs of the host's physical HBAs for LUN access.

Each virtual machine can have up to 4 virtual ports. NPIV-enabled virtual machines are assigned exactly 4 NPIV-related WWNs, which are used to communicate with physical HBAs through virtual ports. Therefore, virtual machines can utilize up to 4 physical HBAs for NPIV purposes.

To view or edit a virtual machine's WWNs:

a. To edit the virtual machine's WWNs, power off the virtual machine.

b. Ensure that the virtual machine has a datastore containing a LUN that has been made available to the host.

c. Select the Options tab.

d. Select Fibre Channel NPIV.

e. Currently assigned WWNs are displayed in the WWN Assignments box.

f. Do one of the following:

   - To leave WWNs unchanged, select Leave unchanged.

   - To have VirtualCenter or the ESX Server host generate new WWNs, select Generate New WWNs.

   - To remove the current WWN assignments, select Remove WWN assignment.

g. Click OK to save your changes and close the dialog box.

**NOTE** A virtual machine with WWNs that are already in use on the storage network is prevented from powering on. To solve this issue, generate new WWNs or remove them.

Provide the WWN assignments to your SAN administrator. The administrator needs those assignments to configure virtual machine access to the LUN. For more information on how to configure an virtual machine to use NPIV, see the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide*.
7 Select Advanced > Virtualized MMU and specify whether to disable the feature, always use the feature where available, or have the host system determine whether the feature should be used.

8 Select Advanced > Swapfile Location.

Choose one of the following options:

- **Default** — Store the virtual machine swapfile at the default location defined by the host or cluster swapfile settings. See “Host Configuration for ESX Server and VirtualCenter” on page 69 for more information on host swapfile settings. See the Resource Management Guide for more information on cluster settings.

- **Always store with the virtual machine** — Store the virtual machine swapfile in the same folder as the virtual machine configuration file.

- **Store in the host’s swapfile datastore** — Store the virtual machine swapfile in the swapfile datastore defined by the host or cluster swapfile settings.

### Changing Virtual Machine Resource Settings

In the Virtual Machine Properties dialog box, you can adjust the host resource allocation for the selected virtual machine. You can change CPU, memory, disk, and advanced CPU resources from this tab.

For more information on resources, see the Resource Management Guide.

### CPU Resources

The CPU Resources panel lets you allocate processor resources for a virtual machine, specifying reservations, limits, and shares. You can edit some of the same information on the Resource Pools tab of the main VI Client window, which you might do to edit resource settings at the same time you edited other virtual machine settings.

**To change CPU settings**

1. Click the Resources tab.
2. Select CPU in the Settings list.
3 Select a shares value, which represents a relative metric for allocating CPU capacity.

- **Shares** – The values Low, Normal, High, and Custom are compared to the sum of all shares of all virtual machines on the server and, on ESX Server 3 hosts, the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.

- **Reservation** – Guaranteed CPU allocation for this virtual machine.

- **Limit** – Upper limit for this virtual machine's CPU allocation. Select Unlimited to specify no upper limit.

For more information on share values, see the Resource Management Guide.

4 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

**Advanced CPU Settings**

The Advanced CPU Resources panel lets you set low-level options that involve scheduling the virtual machine processing to physical processor cores and hyperthreads. This panel does not appear for virtual machines in a DRS cluster or when the host has only one processor core and no hyperthreading.

---

**NOTE** Hyperthreading technology allows a single physical processor to behave like two logical processors. The processor can run two independent applications at the same time. While hyperthreading does not double the performance of a system, it can increase performance by better utilizing idle resources. For detailed information about hyperthreading and its use in VMware Infrastructure, see the Resource Management Guide (choose Help > Manuals).

---

VMware ESX Server generally manages processor scheduling well, even when hyperthreading is enabled. The settings on this page are useful only for fine-grained tweaking of critical virtual machines.

The Hyperthreading Sharing option provides detailed control over whether a virtual machine should be scheduled to share a physical processor core (assuming hyperthreading is enabled on the host at all).

The Scheduling Affinity option allows fine-grained control over how virtual machine CPUs are distributed across the host’s physical cores (and hyperthreads if hyperthreading is enabled).
To change Advanced CPU settings

1. Click the Resources tab.
2. Select Advanced CPU in the Settings list.
3. Choose Hyperthreading Sharing Mode from the drop-down menu. The options are:
   - **Any** – (default) The virtual CPUs of this virtual machine can freely share cores with other virtual CPUs of this or other virtual machines.
   - **None** – The virtual CPUs of this virtual machine have exclusive use of a processor core whenever they are scheduled to it. The other hyperthread of the core is halted while this virtual machine is using the core.
   - **Internal** – On a virtual machine with exactly two virtual processors, the two virtual processors are allowed to share one physical core (at the discretion of the ESX Server scheduler), but this virtual machine never shares a core with any other virtual machine. If this virtual machine has any other number of processors other than two, this setting is the same as the None setting.
4. Choose to schedule affinity by selecting the Run on processor(s) radio button.

**NOTE** This option is not allowed when the virtual machine resides on a DRS cluster, and its values are cleared when a virtual machine is migrated to a new host. The value of the option is only in tuning the performance of a precise set of virtual machines on the same host.

The check boxes for the individual processors represent physical cores if hyperthreading is disabled or logical cores (two per physical core) if hyperthreading is enabled. Checking all the boxes is the same as not applying any affinity. You must provide at least as many processor affinities as the number of virtual CPUs in the virtual machine.

5. Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

**Memory Resources**

The Memory Resources panel lets you allocate memory resources for a virtual machine and specify reservations, limits, and shares. You can edit some of the same information on the Resource Pools tab of the main VI Client window, which you might do to edit resource settings at the same time as other virtual machine settings.
To change memory settings

1. Click the Resources tab.
2. Select Memory in the Settings list.
3. From the drop-down menu in the Resource allocation panel, choose a relative metric for allocating memory to all virtual machines.

   Symbolic values Low, Normal, High, and Custom are compared to the sum of all shares of all virtual machines on the server and, on an ESX Server 3 host, the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.

4. In the Resource allocation panel, use the slider to select the amount of reserved memory and the memory limit, or use the up and down arrows to enter the number of MBs allocated.

   For more information on memory values, see the mem man page.
5. Click OK to save your changes.

   The Virtual Machine Properties dialog box closes.

Advanced Memory Resources

The Advanced Memory Resources page lets you set low-level options that involve distribution of virtual machine memory to NUMA memory nodes.

This page is displayed only if the host utilizes the NUMA memory architecture. Because affinity settings are meaningful only when used to tweak the performance of a specific set of virtual machines on one host, this page also is not displayed when the virtual machine resides on a DRS cluster. The option values are cleared when the virtual machine is moved to a new host.

NUMA memory node affinity enables fine-grained control over how virtual machine memory is distributed to host physical memory. Checking all the boxes is the same as applying no affinity.

Consult the Resource Management Guide for details about NUMA and advanced memory resources.

**NOTE** Specify nodes to be used for future memory allocations only if you have also specified CPU affinity. If you make manual changes only to the memory affinity settings, automatic NUMA rebalancing does not work properly.
To associate memory allocations with a NUMA node

1. Select the Resources tab, and choose Memory.
2. In the NUMA Memory Affinity panel, set memory affinity.

**Disk Resources**

The Disk Resources panel lets you allocate host disk I/O bandwidth to the virtual hard disks of this virtual machine. Disk I/O is a host-centric resource and cannot be pooled across a cluster. However, CPU and memory resources are much more likely to constrain virtual machine performance than disk resources.

**To change disk settings**

1. Click the Resources tab.
2. Select Disk in the Settings list.
   
   On this dialog box, you can adjust the host disk allocation for this virtual machine.
3. In the Resource Allocation panel, select the virtual hard disk from the list.
4. Click in the Shares field. Use the drop-down menu to change the value to allocate a number of shares of its disk bandwidth to the virtual machine.
   
   Shares is a value that represents the relative metric for controlling disk bandwidth to all virtual machines. The values Low, Normal, High, and Custom are compared to the sum of all shares of all virtual machines on the server and, on an ESX Server 3 host, the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.
5. Click OK to save your changes.

**Adding New Hardware**

You can add virtual hardware to a virtual machine using the Add Hardware wizard. The virtual hardware that you add appears in the hardware list displayed in the Virtual Machine Properties wizard. The selected guest operating system determines the devices that are available to be added to a given virtual machine.

**To start the wizard**

1. From the VirtualCenter client, click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
2. To display the Virtual Machine Properties dialog box, click the Edit Settings link in the Commands panel.
3 Click the **Hardware** tab.
4 Click **Add** to start the Add Hardware wizard.

Follow the steps in the following sections to add various types of virtual hardware to your virtual machine.

**To add a serial port**
1 Start the Add Hardware wizard.
2 Select **Serial Port**, and click **Next**.
3 Select the type of media you want the virtual port to access: use a physical serial port on the host, output to a file, or connect to a named pipe.
4 Click **Next**.
5 If you selected **Use physical serial port** on the host, use the drop-down menu to choose the port on the host computer that you want to use for this serial connection.
6 If you selected **Output** to file, browse to the file on the host that you want to use to store the output of the virtual serial port.
7 If you selected **Connect to named pipe**, enter a pipe name in the **Pipe Name** field and use the drop-down menus to choose the near and far ends of the pipe.

The options for the near end are client or server. The options for the far end are a process or a virtual machine.

By default, the serial port is connected when you power on the virtual machine.
8 (Optional) Deselect the **Connect at power on** check box if you do not want the serial port to connect when the virtual machine is powered on.
9 (Optional) Deselect the I/O mode **Yield CPU on poll** check box if you want to configure this serial port to use interrupt mode as opposed to polled mode.

Polled mode is of interest primarily to developers who are using debugging tools that communicate over a serial connection. Polled mode causes the virtual machine to consume a disproportionate share of CPU time. This makes the host and other guests run sluggishly.
10 (Optional) To maintain best performance for applications on the host, select the **Yield CPU on poll** check box.

This forces the affected virtual machine to use interrupt mode, which yields CPU time if the only task it is trying to do is poll the virtual serial port.
11 Review the information on the **Ready to Complete** window, and click **Finish**.
To add a parallel port

1. Start the Add Hardware wizard.
2. Select Parallel Port, and click Next.
3. Select physical parallel port on the host or Output to file.
4. Click Next.
5. If you selected Use physical parallel port on the host, choose the port from the drop-down menu. If you selected Output to file, browse to the location of the file.
6. Under Device status, deselect the Connect at power on check box if you do not want the parallel port device to be connected when the virtual machine powers on.
7. Click Next.
8. Review the information on the Ready to Complete window, and click Finish.

To add a DVD/CD-ROM drive

1. Start the Add Hardware wizard.
2. Select DVD/CD-ROM Drive, and click Next.
3. Select either Use physical drive or Use ISO image.
   a. If you selected Use physical drive, select either client or host as the device location. Choose the drive you want to use from the drop-down menu.
      Select pass through and use the check box to indicate whether to connect exclusively to the virtual machine, or select ATAPI emulation.
   b. If you selected Use ISO Image, enter the path and filename for the image file, or click Browse to navigate to the file.
4. If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at power on.
5. Click Next.
6. Specify the virtual device node the drive uses in the virtual machine, and click Next.
7. Review the information on the Ready to Complete window, and click Finish or Back if you want to change any information.
To add a floppy drive
1  Start the Add Hardware wizard.
2  Select Floppy Drive, and click Next.
3  Select the type of floppy media to use:
   - A physical floppy drive to give the guest access to the floppy on the host.
   - A floppy image, which is a file on the host that stores data in the same format as a physical floppy disk.
   - A blank floppy image to create and use a blank floppy image.
4  Click Next.
5  If you selected Use a physical floppy drive, select either client or host as the device location and choose the drive from the drop-down menu.
   a  If you selected Use a floppy image, browse to the floppy image.
   b  If you selected Create a blank floppy image, browse to the floppy image.
6  To have the floppy drive connected to the virtual machine when you power it on, select Connect at power on.
7  Click Next.
8  Review the information on the Ready to Complete window, and click Finish.

To add an Ethernet adapter (NIC)
1  Start the Add Hardware wizard.
2  Select Ethernet Adapter, and click Next.
3  In the Network connection panel, choose either a named network with a specified label or a legacy network.
4  To connect the virtual NIC when the virtual machine is powered on, select Connect at power on.
5  To complete the wizard, click Finish.
To add a hard disk

1. Start the Add Hardware wizard.
2. Select **Hard Disk**, and click **Next**.
3. Select the type of storage for the virtual machine’s disk, and click **Next**.
   
   You can store virtual machine data in a new virtual disk, an existing virtual disk, or a Mapped SAN LUN. A virtual disk, which appears as a single hard disk to the guest operating system, is composed of one or more files on the host file system. Virtual disks can easily be copied or moved on the same host or between hosts.

4. If you selected **Create a new virtual disk**, do the following:
   a. Enter the disk capacity.
   b. Select the location as either **Store with the virtual machine** or **Specify a datastore**.
   c. If you selected **Specify a datastore**, browse for the datastore location, and click **Next**. Continue with Step 7.

5. If you selected an existing disk, browse for the disk file path and click **Next**.

6. If you selected **Mapped SAN LUN**:
   a. Select the LUN that you want to use for the raw disk, and click **Next**.
   b. Select a datastore and click **Next**.
   c. Select the compatibility mode: physical to allow the guest operating system to access the hardware directly or virtual to allow the virtual machine to use VMware snapshots and other advanced functions. Click **Next**.

7. Specify the virtual device node.

8. Set virtual disk mode options:
   a. Select **Independent** to make the disk independent. Independent disks are not affected by snapshots.
   b. If you selected Independent, select one of the two modes for independent disks:
      - **Persistent** – The disk operates normally except that changes to the disk are permanent even if the virtual machine is reverted to a snapshot.
      - **Nonpersistent** – The disk appears to operate normally, but whenever the virtual machine is powered off or reverted to a snapshot, the contents of the disk return to their original state. All later changes are discarded.
9 Click Next.

10 Review the information, and click Finish.

**To add a SCSI device**

1 Start the Add Hardware wizard.

2 Select SCSI Device, and click Next.

3 Under Connection, use the drop-down menu to choose the physical device you want to use.

4 To connect this virtual machine to the server’s SCSI device when the virtual machine is powered on, select Connect at power on.

5 Under Virtual device node, select the virtual device node where you want this device to appear in the virtual machine.

   You can also select the check box to indicate that the virtual device is set up in the same way as the physical unit.

6 Review the information in the Ready to Complete window, and click Finish.

**Legacy Virtual Machines**

Virtual machines created on an ESX Server 2.x host can run on an ESX Server 3.x host in legacy mode. These virtual machines use an older virtual hardware version than that supported by ESX Server 3.x and are referred to as “legacy virtual machines.” A legacy virtual machine is produced by any of the following operations:

- You create a virtual machine on an ESX Server 2.x host, and then migrate it to an ESX Server 3.x host.

- You create a new virtual machine on an ESX Server 3.x host using an existing virtual disk that was created on an ESX Server 2.x host.

- You add a virtual disk created on an ESX Server 2.x host to an existing non-legacy virtual machine.

Legacy virtual machines continue to run on ESX Server 3.x hosts, but have reduced performance and capabilities. In particular, you cannot add or remove virtual devices on legacy virtual machines. To make full use of these virtual machines, upgrade the virtual hardware as described in the Upgrade Guide.

**NOTE** Virtual machines created on ESX Server 1.x hosts, or using other VMware products such as VMware Workstation, must be converted to run on ESX Server 3.x hosts. See the Virtual Machine Mobility Planning Guide for more information.
**Upgrading Virtual Hardware**

To allow legacy virtual machines to take full advantage of the capabilities offered by ESX Server 3.x, you must upgrade their virtual hardware to the current version. See “Legacy Virtual Machines” on page 201 for more information. You can determine whether a virtual machine needs to be upgraded by determining its hardware version.

**To determine the virtual hardware version for a virtual machine**

1. Select the virtual machine in the inventory.
2. Click *Edit Settings*.
   
   The virtual machine hardware version is displayed at the top right corner of the Virtual Machine Properties dialog box.

**To upgrade virtual hardware**

1. From the VI Client, right-click a virtual machine in the inventory, and choose *Upgrade Virtual Hardware* from the drop-down menu.
   
   A confirmation dialog box appears with the message, “This operation will cause the virtual hardware your guest operating system runs on to change. It is an irreversible operation that will make your virtual machine incompatible with earlier versions of the VMware software products. It is strongly recommended that you make a backup copy of your disk(s) before proceeding. Are you sure you want to upgrade your configuration?”
2. Click *Yes*.
   
   A progress bar appears in the Recent Tasks pane at the bottom of the client window.
This chapter describes creating templates and cloning virtual machines.

This chapter contains the following topics:

- “Understanding Templates” on page 203
- “Creating Templates” on page 204
- “Editing a Template” on page 206
- “Deploying Virtual Machines from Templates” on page 207
- “Deleting Templates” on page 209
- “Regaining Templates” on page 210
- “Cloning Virtual Machines” on page 210
- “Creating a Scheduled Task to Clone a Virtual Machine” on page 212

**Understanding Templates**

A template is a master copy of a virtual machine that can be used to create and provision new virtual machines. This image typically includes a specified operating system and configuration that provides virtual counterparts to hardware components. Typically, a template includes an installed guest operating system and a set of applications.
Templates coexist with virtual machines at any level within the template and virtual machine domain. You can order collections of virtual machines and templates into arbitrary folders and apply a variety of permissions to both virtual machines and templates. Virtual machines can be transformed into templates without requiring a full copy of the virtual machine files and the creation of a new object.

You can use templates to create new virtual machines by deploying the template as a virtual machine. When complete, the deployed virtual machine is added to the folder chosen by the user when the template was created.

To view templates, select the datacenter and select the Virtual Machines tab. All virtual machines and templates for the datacenter are visible from here. Virtual machines and templates have different icons.

Creating Templates

There are three ways to create a template:

- Using an existing virtual machine in place. This process converts the original virtual machine.
- Cloning a virtual machine to a template.
- Cloning an existing template.

You do not need to power off a virtual machine in order to clone it to a template.
To convert an existing virtual machine to a template

1. Start the VI Client and log in to the VirtualCenter Server.
2. Click the Inventory button in the navigation bar.
   
   The inventory panel and the information panel display information about managed datacenters, hosts, resource pools, and virtual machines. The inventory toolbar appears.
3. Expand the inventory as needed, and select a virtual machine.
4. Turn off the virtual machine using the shut down or power off options.
5. From the Commands area or the pop-up menu, click Convert to Template.
   
   VirtualCenter marks that virtual machine as a template and displays the task in the Recent Tasks pane.

To clone a virtual machine to a template

1. Start the VI client, and log in to the VirtualCenter Server.
2. Click Inventory in the navigation bar to display the inventory panel.
3. Right-click the virtual machine and click Clone to Template.
   
   If the Clone to Template option is not enabled, you may need to power off the virtual machine. You cannot clone a suspended virtual machine.
   
   The Clone Virtual Machine to Template wizard appears.
4. Give the new template a name, select its inventory location, and click Next.
   
   Enter a useful name that describes the template. The name can be up to 80 characters long and can contain alphanumeric characters and the underscore ( _ ) and hyphen (-) characters. It should also be unique across all templates and virtual machines in the datacenter. Names are case-insensitive: the name "my_vmi" is identical to "My_Vm".
5. Pass through the target location page. Click Next.
6. Click Finish.
   
   VirtualCenter displays the Tasks inventory panel for reference and adds the cloned template to the list in the information panel.
To clone an existing template

1. Start the VI client, and log in to the VirtualCenter Server.
2. Click the Inventory button in the navigation bar.
3. Select the datacenter that contains the template.
   The virtual machines and templates associated with the datacenter appear in the datacenter panel.
4. Right-click the template and choose **Clone**.
   The Clone Template wizard appears.
5. Give the new template a unique name and description, and click **Next**.
   Enter a useful name and a brief description of the template. Description information can include, for example, the operating system, applications, versions, and intended uses for the template. The name can be up to 80 characters long, and can contain alphanumeric characters and the underscore (_ ) and hyphen (-) characters. It should also be unique across all templates and virtual machines in the datacenter. Names are case-insensitive: the name "my_vm" is identical to "My_Vm".
6. Select the host or cluster, and click **Next**.
7. Choose a datastore for the template. Click **Next**.
8. Select a radio button to either leave the virtual disks in their **Normal** virtual machine format or to **Compact** the virtual disks to minimize storage. Click **Next**.
9. On the **Ready to Complete** window, review the information for your new virtual machine, and click **Finish**.
   You cannot use the new template until the cloning task completes. VirtualCenter adds the cloned template to the list in the **Virtual Machines** tab.

**Editing a Template**

You might want to edit your template (to upgrade an application, for example). However, templates cannot be edited as templates. You must convert the template to a virtual machine, edit it, and convert the edited virtual machine to a template.
To edit the template
1 Convert the template to a virtual machine.
2 Edit the virtual machine.
3 Convert the virtual machine to a template.

You can directly change the name of a template using the procedure below.

To change the name of a template
1 From the VirtualCenter client, click the Inventory button.
2 Select the datacenter that contains the template.
3 Select the Virtual Machines tab.
4 Click on the template. Click the template again.
5 The name of the virtual machine is now an editable field.
6 Change the name, and click outside the field.

Deploying Virtual Machines from Templates
This procedure deploys a virtual machine from an existing template.

NOTE When a template that resides on a legacy VMFS2 datastore is converted to a virtual machine, the resulting virtual machine must be registered on the host where the template was created. Select this host as the destination for the new virtual machine.

To deploy a virtual machine from a template
1 Start the VI Client, and log in to the VirtualCenter Server.
2 Click the Inventory button in the navigation bar.
   The inventory panel and the information panel display information about managed datacenters, hosts, resource pools, and virtual machines. The inventory toolbar appears.
3 Select the datacenter that contains the template, and click the Virtual Machines tab.
   The virtual machines and templates associated with the datacenter appear in the datacenter panel.
4 Right-click the template, and choose Deploy Virtual Machine from this Template.
   The Deploy Template wizard appears.
5 Give the new virtual machine a name, select a location, and click **Next**.

The name can be up to 80 characters long and can contain alphanumeric characters and the underscore (_ ) and hyphen (-) characters. It should also be unique across all templates and virtual machines in the datacenter. Names are case-insensitive: the name "my_vm" is identical to "My_Vm".

6 On the **Host / Cluster** page, select the host on which you want to store the template and click **Next**.

7 Select a resource pool (if applicable) in which you want to run the virtual machine, and click **Next**.

Resource pools allow hierarchical management of resources within a host or cluster. Virtual machines and child pools share the resources of their parent pool.

8 Choose a datastore for the virtual machine, and click **Next**.

You are choosing the datastore in which to store the files for the virtual machine. You should choose one that is large enough to accommodate the virtual machine and all of its virtual disk files so that they can all reside in the same place.

The Advanced button allows you to store individual files in separate locations. To return to the datastore selection page, click the Basic button.

9 In the **Select Guest Customization Option** page, perform one of these actions:

- If you do not want to customize your guest operating system, select **Do not customize** and click **Next**.

- If you want to customize your guest operating system, click one of the other selections as appropriate. You customize guest operating systems through the wizard or by using an existing customization specification that you create. For instructions, see “Customizing Guest Operating Systems” on page 215.

**NOTE** Customization is not supported for all guest operating systems. Additionally, some guest operating systems require Microsoft Sysprep tools. See “Installing the Microsoft Sysprep Tools” on page 353.

10 In the Ready to Complete page, review the information for your new virtual machine, select the Power on the new Virtual Machine after creation check box if you want to power on the virtual machine immediately, and click **Finish**.

After you click **Finish**, you cannot use or edit the virtual machine until the task completes. This might take several minutes. The virtual machine is added to the datastore.
To convert a template to a virtual machine

1. Start VirtualCenter client, and log in to the VirtualCenter Server.
2. Click the Inventory button in the navigation bar.
   - The inventory panel and the information panel display information about managed datacenters, hosts, resource pools, and virtual machines. The inventory toolbar appears.
3. Select the datacenter that contains the template.
   - The virtual machines and templates associated with the datacenter appear in the datacenter panel.
4. Click the Virtual Machines tab.
5. Right-click on the template and choose **Convert to Virtual Machine**.
   - The template is converted to a virtual machine.

Deleting Templates

To remove templates from the VirtualCenter inventory

This procedure unregisters the template. It does not remove the template files from the datastore.

1. Click the **Inventory** button.
2. Select the appropriate template.
3. Right-click the template, and choose **Remove from Inventory**.
4. Click **OK** to confirm removing the template from the VirtualCenter database.
   - All non-datastore template files are removed from the VirtualCenter inventory.

To delete a template from disk

**CAUTION** After a template is deleted from a host, there is no way to recover it.

1. Start VirtualCenter client, and log in to the VirtualCenter Server.
2. Click the Inventory button in the navigation bar, and select the host that contains the template.
3. Select the datastore that contains the template, and click the Virtual Machine tab.
4 Right-click the template, and choose **Delete from Disk**.
5 Click **OK** to confirm removing the template from the VirtualCenter database.

The template is deleted from the disk and cannot be recovered.

### Regaining Templates

Templates are associated with hosts, and the only way to regain or register templates after removing and adding a host is to use the datastore browser to locate the template. Then use the inventory wizard to name and register the .vmtx file as a template back into VirtualCenter.

**NOTE** If you want the template to retain its original name, do not enter a name in the Add to Inventory wizard. VirtualCenter will use the original name if the field in the wizard is left blank.

#### To regain a template

1 Start VirtualCenter client, and log in to the VirtualCenter Server.
2 Click the Inventory button in the navigation bar, and select the host that contains the template.
3 Right-click the datastore that contains the template and select **Browse Datostore**.
4 Browse through the datastore folders to find the .vmtx file.
5 Right-click the .vmtx file and select **Add to Inventory**.

   The Add to Inventory wizard appears.
6 Enter a template machine name, select a location, and click **Next**.

   Select a host or cluster on which to store the template, and click **Next**.
7 Review your selections, and click **Finish**.
8 The template is registered to the host and can be viewed from the host's Virtual Machine tab.

### Cloning Virtual Machines

A clone is a copy plus customization of a virtual machine. When you create a clone, VirtualCenter provides an option to customize the guest operating system of that virtual machine. You can place the new clone on any host within the same datacenter as the original virtual machine, or you can place it in a different datacenter.
You can hot clone a virtual machine in any power state. You do not need to power off the virtual machine in order to clone it. However, you cannot clone a suspended virtual machine.

**To clone a virtual machine**

1. Start VirtualCenter and log in to the VirtualCenter Server.
2. From the inventory panel, click the Inventory button in the navigation bar.
   The inventory panel and the information panel display the datastores, resource pools, hosts, and virtual machine information. The inventory toolbar appears.
3. Expand the inventory as needed, and click the source virtual machine.
4. To start the Clone a Virtual Machine wizard, click the Clone to New Virtual Machine link in the Commands area, or choose Clone from the pop-up menu.
   If the Clone option is not enabled, you may need to power off the virtual machine.
   You cannot clone a suspended virtual machine.
   The Clone Virtual Machine wizard appears.
5. Enter a virtual machine name, select a location, and click Next.
6. Select a host or cluster on which to run the clone, and click Next.
   If you choose a cluster, you must choose a specific host within the cluster, and click Next.
7. Select a resource pool in which to run the clone, and click Next.
8. Select the datastore location where you want to store the virtual machine files, and click Next.
9. Click the Advanced button for more options, and click Next.
   The Select Guest Customization Option page appears. You can choose to customize the guest operating system using the wizard or using an existing customization specification. You can also choose not to customize.
   For more information, see “Customizing Guest Operating Systems” on page 215.
10. Select the appropriate radio button, and click Next.
11. Review your selections, and click Finish.
   On the Ready to Complete New Virtual Machine page, you can select the check box to power on the new virtual machine after creation. After you click Finish, you cannot use or edit the virtual machine until the task completes. If the task involves the creation of a virtual disk, it could take several minutes to complete.
Creating a Scheduled Task to Clone a Virtual Machine

This procedure creates a scheduled task to clone a virtual machine.

To create a scheduled task to clone a virtual machine

1. Click the Scheduled Tasks button in the navigation bar.
   The list of scheduled tasks appears.
2. Choose File > New > Scheduled Task, or click the New button.
   The Select a Task to Schedule dialog box appears.
3. Use the drop-down menu to choose Clone a virtual machine, and click OK.
   The Clone Virtual Machine wizard appears.
4. Select the virtual machine to clone, and click Next.
5. Follow the wizard through the same steps as those in the previous task in which you cloned a virtual machine. The page after Guest Customization is the Schedule the Task page.

6. Enter a name and a task description in the text box.
7. Select the frequency of the task.
8 Select the radio button for **Now** or **Later**. If later, enter the time and date when you want the virtual machine to be deployed, and click **Next**.

To see the calendar, click **Later**, and click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today’s date, and a dark circle indicates the scheduled date.

9 Review the information on the **Ready to Complete New Virtual Machine** page, and click **Finish**.

Optionally, you can select the check box to power on the new virtual machine after it is created.

VirtualCenter adds the new task to the scheduled task list and completes it at the designated time. When it is time to perform the task, VirtualCenter first verifies that the user who created the task still has permission to complete the task. If the permission levels are not acceptable, VirtualCenter sends a message to the log and the task is not performed.
Now that you have created and configured a virtual machine, you have the option to customize the identity and network settings of your virtual machine’s guest operating system so that it is ready to begin work immediately in your target environment.

You can save your virtual machine settings in a specification that you can recall later and reuse. You do this using the customization wizard. There are two ways to access the customization wizard: using the customization specification manager, which lets you create specifications and store them in the database for later use, and using the wizard when you’re cloning a new virtual machine.

**NOTE** Virtual machines must be registered in the VirtualCenter inventory before you can customize their guest operating systems.

This chapter describes how to use the Customization Specification Manager to customize your guest operating systems.

This chapter contains the following topics:

- “Preparing for Guest Customization” on page 216
- “Customizing a Windows Guest Operating System” on page 218
- “Using the Customization Specification Wizard” on page 224
- “Using the Clone Virtual Machine Wizard” on page 228
- “Completing a Guest Operating System Customization” on page 229

For more details on installing a guest operating system, see the *Guest Operating System Installation Guide*. 
Preparing for Guest Customization

When you deploy a new virtual machine from a template or clone an existing virtual machine, you have the opportunity to customize the new guest operating system. The Guest Customization wizard guides you through the configuration options.

Before you run the Guest Customization wizard, if you intend to perform a guest customization, do the following:

- Verify that your system meets the guest customization requirements. If you plan to customize a Windows guest operating system, you must install the components required to support a Windows guest operating system customization. This is described in Appendix B, “Installing the Microsoft Sysprep Tools,” on page 353.
- Install the required components on the Windows machine where the VirtualCenter server is installed.

**NOTE** After deploying and customizing non-volume-licensed versions of Windows XP or Windows 2003, you might need to reactivate your Microsoft operating system on the new virtual machine.

Virtual Hardware Requirements for Guest Customization

Guest customization requires that the source virtual machine used to create the clone or templates has the following:

- VMware Tools installed.
- SCSI disks.

The default configuration for VMware Workstation, and VMware Server creating a Windows XP or Windows Server 2003 virtual machine is IDE disks. If you are customizing a virtual machine with IDE disks, it can be deployed only to a VMware Server host.

VirtualCenter customization operates on the disk attached to the virtual SCSI node with the lowest address on the SCSI controller with the lowest index. As a result, you must make sure that the guest operating system being customized resides on a disk attached as SCSI 0:0 node in the virtual machine configuration.

**NOTE** If a virtual machine has mixed IDE and SCSI disks, the first IDE disk is considered the boot disk, and VirtualCenter passes it to the customizer. “First” is in controller:device order, that is, ide0:0, ide0:1, scsi0:0, scsi0:1, and so on.
For Windows guest operating systems: If the virtual machine resides on a host running ESX Server 3.0.x or earlier, both the active partition (the partition containing boot.ini) and the system partition (the partition containing the system directory, for example, \WINNT or \WINDOWS), are on the same virtual disk and attached the SCSI 0:0 virtual SCSI node.

Note: It is not a requirement that active and system partitions be the same partition.

For Linux guests: If the virtual machine resides on a host running ESX Server 3.0.x or earlier, the virtual disk containing the system partition (the partition containing the /etc directory) must reside on the SCSI 0:0 node.

- 32-bit or 64-bit hardware corresponding to the 32-bit or 64-bit operating system being installed.

Windows Requirements for Guest Customization

Guest customization of a Windows guest operating system can occur if: (See Update)

- The guest operating system is not a primary or backup domain controller.
- The clone or template has one of the following Windows versions installed:
  - Windows 2000 Server, Advanced Server, or Professional (including 64-bit versions)
  - Windows XP Professional (including 64-bit versions)
  - Windows Server 2003, Web, Standard, or Enterprise Editions (including 64-bit versions)
  - Windows Vista (including 64-bit versions)

Note: Windows XP Home or Windows NT4 operating system guest customization is not supported. Windows Vista customization is supported only on hosts running ESX Server 3.5 and greater or ESX Server 3i version 3.5 and greater.

- The most recent version of VMware Tools is installed in the guest operating system.
- The Microsoft Sysprep tools are installed on the VirtualCenter server.
- If the virtual machine resides on a host running ESX Server 3.0.x or earlier, both the active partition (the partition containing boot.ini) and the system partition (the partition containing the system directory, for example, \WINNT or \WINDOWS), must be on the same virtual disk.
Microsoft Sysprep tools have certain requirements and impose certain restrictions on the source machine. See the Microsoft Sysprep documentation for additional information.

**Linux Requirements for Guest Customization**

Guest customization of a Linux guest operating system can occur if: *(SEE UPDATE)*

- The clone or template has one of the following Linux versions installed:
  - Red Hat Enterprise Linux AS versions 2 through 5 (including 64-bit versions)
  - Red Hat Application Server versions 2 through 5 (including 64-bit versions)
  - SUSE LINUX Enterprise Server 8, 9, or 10

  **NOTE** Customization for Red Hat Linux version 4 and greater and SUSE LINUX Enterprise Server version 9 and greater is supported only on hosts running ESX Server 3.5 and greater or ESX Server 3i version 3.5 and greater.

- The most recent version of VMware Tools is installed in the guest operating system.

- The clone or template has a root volume formatted with an ext2, ext3, or ReiserFS file system.

**Customizing a Windows Guest Operating System**

The customizing process varies, depending upon the guest operating system to be used in the new virtual machine. To customize a Windows operating system while deploying a template or cloning a virtual machine, perform the following steps.

**To customize a Windows guest operating system**

The Guest Customization wizard starts indirectly from the Deploy Template wizard or Clone Virtual Machine wizard, or you can start the wizard by selecting a virtual machine and then selecting *Edit > Customization Specifications*.

1. Start the Guest Customization wizard.

2. On the Registration Information page, enter the virtual machine owner’s name and organization. Click *Next*.

   This information is for guest operating system registration purposes. It is displayed in the guest operating system System Properties. In the *Name* field, you can enter the name of a person, user, or group.
3 On the **Computer Name** page, specify the **Computer Name** for the virtual machine. Click **Next**.

The computer name is the name given to the particular instance of a guest operating system. The operating system uses this name to identify itself on the network. On Windows systems, it is called the computer name. On most other operating systems, it is called the host name. This is not the same as the virtual machine name that was declared earlier in the Deploy Template wizard or Clone Virtual Machine wizard. You can set the computer name using the following options:

- **Use a specific name** – The name can contain alphanumeric characters and the underscore (_) and hyphen (-) characters. It cannot contain periods (.) or blank spaces and cannot be made up of digits only. If you want to ensure that the name is unique so that you do not incur conflicts, select **Append a numeric value to ensure uniqueness**. Names are case-insensitive: the name “my_vm” is identical to “My_Vm”.

- **Use the virtual machine’s name** – The computer name that VirtualCenter creates is identical to the name of the virtual machine on which the guest operating system is running.

- **Prompt the user for a name in the Deploy wizard** – The VI Client populates the Deploy Virtual Machine wizard with a prompt for the computer name after you complete all the steps in the wizard.

- **Use a custom application configured with the VirtualCenter Server to generate a name** – Enter a parameter that can be passed to the custom application.

4 On the **Windows License** page, specify the Windows license key for the new guest operating system. Click **Next**.

If you are customizing a Windows Server operating system, select the appropriate license mode, **Per seat** or **Per server**. If you select **Per server**, specify the maximum number of simultaneous connections you want the server to accept.
5 On the **Administrator Password** page, type and confirm the administrator password for the virtual machine. Click **Next**.

If you leave the password blank, the VI Client asks you to confirm that Administrator users aren’t required to provide a password.

**NOTE** You can only change the administrator password if the administrator password on the source Windows virtual machine is blank. If you specify a new administrator password and the source Windows virtual machine or template already has one, the old administrator password does not change.

If you want to automatically log in as administrator when the virtual machine boots, select **Automatically log on as the administrator** and specify how many times automatic log in is to be performed. This is useful if you know you will have a series of reboots before the virtual machine is ready for normal log in users.

6 On the **Time Zone** page, choose the time zone for the virtual machine. Click **Next**.

7 On the **Run Once** page, type any commands you want to run as part of the first startup for the new virtual machine. After you type each command, click **Add**. Use the **Delete** and **Move** options to create the run order for the commands. When you are done with the command list, click **Next**.

**NOTE** See Microsoft Windows Sysprep documentation for more information on the Run Once commands.

8 If you want VirtualCenter to automatically configure all network interfaces from a DHCP server, select **Typical settings** on the **Network** page. Click **Next**.
If typical VirtualCenter configuration is not appropriate for your environment, select **Custom settings**, select the network interface card (NIC) to customize and click **Customize** to make additional specifications.

The Network Properties dialog box opens.

![Network Properties dialog box](Image)

Use the **Network Properties** dialog box to perform these steps:

a. On the **General** tab, select whether you want to use DHCP to obtain an IP address automatically or enter the IP addresses manually. Also select whether you want to use DHCP to obtain an DNS server address automatically or enter the DNS server addresses manually.

b. On the **DNS** tab, specify the DNS connections by entering DNS suffixes. For each DNS suffix you enter, click **Add**. If you are adding multiple DNS connections, use **Move Up** and **Move Down** to specify the order in which a virtual machine is to use the connections.

c. On the **WINS** tab, specify the primary and secondary WINS addresses by typing the IP addresses in the entry boxes.

d. Click **OK** to return to the previous dialog box. Click **Next** on the **Network Guest Customizations** dialog box.
On the **Workgroup or Domain** page, complete one of these steps:

- To join a workgroup, select **Workgroup**, type the workgroup name, and click **Next**.
- To join a domain, select **Windows Server Domain**, specify the user name of a user who can add computers to the Windows domain, and specify the user’s password. Click **Next**.

On the **Operating System Options** page, select **Generate New Security ID (SID)** to generate a new security ID for the virtual machine.

Click **Next**.

(Optional) On the **Save Specification** page, save the customized options as an .xml file by completing these steps:

1. Select **Save this customization specification for later use**.
2. Specify the name for the specification, and click **Next**.

VirtualCenter saves the customized configuration parameters in the VirtualCenter database. If the customization settings are saved, the administrator, and domain administrator, passwords are stored in encrypted format in the database. Because the certificate used to encrypt the passwords is unique to each VirtualCenter Server, reinstalling the VirtualCenter Server, or attaching a new instance of the server to the database, invalidates the encrypted passwords. The passwords must be re-entered before they can be used.

Click **Finish** to save your changes and exit the Guest Customization wizard.

Click **Finish** to deploy the virtual machine and exit the Deploy Template wizard or Clone Virtual Machine wizard.

---

**Customizing a Linux Guest Operating System**

**To customize a Linux guest operating system**

You cannot start the Guest Customization wizard from a menu or toolbar option. The Guest Customization wizard starts indirectly from the Deploy Template wizard or Clone Virtual Machine wizard.

1. Start the Guest Customization wizard.
2. On the Computer Name page, specify the Computer Name and the Domain Name for the virtual machine. Click **Next**.
The computer name is the name given to the particular instance of a guest operating system. The operating system uses this name to identify itself on the network. On Linux systems, it is called the host name. This is not the same as the VMware VI3 virtual machine name that was declared earlier in the Deploy Template wizard or Clone Virtual Machine wizard. You can set the computer name using the following options:

- **Use a specific name** – The name can contain alphanumeric characters and the underscore (\_) and hyphen (-) characters. It cannot contain periods (.) or blank spaces and cannot be made up of digits only. If you want to ensure that the name is unique so that you do not incur conflicts, select **Append a numeric value to ensure uniqueness**. Names are case-insensitive: the name “my_vm” is identical to “My_Vm”.

- **Use the virtual machine’s name** – The computer name that VirtualCenter creates is identical to the name of the virtual machine on which the guest operating system is running.

- **Prompt the user for a name in the Deploy wizard** – The VI Client populates the Deploy Virtual Machine wizard with a prompt for the computer name after you complete all the steps in the wizard.

- **Use a custom application configured with the VirtualCenter Server to generate a name** – Enter a parameter that can be passed to the custom application.

3 If you want VirtualCenter to automatically configure all network interfaces from a DHCP server, select **Typical settings** on the Network page. Click **Next**.

4 If VirtualCenter configuration is not appropriate for your environment, select **Custom settings**, and click Next.

5 Select the network interface card (NIC) to customize and click **Customize** to make additional specifications.

   Use the **Network Properties** dialog box to perform these steps:

   a On the **General** tab, select whether you want to use DHCP to obtain an IP address automatically or enter the IP addresses manually. Also select whether you want to use DHCP to obtain an DNS server address automatically or enter the DNS server addresses manually.

   b Click **OK** to return to the previous dialog box. Click **Next** on the Network Guest Customizations page.
6 On the DNS and Domain settings page, enter the IP addresses for the DNS servers. Specify the DNS connections by entering DNS suffixes. For each DNS suffix you enter, click Add. If you are adding multiple DNS suffixes, use Move Up and Move Down to specify the order in which a virtual machine is to use the connections.

7 (Optional) On the Save Specification page, save the customized options as an .xml file by completing these steps:
   a Select **Save this customization specification for later use.**
   b Specify the filename for the specification, and click **Next.**

VirtualCenter saves the customized configuration parameters in the VirtualCenter database. If the customization settings are saved, the administrator, and domain administrator, passwords are stored in encrypted format in the database. Because the certificate used to encrypt the passwords is unique to each VirtualCenter Server, reinstalling the VirtualCenter Server, or attaching a new instance of the server the database, invalidates the encrypted passwords. The passwords must be re-entered before they can be used.

8 Click **Finish.**

VirtualCenter closes the Guest Customization wizard and returns you to the Deploy Template wizard or Clone Virtual Machine wizard.

9 Click **Finish** to deploy the virtual machine from the template or create the clone.

**Using the Customization Specification Wizard**

The following procedure helps you set up a customization specification that can be used later to customize a guest operating system.

**To start the Guest Customization wizard**

1 Choose **Edit > Customization Specifications.**

   The Customization Specification Manager window appears. From here, you can view the properties of a specification and create, edit, copy, delete, import, or export specifications. Use the **Refresh** button to refresh the display.
To create a new specification, click the **New** icon. The Guest Customization wizard appears.

Choose the target virtual machine operating system from the drop-down menu.

Select the check box if you want to use a custom Sysprep answer file.

Type a name for the new customization specification and an optional description. Click **Next**.

Type the owner’s name and organization to register this copy of the guest operating system. Click **Next**.

The Computer Name page appears. In this page you specify a computer name to identify this virtual machine on a network.

To specify a name for the computer, select the radio button for one of the following:

- **Use a specific name**
  
  With this option, you must type a name in the text field. Select the check box if you want to append a numeric value to the specific computer name to ensure uniqueness of name.

- **Use the Virtual Machine Name**

- **Prompt the user for a name in the Deploy wizard**

- **Use a custom application configured with the VirtualCenter server to generate a name**

  With this selection, you supply an argument.
8 Click **Next**.

The operating system License page appears.

9 In the License page, type the product ID if the virtual machine requires licensing information.

Some virtual machines might not require licensing information. In that case, leave these fields blank.

10 Select the check box for **Include Server License Information** if you are customizing a server guest operating system.

11 Select either per seat or per server operating system, enter the maximum connections for server license mode, and click **Next**.

12 On the Administrator Password panel, type a password and confirm it for the administrator account.

If you do not enter a password, a warning dialog box appears.

13 Select the check box if you want to automatically log in as the administrator, and choose the number of times to log in.

14 Click **Next**.

15 Use the drop-down menu to choose a time zone, and click **Next**.

16 In the **Run Once** page, specify commands to be run the first time a user logs on. Use the navigation buttons to add, delete, and move commands up or down.

**NOTE** See Microsoft Windows Sysprep documentation for more information on the Run Once commands.

17 Click **Next**.

18 Specify the network interface settings if you want to customize the software settings for each network interface. Select the radio button for typical settings to enable DHCP for all network interfaces or the radio button for custom settings to manually configure each network interface.

19 Click **Next**.

20 In the Workgroup or Domain page, select the way in which the virtual machine participates in the network, select the radio button for workgroup and enter a workgroup name, or select the radio button for Windows server domain and enter the domain.

In the latter case, you must also enter a user name and password for a user account that has permission to add a computer to the specified domain.
21 Click Next.

22 In the Operating System Options page, select Generate New Security ID (SID) to generate a new security identifier.

23 Click Next.

24 Review the information you have entered, and click Finish.

The specification appears in the Customization Specification Manager page and can be used to customize a guest operating system.

Saved customization specifications are unique to each VirtualCenter Server and to each version of VirtualCenter due to encryption. You have to recreate the customization specifications for each VirtualCenter Server. Encryption is preserved between upgrade versions on the same VirtualCenter Server. This means you can use the same specifications between upgrades of VirtualCenter. However, if you uninstall VirtualCenter and later do a fresh installation, the ability to decrypt passwords from the earlier installation is lost.

25 To view the properties of a specification, click the Properties icon.

The Customization Specification Properties dialog box appears.

26 Click OK to close the dialog box.
27 Click the Edit icon to redisplay the Guest Customization wizard, and change the information for the specification.

28 Click the Copy icon to create a copy of the specification.

29 To delete a specification, select it and click the Delete icon.

The specification is deleted from the specification manager.

30 To import an existing specification into the manager, click the Import icon and select the specification in the Browse dialog box.

31 To export a specification, click the Export icon and choose a Save As location.

32 Use the maximize, minimize, and close buttons to maximize, minimize, or exit the specification manager.

Using the Clone Virtual Machine Wizard

You have a second opportunity to access the Guest Customization wizard at the end of the deployment wizard. Here, you have the ability to load a saved customization specification. You can choose to get the specification from the local disk or from the server. If you choose not to load a saved specification, the wizard opens with blank fields.

Use the following procedure when you are setting up your new virtual machine. You use the specification that you set up in the previous section as you set up a virtual machine in the following procedure.

For more information on using the customization wizard, see “Customizing a Windows Guest Operating System” on page 218.

To load a saved customization specification using the Clone Virtual Machine wizard

1 Choose Inventory > Virtual Machine > Clone.

   The Clone Virtual Machine wizard appears.

2 Move through the wizard until you reach the Select Guest Customization Option page from which you can customize using the Customization wizard or customize using an existing customization specification selected from the specification manager’s list.
Completing a Guest Operating System Customization

The final customization steps occur when the new virtual machine boots for the first time. As part of this process, the machine might reboot a number of times. The customization process does not complete until the guest operating system boots, runs the finalization scripts, and reaches the log in page.

If the new virtual machine encounters customization errors while it is booting, the errors are reported using the guest’s system logging mechanism. In Linux, these errors are logged to /var/log/vmware/customization.log. In Windows, they are written to %WINDIR%\temp\vmware-imc.

The steps required to finalize guest operating system customization are covered in the following sections:

- “Completing Linux Guest Operating System Customization” on page 229
- “Completing Windows Guest Operating System Customization” on page 229

Completing Linux Guest Operating System Customization

A customized Linux virtual machine does not need any additional rebooting and is operational as soon as the log in page appears after the first boot. If configuration errors occur, they are displayed on the virtual machine’s console window while the guest operating system is booting.

Completing Windows Guest Operating System Customization

When a customized virtual machine is powered on for the first time, its guest operating system completes a set of operations that finalizes the customization and configuration process. Depending on the guest operating system type, this process might require additional rebooting, which is automatically performed.

After powering on for the first time, a customized Windows virtual machine automatically reboots multiple times to finalize the configuration process. It becomes operational when the log in page appears after the second reboot. This process can take several minutes, depending on the speed and load of the host. If any errors occur during the final configuration process, events are logged to the guest operating system’s event database. To view these errors, choose Start > Program > Administrative Tools > Event Viewer from the Windows Start menu.
If any of the information required in the configuration finalization process is not correct, the guest operating system pauses when the new virtual machine boots and waits for you to enter the correct information. Incorrect information might include:

- The computer name is not unique. The computer name must be unique for the network on which the machine is deployed.
- The product key is incorrect.
- The user specified to join a domain that does not exist.
- The DHCP server for the network is not functioning properly.

**To determine if the system is waiting for information**

Open the virtual machine’s console to see if the system is waiting for information.
This chapter describes the process of migrating—moving a virtual machine from one host to another.

This chapter contains the following topics:

- “About Migration” on page 232
- “Cold Migration” on page 232
- “Migrating a Suspended Virtual Machine” on page 233
- “Migration with VMotion” on page 233
- “Using the Migrate Virtual Machine Wizard” on page 243
- “Migration with Storage VMotion” on page 248

**NOTE**  Copying a virtual machine creates a new virtual machine. It is not a form of migration.
About Migration

Migration is the process of moving a virtual machine from one host or storage location to another. In VirtualCenter 2.5 and greater, you have the following migration options:

- **Cold Migration** – Moving a powered-off virtual machine to a new host.
  Optionally, you can relocate configuration and disk files to new storage locations. Cold migration can be used to migrate virtual machines from one datacenter to another.

- **Migrating a Suspended Virtual Machine** – Moving a suspended virtual machine to a new host. Optionally, you can relocate configuration and disk files to new storage location. You can migrate suspended virtual machines from one datacenter to another.

- **Migration with VMotion** – Moving a powered-on virtual machine to a new host. Migration with VMotion allows you to move a virtual machine to a new host without any interruption in the availability of the virtual machine. Migration with VMotion cannot be used to move virtual machines from one datacenter to another.

- **Migration with Storage VMotion** – Moving the virtual disks or configuration file of a powered-on virtual machine to a new host. Migration with Storage VMotion allows you to move a virtual machine's storage without any interruption in the availability of the virtual machine.

Cold Migration

The virtual machine you want to migrate must be powered off prior to beginning the cold migration process. With cold migration, you have the option of moving the associated disks from one datastore to another. The virtual machines are not required to be on shared storage.

A cold migration consists of the following steps:

1. The configuration files, including the NVRAM file (BIOS settings) and log files, as well as the disks of the virtual machine are moved from the source host to the destination host's associated storage area.

2. The virtual machine is registered with the new host.

3. After the migration is completed, the old version of the virtual machine is deleted from the source host.
If errors occur during cold migration, the virtual machines revert to their original states and locations.

You can move virtual machines manually or set up a scheduled task to perform the cold migration. See “Managing Tasks, Events, and Alarms” on page 301 for information on scheduling tasks.

Migrating a Suspended Virtual Machine

Migration of suspended virtual machines is supported in ESX Server 3.x and ESX Server 3i and later only. Virtual machines created using ESX Server 2.x must be powered off before migration. When migrating a suspended virtual machine, you also have the option of moving the associated disks from one datastore to another. The virtual machines are not required to be on shared storage.

When you migrate a suspended virtual machine, the new host for the virtual machine must meet CPU compatibility requirements. For more information, see “About Migration Compatibility Checks” on page 246.

Migration of a suspended virtual machine consists of the following steps:

1  The configuration files, including the NVRAM file (BIOS settings), log files, and the suspend file as well as the disks of the virtual machine are moved from the source host to the destination host's associated storage area.

2  The virtual machine is registered with the new host.

3  After the migration is completed, the old version of the virtual machine is deleted from the source host.

If errors occur during migration, the virtual machines revert to their original states and locations.

Both migration of a suspended virtual machine and migration with VMotion are sometimes referred to as “hot migration”, because they allow migration of a virtual machine without powering it off.

Migration with VMotion

Migration with VMotion allows working processes to continue throughout a migration. The entire state of the virtual machine, as well as its configuration file, if necessary, is moved to the new host, while the associated virtual disk remains in the same location on storage that is shared between the two hosts. After the virtual machine state is migrated to the alternate host, the virtual machine runs on the new host.
The state information includes the current memory content and all the information that defines and identifies the virtual machine. The memory content includes transaction data and whatever bits of the operating system and applications are in the memory. The defining and identification information stored in the state includes all the data that maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC addresses for the Ethernet cards, chip set states, registers, and so forth.

Migration with VMotion happens in three stages:

1. When the migration with VMotion is requested, VirtualCenter verifies that the existing virtual machine is in a stable state with its current host.
2. The virtual machine state information (memory, registers, and network connections) is copied to the target host.
3. The virtual machine resumes its activities on the new host.

If any error occurs during migration, the virtual machines revert to their original states and locations.

Both migration of a suspended virtual machine and migration with VMotion are sometimes referred to as “hot migration”, because they allow migration of a virtual machine without powering it off.

**Host Configuration for VMotion**

In order to successfully use VMotion, you must first configure your hosts correctly. Ensure that you have correctly configured your hosts in each of the following areas:

- Each host must be correctly licensed for VMotion. For more information on licensing, see the *Installation Guide*.
- Each host must be configured to use shared storage. For more information, see “Shared Storage” on page 234.
- Each host must meet the networking requirements for VMotion. For more information, see “VMotion Networking Requirements” on page 235.

**Shared Storage**

During a migration with VMotion, the migrating virtual machine must be on storage accessible to both the source and target hosts. Ensure that the hosts configured for VMotion use shared storage. Shared storage is typically on a storage area network (SAN), but can also be implemented using iSCSI and NAS shared storage. See the VMware SAN Configuration Guide for additional information on SAN and the ESX Server 3 Configuration Guide or ESX Server 3i Configuration Guide for information on other shared storage.
VMotion Networking Requirements

VMotion requires a private Gigabit Ethernet (GigE) network between all VMotion-enabled hosts. Each host enabled for VMotion must have a minimum of two Ethernet adapters, at least one of which must be a GigE adapter.

Recommended networking best practices are as follows:

- Use one dedicated Ethernet adapter for the service console (on ESX Server 3 hosts).
- Use one dedicated GigE adapter for VMotion.
- If only two Ethernet adapters are available:
  - For best security, dedicate the GigE adapter to VMotion, and use VLANs to divide the virtual machine and management traffic on the other adapter.
  - For best availability, combine both adapters into a bond, and use VLANs to divide traffic into networks: one or more for virtual machine traffic, one for the service console (on ESX Server 3 hosts), and one for VMotion.

Configure the virtual networks on VMotion-enabled hosts as follows:

- On each host, configure a VMkernel port group for VMotion.
- Ensure that virtual machines have access to the same subnets on source and destination hosts.
- Ensure that the network labels used for virtual machine port groups are consistent across hosts. During a migration with VMotion, VirtualCenter assigns virtual machines to port groups based on matching network labels.

For more information on host networking configuration, see the ESX Server 3 Configuration Guide or the ESX Server 3i Configuration Guide.

About CPU Compatibility

VMotion transfers the running architectural state of a virtual machine between underlying ESX Server systems. Successful migration requires that the processors of the target host be able to execute using the equivalent instructions that the processors of the source host were using when the virtual machine was migrated off of the source host. Processor clock speeds and cache sizes, and the number of processor cores can vary, but processors must come from the same vendor class (Intel or AMD) and use compatible feature sets to be compatible for migration with VMotion.

Migrations of suspended virtual machines also require that the virtual machine be able to resume execution on the target host using equivalent instructions.
When you initiate a migration with VMotion or a migration of a suspended virtual machine, the Migrate Virtual Machine wizard checks the destination host for compatibility and produces an error message if there are compatibility problems that will prevent migration. For more information, see “About Migration Compatibility Checks” on page 246.

When a virtual machine is powered on, it determines its available CPU feature set. The virtual machine's CPU feature set is based on the host's CPU feature set. However, some of the host CPU features can be hidden from the virtual machine if the host is part of a cluster using Enhanced VMotion Compatibility, or if a CPU compatibility mask is applied to the virtual machine. For more information on Enhanced VMotion Compatibility, see “About Enhanced VMotion Compatibility” on page 238. For more information on CPU compatibility masks, see “About CPU Compatibility Masks” on page 241.

When you attempt to migrate a virtual machine with VMotion, one of the following scenarios applies:

- The destination host feature set matches the virtual machine's CPU feature set. CPU compatibility requirements are met, and migration with VMotion proceeds.
- The virtual machine's CPU feature set contains features not supported by the destination host. CPU compatibility requirements are not met, and migration with VMotion cannot proceed.
- The destination host supports the virtual machine's feature set, plus additional user-level features (such as SSE4.1) not found in the virtual machine's feature set. CPU compatibility requirements are not met, and migration with VMotion cannot proceed.
- The destination host supports the virtual machine's feature set, plus additional kernel-level features (such as Nx) not found in the virtual machine's feature set. CPU compatibility requirements are met, and migration with VMotion proceeds. The virtual machine retains its CPU feature set as long as it remains powered on, allowing it to migrate freely back to the original host. However, if the virtual machine is rebooted, it acquires a new feature set from the new host, which might cause VMotion incompatibility if you attempt to migrate the virtual machine back to the original host.

**NOTE** VMware, in partnership with CPU and hardware vendors, is working to maintain VMotion compatibility across the widest range of processors. For additional information, check the VMware Knowledge Base.
About CPU Families and Feature Sets

Processor families such as Intel Xeon and AMD Opteron are defined by the processor vendors. You can distinguish different processor versions within the same family by comparing the processors’ model, stepping level, and extended features. In some cases, processor vendors have introduced significant architectural changes within the same processor family, such as the SSSE3 and SSE4.1 instructions, and Nx/XD CPU security features.

By default, VirtualCenter identifies mismatches on features accessible to applications as incompatible to guarantee the stability of virtual machines after migrations with VMotion.

Server hardware's CPU specifications will usually indicate whether or not the CPUs contain the features that affect VMotion compatibility. If the specifications of a server or its CPU features are unknown, VMware's bootable CPU identification utility (available for download with ESX Server) can be used to boot a server and determine whether its CPUs contain features such as SSE3, SSSE3, and Nx/XD.

For more information on identifying Intel processors and their features, see Application Note 485: Intel® Processor Identification and the CPUID Instruction, available from Intel. For more information on identifying AMD processors and their features, see CPUID Specification, available from AMD.

Nx/XD Considerations

AMD's No eXecute (Nx) and Intel's eXecute Disable (XD) technology serve the same security purpose: to mark memory pages as data-only to prevent malicious software exploits and buffer overflow attacks.

The following operating systems support Nx and XD:

- Windows Server 2003 (SP1), Windows® XP (SP2), Windows Vista, RHEL4, RHEL 3 (Update 3), SUSE 10, SUSE Linux 9.2, Solaris 10, Linux kernels 2.6.6 or later (or 2.4 kernels with a patch)

In ESX Server 3.x and later, Nx and XD technology is exposed by default for all guest operating systems that can use it (trading off some compatibility for security by default). Hosts previously compatible in ESX Server 2.x might become incompatible after upgrading to ESX Server 3.x if Nx mismatched, but per-VM CPU compatibility masks specified in the VMotion CPU Compatibility Matrix can be used to restore compatibility.
**SSSE3 Considerations**

Within the Intel P4 and Intel Core processor families, VMware places a restriction between processors that do support the SSSE3 instructions and processors that do not support the SSSE3 instructions. Because they are application level instructions that bypass the virtualization layer, these instructions could cause application instability if mismatched after a migration with VMotion.

**SSE4.1 Considerations**

Within the Intel Core 2 processor family, VMware places a restriction between processors that do support the SSE4.1 instructions and processors that do not support the SSE4.1 instructions because they are application level instructions that bypass the virtualization layer, and could cause application instability if mismatched after a migration with VMotion.

**About Enhanced VMotion Compatibility**

You can use the Enhanced VMotion Compatibility (EVC) feature to help ensure VMotion compatibility for the hosts in a cluster. EVC ensures that all hosts in a cluster present the same CPU feature set to virtual machines, even if the actual CPUs on the hosts differ. This prevents migrations with VMotion from failing due to incompatible CPUs.

Configure EVC from the cluster settings dialog box. When you configure EVC, you set all host processors in the cluster to present the features of a baseline processor. EVC leverages Intel FlexMigration technology to present the same feature set as the baseline Intel processor. EVC leverages AMD’s AMD-V Extended Migration technology to present the same feature set as the baseline AMD processor. For more information on baseline processors and supported processors, see “EVC Requirements” on page 238.

EVC cannot prevent virtual machines from accessing hidden CPU features in all circumstances. Applications that do not follow CPU vendor recommended methods of feature detection may behave unexpectedly in an EVC environment. VMware EVC cannot be supported with ill-behaved applications that do not follow the CPU vendor recommendations. For more information on creating well-behaved applications, search the VMware Knowledge Base for the article *Testing and Using New Features in CPUs*.

**EVC Requirements**

In order to enable EVC on a cluster, the cluster must meet the following requirements:

- You must be running VirtualCenter 2.5 Update 2 or later. *(See Update)*
- All hosts in the cluster must have CPUs from a single vendor, either Intel or AMD.
All hosts in the cluster must either have hardware live migration support (Intel FlexMigration or AMD-V Extended Migration) or have the CPU whose baseline feature set you intend to enable for the cluster. For specific host processors supported, see Table 15-1.

All hosts in the cluster must be running ESX Server 3.5 Update 2 or later.

All hosts in the cluster must be connected to the VirtualCenter Server.

All virtual machines in the cluster must be powered off or migrated out of the cluster when EVC is enabled.

Any host added to an existing EVC-enabled cluster must also meet the requirements listed above.

Table 15-1. Processors Supported in EVC Clusters

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Baseline Processor</th>
<th>Processors Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel</td>
<td>Intel Core 2 (Merom)</td>
<td>Intel Core 2 (Merom)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel 45nm Core 2 (Penryn)</td>
</tr>
<tr>
<td>AMD</td>
<td>AMD Second Generation Opteron (Rev-E/F)</td>
<td>AMD Second Generation Opteron (Rev-E/F)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AMD Third Generation Opteron (Barcelona)</td>
</tr>
</tbody>
</table>

Creating an EVC Cluster

When you create an EVC cluster, you can use one of two methods:

- Create an empty cluster, enable EVC, and then move hosts into the cluster.
- Enable EVC on an existing cluster.

VMware recommends creating an empty EVC cluster as the simplest way of creating an EVC cluster with minimal disruption to your existing infrastructure.

Before you create an EVC cluster, ensure that the hosts you intend to add to the cluster meet the requirements listed in “EVC Requirements” on page 238.

To create an EVC cluster

1. Create an empty cluster.

   Other cluster features such as VMware DRS and VMware HA are fully compatible with EVC. You can choose to enable these features when you create the cluster. For more information on specific cluster options, see the VI Client online Help.

2. Edit the cluster settings and enable EVC.
Select the CPU vendor and feature set appropriate for the hosts you intend to add to the cluster. For more information on configuring EVC, see the VI Client online Help.

3 Select a host to move into the cluster, and do one of the following:
   - Power off all the virtual machines on the host.
   - Migrate the host’s virtual machines to another host using VMotion.

   If you migrate the virtual machines to a host with the same CPU type that you have enabled as the baseline for the EVC cluster, you will be able to use VMotion to migrate these virtual machines into the cluster after you have finished setting it up. Otherwise, you will have to power off the virtual machines to migrate them into the cluster.

4 Move the host into the cluster.

   You can power on the virtual machines on the host, or migrate virtual machines into the cluster with VMotion, provided that they meet CPU compatibility requirements for the cluster’s baseline CPU.

5 Repeat Step 3 and Step 4 for each additional host that you want to move into the cluster.

Enabling EVC on an Existing Cluster

Before you enable EVC on an existing cluster, ensure that the hosts in the cluster meet the requirements listed in “EVC Requirements” on page 238.

To enable EVC on an existing cluster

1 Ensure that there are no powered-on virtual machines in the cluster before enabling EVC. Select the cluster for which you want to enable EVC, and do one of the following:
   - Power off all the virtual machines in the cluster.
   - Migrate the cluster’s virtual machines to another host using VMotion.

   If you migrate the virtual machines to a host with the same CPU type that you enable as the baseline for the EVC cluster, you will be able to use VMotion to migrate these virtual machines back into the cluster after you have finished setting it up. Otherwise, you will have to power off the virtual machines to migrate them into the cluster.

2 Ensure that the cluster contains hosts with CPUs from only one vendor: Intel or AMD.
3 Edit the cluster settings and enable EVC.
   Select the CPU vendor and feature set appropriate for the hosts in the cluster.
   For more information on configuring EVC, see the VI Client online Help.

4 Power on the virtual machines in the cluster, or migrate virtual machines into the cluster.

About CPU Compatibility Masks
VirtualCenter compares the CPU features available to a virtual machine with the CPU features of the destination host to determine whether to allow or disallow migrations with VMotion. CPU compatibility masks allow per-virtual machine customization of the CPU features visible to a virtual machine.

Default values for the CPU compatibility masks are set by VMware to guarantee the stability of virtual machines after a migration with VMotion. Changes to these default masks are made conservatively by VMware, and only when new CPU features are introduced and versions of ESX Server are updated to expose or hide them from virtual machines.

In some cases, where a choice between CPU compatibility or guest operating system features (such as Nx/XD) exists, VMware provides check-box options to configure individual virtual machines through the virtual machine’s Advanced Settings option. For more control over the visibility of CPU features, you can edit the virtual machine’s CPU compatibility mask at the bit level.

CAUTION Manual edit of the CPU compatibility masks without the appropriate documentation and testing is NOT recommended and might lead to an unsupported configuration. For more information on editing CPU compatibility masks, see “Changing Virtual Machine Options” on page 186.

CPU compatibility masks cannot prevent virtual machines from accessing masked CPU features in all circumstances. On hosts without hardware live migration support (Intel FlexMigration or AMD-V Extended Migration), applications can detect and use masked features even though they are hidden from the guest operating system. In addition, on any host, applications that use unsupported methods of detecting CPU features rather than using the CPUID instruction can access masked features. Virtual machines running such ill-behaved applications might experience stability problems after migration.
Virtual Machine Configuration Requirements for VMotion

A number of specific virtual machine configurations can prevent migration of a virtual machine with VMotion. These configurations are summarized below:

- You cannot use migration with VMotion to migrate virtual machines using raw disks for clustering purposes.
- You cannot use migration with VMotion to migrate a virtual machine that uses a virtual device backed by a device that is not accessible on the destination host. (For example, you cannot migrate a virtual machine with a CD drive backed by the physical CD drive on the source host.) Disconnect these devices before migrating the virtual machine.
- You cannot use migration with VMotion to migrate a virtual machine that uses a virtual device backed by a device on the client computer. Disconnect these devices before migrating the virtual machine.
- You cannot use migration with VMotion to migrate a virtual machine if the destination host cannot access the virtual machine's swapfile. For more information, see “Swapfile Location Compatibility” on page 242.

Swapfile Location Compatibility

Virtual machines on hosts running ESX Server 3.0.x have a virtual machine swapfile located with the virtual machine configuration file. These virtual machines can be migrated with VMotion only if the destination host can access the VMFS volume where the swapfile is located.

You can configure ESX Server 3.5 and ESX Server 3i version 3.5 hosts or clusters or hosts managed by VirtualCenter 2.5 to store virtual machine swapfiles in one of two locations: with the virtual machine configuration file, or on a local swapfile datastore specified for that host. You can also set individual virtual machines to have a different swapfile location from the default set for their current host.

The location of the virtual machine swapfile affects VMotion compatibility as follows:

- **Migrations between hosts running ESX Server 3.5 or ESX Server 3i version 3.5:** Migrations with VMotion and migrations of suspended and powered-off virtual machines are allowed.
  
  If the swapfile location specified on the destination host differs from the swapfile location specified on the source host, the swapfile is copied to the new location. This can result in slower migrations with VMotion. If the destination host cannot access the specified swapfile location, it stores the swapfile with the virtual machine configuration file.
Migrations between a host running ESX Server 3.5 or ESX Server 3i version 3.5 and a host running an earlier version of ESX Server: Migrations of suspended and powered-off virtual machines are allowed. If the virtual machine is configured to use a local swapfile datastore, attempting to migrate it to a host that does not support this configuration produces a warning, but the migration can proceed. When the virtual machine is powered on again, the swapfile is located with the virtual machine.

See the VI Client online Help for more information on configuring swapfile policies.

Migrations with VMotion are not allowed unless the destination swapfile location is the same as the source swapfile location. In practice, this means that virtual machine swapfiles must be located with the virtual machine configuration file.

Migrating Virtual Machines with Snapshots

Some additional restrictions apply when migrating virtual machines with snapshots. Migrating a virtual machine with snapshots is permitted, regardless of the virtual machine power state, as long as the virtual machine is being migrated to a new host without moving its configuration file or disks. (In other words, the virtual machine must reside on shared storage accessible to both hosts.)

If the migration involves moving the configuration file or virtual disks, then the following additional restrictions apply:

- The starting and destination hosts must be running ESX Server 3 version 3.5 or ESX Server 3i version 3.5 or later.
- All of the virtual machine files and disks must reside in a single directory, and the migrate operation must move all the virtual machine files and disks to a single destination directory.

VirtualCenter generates a warning, but does not prevent migration, when you attempt to migrate a virtual machine with snapshots. Reverting to a snapshot after migration with VMotion might cause the virtual machine to crash, because the migration wizard cannot verify the compatibility of the virtual machine state in the snapshot with the destination host.

Using the Migrate Virtual Machine Wizard

The Migrate Virtual Machine wizard takes you through the process of migrating a virtual machine from one host to another. The wizard options differ slightly, depending on whether you are performing cold migration or migration with VMotion.
To migrate a powered-off or suspended virtual machine

1. Select the virtual machine you want to migrate. Then do one of the following:
   - Right-click and choose Migrate from the pop-up menu.
   - On the Summary tab, click the Migrate to New Host button.
   - Drag the virtual machine onto the target host, cluster, or resource pool.

   **NOTE** If multiple virtual machines are selected and the wizard is invoked through drag-and-drop, the virtual machines must all be in the same power state. Otherwise, an error message is displayed, and the wizard stops.

2. Select the destination host or cluster for the virtual machine and click Next.
   Possible targets include hosts and DRS clusters with any level of automation. If a cluster does not have DRS enabled, select a specific host in the cluster rather than selecting the cluster itself.
   Any compatibility problem is displayed in the Compatibility panel. Fix the problem, or select another host or cluster.
   If the wizard is invoked through drag- and-drop, the Select Destination host or cluster window is skipped if the drag-and-drop target is a standalone host or a resource pool assigned to a standalone host. If a cluster or a cluster’s resource pool is the drag-and-drop target, the Select Destination host or cluster window appears.
3 Select the destination resource pool for the virtual machine migration and click Next.

Any compatibility problem is displayed in the Compatibility panel. Fix the problem, or choose another resource pool.

The Resource Pool Selection page does not appear if a virtual machine was dropped on a resource pool.

4 Choose what to do with the virtual machine configuration files and virtual disks:
   - If you want to keep the virtual machine configuration files and virtual disks in their current location, select Keep virtual machine configuration files and virtual disks in their current locations and click Next.
   - If you want to move the virtual machine configuration files and virtual disks to a new location, select Move virtual machine configuration files and virtual disks, then select the destination datastore and click Next.

5 Review the summary, and click Finish.

VirtualCenter moves the virtual machine to the new host. Event messages appear in the Events tab. The data displayed on the Summary tab shows the status and state throughout the migration.

To migrate a powered-on virtual machine

1 Select the virtual machine you want to migrate. Then do one of the following:
   - Right-click and choose Migrate from the pop-up menu.
   - On the Summary tab, click the Migrate to New Host button.
   - Drag the virtual machine onto the target host, cluster, or resource pool.

**NOTE** If multiple virtual machines are selected and the wizard is invoked through drag-and-drop, the virtual machines must all be in the same power state. Otherwise, an error message is displayed, and the wizard stops.

2 Select a destination host or cluster for the virtual machine.

Possible targets include hosts and DRS clusters with any level of automation. If a cluster does not have DRS enabled, select a specific host in the cluster rather than selecting the cluster itself.
If the wizard is invoked through drag-and-drop, the Select Destination host or cluster window is skipped if the drag-and-drop target is a standalone host or a resource pool assigned to a standalone host. If a cluster or a cluster’s resource pool is the drag-and-drop target, the Select Destination host or cluster window appears. Any compatibility problem is displayed in the Compatibility panel. Fix the problem, or select another host or cluster.

3 Select a resource pool, and click Next.

Any compatibility problem is displayed in the Compatibility panel. Fix the problem, or choose another resource pool.

The Resource Pool Selection page does not appear if a virtual machine was dropped on a resource pool.

4 Select the migration priority level and click Next:

- **High Priority** – VirtualCenter reserves resources on both the source and destination hosts to maintain virtual machine availability during the migration. High priority migrations do not proceed if resources are unavailable.

- **Low Priority** – VirtualCenter does not reserve resources on the source and destination hosts to maintain availability during the migration. Low priority migrations always proceed. However, the virtual machine might become briefly unavailable if host resources are unavailable during the migration.

5 Review the page, and click Finish.

When you click Finish, a task is created that begins the virtual machine migration process. While the virtual machine is in the process of being migrated, you have only limited access to its functions.

**About Migration Compatibility Checks**

During migration, the Migrate Virtual Machine wizard checks the destination host for compatibility with the migrating virtual machine using a number of criteria. When you select a host, the Compatibility panel at the bottom of the Migrate Virtual Machine wizard displays information about the compatibility of the selected host or cluster with the virtual machine’s configuration.

If the virtual machine is compatible, the panel displays the message, “Validation succeeded.” If the virtual machine is not compatible with either the host’s or cluster’s configured networks or datastores, the compatibility window can display both warnings and errors:
Warning messages do not disable migration. Often the migration is justified and you can continue with the migration despite the warnings.

Errors can disable migration if there are no error-free destination hosts among the selected destination hosts. In this case, the Next button is disabled.

For clusters, the network and datastore configurations are taken into account when checking compatibility issues. For hosts, the individual host’s configuration is used. A possible problem might be that VMotion is not enabled on one or both hosts.
A specific host feature’s effects on compatibility are dependent on whether or not ESX Server exposes or hides them from virtual machines:

- Features that are exposed to virtual machines are not compatible when they are mismatched.
- Features that are not exposed to virtual machines are compatible regardless of mismatches.

**Migration with Storage VMotion**

Using Storage VMotion, you can migrate a virtual machine and its disk files from one datastore to another while the virtual machine is running. You can choose to place the virtual machine and all its disks in a single location, or select separate locations for the virtual machine configuration file and each virtual disk. The virtual machine does not change execution host during a migration with Storage VMotion.

Storage VMotion has a number of uses in administering virtual infrastructure, including the following:

- Upgrading VMware Infrastructure without virtual machine downtime. During an upgrade from ESX Server 2.x to ESX Server 3.5, you can migrate running virtual machines from a VMFS2 datastore to a VMFS3 datastore, and upgrade the VMFS2 datastore without any impact on virtual machines. You can then use Storage VMotion to migrate virtual machines back to the original datastore without any virtual machine downtime.

- Storage maintenance and reconfiguration. You can use Storage VMotion to move virtual machines off of a storage device to allow maintenance or reconfiguration of the storage device without virtual machine downtime.

- Redistributing storage load. You can use Storage VMotion to redistribute virtual machines or virtual disks to different storage volumes to balance capacity or improve performance.

**Storage VMotion Requirements and Limitations**

Storage VMotion is subject to the following requirements and limitations:

- Virtual machines with snapshots cannot be migrated using Storage VMotion.
- Virtual machine disks must be in persistent mode or be raw device maps.
You must move the virtual machine’s .vmx file during a migration with Storage VMotion. If you want to move a virtual machine’s disks while keeping the .vmx file in the same place, you can move the .vmx file and the disks to a new location, and then move the .vmx file back to its original location.

The host on which the virtual machine is running must have sufficient resources to support two instances of the virtual machine running concurrently for a brief time.

The host on which the virtual machine is running must have a VMotion license, and be correctly configured for VMotion.

The host on which the virtual machine is running must have access to both the source and target datastores.

VMware Infrastructure 3 supports a maximum of four simultaneous VMotion or Storage VMotion accesses to a single datastore. A migration with VMotion involves two simultaneous accesses to the datastore, by the source and destination hosts. A migration with Storage VMotion involves one access to the source datastore and one access to the destination datastore. Therefore, if no other migrations are occurring, up to four concurrent Storage VMotion migrations involving the datastore can occur simultaneously.

Storage VMotion Remote Command-Line Syntax

In addition to using the Migration wizard, you can initiate migrations with Storage VMotion on both ESX Server 3i and ESX Server 3 hosts from the Remote Command-Line Interface (Remote CLI) using the svmotion command. For more information on installing and using the Remote CLI, see the Remote Command-Line Interface Installation and Reference.

The svmotion command can be invoked in either an interactive or non-interactive mode. To use the command in interactive mode, type svmotion --interactive. You will then be prompted for all the information necessary to complete the storage migration. When the command is invoked in interactive mode, all other parameters given are ignored.

In non-interactive mode, the svmotion command uses the following syntax:

```bash
svmotion [Standard remote CLI options] --datacenter=<datacenter name> --vm
  '<VM config datastore path>:<new datastore>' [--disks
  '<virtual disk datastore path>:<new datastore>, <virtual disk datastore path>:<new datastore>']
```

For more information on the standard Remote CLI options, see the Remote Command-Line Installation and Reference.

Table 15-2 describes the parameters for the svmotion command.
Determining the Path to a Virtual Machine Configuration File

To determine the path to a virtual machine’s configuration file

1. In the VI Client inventory, select the virtual machine and click the Summary tab.
2. Click Edit Settings to display the Virtual Machine Properties dialog box.
3. Click the Options tab, and select General Options.

The path to the virtual machine configuration file is displayed in the Virtual Machine Configuration File text box.

Determining the Path to a Virtual Disk File

To determine the path to a virtual disk file

1. In the VI Client inventory, select the virtual machine to which the virtual disk belongs, and click the Summary tab.
2. Click Edit Settings to display the Virtual Machine Properties dialog box.
3. Click the Hardware tab, and select the virtual disk from the list of devices.

The path to the virtual disk file is displayed in the Disk File text box.

Table 15-2. svmotion command parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;datacenter&gt;</td>
<td>The datacenter which contains the virtual machine to be migrated.</td>
</tr>
<tr>
<td>&lt;VM config datastore path&gt;</td>
<td>The datastore path to the virtual machine's configuration file. The path should be enclosed in single quotes.</td>
</tr>
<tr>
<td>&lt;new datastore&gt;</td>
<td>The name of the new datastore to which the virtual machine configuration file or disk is to be moved. Do not include brackets around the name of the new datastore.</td>
</tr>
<tr>
<td>--disks</td>
<td>If you do not specify this parameter, all virtual disks associated with a virtual machine are relocated to the same datastore as the virtual machine configuration file. By specifying this parameter, you can choose to locate individual virtual disks to different datastores. If you would like to keep a virtual disk on its current datastore, use the --disks option for that disk with its current datastore as the &lt;new datastore&gt;.</td>
</tr>
<tr>
<td>&lt;virtual disk datastore path&gt;</td>
<td>The datastore path to the virtual disk file.</td>
</tr>
</tbody>
</table>
Storage VMotion Command-Line Examples

The examples in this section are formatted on multiple lines for readability. The command should be issued on a single line.

An example of relocating all of a virtual machine’s disks to a datastore named new_datastore:

```
svmotion --url=https://myvc.mycorp.com/sdk
    --username=me
    --password=secret
    --datacenter=DC1
    --vm='[old_datastore] myvm/myvm.vmx: new_datastore'
```

An example of relocating a virtual machine to new_datastore, while leaving the disks, myvm_1.vmdk and myvm_2.vmdk on old_datastore:

```
svmotion --datacenter='My DC'
    --vm='[old_datastore] myvm/myvm.vmx:
        new_datastore'
    --disks='[old_datastore] myvm/myvm_1.vmdk:
        old_datastore,
        [old_datastore] myvm/myvm_2.vmdk:
        old_datastore'
```
VMware VirtualCenter snapshots allow you to preserve the state of the virtual machine so you can return to the same state repeatedly.

This chapter contains the following topics:
- “Understanding Snapshots” on page 253
- “Using the Snapshot Manager” on page 257
- “Restoring a Snapshot” on page 259

Understanding Snapshots

A snapshot captures the entire state of the virtual machine at the time you take the snapshot. This includes:

- **Memory state** – The contents of the virtual machine's memory.
- **Settings state** – The virtual machine settings.
- **Disk state** – The state of all the virtual machine's virtual disks.

**NOTE** Snapshots of raw disks, RDM physical mode disks, and independent disks are not supported.

Snapshots operate on individual virtual machines. In a team of virtual machines, taking a snapshot preserves the state only of the active virtual machine.
When you revert to a snapshot, you return all these items to the state they were in at the time you took that snapshot. If you want the virtual machine to be suspended, powered on, or powered off when you launch it, be sure it is in the correct state when you take that snapshot.

Snapshots are useful when you need to revert repeatedly to the same state but you don’t want to create multiple virtual machines. With snapshots, you create backup and restore positions in a linear process. You can also preserve a baseline before diverging a virtual machine in a process tree.

Snapshots can be used as restoration points during a linear or iterative process, such as installing update packages, or during a branching process, such as installing different versions of a program. Taking snapshots ensures that each installation begins from an identical baseline.

Multiple snapshots refers to the ability to create more than one snapshot of the same virtual machine. To take snapshots of multiple virtual machines, (for example, snapshots for all members of a team) requires that you take a separate snapshot of each team member.

Multiple snapshots are not simply a new way of saving your virtual machines. With multiple snapshots, you can save many positions to accommodate many kinds of work processes.

**SEE UPDATE** Although you can take snapshots up to 32 levels, the amount of time it takes to commit or delete those snapshots increases as the levels get deeper. The required time is directly proportional to the amount of data (committed or deleted) and the virtual machine’s RAM size.

### Relationship Between Snapshots

The relationship between snapshots is like that of a parent to a child:

- **In the linear process**, each snapshot has one parent and one child, except for the last snapshot, which has no children.

- **In the process tree**, each snapshot has one parent, but one snapshot may have more than one child. Many snapshots have no children.

You can revert to a parent or a child.
Snapshots and Other Activity in the Virtual Machine

When you take a snapshot, be aware of other activity going on in the virtual machine and the likely effect of reverting to that snapshot. In general, it is best to take a snapshot when no applications in the virtual machine are communicating with other computers. The potential for problems is greatest if the virtual machine is communicating with another computer, especially in a production environment.

For example, if you take a snapshot while the virtual machine is downloading a file from a server on the network, the virtual machine continues downloading the file, communicating its progress to the server. If you revert to the snapshot, communications between the virtual machine and the server are confused and the file transfer fails.

Another example is taking a snapshot while an application in the virtual machine is sending a transaction to a database on a separate machine. If you revert to that snapshot—especially if you revert after the transaction starts but before it has been committed—the database is likely to be confused.

Taking a Snapshot

Taking a snapshot is a synchronous operation. All user operations to the virtual machine during this period are blocked for snapshot and data consistency. The time taken to develop a snapshot depends on the amount of data and the load on the server. On average, the time ranges from 30 to 40 seconds for minimal snapshot creation.

You can take a snapshot while a virtual machine is powered on, powered off, or suspended. If you are suspending a virtual machine, wait until the suspend operation has finished before taking a snapshot.

You must power off the virtual machine before taking a snapshot if the virtual machine has multiple disks in different disk modes. For example, if you have a special purpose configuration that requires you to use an independent disk, you must power off the virtual machine before taking a snapshot.

To take a snapshot


   You can also click the Take a snapshot of this virtual machine button, or right-click the virtual machine and choose Snapshot > Take Snapshot.

   The Take Virtual Machine Snapshot window appears.

2. Type a name for your snapshot.
3  (Optional) Type a description for your snapshot.
   Descriptions are useful to identify differences between similarly named snapshots. Descriptions appear in the Snapshot Manager.

4  Click OK.
   A progress pop-up menu box appears. When the snapshot has been successfully taken, it is listed in the Recent Tasks field at the bottom of VirtualCenter.

5  Click the target virtual machine to display tasks and events for this machine or, while the virtual machine is still selected, click the Tasks & Events tab.

### Changing Disk Mode to Exclude Virtual Disks from Snapshots

You must power off and delete any existing snapshots before you attempt to change the disk mode. Deleting a snapshot involves committing the existing data on the snapshot disk to the parent disk.

**To exclude a disk from a snapshot**

1  Choose Inventory > Virtual Machine > Edit Settings.
2  Click the Hardware tab, and select the hard disk you want to exclude.
3 Under **Mode**, select Independent. Independent disks are not affected by snapshots.

You have the following persistence options for an independent disk:

- **Persistent** – Changes are immediately and permanently written to the disk. All changes to an independent disk in persistent mode remain, even when you revert to that snapshot.
- **Nonpersistent** – Changes to the disk are discarded when you power off or revert to that snapshot.

4 Click **OK**.

**Using the Snapshot Manager**

The Snapshot Manager lets you review all snapshots for the active virtual machine and act on them directly.

The Snapshot Manager window contains the following areas: Snapshot tree, Details region, Command buttons, Navigation region, and a You are here icon.

**Figure 16-1. Snapshot Manager**

- **Snapshot tree** – Displays all snapshots for the virtual machine.
- **You are here** icon – Represents the current operational state of the virtual machine. The **You are here** icon is always selected and visible when you open the Snapshot Manager.
The **You are here** icon represents a state that is never a snapshot itself but rather the virtual machine state after the parent snapshot. A snapshot is always a static record of a virtual machine state. The You are here state can be operational and changing. Even when you create a snapshot of a powered off or suspended virtual machine, the You are here state is not identical to the snapshot.

You cannot go to or select the You are here state. You are here always represents the current and active state.

- **Command Buttons** – The Snapshot Manager has three command buttons in the left pane: Go to, Delete, and Delete All.
- **Details** – Displays the name and description of the selected snapshot. These fields are blank if you have not selected a snapshot.
- **Navigation Region** – Contains buttons for navigating out of the dialog box:
  - **Close** – Closes the Snapshot Manager.
  - **Help** – Opens the help system.

**To use the Snapshot Manager**

1. Choose **Inventory > Virtual Machine > Snapshot > Snapshot Manager**.
2. In the Snapshot Manager, select a snapshot by clicking it.
3. To go to a snapshot, click the **Go to** button to restore the virtual machine to any arbitrary snapshot.
   - The **Go to** command allows you to restore the state of any snapshot.
4. Click **Yes** in the confirmation dialog box.
5. To delete a snapshot, click the **Delete** button to permanently remove a snapshot from VirtualCenter use.
6. Click **Yes** in the confirmation dialog box.
7. To delete all snapshots, click the **Delete All** button to permanently remove all snapshots from VirtualCenter use.

<table>
<thead>
<tr>
<th>NOTE</th>
<th><strong>Delete</strong> commits the snapshot data to the parent and then removes the selected snapshot. <strong>Delete All</strong> commits all the immediate snapshots before the You are here current state to the base disk and removes all existing snapshots for that virtual machine.</th>
</tr>
</thead>
</table>

8. Click **Yes** in the confirmation dialog box.
9. Click **Close** to exit the Snapshot Manager.
Restoring a Snapshot

VMware VirtualCenter includes the following snapshot methods to allow you to return to the original virtual machine:

- The Inventory > Virtual Machine > Snapshot menu contains the command Revert to Snapshot.
- The Snapshot Manager has a Go to button.

Parent Snapshot

To discern between the Revert to Snapshot and Go to commands, you must understand what is meant by the parent snapshot.

The parent snapshot is the most recently saved version of the current state of the virtual machine. If you have just taken a snapshot, that stored state is the parent snapshot of the current state (You are here). If you revert or go to a snapshot, that snapshot becomes the parent of the current state (You are here).

The parent snapshot is always the snapshot appearing immediately above the You are here icon in the Snapshot Manager.

Figure 16-2. Parent Snapshot

NOTE The parent snapshot is not always the snapshot you took most recently. For example, if you take a snapshot today and then Go to a snapshot you took yesterday, the snapshot you took today is no longer the parent of the current state of the virtual machine. The parent snapshot has become the snapshot you took yesterday.
Revert to Snapshot Command

Revert to Snapshot is essentially a shortcut to the parent snapshot of You are here. This command immediately activates the parent snapshot of the current state of the virtual machine.

The current disk and memory states are discarded and restored as they were when you took that snapshot. If your parent snapshot was taken when the virtual machine was powered off, choosing Snapshot > Revert to Snapshot moves the powered-on virtual machine to that parent state, that is, to a powered-off state.

Figure 16-3. Revert to Snapshot

When you revert a virtual machine, the virtual machine returns to the parent snapshot of the virtual machine (that is, the parent of the current You are here state).
There are three ways to revert to the parent snapshot:

- Choose Inventory > Virtual Machine > Snapshot > Revert to Snapshot.
- Click the Revert to snapshot button on the toolbar.
- Right-click the virtual machine, and choose Snapshot > Revert to Snapshot.
System Administration
This chapter describes users, groups, permissions, and roles. VirtualCenter and ESX Server hosts determine the level of access for the user based on the permissions assigned to the user. The combination of user name, password, and permissions is the mechanism by which VirtualCenter and ESX Server hosts authenticate a user for access and authorize the user to perform activities. The servers and hosts maintain lists of authorized users and the permissions assigned to each user.

**NOTE** You must be in Admin view for the **Admin > Roles** menu item to be enabled.

*Privileges* define basic individual rights required to perform actions and read properties. ESX Server and VirtualCenter use sets of privileges, or *roles*, to control which individual users or groups can access particular VMware Infrastructure objects. ESX Server and VirtualCenter provide a set of pre-established roles. You can also create new roles.

The privileges and roles assigned on an ESX Server host are separate from the privileges and roles assigned on a VirtualCenter Server. If you have privileges and roles assigned on an ESX Server host and then add that host to the VirtualCenter Server inventory, only the privileges and roles assigned through the VirtualCenter Server are recognized. If you then remove the host from the VirtualCenter Server inventory, the previously set ESX Server host privileges and roles are used.

For a complete list of privileges available, see Appendix A, “Defined Privileges,” on page 331.

This chapter contains the following topics:

- “Access Elements” on page 266
- “Access Rules” on page 266
Access Elements

Access to VMware Infrastructure objects and activities is established through the combination of:

- **Log In information** – User name and password.
- **Groups** – A method for grouping individual users.
  You can manage users more easily by assigning them to groups. If you create groups, you can apply a role to the group, and this role is inherited by all the users in the group.
- **Roles** – A defined collection of privileges.
  Roles are a collection of defined privileges that control individual user or group access to particular VMware Infrastructure objects. ESX Server and VirtualCenter Server provide a set of default roles. You can also create new roles.
- **Privileges** – A particular right corresponding to a set of operations or methods on a class of objects.
- **Permissions** – The combination of the role plus user or group name assigned to a VMware Infrastructure inventory object.
  The role and a user or group name make a pair. This pair is assigned to a VMware Infrastructure object. Typically, this role and user pairing is propagated to the children in the inventory hierarchy. The pair is called a *permission*.

Access Rules

The following is a list of general rules to consider when configuring your user’s and group’s permissions.

Users do not need to log out and log in for changes to take effect. All changes take effect immediately.
Hierarchical Inheritance

Propagation is set per permission rule, not universally applied. Permissions defined for a sub-object always override those propagated from parent objects.

With respect to permissions, there are three types of elements in the hierarchy. They are:

- **Managed entity** – These can have permissions defined on them.
  - Virtual machines
  - Folders
  - Datacenters
  - Clusters
  - Hosts
  - Resource pools
  - Templates

- **Related to a managed entity** – These cannot have permissions defined on them, but inherit access from the object they are related to. Examples include:
  - Networks
  - Datastores

- **Global entity** – These always get their permissions from the root node. Examples include:
  - Custom fields
  - Licenses
  - Statistics intervals
  - Roles
  - Sessions

Multiple Permission Settings

Objects might have multiple permissions, but at most one for each user or group.

If you apply permissions, they override each other down the hierarchy. If permissions are defined on the same entity, a couple of situations are possible:

- **If a user is a member of multiple groups with different permissions.** For each object the group has permissions on, the same permissions apply as if granted to the user directly.
If multiple group permissions are defined on the same object and the user belongs to two or more of those groups:

- If there is no permission defined explicitly for the user on that object, the user is assigned the union of privileges assigned to the groups for that object.
- If there is a permission defined explicitly for the user on that object, that permission takes precedence over all group permissions.

Example 1: Expanding a user’s permissions

- Role 1 can power on virtual machines.
- Role 2 can take snapshots of virtual machines.
- Group A is granted Role 1 on virtual machine.
- Group B is granted Role 2 on virtual machine.

User 1 is not assigned specific permission:

- User 1, who belongs to groups A and B, logs on.
- User 1 can both power on and take snapshots of virtual machine.

Example 2: Limiting a user’s permissions

- Role 1 can power on virtual machines.
- Role 2 can take snapshots of virtual machines.
- Group A is granted Role 1 on virtual machine parent folder.
- Group B is granted Role 2 on virtual machine.

User 1 Read Only permission is removed on virtual machine:

- User 1 can take snapshots but not power on.

Tasks Requiring Settings on Multiple Objects

When setting permissions, verify that all the object types are set with appropriate privileges for each particular action. Some operations require access permission at the root folder in addition to access permissions on the object being manipulated. Some operations require access or performance permission at a parent folder and a related object.

See Appendix A, “Defined Privileges,” on page 331 for a list of predefined roles and associated privileges. Use these predefined roles to help determine the role + object pairing required to perform your chosen task.
Example 3: Adding a virtual machine

- Role 3 can add virtual machines.
- Role 4 is read only.
- Group C is granted Role 3 on Host 1.
- Group C is also granted Role 4 on the parent folder or datacenter for Host 1’s associated datastores and networks.

These objects inherit their permissions from their parent folder or datacenter. Setting both permissions allows Group C users to add a virtual machine to the host.

Example 4: Delegating resources

- Using default roles for Resource Pool Administrator, Virtual Machine User, and Read Only
- Grant User 1 the role of Resource Pool Administrator on ResourcePoolA.
- Grant User 1 the role of Virtual Machine User on all the virtual machines in ResourcePoolA.
- Grant User 1 the role, Read Only on the folder or datacenter containing the datastores and networks associated with ResourcePoolA.

Because resource pools affect multiple inventory objects you must assign various privileges on selected objects to effectively perform tasks (in this case, delegating resources within a resource pool on to the virtual machines in that resource pool).

**Users**

A user is an individual authorized to log in to an ESX Server host or to VirtualCenter. Users on a host fall into two categories: those who can access the ESX Server host through VirtualCenter and those who can access the host by directly logging in to the host from VI Client, VI Web Access, a third-party client, or a command shell. These two categories draw users from different sources:

- **VirtualCenter users** – Authorized users for VirtualCenter are those included in the Windows domain list referenced by VirtualCenter or local Windows users on the VirtualCenter host.

You cannot use VirtualCenter to manually create, remove, or otherwise change users. If you need to manipulate the user list or change user passwords, you must do so through the tools you normally use to manage your Windows domain.
Any changes you make to the Windows domain are reflected in VirtualCenter. Because you cannot directly manage users in VirtualCenter, the user interface doesn't provide a user list for you to review. You see these changes only when you select users to configure permissions.

- **Direct access users** – Users authorized to work directly on an ESX Server host are those added to the internal user list by default when ESX Server is installed or by a system administrator after installation.

  If you log in to an ESX Server host as root using the VI Client, you can perform a variety of management activities for these users, such as changing passwords, group memberships, permissions, and so forth. You can also add and remove users.

Even if the lists maintained by an ESX Server host and VirtualCenter appear to have common users (for instance, a user called devuser), these users should be treated as separate users who have the same name. The attributes of devuser in VirtualCenter, including permissions, passwords, and so forth, are separate from the attributes of devuser on the ESX Server host. If you log in to VirtualCenter as devuser, you might have permission to view and delete files from a datastore. If you log in to an ESX Server host as devuser, you might not.

Users and groups in the VMware Infrastructure environment are created using the following methods:

- When the VI Client is connected to a VirtualCenter Server system, users and groups are defined through the standard methods for Windows domains or Active Directory. You do not create users and groups for access to the VirtualCenter Server through the VI Client.

- When the VI Client is connected to an ESX Server host, users and groups are defined through the Users and Groups tab.

Each ESX Server host has two default users:

- The root user has full administrative privileges. Administrators use this log in and its associated password to log in to a host through the VI Client. Root users have a complete range of control activities on the specific host that they are logged on to, including manipulating permissions, creating groups and users, working with events, and so forth.

### WARNING

See the Authentication and User Management chapter of the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide* for information about root users and your ESX Server before you make any changes to the root user. Mistakes here can have serious access consequences.
- The vpxuser user is a VirtualCenter entity with root rights on the ESX Server host, allowing it to manage activities for that host. The vpxuser is created at the time that an ESX Server host is attached to VirtualCenter. It is not present on the ESX Server host unless the host is being managed through VirtualCenter.

**CAUTION** Do not change vpxuser and do not change its permissions. If you do so, you might experience problems working with the ESX Server host through VirtualCenter.

For information on creating users and groups for use with VirtualCenter Server, see Microsoft documentation.

For information on creating users and group for use with ESX Server, see the Security section of the *ESX Server 3 Configuration Guide* or *ESX Server 3i Configuration Guide*.

### Groups

You can efficiently manage some user attributes by creating groups. A group is a set of users that you want to manage through a common set of rules and permissions. When you assign permissions to a group, they are inherited by all users in the group. Using groups can significantly reduce the time it takes to set up your permissions model.

The group lists in VirtualCenter and an ESX Server host are drawn from the same sources as the user lists. If you are working through VirtualCenter, the group list is called from the Windows domain. If you are logged on to an ESX Server host directly, the group list is called from a table maintained by the host.

The VirtualCenter Server grants access to each inventory object by assigning a role with defined privileges and a user or group to each object. Roles are a defined set of access privileges.

Individual permissions are assigned through the VirtualCenter Server or the ESX Server host by pairing a user and a role and assigning this pair to an inventory object.

### Permissions

In VMware Infrastructure, a permission is defined as an access role that consists of a user and the user’s assigned role for an object, such as a virtual machine or ESX Server host. Permissions grant users the right to perform specific activities and manage specific objects on a specific host or, if users are working from VirtualCenter, all VirtualCenter-managed objects. For example, to configure memory for an ESX Server host, you must have host configuration permissions.
Most users have limited ability to manipulate the objects associated with the host. However, ESX Server provide full access rights and permissions on all virtual objects, such as datastores, hosts, virtual machines, and resource pools, to two users: root and vpxuser.

As root, you can grant permissions on a host to individual users or groups. Through VirtualCenter, you can grant permissions to any user or group included in the Windows domain list referenced by VirtualCenter.

**NOTE** By default, all users who are members of the Windows Administrators group on the VirtualCenter Server are granted the same access rights as any user assigned to the Administrator role. Users who are members of the Administrators group can log in as individuals and have full access.

The method you use to configure permissions directly on a host is identical to the method you use to configure permissions in VirtualCenter. The list of privileges is the same for ESX Server and VirtualCenter.

**NOTE** When you connect directly to an ESX Server host using the VI Client, you cannot set virtual machine-only permissions. To set permissions on individual virtual machines, connect to the host through VirtualCenter Server.

The table in Appendix A lists the access permissions.

### Roles

VirtualCenter and ESX Server grant access to objects only to users who have been assigned permissions for the object. When you assign a user or group permissions for the object, you do so by pairing the user or group with a role. A role is a predefined set of privileges.

VirtualCenter and ESX Server hosts provide default roles:

- **System roles** – System roles are permanent and the privileges associated with these roles cannot be changed.
- **Sample roles** – Sample roles are provided for convenience as guidelines and suggestions. These roles can be modified or removed.

You can also create completely new roles. Table 17-1 lists the default roles that can be paired with a user and assigned to an object.
### Table 17-1. Default Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Role Type</th>
<th>Description User Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Access User</td>
<td>system</td>
<td>Cannot view or change the assigned object. VI Client tabs associated with an object display without content. This is the default role for all users except those users in the Administrators group.</td>
</tr>
<tr>
<td>Read Only User</td>
<td>system</td>
<td>View the state and details about the object. View all the tab panels in the VI Client except the console tab. Cannot perform any actions through the menus and toolbars.</td>
</tr>
<tr>
<td>Administrator</td>
<td>system</td>
<td>All privileges for all objects. Add, remove, and set access rights and privileges for all the VirtualCenter users and all the virtual objects in the VMware Infrastructure environment. This is the default role for all members of the Administrators group.</td>
</tr>
<tr>
<td>Virtual Machine</td>
<td>sample</td>
<td>Perform actions on virtual machines only. Interact with virtual machines, but not change the virtual machine configuration. This includes:</td>
</tr>
<tr>
<td>User</td>
<td></td>
<td>▪ All privileges for the scheduled tasks privileges group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Selected privileges for the global items and virtual machine privileges groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ No privileges for the folder, datacenter, datastore, network, host, resource, alarms, sessions, performance, and permissions privileges groups.</td>
</tr>
<tr>
<td>Virtual Machine</td>
<td>sample</td>
<td>Perform actions on the virtual machine and resource objects. Interact and change most virtual machine configuration settings, take snapshots, and schedule tasks. This includes:</td>
</tr>
<tr>
<td>Power User</td>
<td></td>
<td>▪ All privileges for scheduled task privileges group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Selected privileges for global items, datastore, and virtual machine privileges groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ No privileges for folder, datacenter, network, host, resource, alarms, sessions, performance, and permissions privileges groups.</td>
</tr>
</tbody>
</table>
All roles permit the user to schedule tasks by default. Users can schedule only tasks they have permission to perform at the time the tasks are created. Use the role-editing facilities in the VI Client to create privilege sets that match your user needs. If you use the VI Client connected to VirtualCenter to manage your hosts, you have additional roles to choose from VirtualCenter. The roles you create directly on an ESX Server host are not accessible within VirtualCenter. You can work with these roles only if you log in to the host directly from the VI Client.

Activities you can perform with roles are described in the following sections:

- “Creating Roles” on page 275
- “Cloning Roles” on page 276
- “Editing Roles” on page 277
“Removing Roles” on page 277
“Renaming Roles” on page 278

NOTE Changes to permissions and roles are implemented immediately, even if the users involved are logged on.

Creating Roles

Some of the default roles are preconfigured and cannot be changed. If you have situations that require a different combination of access privileges, create an additional role or modify the provided sample roles to suit your needs.

To create a role

1. Log in to the VI Client connected to either a VirtualCenter Server or an ESX Server host as a user with Administrator privileges.

2. From the VI Client, click the Admin button in the navigation bar. Click the Roles tab.

3. Right-click in the Roles tab information panel. Choose Add.

   The Add Role dialog box appears.
4 Type a name for the new role.
5 Select the privileges you want the new role to have. Click the plus (+) signs to expand the lists, as needed. Click OK to complete the process.

Cloning Roles

You can make a copy of an existing role, rename it, and later edit it. When you make a copy, the new role is not automatically applied to the same user or groups and objects.

To clone a role
1 From the VI Client, click the Admin button in the navigation bar. Click the Roles tab.
2 To select the role to duplicate, click the object in the list of Roles.
3 To clone the selected role, choose Administration > Role > Clone.
   A duplicate of the role is added to the list of roles. The name is Copy of <rolename>. 
Editing Roles

When you edit a role, you have the option to change any or all of the privileges selected for that role. When completed, these new privileges are applied to any user or group assigned the edited role.

To edit a permissions role

1. From the VI Client, click the Admin button in the navigation bar. Click the Roles tab.
2. To select the role to edit, click the object in the list of Roles.
3. Choose Administration > Role > Edit Role.
4. Select the privileges you want the new role to have. Click the plus (+) signs to expand the lists, as needed.
5. Click OK to complete the process.

Removing Roles

When you remove a role, if it is not assigned to any users or groups, the definition is removed from the list of possible roles. When you remove a role that is assigned to a user or group you can remove all assignments or replace them with an assignment to another role.

CAUTION Be sure that you understand how users will be affected before removing all assignments or replacing them.

To remove an existing role

1. From the VI Client, click the Admin button in the navigation bar. Click the Roles tab.
2. To select the role to remove, click the object in the list of roles.
   
   You can select multiple roles using the Ctrl or Shift keys.
3. Choose Administration > Role > Remove.
4 To confirm that you want to delete the selected role, click OK. The role is removed from the list and is no longer available for assigning to users or groups.

If the role is assigned to a user or group, a warning message appears.

5 Select one of the radio button options and click OK. The options are:

- **Remove Role Assignments** — This option removes any configured user or group + role pairings on the server. If a user or group does not have any other permissions assigned, they lose all privileges.

- **Reassign affected users to** — This option reassigns any configured user or group + role pairings to the selected new role.

### Renaming Roles

Roles, like most other VMware Infrastructure objects, can be renamed.

**To rename an existing role**

1 From the VI Client, click the Admin button in the navigation bar. Click the Roles tab.
2 To select the role to rename, click the object in the list of roles.
3 Choose Administration > Role > Rename.
4 Type the new name. Press Enter or click another object.

### Access Permissions

For each object in the VMware Infrastructure hierarchy, determine the permissions for each VirtualCenter user and group.

**NOTE** Several users can access the VirtualCenter Server from different VMware Infrastructure Client sessions at the same time. VMware Infrastructure does not explicitly restrict users with the same authentication credentials from accessing and taking action within the VMware Infrastructure environment.

If you remove users from an ESX Server host, see the Security chapter in the ESX Server 3 Configuration Guide or ESX Server 3i Configuration Guide for process and consequences.
If you remove users from the VirtualCenter domain, they lose permissions to all objects in the VMware Infrastructure and will not be able to log in again. Users who are currently logged on and are removed from the domain retain their VMware Infrastructure permissions only until the next validation period (the default is every 24 hours). Removing a group does not affect the permissions granted individually to the users in that group, or those granted as part of inclusion in another group.

If you change a user’s name in the domain, the existing user name becomes invalid in the VMware Infrastructure system. The same methodology applies to groups, but this applies to a group only after VirtualCenter Server has been restarted.

### Assigning Access Permissions

After any additional roles are defined and users and groups are created, you must assign the users and groups their roles, with associated permissions, to the relevant inventory objects.

#### To assign a user or group permission

1. Log in to the VI Client as a user with the Administrator privileges.
2. From the VI Client, click the **Inventory** button in the navigation bar. Expand the inventory as needed, and click the appropriate object.
   - The objects that can have permissions assigned to them are:
     - **In VirtualCenter** – Folders, datacenters, clusters, resource pools, hosts
     - **In ESX Server** – Resource pools, the host, virtual machines
3. With the appropriate object selected, click the **Permissions** tab.
4 Right-click in the Permissions tab and choose Add Permission.

5 Choose a role from the Assigned Role drop-down menu.

This menu displays all the roles that have been assigned to that host. When the role is displayed, the privileges granted on the role are listed in the section below the role title for reference purposes.

6 (Optional) Select the Propagate to Child Objects check box.

If this check box is selected, the role is also applied to all child objects of the selected inventory object. Most of the time selecting this box is appropriate.
7 Click the **Add** button to open the **Select Users or Groups** dialog box.

![Select Users or Groups dialog box]

See “**Adjusting the Search List in Large Domains**” on page 282 for information on adjusting the list of users and groups you select from.

8 Identify the user or group that is being assigned this role:

   a Choose the domain where the user or group is located from the **Domain** drop-down menu.

   b Type a name in the Search box or select a name from the **Name** list.

   c Click **Add**.

   The name is added to either the **Users** or **Groups** list.

   d Repeat step a through Step c to add additional users or groups.

   e Click **OK** when finished.

   If you know the user or group name, you can type it in the **Name** field manually.

9 Verify the users and groups are assigned to the appropriate permissions, and click **OK**.

10 To finish the task, click **OK**.

   The server adds the permission to the list of permissions for the object.

   The list of permissions references all users and groups that have roles assigned to the object, and indicates where in the VirtualCenter hierarchy the role is assigned.
Adjusting the Search List in Large Domains

If you have domains with thousands of users or groups in them, adjust the search settings for use in the Select Users or Groups dialog box.

**NOTE** This procedure applies only to VirtualCenter user lists. ESX Server user lists cannot be searched in the same way.

**To adjust users and groups search parameters**

1. From the VI Client connected to a VirtualCenter Server, choose Administration > VirtualCenter Management Server Configuration.

   The VirtualCenter Configuration wizard appears.

2. When the wizard is displayed, click the Active Directory list item.

3. Change the values as needed:
   - **Active Directory Timeout** – Specifies in seconds the maximum amount of time VirtualCenter allows the search to run on the selected domain. Searching very large domains can take a very long time.
   - **Enable Query Limit and Users & Groups value** – Specifies the maximum number of users and groups VirtualCenter displays from the selected domain in the Select Users or Groups dialog box. To specify no maximum limit, deselect the check box.
   - **Enable Validation and Validation Period** – Specifies the time in minutes between permissions checks. VirtualCenter verifies that all users and groups known to VirtualCenter currently exist in Windows.

   For example, if user Smith was assigned permissions and in the domain the user’s name was changed to Smith2, VirtualCenter concludes that Smith no longer exists and removes permissions for that user.

   Similarly, if user Smith is removed from the domain, all permissions are irrelevant. That is until a new user Smith is added to the domain. The new user Smith receives all the permissions the old user Smith was assigned, unless you use this option to delete old user Smith from the system.

   To deactivate the validation functions, deselect the check box.

   **NOTE** Permissions are always validated when the server starts. Even if the server is disabled.

4. Click **OK**.
Changing Access Permissions

After a user or group + role pair is set for an inventory object, the only change you can make is to the role paired with the user or group and the Propagate check box. You do have the option to remove the permission setting. See “Removing Access Permissions” on page 284 for information.

**To change the permission role for a user or group**

1. From the VI Client, click the **Inventory** button in the navigation bar. Expand the inventory as needed, and click the appropriate object.
2. With the object selected, click the **Permissions** tab.
3. To select the user or group + role pair that you want to change, click the appropriate line item.
4. Choose **Inventory > Permissions > Properties**.
5. To select the appropriate role for the user or group, choose from the drop-down menu. Click OK.

![Change Access Rule](image)

6. To propagate the privileges to the children of the assigned inventory object, click the **Propagate** check box.
Removing Access Permissions

Removing a permission for a user or group does not remove the user or group from the list of those available. It also does not remove the role from the list of available items. It removes the user or group + role pair from the selected inventory object.

To remove a permission role for a user or group

1. From the VI Client, click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate object.
2. With the object selected, click the Permissions tab.
3. To select the user or group + role pair that you want to delete, click the appropriate line item.
4. Choose Inventory > Permissions > Delete.
   The VMware Infrastructure server removes the permission setting.

   **NOTE**  There is no additional warning that the permission is going to be removed.
This chapter describes how to set up performance statistics for hosts, clusters, resource pools, and virtual machines. It also provides information on customizing and viewing performance charts and resource maps.

This chapter contains the following topics:

- “Statistics Collection” on page 285
- “Performance Charts” on page 293
- “Resource Maps” on page 297

### Statistics Collection

You can collect performance statistics for all hosts, clusters, virtual machines, resource pools, and in your environment. This includes statistical data on CPUs, disks, networks, and the like. VirtualCenter uses statistic counters to query each entity and writes the data to the VirtualCenter database. To ensure performance is not impaired when collecting and writing the data to the database, VirtualCenter performs cyclical queries rather than performing one single query. It also uses collection levels to determine how many statistic counters to use while querying for data. Combined, collection intervals and collection levels enable you to control how statistics are collected across your environment.
About Collection Intervals and Collection Levels

By default, VirtualCenter has four collection intervals: **Day, Week, Month, and Year**. Each interval specifies a length of a time during which statistics are collected at a certain frequency. For example, the **Day** interval sets statistics to be collected every 5 minutes during a 1 day period, as shown in Figure 18-1, "Example: Daily Statistics Collection," on page 286.

**Figure 18-1. Example: Daily Statistics Collection**

![Clock diagram showing collection intervals]

Table 18-1 below lists the default interval duration and collection frequency value for each interval.

**Table 18-1. Interval Duration and Collection Frequency: Defaults**

<table>
<thead>
<tr>
<th>Collection Interval</th>
<th>Interval Duration</th>
<th>Collection Frequency</th>
<th>Configurable Attributes — Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>1 Day</td>
<td>5 Minutes</td>
<td>Interval Length (Days) — 1-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Collection Frequency (Minutes) — 1, 2, 3, 5</td>
</tr>
<tr>
<td>Week</td>
<td>1 Week</td>
<td>30 Minutes</td>
<td>None</td>
</tr>
<tr>
<td>Month</td>
<td>1 Month</td>
<td>2 Hours</td>
<td>None</td>
</tr>
<tr>
<td>Year</td>
<td>1 Year</td>
<td>1 Days</td>
<td>Interval Length (Years) — 1-3 (SEE UPDATE)</td>
</tr>
</tbody>
</table>

(SEE UPDATE)
Each collection interval also has a default *collection level* that determines how many counters are used when collecting statistics data. Counters establish which metrics are retrieved and recorded in the database. You can assign a collection level of 1-4 to each collection interval, with level 4 having the largest number of counters. By default, all collection intervals use collection level 1.

**NOTE** The collection level for an interval can not be greater than the collection level set for the preceding collection interval. For example, if the *Month* interval is set to collection level 3, the *Year* interval can be set to collection level 1, 2, or 3, but not to collection level 4.

**NOTE** The collection level value for a collection interval must be less than or equal to the collection level set for the proceeding collection interval. This is a VirtualCenter dependency.

**Table 18-2. Statistic Collection Levels**

<table>
<thead>
<tr>
<th>Collection Level</th>
<th>Metrics</th>
<th>Best Practice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1</td>
<td>Basic metrics:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Average usage for CPU, memory, disk, and network counters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ System uptime and heartbeat</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ DRS metrics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use for long-term performance monitoring when device statistics are not required.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Level 1 is the default Collection Level for all Collection Intervals.</td>
<td></td>
</tr>
<tr>
<td>Level 2</td>
<td>All metrics for:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ CPU, memory, disk, and network counters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Average, summation, and latest rollup types (does not include maximum and minimum rollup types)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ System uptime and heartbeat</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ DRS metrics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use for long-term performance monitoring when device statistics are not required but you want to monitor more than the basic statistics.</td>
<td></td>
</tr>
</tbody>
</table>
Table 18-2. Statistic Collection Levels (Continued)

<table>
<thead>
<tr>
<th>Collection Level</th>
<th>Metrics</th>
<th>Best Practice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 3</td>
<td>All metrics for all counter groups, excluding those for maximum and minimum rollup types.</td>
<td>Use for short-term performance monitoring after encountering problems or when device statistics are required. Due to the large quantity of troubleshooting data retrieved and recorded, use level 3 for the shortest time period possible—the Day or Week collection interval.</td>
</tr>
<tr>
<td>Level 4</td>
<td>All metrics for all counter groups supported by VirtualCenter.</td>
<td>Use for short-term performance monitoring after encountering problems or when device statistics are required. Due to the large quantity of troubleshooting data retrieved and recorded, use level 4 for the shortest amount of time possible.</td>
</tr>
</tbody>
</table>

Collection Level Scenarios

For most purposes, setting the collection level to 1 or 2 is adequate for all collection intervals. Reasons to use collection level 2:

- To identify virtual machines that can be co-located because of complimentary memory sharing.
- To detect the amount of active memory on a host to determine whether it can handle additional virtual machines.

Reasons to use collection level 3:

- To compare ready and wait times of virtual CPUs to determine the effectiveness of VSMP.
- To diagnose problems with devices, or compare performance among multiple devices.

Reasons to use collection level 4:

- To determine whether a device is being saturated.
- To troubleshoot errors.
Using Collection Levels Effectively

- To retrieve more detailed metrics for a short period of time, view a real-time data chart rather than increase the collection level. Viewing real-time data has less impact on performance because metrics are retrieved directly from the source without being written to the VirtualCenter database. For more information on data charts, see “Performance Charts” on page 293.

- When you use collection level 3 or 4 to diagnose problems, reset the collection level to its previous state as soon as possible.

- When you use collection level 4, try to limit the collection period to the Day interval so the database isn’t impacted. If you need to save the data for longer than 1 day, increase the Day interval duration to 2 or 3 rather than use the Week interval. For example, if you need to record data over the weekend, set the interval to 3 days. As a rule, increase the collection interval to the Week interval only when you need the interval duration to be more than 3 days.

How statistical data is stored in the database

The statistical data for each collection interval is stored in its own database table. At the end of an interval, one of two things can occur:

- If the next interval is disabled, the data in the table that is older than the interval duration is purged.

- If the next interval is enabled, the data is aggregated into groups and is rolled up to the database table of the subsequent collection interval. For example, say the Day interval has a 5 minute collection frequency and the Week interval has a 30 minute collection frequency. When the Day interval completes, it aggregates the 5 minute queries into groups of 6 (equalling 30 minutes) and rolls the 30 minute data block to the Week interval database table. The day-old data is then purged from the database to make room for new queries. Figure 18-1, “Example: Daily Statistics Collection,” on page 286 shows the default rollup process.
You control how long statistical data is stored in the database by enabling or disabling a collection interval. When you disable a collection interval, all subsequent intervals are automatically disabled. For example, when you disable the Week interval, the Month and Year intervals are also disabled. Data is purged at the end of the Day interval cycle since no rollups can occur. Oldest data is purged first.

**NOTE** You must manually enable each collection interval to use it again; subsequent collection intervals are not enabled automatically. Also, you can only enable a collection interval if all previous collection intervals are enabled. For example, to enable the Month interval, the Day and Week intervals must be enabled.

**(SEE UPDATE)** By default, statistics are stored in the VirtualCenter database for 1 year; however, you can increase this to 3 years. VMware suggests you archive your statistical data outside of the VirtualCenter database to save it for longer than 3 years.
Configuring Statistics Collection Intervals

By default, all collection intervals are enabled and query for statistics at collection level 2. You can change the default implementation by:

- Changing the interval length or collection frequency.
- Changing the collection level.
- Enabling or disabling a collection interval.

To ensure your database can handle the statistics collection you configure, VI Client provides you with a database estimation calculator in which you enter the number of hosts and virtual machines in your inventory. The calculator uses these numbers to determine how much database space is required for the collection interval configuration you defined. This ensures you have necessary resources.

For information on how to use the database estimation calculator, see “To estimate the statistics impact on the database” on page 293.

To configure collection intervals

1. In VI Client, choose Administration > VirtualCenter Management Server Configuration to open the VirtualCenter Management Server Configuration dialog box.

2. Select Statistics in the navigation panel.

3. If necessary, select the collection interval check box to enable or disable it.
4 Select the row containing the collection interval.

5 Click Edit. The Edit Collection Interval dialog box opens.

6 Change the following attribute values where appropriate:
   ■ Collection Frequency
   ■ Keep samples for
   ■ Collection Level

   **NOTE** To keep data samples for more than 3 years, archive it outside of the VirtualCenter database.

   For a list of collection interval attributes that are configurable, See Table 18-2, “Statistic Collection Levels,” on page 287.

   For a description of collection frequency and duration, see “About Collection Intervals and Collection Levels” on page 286.

7 Click OK.

8 Repeat Step 3-Step 7 for each collection interval to change.

9 Validate the new configuration by using the database estimation calculator.
   ■ Enter the number of Physical Hosts in your inventory.
   ■ Enter the number of Virtual Machines in your inventory.

**To enable or disable a collection interval**

1 In the VirtualCenter Management Server Configuration dialog box, select Statistics.

2 Do one of the following:
   ■ To enable a collection interval, select its check box under Interval Duration.
   ■ To disable a collection interval, deselect its check box under Interval Duration.

   **NOTE** When you disable a collection interval, all subsequent intervals are automatically disabled.

3 (Optional) Validate the change by using the database estimation calculator.
   ■ Enter the number of Physical Hosts in your inventory.
   ■ Enter the number of Virtual Machines in your inventory.
To estimate the statistics impact on the database

1. Configure your collection intervals. See “To configure collection intervals.”
2. Enter the number of Physical Hosts in your inventory.
3. Enter the number of Virtual Machines in your inventory.

Performance Charts

Performance charts display performance data for a variety of metrics. Performance charts are accessible through the Performance tab, which is available for hosts, clusters, resource pools, and virtual machines. Performance data is specific to the type of object. For example, virtual machine performance metrics are different from cluster performance metrics.

Charts can display real-time data (20 second intervals for ESX Server 3.x hosts; 60 second intervals for ESX Server 2.x hosts) or historical data. The amount of historical data collected depends on the following settings:

- Statistics Collection Intervals
- Statistics Collection Levels

For more information on these settings, see “Configuring Statistics Collection Intervals” on page 291.

Real-time data can be viewed through a VI Client connected to either a VirtualCenter server or directly to an ESX Server host. Historical data, however, can be viewed only through a VI Client connected to VirtualCenter. All performance data is available to external programs through the VMware Infrastructure SDK.

NOTE   Full chart functionality is available to VI Client sessions only when they are connected to, and when the monitored items are managed by, VirtualCenter. VI Clients connected directly to ESX Server hosts only display real-time statistics and 5 minute statistics for 1 day.

Viewing Charts

Several chart views are preconfigured for you. A chart view is a collection of settings that define what data the chart displays. Settings for preconfigured views can be customized, or entirely new views can be created. Charts display data as line graphs or stacked graphs. Stacked graphs are limited to displaying data on a single metric, but can plot the data on that metric for multiple inventory objects.
To view performance charts

1. Select a host, cluster, resource pool, or virtual machine in the inventory panel.
2. Select the Performance tab.

**Figure 18-3.** VI Client displaying Performance tab for virtual machine.

3. Select an option from the Switch to menu to view a different chart. Preconfigured charts include the following:
   - **CPU** – Shows the CPU usage in MHz of the selected inventory object. Available for cluster, resource pool, host, and virtual machine.
   - **Memory** – Shows the amount of memory granted to the selected inventory object. Available for cluster, resource pool, host, and virtual machine.
   - **Disk** – Shows the aggregated storage performance statistics of the selected inventory object. Available for host and virtual machine.
   - **Network** – Shows the aggregated network performance statistics of the selected inventory object. Available for host and virtual machine.
   - **System** – Available for host and virtual machine.
   - **Cluster Services** – Available for DRS/HA clusters and hosts that are part of DRS clusters.
Chapter 18 Setting Up and Monitoring Performance Statistics and Resource Maps

Saving Chart Data to a File

You can save chart data to a file in various graphics formats or in Microsoft Excel format.

To save chart data to a file
1. In the Performance tab, click the export icon ( ) to open a file browser.
2. Select the location where you want to store the file.
3. Enter a name for the file.
4. Select a file type (JPEG, PNG, GIF, Bitmap, Microsoft Office Excel Workbook).
5. Click Save.

You can also export performance data for a selected inventory item to a Microsoft Office Excel file through the Export Performance dialog box. To access that dialog box, select Report > Performance from the File menu, or select Report Performance from the inventory item’s right-click menu.

Customizing Chart Views

You can customize preconfigured views, or create entirely new views. New views are added to the Switch to menu. Changes to chart options take effect immediately.
To customize charts

1. In the Performance tab, click Change Chart Options. The Customize Performance Chart dialog box is displayed.

   Figure 18-4. Customize Performance Chart dialog box.

2. In the Chart Options area, select a metric and a time range to access the settings for that chart, or select Custom to create an entirely new chart with a time range you specify.

3. Adjust the settings to your liking and click Apply. See the performance chart measurement tables in Appendix C for detailed information about setting options.

   NOTE  Consider the following when creating a stacked-graph chart:

   - Any number of items in the Objects area can be selected. However, only one item in the Counter area can be selected. A stacked graph can not chart more than one measurement over a set of objects.

   - Per virtual machine stacked graphs are available only for hosts. The host and all virtual machines on it are available for selection in the Objects area.

   - Some metrics are not applicable to virtual machine stacked charts. These metrics are not included in the list of selectable measurements.
To save your settings as a new chart view
1. In the Customize Performance Chart dialog box, click Save Chart Settings. The Save Selection dialog box is displayed.
2. Select a chart and click OK. Your settings are saved and added to the Switch to menu, and the Save Selection dialog box is closed.

To delete chart views
1. In the Customize Performance Chart dialog box, click Manage Charts. A dialog box is displayed.
2. Select a chart and click Delete. The chart is deleted and it is removed from Switch to menu.
3. Click OK to close the dialog box and return to the Customize Performance Chart dialog box.

Resource Maps
In VirtualCenter, a map is a visual representation of your datacenter's topology. Maps provide a visual representation of the relationships between the virtual and physical resources available in VirtualCenter. The following preconfigured map views are available:

- **Virtual Machine Resources** – Displays virtual machine-centric relationships.
- **Host Resources** — Displays host-centric physical relationships.
- **VMotion Resource** — Displays potential hosts for VMotion migration. See About VMotion Resource Maps.

A map view limits or expands the scope of a map, as does the location where you are viewing the map. When accessing map views from the Maps button in the navigation bar, all VirtualCenter resources are available for display. When accessing map views from the Maps tab of a selected inventory item, only items relevant to that item are available for display. The only map view available through the Maps tab for virtual machine inventory items is the VMotion Resources view. All map views, except VMotion Resources maps, can be customized.

Viewing maps can help you determine such things as which clusters or hosts are most densely populated, which networks are most critical, and which storage devices are being utilized.

**NOTE** Maps are available only when the VI Client is connected to a VirtualCenter Server.
About VMotion Resource Maps

VMotion Resource maps, like other maps, provide a visual representation of the resources (hosts, datastores, and networks) associated with the selected virtual machine. In addition to this basic information, these maps also indicate the hosts in the virtual machine’s cluster or datacenter which are potential migration targets. That is, the map indicates which hosts are compatible with the selected virtual machine such that VMotion could potentially migrate the virtual machine to one of the compatible hosts. Hosts marked as VMotion compatible must meet the following criteria:

- **Datastore compatibility** – Host must be connected to all the same datastores as the virtual machine.
- **Network compatibility** – Host must be connected to all the same networks as the virtual machine.
- **Software compatibility** – Host must have compatible software with the virtual machine.
- **CPU compatibility** – Host CPU must be compatible with the virtual machine.

**NOTE** The VMotion map is not a conclusive statement as to whether VMotion is possible between the virtual machine and hosts identified as possible migration targets. However, it does provide information as to whether VMotion might be possible, and if not, what an administrator might do to remedy the situation.

Map Elements and Icons

The following table describes map elements and icons are described in the following table.

**Table 18-3. Map Elements and Icons**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Host icon" /></td>
<td>Host icon.</td>
</tr>
<tr>
<td><img src="image" alt="Compatible host icon" /></td>
<td>A host that is compatible for VMotion migration. The color of the circle varies in intensity based on the load of the current host. Heavily used hosts are pale; low-load hosts are saturated green.</td>
</tr>
<tr>
<td><img src="image" alt="Not compatible host icon" /></td>
<td>A host that is not compatible for VMotion migration.</td>
</tr>
</tbody>
</table>
Table 18-3. Map Elements and Icons (Continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Virtual machine icon]</td>
<td>Virtual machine icon.</td>
</tr>
<tr>
<td>![Network icon]</td>
<td>Network icon.</td>
</tr>
<tr>
<td>![Datastore icon]</td>
<td>Datastore icon.</td>
</tr>
<tr>
<td>Overview section</td>
<td>Thumbnail graphic of the full-scale map.</td>
</tr>
<tr>
<td>Map Relationships section</td>
<td>Displayed when more than one map view is available.</td>
</tr>
<tr>
<td>Refresh link</td>
<td>Maps do not auto-refresh. Click Refresh to synchronize your map with the current state of the inventory and to center the map view.</td>
</tr>
</tbody>
</table>

Viewing Maps

Global maps – maps where all VirtualCenter objects are available for display – are accessible through the Maps button in the navigation bar.

Maps for specific inventory objects are available through the Maps tab for those objects. To access an inventory object’s Maps tab, select either the Hosts and Clusters or the Virtual Machines and Templates option from the Inventory button in the navigation bar, then select an inventory item.

You can customize a map view by selecting or deselecting objects in the inventory pane (global maps), or by selecting or deselecting options in the Map Relationships area.

You can reposition the map by dragging it (click anywhere on the map, hold, drag). A grey box in the overview area represents the section of the total map that is viewable and moves as you drag the map. You can resize the grey box to zoom in or out of a section of the map.

You can double-click any object in a map to switch to the Map tab for that item (providing a Map tab is available for that type of object). You can right-click on any object in a map to access its right-click menu.
**Printing Maps**

You can print maps by selecting File > Print Maps > Print, or by clicking the Print button (global maps).

**Exporting Maps**

You can export maps to image files (BPM, JPEG, or EMF) by selecting File > Export > Export Maps, or by clicking the Export button (global maps).
Managing Tasks, Events, and Alarms

This chapter contains the following topics:

- “Managing Tasks” on page 301
- “Managing Events” on page 311
- “Managing Alarms” on page 316

Managing Tasks

This section describes how to view and schedule VirtualCenter tasks. Tasks are planned activities. These activities are scheduled or initiated manually. Tasks generate event messages that indicate any issues associated with the task. There are two kinds of tasks:

- An unscheduled task, which can result from performing an operation that might take a while, like adding a host.
- A scheduled task, which you set up to initiate at a future time.

NOTE The views and capabilities displayed vary depending on whether the VI Client is connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, task, or description applies to both kinds of VI Client connections. The Tasks option is not available when the VI Client is connected to an ESX Server, but it does offer the recent tasks window at the bottom of the VI Client window.
This section contains the following sections:

- “Understanding Tasks” on page 302
- “Viewing and Performing Tasks” on page 303
- “Managing Scheduled Tasks” on page 305
- “Rescheduling a Scheduled Task” on page 308
- “Removing a Scheduled Task” on page 308
- “Canceling a Task” on page 309

**Understanding Tasks**

The scheduled tasks option allows you to configure selected VirtualCenter activities to occur at designated times. The timing options include immediately, later, or on a recurring basis. Scheduled tasks are performed in addition to manually driven activities.

Create a scheduled task through the New Task wizard, which displays the available task options. After you select an option, the wizard displays the pages that are relevant to the type of task you are scheduling. The New Task wizard ends when you set the timing of the task. After you create a task, you can reschedule the task to change its timing and frequency.

If the directions of manually driven and scheduled activities conflict, VirtualCenter performs whichever activity is due first. If a virtual machine is in an incorrect state to perform any activity, manual or scheduled, VirtualCenter sends a message to the log and does not perform the task.

When you create a scheduled task, VirtualCenter verifies that you have the correct permissions to perform the actions on the relevant datacenters, hosts, and virtual machines. After the task is created, the task is performed even if you no longer have permission to perform the task.

When an object is removed from VirtualCenter, all associated tasks are also removed.

Events are logged to the event log at start and completion of the tasks. Any errors that occur during the task are also recorded in the event log.

**CAUTION** Do not schedule multiple tasks to be performed at the same time on the same object. The results are unpredictable.
Viewing and Performing Tasks

You have the option to view the list of tasks associated with particular inventory objects or the complete list of tasks assigned to the entire VirtualCenter inventory. Tasks include activities such as powering on or off a virtual machine, cloning a virtual machine, or adding a virtual machine to a resource pool.

Tasks are not tracked or scheduled on your ESX Server host unless the ESX Server is registered and connected to a VirtualCenter Server.

To view recent tasks

From the VI Client connected to an ESX Server or a VirtualCenter Server, click the Tasks toggle button on the lower left side of the VI Client window.

To perform a task on an ESX Server

1. From the VI Client connected to an ESX Server, click the Inventory button in the navigation bar. Expand the inventory as needed, and click the object where the action is to be performed.

2. Choose the activity from the main or pop-up menu associated with the object.

   For example, select a virtual machine, right-click, and choose the Power On option.

To schedule or view a list of tasks on an ESX Server

Add the host to the VirtualCenter inventory.

See “Adding a Host” on page 129 for more information.

To schedule a task on a VirtualCenter Server, see “Managing Scheduled Tasks” on page 305.
To view a list of tasks completed on a VirtualCenter Server

1. From the VI Client, click the Inventory, and click the root folder.
2. Click the Task & Events tab. Click the Tasks button on the Tasks & Events panel.
3. Click a task in the panel.

Detailed information appears in the Task Details pane.

To sort the list of tasks

1. From the VI Client, display the inventory panel, select the appropriate object and view the Tasks & Events panel.
2. Click the column title. It toggles between ascending and descending sort.

To filter the list of tasks

1. From the VI Client, expand the inventory as needed, and click the appropriate object.
2. Click the Task & Events tab. Click the Tasks button on the Tasks & Events panel.
3. Choose View > Filtering, if needed.
Managing Scheduled Tasks

You can schedule tasks to occur at designated times. Each schedule task option runs the corresponding wizard for the task and adds a scheduling time option at the end of the wizard. The possible tasks that can be scheduled through the New Task wizard are listed below. See the listed document for information on completing the individual task wizards:

- Change the power state of a virtual machine (see “Changing Virtual Machine Power States” on page 169)
- Create a virtual machine template (see “Creating Templates” on page 204)
- Move a virtual machine with VMotion (see “Migration with VMotion” on page 233)
- Create a virtual machine (see “Using the New Virtual Machine Wizard” on page 144)
Basic System Administration

- Take a snapshot of a virtual machine (see “Understanding Snapshots” on page 253)
- Customize a virtual machine (see “Preparing for Guest Customization” on page 216)
- Add a host (see “Adding a Host” on page 129)

**NOTE** Any operation can be set as a scheduled task through the VMware Infrastructure API. However, only a subset of all operations can be part of a scheduled task through the VI Client.

**To create a scheduled task**

1. From the VI Client connected to a VirtualCenter Server, click the Scheduled Tasks option in the navigation bar.
   The current list of scheduled tasks appears.
2. Click New in the toolbar, or choose File > New > Scheduled Task.
3. Select the task you want to schedule from the drop down menu. Click OK.

4. Complete the task-specific information.
   The New Task wizard displays a series of pages that correspond to the pages you see when you perform the task starting from the selected object.
   See the section or the manual that is appropriate for each option for specific information on each task. Most of the scheduling processes differ from manually performed tasks only in that you must specify the virtual machine, host, or datacenter to which the task applies and specify the time to perform the task.
5. Select the frequency of the scheduled task, and compete the scheduling according to the option described in Table 19-1.
   The time when a scheduled task occurs is relative to the VirtualCenter Server and not to the local VI Client from which you configure the task.

**NOTE** Only one timing schedule can be set per task. To set more than one frequency type, set up additional tasks.
Table 19-1. Scheduled Task Frequency Options

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Procedure to Set</th>
</tr>
</thead>
</table>
| Once      | To run the scheduled task immediately after creation, select **Now**, and click **Next**. To run the scheduled task at a later date and time, do the following:  
  1. Select **Later**.  
  2. Type a clock time in the **Time** field.  
  3. Click the **Date** arrow to display a calendar. Select a date by clicking it on the calendar. Click the left and right arrows to view additional months. Select the month and choose from the list. Select the year by clicking the up and down arrows.  
  4. Click **Next**. |
| After Startup | Enter the amount of delay, and click **Next**. |
| Hourly | Enter the start time after the beginning of the hour and the interval (for example, 15 minutes after every eight hours). Click **Next**. |
| Daily | Enter the start time and interval. Click **Next**. For example, enter 14:30 every fourth day to run the task at 2:30 pm every four days. |
| Weekly | Enter the start time, day of the week, and interval. Click **Next**. For example, Tuesdays and Thursday, 8:00 am, every second week. You can select multiple days of the week. |
| Monthly | Enter the start time, day of the month, and interval. Click **Next**. For example, enter second Thursday of the month, 11:00 every third month. If you select a day higher than 28, a warning message is displayed because some months are 29, 30, or 31 days. The last <day> of the month selects the last week in the month that the day occurs. If you select the last Monday of the month, and the month ends on a Sunday, the last Monday will be six days before the end of the month. |
To complete the wizard, click **Finish**.

VirtualCenter adds the task to the list in the **Scheduled Tasks** tab.

### Rescheduling a Scheduled Task

You can change the properties of scheduled tasks:

**NOTE** The VI Client converts to local time when it and the VirtualCenter Server are located in different time zones. For example, assume the VirtualCenter Server is located in Eastern Standard Time (EST), and the VI Client is located in Pacific Standard Time (PST), three hours behind EST. Assume a user schedules a task to run at noon, Monday PST. Before the VI Client sends the task to the VirtualCenter Server, it converts the execution time to Monday, 3pm EST. A user in yet a different time zone will see the task scheduled for whatever Monday, 3pm EST equates to in their local time.

**To edit a scheduled task**

1. Click **Scheduled Tasks** in the navigation bar.
2. Right-click on a task and select **Properties**.
3. The wizard associated with the task is displayed.
4. Edit task properties through the wizard.

### Removing a Scheduled Task

Removing a scheduled task removes all future occurrences of the task. The history associated with all previous executions of the task remains in the VirtualCenter database.

**NOTE** Removing a task differs from canceling a task. Canceling a task stops a task currently occurring, whether started manually or schedule. Removing a task removes future occurrences of a scheduled task.
To remove a task that has been scheduled

1. From the VI Client connected to a VirtualCenter Server, click the Scheduled Tasks option in the navigation bar.
   The list of scheduled tasks appears.
2. Select the appropriate task from the list. Choose Inventory > Scheduled Task > Remove.
   VirtualCenter removes the task from the scheduled task list.
3. To verify that you want to remove the task, click OK.
   The task is deleted from the list of tasks.

Canceling a Task

Only tasks that are in process can be canceled. And only selected (scheduled or manually initiated) tasks can be canceled while in process. Canceling a task while it is running requires that you have the appropriate permissions assigned to the host where the task is occurring.

**NOTE**  The canceling operation is not allowed if one or both of the hosts involved is an ESX Server version 2.0.1.

Canceling a task differs from removing a task. Canceling a task stops a task currently occurring, whether started manually or scheduled. Removing a task removes future occurrences of a scheduled task.

The tasks that can be canceled after they start are:

- Connecting to a host
- Cloning a virtual machine
- Migrating a virtual machine
- Deploying a template
- Creating a template from a virtual machine
- Cloning a template
To cancel a task that is currently running

1. From the VI Client connected to a VirtualCenter Server, view the Recent Tasks panel.

2. If the Recent Tasks panel is not currently displayed, click Tasks at the lower-left corner of the VI Client window.

3. Select the appropriate task from the list.

4. Right-click the task, and choose Cancel.

Not all tasks can be cancelled. If the cancel option is unavailable, the selected task cannot be cancelled.

VirtualCenter stops progress on the task, returns the objects to their previous states, and displays the task as canceled.
Managing Events

An event is any action that is of interest to the VirtualCenter Server or the ESX Server. Each event triggers an event message. All event messages are archived on the VirtualCenter Server’s database. View event messages from two locations:

- The Events option in the navigation bar displays all events that have occurred on the VirtualCenter Server.
- An Events tab for any object under the Inventory button. These Events tab listings show only the events that occurred on or to the selected datacenter, host, or virtual machine.

The most recent events appear at the end of a scrollable list. Messages are identified by type: Information, Error, or Warning. Messages are also color-coded. A shortened event message appears in the description portion of the panel. A more detailed version of a selected event message appears in the Event Details portion of the panel. Typically, the Event Detail entry indicates the host or virtual machine on which the event occurred and describes the action that occurred. The object of the event is a link to the object’s individual event page.

This section contains the following:

- “Viewing All Event Messages” on page 311
- “Viewing Selected Event Messages” on page 313
- “Sorting and Filtering Event Messages” on page 314
- “Exporting Event Messages” on page 315

Viewing All Event Messages

The Events tab is available when you select a resource pool, host, or virtual machine object from the Inventory panel. This view of the events is available when the VI Client is connected to an ESX Server.

NOTE When connected to a VirtualCenter Server, Events are combined with the Tasks tab.
**Figure 19-1. VI Client Connected to ESX Server > Inventory > Virtual Machine > Events Tab**

To view event details

From the Inventory panel, click the **Events** tab. Click an event.

The Event Details field displays additional information about the event:

- **Events** are messages that report VMware Infrastructure Client activity. Event messages are predefined in the product.

- **Logs** are stored reference information related to selected event messages. Logs are predefined in the product. You can configure whether selected logs are generated or not.

**NOTE** The views and capabilities displayed vary depending on whether the VI Client is connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, task, or description applies to both kinds of connections.
Viewing Selected Event Messages

Each object in the inventory panel has an **Events** tab in the information panel. Each event that appears is an object-specific subset of all the server events.

**To view the event messages and event detail for an object**

1. From the VI Client connected to either a VirtualCenter Server or an ESX Server, click the **Inventory** button in the navigation bar. Expand the inventory as needed.

2. In the inventory panel, select a folder, cluster, resource pool, host, or virtual machine, as appropriate.
   
   If you select a host, the event messages for all the virtual machines on that host are included in the Events log.

3. Click the **Events** tab.

4. Click the event.

   A full text message with links to related objects appears in the **Event Details** box.

5. Click any of the blue highlighted items in the **Events Details** box.

   The view changes to display the selected linked object.
Sorting and Filtering Event Messages

Sort all items in the list by clicking in the column label heading. A triangle in the column head shows the sort order as ascending or descending.

To sort a list

Click the column heading to resort the list by the entries in that column. The current selection does not change.

To change ascending or descending order

Click the column heading to toggle between ascending and descending order.

To choose items in a list

Click an individual item. Use **Shift-click** to choose multiple items in the Events panel.

To view selected columns only

Right-click any column head, and choose from the list of data fields to be displayed.

To search and list selected items

1. Choose **View > Filtering** to see the filtering options.
2. Enter text into the data field. Click **Clear** to empty the data field.

Entries in multiple columns that match the search term are displayed. In the example, the search word “power” is found in both the Description and the Task column entries.
Exporting Event Messages

You can export all or part of the events log file.

To export the events file

1. From the VI Client connected to a VirtualCenter Server, choose File > Export > Export Events.
2. Specify the time range of messages and the type of messages to export.
3. Specify a filename, file type, and location for the exported file. Click the Browse button to view the Save As dialog box.
   The file is saved as a text file.
4. Select the Type radio button to indicate the type of errors to include in the exported file.
   You can specify whether to include user-generated or system-generated events.
   You can specify all users, or you can specify These users and click Browse to select a subset of users.
5. Specify the time range of events to export. Options are Hours, Days, Weeks, Months, and From/To date ranges.
6 Specify the number of events to export, either all or a specific number.
7 Click OK to create a file of the selected data.

VirtualCenter creates a file of the selected data based on the file extension provided and stores the file at the specified location. If no file extension is provided, the default is a text file. The file contains **Type**, **Time**, and **Description**.

### Managing Alarms

*Alarms* are specific notifications that occur in response to selected events. Some alarms are defined by product default. Additional alarms can be created and applied to selected inventory objects or all inventory objects.

**NOTE** The views and capabilities displayed vary depending on whether the VI Client is connected to a VirtualCenter Server or an ESX Server. The Alarms option is not available when the VI Client is connected to an ESX Server.

This section contains the following topics:
- “Understanding Alarms” on page 317
- “Preparing for Email Message SMTP Alarm Notification” on page 319
- “Preparing for SNMP Alarm Notification” on page 320
- “Creating Alarms” on page 321
- “Editing Alarms” on page 326
- “Removing Alarms” on page 327

The Alarms tab in the inventory panel displays the list of alarms for the selected object that are activated upon designated events. Alarms can apply to hosts and virtual machines, and can be defined in parent entities such as folders or resource pools.

**NOTE** Alarms are configurable only through the VirtualCenter Server. ESX Server hosts connected to a VI Client directly do not have the alarms functionality. To get the alarm features, have the VirtualCenter Server manage the ESX Server.
The Alarms tab has two views available through buttons:

- **Alarms** – Displays triggered alarms against the selected inventory item.

  ![Figure 19-2. VI Client Connected to VirtualCenter Server > Inventory: Hosts and Clusters > Host > Alarms Tab > Alarms Button](image)

- **Definitions** – Displays the alarms that are monitoring the selected inventory item. If the event configured in an alarm occurs, the alarm is triggered and the server takes the configured action (for example, sends an email notification).

  ![Figure 19-3. VI Client Connected to VirtualCenter Server > Inventory: Hosts and Clusters > Host > Alarms Tab > Definitions Button](image)

**Understanding Alarms**

Alarms send notification messages when selected events occur to or on hosts or virtual machines. Alarms indicate the status levels of an object or collection of objects in the hierarchy. Alarms can be defined at all hierarchical levels, including folders, datacenters, clusters, resource pools, hosts, and virtual machines.

Alarms are inherited from parent levels and cannot be changed or overridden at a child level. When you add new alarms to any object you contribute to the collection of alarms that are in force at any of its child levels.
When an alarm is created, VirtualCenter verifies the user permissions to perform the actions on the relevant datacenters, hosts, and virtual machines. After the alarm is created, the alarm is performed even if the creating user no longer has permission to create the alarm.

Alarms are applied to either hosts or virtual machines. Each alarm has a triggering event and a notification method.

There are two kinds of alarm triggers:

- **Metric** — Trigger an alarm when a particular property of a monitored object falls within a particular range of values for a period of five minutes. For example, the Host CPU Usage trigger can be set to trigger an alarm when the CPU usage rises above or falls below a specified percentage value.

  Alarms for metric triggers are triggered only when the specified metric meets the trigger condition for five minutes. This prevents alarms from triggering due to transient spikes in the monitored metric.

- **State** — Trigger an alarm when a monitored object enters a specified state.

  For example, the Host State trigger can be set to trigger an alarm when the host enters any of the following states: *None*, *Connected*, *Disconnected*, or *Not responding*. Alarms for state triggers are triggered immediately when the specified state is reached.

There are several types of alarm notification methods:

- **Send a notification email message**

  SMTP sends an email message. The SMTP must be ready when the email message is sent. There are two ways to set SMTP: through VirtualCenter or through Microsoft Outlook Express. The VirtualCenter setup is not always needed if the SMTP setting in Outlook Express is correct.

  The VirtualCenter Server generates the subject and body text of the email message. Only the **To** list (receiver) is required from user input. Specify the email message address where the message should be sent. Separate the names of multiple recipients with commas or semicolons.

- **Send a notification trap**

  The VirtualCenter Server is the default SNMP notification receiver. An SNMP trap viewer is required to view a sent trap. The VirtualCenter Server host must be configured to receive SNMP traps. See “Preparing for SNMP Alarm Notification” on page 320.
Run a script
The user script command and its arguments must be formatted into one string.
The user script is running as separate process and does not block the VirtualCenter Server processes. But the script does run and consume the resources on the VirtualCenter Server machine, such as processor and memory.

Suspend the virtual machine
Power off the virtual machine
Reset the virtual machine

The actions available with alarms are described in the following sections:

- “Preparing for Email Message SMTP Alarm Notification” on page 319
- “Preparing for SNMP Alarm Notification” on page 320
- “Creating Alarms” on page 321
- “Editing Alarms” on page 326
- “Removing Alarms” on page 327

Preparing for Email Message SMTP Alarm Notification
If you want to use email messages to send SMTP notifications, you must:

- Define the SMTP and email message addressing information.
- Specify the email message address for those intended to receive the notification when you create the alarm.

To define the SMTP and email message addressing information

1. From the VI Client, choose Administration > VirtualCenter Management Server Configuration.
2. Click Mail in the navigation list.
3. For email message notification, set the SMTP server and SMTP port:
   - **SMTP Server** – The DNS name or IP address of the SMTP gateway to use for sending email messages.
   - **Sender Account** – The email address of the sender, for example, mail_server datacenter.com. (SEE UPDATE)
4. Click OK.
Preparing for SNMP Alarm Notification

To use SNMP traps, you must configure:

- The VirtualCenter Server host.
- The SNMP receiver server to accept the traps from VirtualCenter.

When you create an alarm, only one trap is triggered and sent. The alarm parameters include:

- **Type** – The state VirtualCenter is monitoring for the alarm. Options include Host Processor (or CPU) usage, Host Memory usage, Host State, Virtual Machine Processor (or CPU) usage, Virtual Machine Memory usage, Virtual Machine State, Virtual Machine Heartbeat.
- **Name** – The name of the host or virtual machine that triggers the alarm.
- **Old Status** – The alarm status before the alarm was triggered.
- **New Status** – The alarm status when the alarm is triggered.
- **Object Value** – The object value when the alarm is triggered.

To define the SNMP information

1. From the VI Client, choose **Administration > VirtualCenter Management Server Configuration**.
2. Click **SNMP** in the navigation list.
3. Enter the SNMP and mail addressing, as appropriate:
   - Configure up to four receivers of SNMP traps. They must be configured in numerical order, 1, 2, 3, and 4. Each SNMP trap requires a corresponding host name, port and community. For example:
     - **Receiver URL** – The DNS name and IP address of the SNMP receiver.
     - **Receiver port** – The port number of the receiver.
       - If the port value is empty, VirtualCenter uses the default port. The default port is 902.
     - **Community String** – The community identifier.
4. Click **OK**.
Creating Alarms

If you plan to use email message or SNMP notification, see “Preparing for Email Message SMTP Alarm Notification” on page 319 and define the address information before you create your alarm.

To create an alarm

1. From the VI Client connected to a VirtualCenter Server, click the Inventory button. Expand the inventory as needed, click the appropriate object, click the Alarms tab, and click the Definitions button.
   
   If you start from a folder, datacenter, or cluster, the Alarm Properties dialog box displays the option to create an alarm for either a host or a virtual machine. If you start from a resource pool, host, or a virtual machine, Monitor a host or Monitor a VM is preselected and the other option is dimmed.
3. Select the alarm type.

4. In the General tab, specify a name for the alarm, the object to be monitored (host or virtual machine), the trigger priority, and whether to enable this alarm.

   Trigger priorities can be set to Red or Green:
   - **Red** – The default, triggers the alarms prioritized red as first, then yellow, and green alarms last.
   - **Green** – Triggers the alarms prioritized as green first, then yellow, and red alarms last.
5. To define the alarm but not make it active, deselect the **Enable** box.

6. Click the **Triggers** tab and the **Add** button.

![Alarm Properties with Triggers tab highlighted](image)

In the Triggers tab, there are four drop-down menus:

- **Trigger Type**
  
  The options listed apply to either the host or virtual machine.

  For host alarms, the options are **Host Processor** (or CPU) **Usage**, **Host Memory Usage**, **Host Network Usage**, **Host Disk Usage**, **Host State**, and **Host Hardware Health**.

  For virtual machine alarms, the options are **VM Processor** (or CPU) **Usage**, **VM Memory Usage**, **VM Network Usage**, **VM Disk Usage**, and **VM State**.

- **Condition**
  
  The options for metric triggers are **Is Above** and **Is Below**.

  **NOTE** Alarms for metric triggers are triggered only when the specified metric meets the trigger condition for five minutes. This prevents alarms from triggering due to transient spikes in the monitored metric.

  The options for state triggers are **Is** (state) and **Is Not** (state).
- **Warning** (Yellow) state or metric value and **Alert** (Red) state or metric value

Percentage options range from 5 percent to 100 percent in 5 percent increments. For non-percentage metrics, such as Network Usage, you can type any value.

*(SEE UPDATE)* Virtual machine state options correspond to these activities: Creating, Migrating, Connecting, Disconnecting, Migrating with VMotion, Reconnecting, Removing, Resuming, Starting, Stopping, Suspending, Disconnected, Initial, Orphaned, Powered Off, Powered On, and Suspended. Host state options correspond to these activities: Connecting, Disconnecting, Reconnecting, Removing, Shutting down, Connected, and Disconnected. Exiting state is considered a yellow condition at selected state.

The colors corresponding to the exiting/from and entering/to states are set in the Actions tab. The default is From **yellow** to **red**.

7 (Optional) Define multiple conditions for the alarm triggering event. Click **Add**. Enter the parameters for each condition.
8 Specify the reporting frequency when the alarm is triggered. Enter a value for Tolerance and one for Frequency.

9 Specify the action to be taken when the alarm is triggered.

10 Click the Actions tab. Click the Add button. Click the appropriate check box. There are four different level changes: green to yellow, yellow to red, red to yellow, and yellow to green. Attach an action for each change from one level to another.
Choose the action to be taken when the event is triggered and specify the associated information.

The options are:

- **Send a notification email.**
  
  Provide the email address of the notification recipient in the Value field.

  SMTP sends a notification email. The SMTP must be ready when the email is sent. There are two ways to set SMTP: through VirtualCenter or through Microsoft Outlook Express. VirtualCenter setup is not always needed if the SMTP setting in Outlook Express is correct.

  VirtualCenter Server generates the email message subject and body text. Only the “to” list (receiver) is required from user input. Specify the email address to which the message should be sent. Separate multiple recipients with commas or semicolons. See “Preparing for Email Message SMTP Alarm Notification” on page 319.

- **Send a notification trap.**
  
  There is a default SNMP notification receiver, the VirtualCenter Server. An SNMP trap viewer is required to view a sent trap. The VirtualCenter Server host must be configured to receive SNMP traps. See “Preparing for SNMP Alarm Notification” on page 320.

- **Run a script.**
  
  If the script is a .exe file, provide the path to the script to run. If the script is a .bat file, provide the script path as an argument to the c:\windows\system32\cmd.exe command. For example, to execute a script located in c:\alarmscript.bat, give the script path as "c:\windows\system32\cmd.exe /c c:\alarmscript.bat".

  The user script command and its arguments must be formatted into one string.

  The user script runs in other processes and does not block the VirtualCenter Server from running. However, the script consumes server resources, such as processor and memory.

  {eventDescription} — full formatted message for alarm triggering event

  {targetName} — name of the entity name where the alarm is triggered

  {alarmName} — name of the alarm that is triggered

  {triggeringSummary} — summary info of the alarm with triggering values

  {declaringSummary} — summary info of the alarm declaration
Basic System Administration

{oldStatus} — alarm status before it is triggered
{newStatus} — alarm status after it is triggered
{target} — inventory object as triggering alarm

Example scripts:
"c:\windows\system32\cmd.exe /c c:\MyAlarmProcess.bat {targetName} {alarmName}"

Two alarm-triggering parameters are passed to the back file. The first parameter is the name of the entity, and the second is the name of the alarm. When the entity name is MyEntity and alarm name is MyAlarm, the script becomes "c:\windows\system32\cmd.exe /c c:\MyAlarmProcess.bat MyEntity MyAlarm".

"d:\tools\alarm.exe '{targetName}' '{alarmName}' {newStatus}"

Three alarm-triggering parameters are passed to the execution file. The first is the entity name, the second is the alarm name, and the third is the alarm status after triggering. When the entity name is my dummy vm, the alarm name is my test alarm, and the new status is red, the script becomes:
"d:\tools\alarm.exe 'my dummy vm' 'my test alarm' red"

- **Power on, Power off, Suspend, or Reset the virtual machine.**

  These apply only to a virtual machine alarm.

12 To complete the alarm, click OK.

VirtualCenter verifies the configuration of the alarm and adds the alarm to the list of alarms for the selected object.

Notice that the **Defined In** column indicates where in the inventory hierarchy the alarm is defined.

**Editing Alarms**

Alarms can be modified, but you must edit them at the hierarchical level where they were created. A simple change is to enable or disable the alarm. If an alarm is disabled, an X appears on the alarm listing icon.

**To edit an existing alarm**

1 From the VI Client connected to a VirtualCenter Server, click the Inventory button in the navigation bar. Expand the inventory as needed, click the Alarms tab, and click the **Definitions** button.

2 If the alarm you want to change is not defined at the current location, click the linked object in the **Defined in** column.

  VirtualCenter displays the Alarms panel for the object where the alarm was defined.
3 Select the alarm to edit. Choose Inventory > Alarm > Edit Settings. The entry in the Defined in column for the alarm must be This object.

4 Edit the alarm general settings, triggers, or actions, as needed. Click OK.

VirtualCenter verifies the configuration of the alarm and edits the alarm for the selected object. See “Creating Alarms” on page 321 for additional information.

Removing Alarms

Remove alarms from the object in which they were defined. You cannot remove them from a child that inherited the alarm.

To remove an alarm

1 From the VI Client connected to a VirtualCenter Server, click the Inventory button in the navigation bar. Expand the inventory as needed, click the Alarms tab, and click the Definitions button.

2 If the alarm you want to change is not defined at the current location, click the linked object in the Defined in column. VirtualCenter displays the Alarms panel for the object where the alarm was defined.

3 To remove the alarm, select the alarm, and choose Inventory > Alarm > Remove. A confirmation pop-up window appears.

4 Click Yes.

The alarm is removed.
Appendixes
Defined Privileges

The following tables list the default privileges that, when selected for a role, can be paired with a user and assigned to an object. The following tables use VC to indicate VirtualCenter Server and HC to indicate host client, a standalone ESX Server.

When setting permissions, verify all the object types are set with appropriate privileges for each particular action. Some operations require access permission at the root folder or parent folder in addition to access to the object being manipulated. Some operations require access or performance permission at a parent folder and a related object. See Chapter 17, “Managing Users, Groups, Permissions, and Roles,” on page 265 for information on applying privileges to inventory objects.

See Table 17-1, “Default Roles,” on page 273 for a list of predefined grouped privileges.

This appendix contains the following topics:

- “Alarms” on page 332
- “Datacenter” on page 333
- “Datastore” on page 333
- “Extensions” on page 334
- “Folders” on page 334
- “Global” on page 335
- “Host CIM” on page 337
- “Host Configuration” on page 337
- “Host Inventory” on page 339
- “Host Local Operations” on page 341
Alarms

Table A-1. Alarms Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Used</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Alarm&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Creates a new alarm.</td>
<td>VC only</td>
<td>Alarm object parent</td>
<td>All inventory items</td>
</tr>
<tr>
<td></td>
<td>User interface element – Alarm tab pop-up menu, File menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Alarm</td>
<td>Deletes an existing alarm.</td>
<td>VC only</td>
<td>Alarm object parent</td>
<td>All inventory items</td>
</tr>
<tr>
<td></td>
<td>User interface element – Alarm tab pop-up menu, File menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Alarm</td>
<td>Changes the properties of an existing alarm.</td>
<td>VC only</td>
<td>Alarm object parent</td>
<td>All inventory items</td>
</tr>
<tr>
<td></td>
<td>User interface element – Alarm tab pop-up menu, File menu</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<sup>1</sup> When creating alarms with a custom action, privilege to perform the action is verified when the use creates the alarm.
## Datacenter

**Table A-2. Datacenter Privileges**

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Datacenter</td>
<td>Creates a new datacenter. <strong>User interface element – Inventory</strong> pop-up menu, toolbar button, and File &gt; New Datacenter</td>
<td>VC only</td>
<td>Datacenter</td>
<td>Datacenter folders</td>
</tr>
<tr>
<td>Delete Datacenter</td>
<td>Removes a datacenter. <strong>User interface element – Inventory</strong> pop-up menu, <strong>Inventory &gt; Datacenter &gt; Remove</strong>, <strong>Edit &gt; Remove</strong></td>
<td>VC only</td>
<td>Datacenter plus parent object</td>
<td>Datacenters</td>
</tr>
<tr>
<td>Move Datacenter</td>
<td>Moves a datacenter. Privilege must be present at both the source and destination. <strong>User interface element – Inventory drag-and-drop</strong></td>
<td>VC only</td>
<td>Datacenter, source and destination</td>
<td>Datacenters, Datacenter folders</td>
</tr>
<tr>
<td>Rename Datacenter</td>
<td>Changes the name of a datacenter. <strong>User interface element – Inventory</strong> object, <strong>Inventory pop-up menu, Edit &gt; Rename</strong>, <strong>Inventory &gt; Datacenter &gt; Rename</strong></td>
<td>VC only</td>
<td>Datacenter</td>
<td>Datacenters</td>
</tr>
</tbody>
</table>

## Datastore

**Table A-3. Datastore Privileges**

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Datastore</td>
<td>Browses files on a datastore. <strong>User interface element – Add existing disk, browse for CD-ROM or Floppy media, serial or parallel port files</strong></td>
<td>HC and VC</td>
<td>Datastores</td>
<td>Datastores</td>
</tr>
<tr>
<td>Delete Datastore</td>
<td>Removes a datastore. <strong>User interface element – Inventory</strong> datastore pop-up menu, <strong>Edit &gt; Remove</strong>, <strong>Inventory &gt; Datastore &gt; Remove</strong></td>
<td>HC and VC</td>
<td>Datastores</td>
<td>Datastores</td>
</tr>
<tr>
<td>Delete Datastore File</td>
<td>Deletes a file in the datastore. <strong>User interface element – Datastore Browser toolbar button and Datastore pop-up menu</strong></td>
<td>HC and VC</td>
<td>Datastores</td>
<td>Datastores</td>
</tr>
</tbody>
</table>
Table A-3. Datastore Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Management</td>
<td>Carries out file operations in the datastore browser.</td>
<td>HC and VC</td>
<td>Datastores</td>
<td>Datastores</td>
</tr>
<tr>
<td>Rename Datastore</td>
<td>Renames a datastore.</td>
<td>HC and VC</td>
<td>Datastores</td>
<td>Datastores</td>
</tr>
<tr>
<td>User interface element – Datastore Properties dialog Change button, host Summary tab pop-up menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Extensions

Table A-4. Extension Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register Extension</td>
<td>Registers an extension (plugin)</td>
<td>VC only</td>
<td>Root Folder</td>
<td>Root Folder</td>
</tr>
<tr>
<td>Unregister Extension</td>
<td>Unregisters an extension (plugin)</td>
<td>VC only</td>
<td>Root Folder</td>
<td>Root Folder</td>
</tr>
<tr>
<td>Update Extension</td>
<td>Updates an extension (plugin)</td>
<td>VC only</td>
<td>Root Folder</td>
<td>Root Folder</td>
</tr>
</tbody>
</table>

Folders

Table A-5. Folder Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Folder</td>
<td>Creates a new folder. User interface element – Taskbar button, File menu, pop-up menu</td>
<td>VC only</td>
<td>Folders</td>
<td>Folders</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>Deletes a folder. User interface element – File menu, pop-up menu</td>
<td>VC only</td>
<td>Folders plus parent object</td>
<td>Folders</td>
</tr>
</tbody>
</table>
Table A-5. Folder Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Folder</td>
<td>Moves a folder. Privilege must be present at both the source and destination.</td>
<td>VC only</td>
<td>Folders, source and destination</td>
<td>Folders</td>
</tr>
<tr>
<td>Rename Folder</td>
<td>Changes the name of a folder.</td>
<td>VC only</td>
<td>Folders</td>
<td>Folders</td>
</tr>
</tbody>
</table>

Global

Table A-6. Global Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Task</td>
<td>Cancels a running or queued task.</td>
<td>HC and VC</td>
<td>Any object</td>
<td>Inventory object related to the task</td>
</tr>
<tr>
<td>Capacity Planning</td>
<td>Enables the use of capacity planning for planning consolidation of physical machines to virtual machines.</td>
<td>VC only</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Gets list of diagnostic files, log header, binary files, or diagnostic bundle.</td>
<td>VC only</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
<tr>
<td>Disable Methods</td>
<td>Allows servers for VirtualCenter extensions to disable certain operations on objects managed by VirtualCenter. No user VI Client interface elements are associated with this privilege.</td>
<td>VC only</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
</tbody>
</table>
### Table A-6. Global Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Methods</td>
<td>Allows servers for VirtualCenter extensions to enable certain operations on objects managed by VirtualCenter. No user VI Client interface elements are associated with this privilege.</td>
<td>VC only</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
<tr>
<td>Licenses</td>
<td>Sees what licenses are installed and adds or removes licenses. <strong>User interface element</strong> — Licenses tab, <strong>Configuration &gt; Licensed Features</strong></td>
<td>HC and VC</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
<tr>
<td>Log Event</td>
<td>Logs a user-defined event against a particular managed entity. <strong>User interface element</strong> — Should ask for a reason when shutting down or rebooting a host.</td>
<td>HC and VC</td>
<td>All objects</td>
<td>All inventory objects</td>
</tr>
<tr>
<td>Manage Custom Attributes</td>
<td>Adds, removes, renames custom attributes for a managed entity. <strong>User interface element</strong> — Administration &gt; Custom Attributes</td>
<td>VC only</td>
<td>All objects</td>
<td>Root folder</td>
</tr>
<tr>
<td>Proxy</td>
<td>Allows access to an internal interface for adding or removing endpoints to or from the proxy. No user VI Client interface elements are associated with this privilege.</td>
<td>VC only</td>
<td>All objects</td>
<td>Root folder</td>
</tr>
<tr>
<td>Script Action</td>
<td>Schedules a scripted action in conjunction with an alarm. <strong>User interface element</strong> — Alarm Settings dialog box</td>
<td>VC only</td>
<td>All inventory objects</td>
<td>All inventory objects</td>
</tr>
<tr>
<td>Service Managers</td>
<td>Allows use of the resxtop command in the Remote CLI. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>Set Custom Attributes</td>
<td>Views, creates, and removes custom attribute fields. <strong>User interface element</strong> — Any list view shows the fields defined and allows setting them</td>
<td>VC only</td>
<td>All objects</td>
<td>All inventory objects</td>
</tr>
</tbody>
</table>
Table A-6. Global Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Reads and modifies runtime VC configuration settings.</td>
<td>VC only</td>
<td>All objects</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong>  –  Administration &gt; VirtualCenter Management Server Configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC Server</td>
<td>Prepares or initiates a VMotion send operation or a VMotion receive operation.</td>
<td>VC only</td>
<td>All objects</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td>No user VI Client interface elements are associated with this privilege.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Host CIM

Table A-7. Host CIM Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIM Interaction</td>
<td>Allows a client to obtain a ticket to use for CIM services.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
</tbody>
</table>

Host Configuration

Table A-8. Host Configuration Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Configuration</td>
<td>Sets advanced options in host configuration.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Host Configuration tab &gt; Advanced Settings, Inventory hierarchy pop-up menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Date Time Settings</td>
<td>Sets time and date settings on the host.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Host Configuration tab &gt; Time Configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Settings (SEE UPDATE)</td>
<td>Allows setting of lockdown mode.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Host Configuration tab &gt; Security Profile &gt; Lockdown Mode &gt; Edit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A-8. Host Configuration Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change SNMP Settings</td>
<td>Edits, restarts, and stops SNMP agent. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>Connection</td>
<td>Changes the connection status of a host (connected or disconnected).</td>
<td>VC only</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>User interface element – Right-click Host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Firmware</td>
<td>Allows updates to the host firmware on ESX Server 3i hosts. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Hosts (ESX Server 3i only)</td>
<td>Hosts</td>
</tr>
<tr>
<td>Hyper Threading</td>
<td>Enables and disables hyperthreading in the host CPU scheduler.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>User interface element – Host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration tab&gt; Processors</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td>Puts the host in and out of maintenance mode, shuts down and restarts the host.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>User interface element – Host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory &gt; Host &gt; Enter Maintenance Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory Configuration</td>
<td>Sets configured service console memory reservation. This setting is applicable only on ESX Server 3 hosts.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>User interface element – Host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration tab &gt; Memory</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Configuration</td>
<td>Configures network, firewall, and VMotion network.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>User interface element – Host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration tab&gt; Networking, Network Adapter, DNS and Routing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query Patch</td>
<td>Allows querying for installable patches and installation of patches on the host.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>Security Profile and Firewall</td>
<td>Configures internet services, such as SSH, Telnet, SNMP, and host firewall.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>User interface element – Host</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration tab&gt; Security Profile</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A-8. Host Configuration Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Management</td>
<td>Allows extensions to manipulate the file system on the host. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>System Resource Settings</td>
<td>Updates the configuration of the system resource hierarchy.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>Storage Partition Configuration</td>
<td>Manages VMFS datastore and diagnostic partitions. Scans for new storage devices. Manages iSCSI.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
<tr>
<td>Virtual Machine Auto-start Configuration</td>
<td>Changes auto-start and auto-stop order of virtual machines on a single host.</td>
<td>HC and VC</td>
<td>Hosts</td>
<td>Hosts</td>
</tr>
</tbody>
</table>

### Host Inventory

### Table A-9. Host Inventory Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Host To Cluster</td>
<td>Adds a host to an existing cluster. User interface element – Inventory pop-up menu</td>
<td>VC only</td>
<td>Hosts</td>
<td>Clusters</td>
</tr>
<tr>
<td>Add Stand-alone Host</td>
<td>Adds a standalone host. User interface element – Toolbar button, inventory pop-up menu, Inventory &gt; Datacenter &gt; Add Host, File &gt; New &gt; Add Host, Hosts tab pop-up menu</td>
<td>VC only</td>
<td>Hosts</td>
<td>Datacenters, Host folders</td>
</tr>
</tbody>
</table>

---

VMware, Inc.
### Table A-9. Host Inventory Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Cluster</td>
<td>Creates a new cluster.</td>
<td>VC only</td>
<td>Clusters</td>
<td>Datacenters, Host folders</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Toolbar button, inventory pop-up menu,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Inventory &gt; Datacenter &gt; New Cluster, File &gt; New &gt; Cluster</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Cluster</td>
<td>Changes the properties of a cluster.</td>
<td>VC only</td>
<td>Clusters</td>
<td>Clusters</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory pop-up menu, <em>Inventory &gt; Cluster &gt;</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Edit Settings, Summary tab</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Cluster/Standalone Host</td>
<td>Moves a cluster or standalone host between folders.</td>
<td>VC only</td>
<td>Clusters, source and destination</td>
<td>Clusters, Host folders</td>
</tr>
<tr>
<td></td>
<td><strong>Privilege must be present at both the source and destination.</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory hierarchy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Host</td>
<td>Moves a set of existing hosts into a cluster.</td>
<td>VC only</td>
<td>Hosts, source and</td>
<td>Clusters, Host folders</td>
</tr>
<tr>
<td></td>
<td><strong>Privilege must be present at both the source and destination.</strong></td>
<td></td>
<td>destination</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory hierarchy drag-and-drop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Cluster</td>
<td>Deletes a cluster or standalone host.</td>
<td>VC only</td>
<td>Clusters plus parent</td>
<td>Clusters, Hosts</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory pop-up menu, <em>Edit &gt; Remove, Inventory &gt; Cluster &gt; Remove</em></td>
<td></td>
<td>object</td>
<td></td>
</tr>
<tr>
<td>Remove Host From Cluster</td>
<td>Removes a host in a cluster or standalone host.</td>
<td>VC only</td>
<td>Clusters plus parent</td>
<td>Clusters, Host folders</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory drag-and-drop out of cluster, pop-up menu, <em>Inventory &gt; Host &gt; Remove</em></td>
<td></td>
<td>object</td>
<td></td>
</tr>
<tr>
<td>Rename Cluster</td>
<td>Renames a cluster.</td>
<td>VC only</td>
<td>Clusters</td>
<td>Clusters</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory single click, inventory hierarchy pop-up menu, <em>Inventory &gt; Cluster &gt; Rename</em></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Host Local Operations

**Table A-10.** Host Local Operations Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Host to VirtualCenter</td>
<td>Installs and uninstalls various agents on a host, for example, vpxa and aam. No user VI Client interface elements are associated with this privilege.</td>
<td>HC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>Create Virtual Machine</td>
<td>Creates a new virtual machine from scratch on a disk without registering it on the host. No user VI Client interface elements are associated with this privilege.</td>
<td>HC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>Delete Virtual Machine</td>
<td>Deletes a virtual machine on disk, whether registered or not. No user VI Client interface elements are associated with this privilege.</td>
<td>HC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>Manage User Groups</td>
<td>Manages local accounts on a host. User interface element – Users &amp; Groups tab (only present if the VI Client logs on to the host directly)</td>
<td>HC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
</tbody>
</table>

### Network

**Table A-11.** Network Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Network</td>
<td>Removes a network. User interface element – Inventory network pop-up menu, Edit &gt; Remove, Inventory &gt; Network &gt; Remove</td>
<td>HC and VC</td>
<td>Datacenter</td>
<td>Datacenters</td>
</tr>
</tbody>
</table>
Performance

Table A-12. Alarm Management Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Intervals</td>
<td>Creates, removes, and updates performance data collection intervals.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Administration &gt; VirtualCenter Management Server Configuration &gt; Statistics</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Permissions

Table A-13. Permissions Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Used</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Permission</td>
<td>Defines one or more permission rules on an entity, or updates rules if already present for the given user or group on the entity.</td>
<td>HC and VC</td>
<td>Any object plus parent object</td>
<td>All inventory items</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Permissions tab pop-up menu, <strong>Inventory</strong> &gt; <strong>Permissions</strong> menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Role</td>
<td>Updates a role’s name and the privileges.</td>
<td>HC and VC</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Roles tab pop-up menu, toolbar button, <strong>File</strong> menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reassign Role Permissions</td>
<td>Reassigns all permissions of a role to another role.</td>
<td>HC and VC</td>
<td>Any object</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Delete Role dialog box radio button and associated menu</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Resource

### Table A-14. Resource Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Recommendation</td>
<td>Asks the server to go ahead with a suggested VMotion.</td>
<td>VC only</td>
<td>Clusters</td>
<td>Clusters</td>
</tr>
<tr>
<td>User interface element – Cluster DRS Recommendations tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Virtual Machine To Pool</td>
<td>Assigns virtual machines to a resource pool.</td>
<td>HC and VC</td>
<td>Resource pools</td>
<td>Resource pools</td>
</tr>
<tr>
<td>User interface element – New Virtual Machine wizard</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Pool</td>
<td>Creates a new resource pool.</td>
<td>HC and VC</td>
<td>Resource pools, clusters</td>
<td>Resource pools, clusters</td>
</tr>
<tr>
<td>User interface element – File menu, pop-up menu, Summary tab, Resources tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Migrate</td>
<td>Migrates a virtual machine’s execution to a specific resource pool or host.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – Inventory pop-up menu, Virtual Machine Summary tab, Inventory &gt; Virtual Machine &gt; Migrate, drag-and-drop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Pool</td>
<td>Changes the allocations of a resource pool.</td>
<td>HC and VC</td>
<td>Resource pools plus parent object</td>
<td>Resource pools</td>
</tr>
<tr>
<td>User interface element – Inventory &gt; Resource Pool &gt; Remove, Resources tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Pool</td>
<td>Moves a resource pool. Privilege must be present at both the source and destination.</td>
<td>HC and VC</td>
<td>Resource pools, source and destination</td>
<td>Resource pools</td>
</tr>
<tr>
<td>User interface element – Drag-and-drop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query VMotion</td>
<td>Investigates the general VMotion compatibility of a virtual machine with a set of hosts.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>User interface element – Required when displaying the migration wizard for a powered-on VM, to check compatibility</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A-14. Resource Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relocate</td>
<td>Cold migrates a virtual machine’s execution to a specific resource pool or host.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Inventory pop-up menu, Virtual Machine Summary tab, Inventory &gt; Virtual Machine &gt; Migrate, drag-and-drop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Pool</td>
<td>Deletes a resource pool.</td>
<td>HC and VC</td>
<td>Resource pools plus parent object</td>
<td>Resource pools</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Edit &gt; Remove, Inventory &gt; Resource Pool &gt; Remove, inventory pop-up menu, Resources tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename Pool</td>
<td>Renames a resource pool.</td>
<td>HC and VC</td>
<td>Resource pools</td>
<td>Resource pools</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Edit &gt; Rename, Inventory &gt; Resource Pool &gt; Rename, single-click, pop-up menu</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Scheduled Task

### Table A-15. Scheduled Task Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Tasks(^1)</td>
<td>Schedules a task. Requires the privileges to perform the scheduled action at the time of scheduling. <strong>User interface element</strong> – Scheduled Tasks toolbar button and pop-up menu</td>
<td>VC only</td>
<td>All inventory objects</td>
<td>All inventory objects</td>
</tr>
<tr>
<td>Modify Task</td>
<td>Reconfigures the scheduled task properties. <strong>User interface element</strong> – Inventory &gt; Scheduled Tasks &gt; Edit, Scheduled Tasks tab pop-up menu</td>
<td>VC only</td>
<td>All inventory objects</td>
<td>All inventory objects</td>
</tr>
<tr>
<td>Remove Task</td>
<td>Removes a scheduled task from the queue. <strong>User interface element</strong> – Scheduled Tasks pop-up menu, Inventory &gt; Scheduled Task &gt; Remove, Edit &gt; Remove</td>
<td>VC only</td>
<td>All inventory objects</td>
<td>All inventory objects</td>
</tr>
</tbody>
</table>
Appendix A Defined Privileges

### Table A-15. Scheduled Task Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Task</td>
<td>Runs the scheduled task immediately. User interface element – Scheduled Tasks pop-up menu, Inventory &gt; Scheduled Task &gt; Run</td>
<td>VC only</td>
<td>All inventory objects</td>
<td>All inventory objects</td>
</tr>
</tbody>
</table>

1. Creating and running a task (on-demand) requires permission to invoke the associated action. For example, Alarms requires permissions on a folder to create alarms on objects in that folder.

### Sessions

#### Table A-16. Session Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Message</td>
<td>Sets the global log in message. User interface element – Sessions tab, Administration &gt; Edit Message of the Day</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>Impersonate User</td>
<td>Impersonates another user. This capability is used by extensions.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>Validate Session</td>
<td>Verifies session validity.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>View and Terminate Sessions</td>
<td>Allows viewing of session. Forces log out of one or more logged-on users. User interface element – Sessions tab</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
</tbody>
</table>

### Tasks

#### Table A-17. Tasks Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Allows an extension to create a user-defined task.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td>Update</td>
<td>Allows an extension to updates a user-defined task.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
</tbody>
</table>
## Virtual Machine Configuration

### Table A-18. Virtual Machine Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Existing Disk</td>
<td>Adds a virtual disk that refers to an existing virtual disk. User interface element – Virtual Machine Properties dialog box</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Add New Disk</td>
<td>Adds a virtual disk that creates a new virtual disk. User interface element – Virtual Machine Properties dialog box</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Add or Remove Device</td>
<td>Adds or removes any non-disk device. User interface element – Virtual Machine Properties dialog box</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Advanced</td>
<td>Changes values in extraConfig. User interface element – Virtual Machine Properties dialog box &gt; Options tab &gt; Advanced - General option &gt; Configuration Parameters button</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Change CPU Count</td>
<td>Changes the number of virtual CPUs. User interface element – Virtual Machine Properties dialog box</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Change Resource</td>
<td>Changes resource configuration of a set of VM nodes in a given resource pool.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>DiskExtend</td>
<td>Expands the size of a virtual disk.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Disk Lease</td>
<td>Leases disks for VMware Consolidated Backup. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Host USB Device</td>
<td>Attaches a host-based USB device to a virtual machine. User interface element &gt; Virtual Machine Properties dialog box</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
</tbody>
</table>
### Table A-18. Virtual Machine Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Changes the amount of memory allocated to the VM. User interface element – Virtual Machine Properties dialog box &gt; Memory</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Modify Device Settings</td>
<td>Changes the properties of an existing device. User interface element – Virtual Machine Properties dialog box &gt; SCSI/IDE node selection</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Raw Device(^1)</td>
<td>Adds or removes a raw disk mapping or SCSI pass through device. User interface element – Virtual Machine Properties dialog box &gt; Add/Remove raw disk mapping</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Remove Disk</td>
<td>Removes a virtual disk device. User interface element – Virtual Machine Properties dialog box &gt; Hard Disk (but not a raw disk mapping)</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames a virtual machine or modifies the associated notes of a virtual machine. User interface element – Virtual Machine Properties dialog box, inventory, inventory pop-up menu, File menu, Inventory menu</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Reset Guest Information</td>
<td>Clears guestinfo variables. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Settings</td>
<td>Changes general VM settings. User interface element – Virtual Machine Properties dialog box &gt; Options tab</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Swap Placement</td>
<td>Changes the swapfile placement policy for a virtual machine.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
</tbody>
</table>
### Upgrade Virtual Hardware
Upgrades the virtual machine's virtual hardware version from a previous version of VMware.

*User interface element* – Pop-up menu, File menu (appears only if vmx file shows a lower configuration number)

1. Setting this parameter overrides any other privilege for modifying raw devices, including connection states.

### Virtual Machine Interaction

#### Table A-18. Virtual Machine Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade Virtual Hardware</td>
<td>Upgrades the virtual machine's virtual hardware version from a previous version of VMware.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>User interface element</em> – Pop-up menu, File menu (appears only if vmx file shows a lower configuration number)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table A-19. Virtual Machine Interaction

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer Question</td>
<td>Resolves issues with VM state transitions or runtime errors.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>User interface element</em> – Summary tab, Inventory menu, pop-up menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure CD Media</td>
<td>Changes the backing of a CD-ROM device.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>User interface element</em> – Virtual Machine Properties dialog box &gt; DVD/CD-ROM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure Floppy Media</td>
<td>Changes the backing of a floppy device.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>User interface element</em> – Virtual Machine Properties dialog box</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Console Interaction</td>
<td>Interacts with the virtual machine's virtual mouse, keyboard, and screen; gets screenshot information.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>User interface element</em> – Console tab, toolbar button, Inventory &gt; Virtual Machine &gt; Open Console, inventory pop-up menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defragment All Disks</td>
<td>Defragments all disks on the virtual machine.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
</tbody>
</table>

VMware, Inc.
### Table A-19. Virtual Machine Interaction (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Changes the connected state of a virtual machine’s disconnectable virtual</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td>device.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Virtual Machine Properties dialog box</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Off</td>
<td>Powers off a powered-on virtual</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td>machine, shuts down guest.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – File menu item, pop-up menu, pop-up console</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>menu, toolbar button, <strong>Summary</strong> tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power On</td>
<td>Powers on a powered-off virtual</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td>machine, resumes a suspended virtual</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – File menu item, pop-up menu, pop-up console</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>menu, toolbar button, <strong>Summary</strong> tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Resets virtual machine and reboots the guest operating system.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – File menu item, pop-up menu, pop-up console</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>menu, toolbar button, <strong>Summary</strong> tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Suspend</td>
<td>Suspends a powered-on virtual</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td>machine, puts guest in standby mode.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – File menu item, pop-up menu, pop-up console</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>menu, toolbar button, <strong>Summary</strong> tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tools Install</td>
<td>Mounts and unmounts the VMware Tools CD installer as a CD-ROM for the guest</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td></td>
<td>operating system.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – File menu item, pop-up menu, pop-up console</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>menu</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Virtual Machine Inventory

**Table A-20. Virtual Machine Inventory Privileges**

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates a new virtual machine and allocates resources for its execution. <strong>User interface element</strong> – File menu, pop-up menu, <strong>Summary tab</strong> - New Virtual Machine links</td>
<td>HC and VC</td>
<td>Parent folders</td>
<td>Virtual machine folders</td>
</tr>
<tr>
<td>Move</td>
<td>Relocates a virtual machine in the hierarchy. Privilege must be present at both the source and destination. <strong>User interface element</strong> – Inventory hierarchy drag-and-drop in Virtual Machines &amp; Templates view</td>
<td>VC only</td>
<td>Virtual machines, parent folders</td>
<td>Virtual machines, virtual machine folders</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes a virtual machine, optionally removes underlying files from disk. <strong>User interface element</strong> – File menu, pop-up menu, <strong>Summary tab</strong></td>
<td>HC and VC</td>
<td>Virtual machines plus parent folders</td>
<td>Virtual machines</td>
</tr>
</tbody>
</table>

### Virtual Machine Provisioning

**Table A-21. Virtual Machine Provisioning Privileges**

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Disk Access</td>
<td>Opens a disk on a virtual machine for random read and write access. Used mostly for remote disk mounting. No user VI Client interface elements are associated with this privilege.</td>
<td>n/a</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Allow ReadOnly Disk Access</td>
<td>Opens a disk on a virtual machine for random read access. Used mostly for remote disk mounting. No user VI Client interface elements are associated with this privilege.</td>
<td>n/a</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>Allow Virtual Machine Download</td>
<td>Reads files associated with a virtual machine, including vmx, disks, logs, and nvram. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Root folders</td>
</tr>
</tbody>
</table>
### Table A-21. Virtual Machine Provisioning Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Virtual Machine Files</td>
<td>Writes files associated with a virtual machine, including vmx, disks, logs, and nvram. No user VI Client interface elements are associated with this privilege.</td>
<td>HC and VC</td>
<td>Virtual machines</td>
<td>Root folders</td>
</tr>
<tr>
<td>Upload</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clone</td>
<td>Clones an existing virtual machine and allocates resources.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – File menu, pop-up menu, Summary tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clone Template</td>
<td>Clones a template.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – File menu, pop-up menu, Virtual Machines tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Template From Virtual Machine</td>
<td>Creates a new template from a virtual machine.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – “Clone to template...” File menu, pop-up menu, Summary tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customize</td>
<td>Customizes a virtual machine's guest operating system without moving the virtual machine.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – Clone Virtual Machine wizard: Guest Customization</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deploy Template</td>
<td>Creates a new virtual machine from a template.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – “Deploy to template” File menu, pop-up menu items, Virtual Machines tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mark As Template</td>
<td>Marks an existing, powered off virtual machine as a template.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – “Convert to template...” File menu, pop-up menu items, Virtual Machines tab, Summary tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mark As Virtual Machine</td>
<td>Marks an existing template as a VM.</td>
<td>VC only</td>
<td>Virtual machines</td>
<td>Virtual machines</td>
</tr>
<tr>
<td>User interface element – “Convert to Virtual Machine...” File menu, pop-up menu items, Virtual Machines tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table A-21. Virtual Machine Provisioning Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Customization Specs</td>
<td>Creates, modifies, or deletes customization specifications.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Customization Specifications Manager</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read Customization Specs</td>
<td>Views the customization specifications defined on the system.</td>
<td>VC only</td>
<td>Root folder</td>
<td>Root folder</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Edit &gt; Customization Specifications</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Virtual Machine State

Table A-22. Virtual Machine State Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
<th>Pair with Object</th>
<th>Effective on Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Snapshot</td>
<td>Creates a new snapshot from the virtual machine’s current state.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Pop-up menu, toolbar button, <strong>Inventory</strong> menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Snapshot</td>
<td>Removes a snapshot from the snapshot history.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Pop-up menu, toolbar button, <strong>Inventory</strong> menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename Snapshot</td>
<td>Renames this snapshot with either a new name or a new description or both.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No user VI Client interface elements are associated with this privilege.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revert To Snapshot</td>
<td>Sets the VM to the state it was in at a given snapshot.</td>
<td>HC and VC Virtual machines</td>
<td>Virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> – Pop-up menu, toolbar button, <strong>Inventory</strong> menu, <strong>Virtual Machines</strong> tab</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Installing the Microsoft Sysprep Tools

If you plan to customize a Windows guest operating system, you must first install the Microsoft Sysprep tools on your VirtualCenter Server machine.

Microsoft includes the Sysprep tool set on the installation CD-ROM discs for Windows 2000, Windows XP, and Windows 2003. It also distributes Sysprep from the Microsoft Web site. To perform a Windows customization, you must install the Sysprep tools either from your installation disc, or from the Microsoft download package. You must install the correct version of the Sysprep tools for each operating system you want to customize. Also, ensure that the password for the local administrator account on the virtual machine is set to blank (“”).

During customization, VirtualCenter searches for the Sysprep package corresponding to your guest operating system. If VirtualCenter does not find any Sysprep tools, the Windows virtual machine customization does not proceed.

(See Update) The guest operating system customization feature in VirtualCenter Server 3.5 takes full advantage of Windows sysprep functionality. As a result, it is very important that you have sysprep installed for each of the guests that you wish to customize. If for example sysprep is not provided for Windows Server 2003, customization will not attempt to use an earlier version, but will simply disable the customization operation for that guest.

NOTE Sysprep tools are built into the Windows Vista operating system.
To install the Microsoft Sysprep tools from a Microsoft Web site download

1. Download the Sysprep package from the Microsoft download center. Make sure that you download the correct version for the guest operating system you want to customize.

2. Click Next to continue.

3. Click I agree to accept the terms and conditions.

4. Click Download.

5. Save the file to your local disk.

6. Open and expand the .cab file, using a tool such as Winzip.exe or another tool capable of reading Microsoft CAB files.

7. Extract the files to the provided directory.

   The following Sysprep support directories were created during VirtualCenter installation:

   ```
   C:\<ALLUSERSPROFILE>\Application Data\VMware\VMware VirtualCenter\sysprep ...
   ...\1.1\ ...
   ...\2k\ ...
   ...\xp\ ...
   ...\svr2003\ ...
   ...\xp-64\ ...
   ...\svr2003-64\ ...
   ```

   where <ALLUSERSPROFILE> is usually \Documents And Settings\All Users\. This is where vpxd.cfg is also located.

   Select the subdirectory that corresponds to your operating system.

8. Click OK to expand the files.

   After you have extracted the files from the .cab file, you should see:

   ```
   ...
   ...\<guest>\deptool.chm ...
   ...\<guest>\readme.txt ...
   ...\<guest>\setupcl.exe ...
   ...\<guest>\setupmgr.exe ...
   ...\<guest>\setupmgx.dll ...
   ...\<guest>\sysprep.exe ...
   ...\<guest>\unattend.doc
   ```

   where <guest> is 2k, xp, svr2003, xp-64, or svr2003-64.
To install the Microsoft Sysprep tools from the Windows operating system CD

1. Insert the Windows operating system CD into the CD-ROM drive (often the D: drive).
2. Locate the DEPLOY.CAB file in the CD directory, \Support\Tools.
3. Open and expand the DEPLOY.CAB file, using a tool such as Winzip.exe or another tool capable of reading Microsoft CAB files.
4. Extract the files to the directory appropriate to your Sysprep guest operating system.

The following Sysprep support directories were created during VirtualCenter installation:

```
C:<ALLUSERSPROFILE>\Application Data\VMware\VMware VirtualCenter\sysprep ...
...
...
...
...
...
...
...

where <ALLUSERSPROFILE> is usually \Documents And Settings\All Users\.
This is where vpxd.cfg is also located.

Select the subdirectory that corresponds to your operating system.

5. Click OK to expand the files.

After you have extracted the files from the .cab file, you should see:

```
...
...
...
...
...
...
...
...
...

where <guest> is 2k, xp, svr2003, xp-64, or svr2003-64.

6. Repeat this procedure to extract Sysprep files for each of the Windows guest operating systems (Windows 2000, Windows XP, or Windows 2003) you plan to customize using VirtualCenter.

You are now ready to customize a new virtual machine with a supported Windows guest operating system when you clone an existing virtual machine.
This appendix lists the metrics, or counters, available for display in performance charts. The availability of some counters depends on the Statistics Collection Level setting (see “About Collection Intervals and Collection Levels” on page 286). Changes to chart options take effect after the current data collection cycle is complete and the next cycle begins.

Counters have rollup and statistics type characteristics. A metric’s rollup refers to what type of measurement is being presented. Rollup types include the following:

- **Average** – Data collected for the specified duration is averaged. The measurement displayed in the chart represents an average for the duration of the data collection cycle.
- **Summation** – Data collected is summed. The measurement displayed in the chart represents the sum of data collected during the collection cycle.
- **Latest** – Data collected is a set value. The measurement displayed in the chart represents the current setting.
- **Minimum** – Data collected is averaged. The measurement displayed in the chart represents the average minimum value for the duration of the data collection cycle.
- **Maximum** – Data collected is averaged. The measurement displayed in the chart represents the average maximum value for the duration of the data collection cycle.

A metric’s statistics type refers to whether the measurement represents a changed value (Delta), an absolute value (Absolute), or a ratio (Rate).
Tables are organized by resource and inventory object and contain the following information:

- **Counter** — Lists the display name of each metric.
- **Available in Collection Level** — Indicates the minimum value to which the statistics collection level must be set for the metric to be included as a selectable option in the Customize Chart Performance dialog box.
- **VC/ESX** — Indicates whether the option is available when the VI Client is connected to VirtualCenter Server or directly to an ESX Server host.
- **Description** – Provides a brief description of the metric.

Calculations for all metrics listed in the tables are for the duration of the data collection cycle. Collection cycle durations are specified in the Statistics Collection Interval setting (see “About Collection Intervals and Collection Levels” on page 286).

This appendix contains the following topics:

- “CPU” on page 358
- “Disk” on page 361
- “Cluster Services” on page 369
- “Network” on page 370
- “System” on page 371

### CPU

The tables in this section list metrics for measuring CPU performance. All measurements are in milliseconds unless otherwise noted. CPU performance charts are available for the following inventory objects:

- Virtual Machine
- Host
- Resource Pool
- Cluster
Virtual Machine

Table C-1. CPU Performance Metrics for Virtual Machines

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Usage</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates CPU usage as a percentage. Rollup: Average (Minimum/Maximum) Stats Type: Rate</td>
</tr>
<tr>
<td>CPU Usage in MHz</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates CPU usage in Megahertz. Rollup: Average (Minimum/Maximum) Stats Type: Rate</td>
</tr>
<tr>
<td>CPU Used</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is used. Rollup: Summation Stats Type: Delta</td>
</tr>
<tr>
<td>CPU Guaranteed</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is guaranteed. Rollup: Latest Stats Type: Absolute</td>
</tr>
<tr>
<td>CPU Extra</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is unused. Rollup: Latest Stats Type: Absolute</td>
</tr>
<tr>
<td>CPU Ready</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is consumed by being in the ready state. Rollup: Latest Stats Type: Absolute</td>
</tr>
<tr>
<td>CPU System</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is consumed by system processes. Rollup: Latest Stats Type: Absolute</td>
</tr>
<tr>
<td>CPU Idle Time</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is consumed by being in the wait state. Rollup: Latest Stats Type: Absolute</td>
</tr>
</tbody>
</table>
### Host

**Table C-2. CPU Performance Metrics for Hosts**

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Used</td>
<td>1</td>
<td>Yes/Yes</td>
<td>Calculates amount of CPU time that is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Summation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Delta</td>
</tr>
<tr>
<td>idle</td>
<td>1</td>
<td>Yes/Yes</td>
<td>Calculates CPU idle time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Summation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Delta</td>
</tr>
<tr>
<td>CPU Reserved Capacity</td>
<td>1</td>
<td>Yes/Yes</td>
<td>Compares value of resource pool's reservation setting with sum of child objects' reservation settings. Displays the greater of the two values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Latest</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>CPU Usage in MHz</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates average CPU usage in Megahertz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average (Minimum/Maximum)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Rate</td>
</tr>
<tr>
<td>CPU Usage</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates CPU usage as a percentage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average (Minimum/Maximum)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Rate</td>
</tr>
</tbody>
</table>

### Resource Pool

**Table C-3. CPU Performance Metrics for Resource Pools**

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Usage in MHz</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates CPU usage in Megahertz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average (Minimum/Maximum)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Rate</td>
</tr>
</tbody>
</table>
Cluster

Table C-4. CPU Performance Metrics for Clusters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Usage in MHz</td>
<td>1(4)</td>
<td>Yes/No</td>
<td>Calculates CPU usage in Megahertz. Rollup: Average (Minimum/Maximum) Stats Type: Rate</td>
</tr>
</tbody>
</table>

Disk

The table in this section lists metrics for measuring disk performance. All measurements are in kilobytes unless otherwise noted. Disk performance charts are available for hosts and virtual machines; chart options are identical for both.

Host and Virtual Machine

Table C-5. Disk Performance Metrics for Host and Virtual Machines

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Usage in MHz</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates sum of data read and written to all disk instances in kilobytes per second. Rollup: Average (Minimum/Maximum) Stats Type: Rate</td>
</tr>
<tr>
<td>Read</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of data read from disk in kilobytes per second per HBA. Rollup: Average Stats Type: Rate</td>
</tr>
<tr>
<td>Write</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Calculates amount of data written to disk in kilobytes per second per HBA. Rollup: Average Stats Type: Rate</td>
</tr>
</tbody>
</table>
Memory

The tables in this section list metrics for measuring memory performance. Memory performance charts are available for the following inventory objects:

- Virtual Machine
- Host
- Resource Pool
- Cluster

Virtual Machine

Table C-6. Memory Performance Metrics for Virtual Machines

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Swap In</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory swapped in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap In</td>
<td>4</td>
<td>Yes/Yes</td>
<td>Calculates average minimum amount of memory swapped in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Minimum</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
</tbody>
</table>
### Table C-6. Memory Performance Metrics for Virtual Machines (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Swap In</td>
<td>4</td>
<td>Yes/Yes</td>
<td>Calculates average maximum amount of memory swapped in. Rollup: Maximum</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Balloon Target</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory available to memory control. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Balloon</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory used by memory control. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Out</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory swapped out. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Usage</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory used as a percentage of total configured, or total</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>available memory. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Overhead</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of additional host memory allocated to the virtual machine.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Zero</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of zero page memory. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Active</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory actively used. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Shared</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory shared. Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
</tbody>
</table>
Table C-6. Memory Performance Metrics for Virtual Machines (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Granted</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory granted. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Consumed</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of host memory consumed by the virtual machine for guest operating system memory. Rollup: Average (Minimum/Maximum) Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Target</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory that can be swapped. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swapped</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory swapped. Rollup: Average Stats Type: Absolute</td>
</tr>
</tbody>
</table>

**Host**

Table C-7. Memory Performance Metrics for Hosts

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory State</td>
<td>2</td>
<td>Yes/Yes</td>
<td>Calculates the memory state. Rollup: Latest Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Used by VMKernel</td>
<td>2</td>
<td>Yes/Yes</td>
<td>Calculates the amount of memory used by vmkernel. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Used</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates the amount of memory used by swap Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Active</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory actively used. Rollup: Average Stats Type: Absolute</td>
</tr>
</tbody>
</table>
### Table C-7. Memory Performance Metrics for Hosts (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Consumed</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of host memory consumed by the virtual machine for guest operating system memory. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Out</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory swapped out. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Unreserved</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory that is unreserved. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Heap</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory allocated for heap.</td>
</tr>
<tr>
<td>Memory Reserved Capacity</td>
<td>2</td>
<td>Yes/Yes</td>
<td>Calculates amount in MB of memory reserved by the virtual machines. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Zero</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of zero page memory. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Heap Free</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of free space in the memory heap. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Usage</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory used as a percentage of total configured, or total available memory. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Shared</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory shared. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap In</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory swapped in. Rollup: Average Stats Type: Absolute</td>
</tr>
</tbody>
</table>
### Table C-7. Memory Performance Metrics for Hosts (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Overhead</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of additional host memory allocated to the virtual machine.</td>
</tr>
<tr>
<td>Memory Balloon</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory used by memory control.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Granted</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory granted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Shared Common</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory shared by common.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
</tbody>
</table>

### Resource Pool

### Table C-8. Memory Performance Metrics for Resource Pools

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Usage</td>
<td>1(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory used as a percentage of total configured, or total available memory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Granted</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory granted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Active</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory actively used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Shared</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory shared.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
</tbody>
</table>
### Table C-8. Memory Performance Metrics for Resource Pools

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Zero</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of zero page memory. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swapped</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory swapped. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Target</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory that can be swapped. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap In</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory swapped in. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Out</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory swapped out. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Balloon</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory used by memory control. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Balloon Target</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of memory available to memory control. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Overhead</td>
<td>2(4)</td>
<td>Yes/Yes</td>
<td>Calculates amount of additional host memory allocated to the virtual machine. Rollup: Average Stats Type: Absolute</td>
</tr>
</tbody>
</table>
### Cluster

**Table C-9. Memory Performance Metrics for Clusters**

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Usage</td>
<td>1(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory used as a percentage of total configured, or total available memory. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Granted</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory granted. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Active</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory actively used. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Shared</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory shared. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Zero</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of zero page memory. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Unreserved</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory that is unreserved. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Used</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory used by swap. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Swap Unreserved</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory not reserved for swap. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Shared Common</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory shared by common. Rollup: Average Stats Type: Absolute</td>
</tr>
</tbody>
</table>
Table C-9. Memory Performance Metrics for Clusters (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Heap</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory allocated for heap. Rollup: Average                                                             Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Heap Free</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates free space in memory heap. Rollup: Average                                                             Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory State</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates state. Rollup: Latest Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Balloon</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory used by memory control. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Balloon Target</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of memory available to memory control. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Memory Overhead</td>
<td>2(4)</td>
<td>Yes/No</td>
<td>Calculates amount of additional host memory allocated to the virtual machine. Rollup: Average Stats Type: Absolute</td>
</tr>
</tbody>
</table>

Cluster Services

The table in this section lists metrics for measuring the performance of cluster services such as DRS and HA. Cluster services performance charts are available only for clusters.
Cluster

### Table C-10. Cluster Services Metrics for Clusters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective CPU Resources</td>
<td>1(4)</td>
<td>Yes/No</td>
<td>Calculates average DRS effective CPU resources available measured in MHz. Rollup: Average Stats Type: Rate.</td>
</tr>
<tr>
<td>Effective Memory Resources</td>
<td>1(4)</td>
<td>Yes/No</td>
<td>Calculates average DRS effective memory resources available in MB. Rollup: Average Stats Type: Absolute</td>
</tr>
<tr>
<td>Current failover level</td>
<td>1(4)</td>
<td>Yes/No</td>
<td>Calculates the current number of failovers that can be tolerated by HA. Rollup: Latest Stats Type: Absolute.</td>
</tr>
</tbody>
</table>

Network

The table in this section lists metrics for measuring network performance. Network performance charts are available for virtual machines and hosts; chart options are identical for both.

Host and Virtual Machine

### Table C-11. Network Metrics for Hosts and Virtual Machines

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Data Receive Rate</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Rate at which data is received in KBps. Rollup: Average Stats Type: Rate</td>
</tr>
<tr>
<td>Network Packets Transmitted</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Number of packets transmitted in the period. Rollup: Summation Stats Type: Delta</td>
</tr>
<tr>
<td>Network Data Transmit Rate</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Rate at which data is transmitted. Rollup: Average Stats Type: Rate</td>
</tr>
</tbody>
</table>
Appendix C Performance Chart Metrics

Table C-11. Network Metrics for Hosts and Virtual Machines (Continued)

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Usage (Average)</td>
<td>1(4)</td>
<td>Yes/Yes</td>
<td>Aggregated network performance statistics in KBps.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average (Minimum/Maximum)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Rate</td>
</tr>
<tr>
<td>Network Packets Received</td>
<td>3</td>
<td>Yes/Yes</td>
<td>Number of packets received in the period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Summation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Delta</td>
</tr>
</tbody>
</table>

System

The table in this section lists metrics for measuring system performance. System performance charts are available for virtual machines and hosts.

Table C-12. System Metrics for Virtual Machines and Hosts

<table>
<thead>
<tr>
<th>Counter</th>
<th>Available in Collection Level</th>
<th>VC/ESX</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heartbeat</td>
<td>1</td>
<td>Yes/Yes</td>
<td>Number of heartbeats in collection period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Summation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Delta</td>
</tr>
<tr>
<td>Uptime</td>
<td>1</td>
<td>Yes/Yes</td>
<td>Number of seconds since startup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Latest</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Absolute</td>
</tr>
<tr>
<td>Resource CPU Usage</td>
<td>3(4)</td>
<td>Yes/Yes</td>
<td>CPU usage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Rollup: Average (Minimum/Maximum)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stats Type: Rate</td>
</tr>
</tbody>
</table>
Index

Symbols
176, 285

A
access
inventory objects 266
permissions 278
privileges 331
rules 266
to VirtualCenter through Web 78
Active Directory 118
VirtualCenter settings 75
active sessions 81
send messages 82
adapters
Ethernet 180, 199
SCSI 150
alarms 29
about 316
define rules for 321
edit 326
email notification of 316
privileges 332
remove 327
scripts 319
SNMP traps 318
tab 54
annotations 61
appliances 139
ATAPI 150

B
baselines, security 26
boot settings 189
BusLogic 150

ccharts
best practices for setting collection levels 287
customize 295
export 295
performance 293
cclone
save guest operating system customization 228
templates 204
virtual machines 210
cclusters 27
remove hosts 133
shared storage 234
collection
best practices 287
levels and intervals 285
ccommand-line interface
tremote 42
ccommands
ESX Server 74
service console 42
ccomponents
datastore 23
ESX Server 21
host agent 23
license server 23
VirtualCenter agent 23
VirtualCenter database 22
VirtualCenter Server 22
VMware Infrastructure 21

console
  service, the 41
  tab 54
  virtual machine 50

consolidation
  about 118
  analysis results 122
  cache 125
  confidence metric 123
  credentials 120
  first time use 119
  limits 125
  prerequisites 118
  services 118
  settings 119, 120
  tasks 125
  troubleshoot 125

consolidation settings 118
convert, see consolidation
CPU
  advanced settings 193
  compatibility masks 241
  configuration 186
CPU Identification Mask 189
credentials
  consolidation 120
  custom attributes 61

D
database
  calculator 293
  VirtualCenter 22, 76

datacenters 28
  consolidation 118

privileges 333
topology maps 297
Datastore Browser 113
datastores 27
  about 23
  privileges 333
  relocate virtual machine files 248

DHCP 41
diagnostic data
  export 101
diagnostics 98
disks 180, 200
  independent 257
  independent mode 151
  modes 200
  raw device mapping 72
  resources 196

DVD/CD-ROM, see optical drives

E
ESX Server
  about 21
  agent, configure 95
  commands 74
  diagram 21
  hosts 128
  hosts, add to VirtualCenter 129
  hosts, configure 70
  manage 20
  reboot 36
  storage 72
  syslog service 102
  traps 89

ESX Server 3
  SNMP traps 96
ESX Server 3i
  SNMP 96

Ethernet adapters 180, 199
events 28, 29
Index

about 311
alarms 316
export 103, 315
navigation bar 54
tab 54
export
applications 139
events 103
virtual machines 141
extensions
privileges 334

F
Fibre Channel NPIV 81, 187, 190
firewall
configure communication 76
floppy drives 180, 199
folders 27
privileges 334

G
Getting Started tabs, enable and disable 56
global privileges 335
groups 266, 271
guest operating systems 215
customization prerequisites 216
install 154
Guided Consolidation 53, 114

H
hardware
virtual machine 180, 196
HBA 190
host bus adapter (HBA) 87
hosts 26
about 128
add 129
advanced configuration 138

CIM privileges 337
configuration privileges 337
configure 70
connect to VirtualCenter 132
custom attributes 61
disconnect from VirtualCenter 132
inventory privileges 339
local operations privileges 341
network configuration 72
reconnecting 133
remove from cluster 133
remove from VirtualCenter 135, 136
states 129
tab 54
HTTP and HTTPS ports
VirtualCenter settings 76
hyperthreading 193

I
IDE 150
IIS 78
image files
ISO 181
import
applications 139
independent disks 257
install
VMware Tools 155
interfaces 24
inventory
about 28
access to objects 266
navigation bar 54
objects, add 110
topology maps 297
ISO image files 181

L
legacy virtual machines 201
license server 23
diagram 21
VirtualCenter settings 74
Linux
guest, customize 215
guest, install VMware Tools on 158
load balancing 25
log files 29, 99
collect 104
export 101
external 101
logging
VirtualCenter settings 76
logging in 266
VI Client 38
VI Web Access 40
logging out
VI Client 39
VI Web Access 40
LSI logic 150
LUNs 153, 200
M
MAC address 88
mail
VirtualCenter settings 75
man pages
service console 43
managed devices
MIB files 83
maps 28, 297
exporting 300
print 300
view 299
VMotion resources 298
memory
resources 194
metrics
performance 357
MIB 83, 95
Microsoft Sysprep 353
migration
about 232
relocate virtual machine files 248
Storage VMotion 248
with snapshots 243
modules, see plugins
N
navigation bar
overview 51
NetWare 162
networks 27
host configuration 72
privileges 341
requirements for VMotion 235
NIC 199
NPIV 81, 187, 190
NUMA 194
O
object identifiers (OIDs) 83
objects
inventory 110
VirtualCenter 63
Open Virtual Machine Format (OVF) 140
operating system, guest 154
optical drives 180, 198
OVF 139, 140
P
paravirtualization 190
PCI 190
performance
best practices for setting collection levels 287
charts 293, 295
metrics 357
privileges 342
statistics collection 285
tab 54
permissions 266, 271
access 278
privileges 342
settings 267
tab 54
plugins 22
manage 67
ports 180
parallel 198
Web access to VirtualCenter 78
power management 25
power off
shutdown, versus 172
power states
transitional 172
virtual machines 169, 174
privileges 266, 331
alarms 332
configuration 337
datacenter 333
datastore 333
extension 334
folders 334
global 335
host CIM 337
host inventory 339
host local operations 341
network 341
performance 342
permission 342
resource 343
scheduled tasks 344
sessions 345
tasks 345
virtual machine 350
virtual machine configuration 346
virtual machine interaction 348
virtual machine provisioning 350
virtual machine state 352
R
raw device mapping 72, 200
reconnecting hosts 133
remote
command-line interface 42
reset 170
resource maps 297
resource pools 27
resources
CPU 192
management 25
memory 194
privileges 343
virtual machine settings 192
restart
virtual machines 170
VirtualCenter 37
resume 170
virtual machines 173
roles 266, 272
copy 276
create 275
default 273
edit 277
privileges, lists of 331
remove 277
rename 278
rollup 285, 357
figure 290
RPM installer 158
runtime settings
VirtualCenter settings 75
S
SAN LUN 200
mapping 153
schedule
  power states 174
scheduled tasks 302
  about 28
  cancel 309
  clone virtual machine 212
  manage 305
  privileges 344
scheduling affinity 193
scripts
  alarms 319
SCSI 180, 201
  adapter 150
security
  baselines 26
  configuration 73
  SNMP 97
serial port 197
service console 41
  commands 42
  configure ESX Server agent 95
  connection 42
  DHCP 41
  man pages 43
  remote command-line interface, versus 42
services
  consolidation 119
  syslogd 102
  VMware Tools 155
sessions
  privileges 345
  VI Client, terminating 82
shutdown 170, 177
  power off, versus 172
SMTP
  VirtualCenter settings 75
snapshots
  about 253
  exclude virtual disks from 256
  manage 257
  parent 259
  revert to 259
  virtual machines, migrate 243
SNMP 83, 98
  alarms, set traps for notification of 318
  configure 83, 93
  diagnostics 98
  ESX Server 3i 96
  management software 97
  security 97
  traps 94
  traps, configure 96
  VirtualCenter settings 75
Solaris 161
SSH 42
SSL
  VirtualCenter 76
  SSL certificate 133
standby 170
starting
  VI Client 38
startup 177
statistics
  about 285
  database calculator 293
  VirtualCenter settings 74
storage 200
  raw device mapping 72
Storage VMotion 248
  command-line syntax 249
  limitations 248
  requirements 248
streaming multimedia
  WYSE 165
Summary tab 54
Index

suspend 170
  virtual machines 173
swapfile 81, 187
syslog 102
sysprep 353

t
  tabs
    Admin 53
    Getting Started 56
    Inventory 54
    Summary 54
.tar installer 159, 160
tasks 29
  about 302
  cancel 309
  clone virtual machine 212
  events 311
  manage 301
  navigation bar 54
  privileges 345
  scheduled 305
Telnet 42
templates 26
  about 203
  create 204
  delete 209
  deploy virtual machines 207
  edit 206
  inventory, return to 210
  navigation bar 54
  returning to VirtualCenter 176
  unregister 209
  virtual machines, convert to 209
timeout
  VirtualCenter settings 76
traps 89
  SNMP 94
  SNMP, configure 96
troubleshoot
  consolidation 125
  log files 99, 104
tutorial 57

U
  upgrade
    VMware Tools 155, 157
users 269
utilities
  sysprep 353
  VMware Tools 155

V
  VI Client 20, 24, 38
    about 45
    communication through firewall 76
    console window 50
    diagram 21
    logging in 38
    logging out 39
    sessions 82
    starting 38
    stop 39
    VirtualCenter port configuration 77
  VI Web Access 24, 40
    logging in 40
    logging out 40
  virtual disks 200
  virtual hardware
    upgrade 202
  virtual machine
    SCSI device 201
  virtual machine configuration
    Fibre Channel NPIV 187
    swapfile location 187
  virtual machine name 148
  virtual machines
    acceleration 188
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>add existing</td>
<td>175</td>
</tr>
<tr>
<td>advanced settings</td>
<td>188</td>
</tr>
<tr>
<td>boot settings</td>
<td>189</td>
</tr>
<tr>
<td>clone</td>
<td>210</td>
</tr>
<tr>
<td>configuration privileges</td>
<td>346</td>
</tr>
<tr>
<td>configure</td>
<td>179</td>
</tr>
<tr>
<td>convert</td>
<td>26</td>
</tr>
<tr>
<td>copy disks</td>
<td>114</td>
</tr>
<tr>
<td>CPU compatibility masks</td>
<td>241</td>
</tr>
<tr>
<td>CPU configuration</td>
<td>186</td>
</tr>
<tr>
<td>CPU settings, resource</td>
<td>192</td>
</tr>
<tr>
<td>CPU, settings, advanced</td>
<td>193</td>
</tr>
<tr>
<td>CPUID Mask settings</td>
<td>189</td>
</tr>
<tr>
<td>create</td>
<td>144</td>
</tr>
<tr>
<td>custom attributes</td>
<td>61</td>
</tr>
<tr>
<td>deploying from templates</td>
<td>207</td>
</tr>
<tr>
<td>disk settings</td>
<td>196</td>
</tr>
<tr>
<td>Ethernet adapter</td>
<td>199</td>
</tr>
<tr>
<td>export</td>
<td>141</td>
</tr>
<tr>
<td>Fibre Channel NPIV</td>
<td>81</td>
</tr>
<tr>
<td>Fibre Channel NPIV settings</td>
<td>190</td>
</tr>
<tr>
<td>floppy drives</td>
<td>199</td>
</tr>
<tr>
<td>guest operating system</td>
<td>154</td>
</tr>
<tr>
<td>guest operating system customization</td>
<td>216</td>
</tr>
<tr>
<td>guest operating system settings</td>
<td>187</td>
</tr>
<tr>
<td>hard disks</td>
<td>200</td>
</tr>
<tr>
<td>hardware</td>
<td>180, 196</td>
</tr>
<tr>
<td>interaction privileges</td>
<td>348</td>
</tr>
<tr>
<td>inventory privileges</td>
<td>350</td>
</tr>
<tr>
<td>legacy</td>
<td>201</td>
</tr>
<tr>
<td>log settings</td>
<td>188</td>
</tr>
<tr>
<td>managing</td>
<td>169</td>
</tr>
<tr>
<td>memory settings</td>
<td>194</td>
</tr>
<tr>
<td>migration</td>
<td>232</td>
</tr>
<tr>
<td>name</td>
<td>145, 187</td>
</tr>
<tr>
<td>NIC</td>
<td>199</td>
</tr>
<tr>
<td>optical drives</td>
<td>198</td>
</tr>
<tr>
<td>options</td>
<td>186</td>
</tr>
<tr>
<td>parallel port</td>
<td>198</td>
</tr>
<tr>
<td>paravirtualization settings</td>
<td>190</td>
</tr>
<tr>
<td>power management settings</td>
<td>188</td>
</tr>
<tr>
<td>power settings</td>
<td>80</td>
</tr>
<tr>
<td>power states</td>
<td>169</td>
</tr>
<tr>
<td>properties</td>
<td>179</td>
</tr>
<tr>
<td>provisioning privileges</td>
<td>350</td>
</tr>
<tr>
<td>removing</td>
<td>175</td>
</tr>
<tr>
<td>resource settings</td>
<td>192</td>
</tr>
<tr>
<td>resume</td>
<td>173</td>
</tr>
<tr>
<td>returning to VirtualCenter</td>
<td>176</td>
</tr>
<tr>
<td>scheduled task to clone</td>
<td>212</td>
</tr>
<tr>
<td>scheduling power states</td>
<td>174</td>
</tr>
<tr>
<td>security compliance</td>
<td>26</td>
</tr>
<tr>
<td>see also appliances</td>
<td></td>
</tr>
<tr>
<td>serial port</td>
<td>197</td>
</tr>
<tr>
<td>shutdown</td>
<td>177</td>
</tr>
<tr>
<td>snapshots</td>
<td>253</td>
</tr>
<tr>
<td>startup</td>
<td>177</td>
</tr>
<tr>
<td>state privileges</td>
<td>352</td>
</tr>
<tr>
<td>statistic collection settings</td>
<td>188</td>
</tr>
<tr>
<td>suspend</td>
<td>173</td>
</tr>
<tr>
<td>swapfile location</td>
<td>81</td>
</tr>
<tr>
<td>tab</td>
<td>54</td>
</tr>
<tr>
<td>templates, convert from</td>
<td>209</td>
</tr>
<tr>
<td>templates, convert to</td>
<td>204</td>
</tr>
<tr>
<td>upgrade hardware</td>
<td>202</td>
</tr>
<tr>
<td>upgrade version</td>
<td>201</td>
</tr>
<tr>
<td>view configuration</td>
<td>79</td>
</tr>
<tr>
<td>VMware Tools</td>
<td>80</td>
</tr>
<tr>
<td>VMware Tools settings</td>
<td>187</td>
</tr>
<tr>
<td>VirtualCenter</td>
<td></td>
</tr>
<tr>
<td>about</td>
<td>22</td>
</tr>
<tr>
<td>active sessions, view</td>
<td>81</td>
</tr>
<tr>
<td>agent</td>
<td>23</td>
</tr>
<tr>
<td>alarms</td>
<td>316</td>
</tr>
<tr>
<td>communication through firewall</td>
<td>76</td>
</tr>
<tr>
<td>configuration</td>
<td>74</td>
</tr>
<tr>
<td>custom attributes</td>
<td>61</td>
</tr>
</tbody>
</table>
database 22, 76

diagram 21

events 311

hosts, add 129

hosts, remove 135

inventory 28

objects 63

plugins 22, 26

port configuration 77

restarting 37

SNMP 93

start 36

stop 36, 38

tasks 301

templates, unregister 209

traps 89

VMFS 153

VMI paravirtualization 190

VMotion 24, 232

compatibility 246

network requirements 235

Nx and XD considerations 237

requirements 234

resource maps 298

swapfile considerations 242

VMware Capacity Planner service 119

VMware Converter Enterprise

about 26

service 119

VMware DRS 25

VMware High Availability (HA) 24

VMware Infrastructure

components of 21

diagram 21

VMware SDK 25

VMware Service Console 24

VMware Tools 80, 143

automate upgrades 163

install and upgrade 155

Linux 158

NetWare 162

properties 162

RPM installer 158, 159

settings 187

Solaris 161

tar installer 159

upgrade 157

WYSE 165

VMware Update Manager 26

W

Web access

VirtualCenter port configuration 78

Web Service

VirtualCenter settings 76

Windows

guest operating system customization 215

WWN 190

WYSE multimedia 165

X

X terminal 158
Updates for the Basic Administration Guide

Last Updated: May 14, 2010

This document provides updates to the Update 2 release of the ESX Server 3.5 and ESX Server 3i version 3.5 versions of the Basic Administration Guide. Updated descriptions are organized by page number so that you can easily locate the area of the guide that has changes. If the change spans multiple sequential pages, this document provides the starting page number only.

The following is a list of updates made to the Basic Administration Guide:

- Updates to Hardware Tab on Page 70
- Updates to the Configuring VirtualCenter Communication over a Web Connection Section on Page 79
- Updates to the About MIB Files Section on Page 83
- Updates to the To configure your management program to interpret VirtualCenter SNMP traps Procedure on Page 94
- Updates to the Using SNMP with ESX Server 3 Section on Page 94
- Updates to the Configuring the ESX Server Agent from the Service Console Section on Page 95
- Updates to the Adding a Host Section on Page 129
- Updates to the Importing a Virtual Appliance Procedure on Page 141
- Updates to the To Install or Upgrade VMware Tools on a Linux Guest from X with the RPM Installer Procedure on Page 158
- Updates to the To Install or Upgrade VMware Tools on a Linux Guest with the tar Installer or RPM Installer Procedure on Page 160
- Updates to the VMware Tools Upgrades Information on Page 163
- Updates to the To Change the Memory Configuration Procedure on Page 183
- Updates to the To Change the Serial Port Configuration Procedure on Page 184
Updates for the Basic Administration Guide

- Updates to the Change the virtual processor or CPU configuration Procedure on Page 186
- Updates to the Windows Requirements for Guest Customization Section on Page 217
- Updates to the Linux Requirements for Guest Customization Section on Page 218
- Updates to EVC Requirements Section on Page 238
- Updates to the Storage VMotion Remote Command-Line Syntax Section on Page 249
- Updates to the Understanding Snapshots Section on Page 254
- Updates to the Interval Duration and Collection Frequency: Defaults Table on Page 286
- Updates to the How statistical data is stored in the database Section on Page 290
- Updates to the To Define the SMTP and Email Message Addressing Information Procedure on Page 319
- Updates to the To create an alarm Procedure on Page 323
- Update to the Host Configuration Privileges Table on Page 337
- Updates to the Installing the Microsoft Sysprep Tools Appendix on Page 353
- Updates to the Memory Performance Metrics for Resource Pools on Page 366

Updates to Hardware Tab on Page 70

In Hardware Tab, the description of the Health Status option incorrectly states that it is available for ESX Server 3i only. The Health Status option is also available for ESX Server 3.5 Update 2 and later.

Updates to the Configuring VirtualCenter Communication over a Web Connection Section on Page 79

Step 7 of the To open a Web port between the VirtualCenter Server and the VI Client using IIS procedure is now invalid. The following information should be included in the section:

The current version of VirtualCenter does not use VmdbHttpProxy.dll for communication between the VI Client and the VirtualCenter Server.
In VirtualCenter Server 2.5 and later, the VirtualCenter Server acts as a Web service. If your environment requires the use of a Web proxy, VirtualCenter Server can be used as a proxy server like any other Web service.

The VI Client uses ports 80 and 443 to communicate with VirtualCenter Server and ESX/ESXi hosts. These ports cannot be changed. Configure your firewall to allow communication between the VI Client and VirtualCenter Server using the ports 80 and 443.

Updates to the About MIB Files Section on Page 83

The content in the About MIB Files section should be replaced with the following content:

VMware MIB files define the information provided by ESX/ESXi hosts and vCenter Server to SNMP management software. You can download these MIB files from the VMware Web site.

Refer KB 1013758 for more information on using SNMP with VirtualCenter 2.5 and ESX 3.5.

Table 5-1 lists the MIB files provided by VMware and describes the information that each file provides.

Updates to the To configure your management program to interpret VirtualCenter SNMP traps Procedure on Page 94

Step 1 in the To configure your management program to interpret VirtualCenter SNMP traps procedure is incorrect. The following details should replace the incorrect step:

1. Copy the following MIB files to the location required by your management software:
   - VMWARE-VC-EVENT-MIB
   - VMWARE-OBSOLETE-MIB

These MIB files are required to interpret VirtualCenter Server Traps.

You can download these SNMP MIB files from the VMware Web site. Refer KB 1013445 for more details on downloading the MIB files.
Updates for the Basic Administration Guide

Updates to the Using SNMP with ESX Server 3 Section on Page 94

The sentence in the Using SNMP with ESX Server 3 section regarding SMIv1 and SNMPv1 should be replaced with the following content:

The ESX Server 3 Net-SNMP-based agent can be used with any management software that can load and compile a management information base (MIB) in SMIv2 format and can understand SNMPv2 trap messages.

Updates to the Configuring the ESX Server Agent from the Service Console Section on Page 95

The Configuring the ESX Server Agent from the Service Console section does not provide detailed instructions for configuring an ESX Server host for generating traps. The following procedure, which enables you to modify /etc/vmware/snmp.xml to setup trap targets for VMware related traps from Service Console, should be added to this section. (Refer KB 1008065 to use the vicfg-snmp command from the Remote CLI to enable the SNMP agent and configure trap destinations).

To configure an ESX host for SNMP Traps

1. Log in as root to the service console of the ESX host.
2. Run the following command to edit the snmp.xml file:
   vi /etc/vmware/snmp.xml
3. Update the snmp.xml file with the following text:
   
   <config>
     <snmpSettings>
       <communities>public</communities>
       <enable>true</enable>
       <port>99</port>
       <targets>localhost@162 private</targets>
     </snmpSettings>
   </config>

4. Run the following command to edit the config.xml file:
   vi /etc/vmware/hostd/config.xml
5. Update the `config.xml` file with the following text:

```xml
<log>
  <directory>/var/log/vmware/</directory>
  <name>hostd</name>
  <outputToConsole>false</outputToConsole>
  <level>verbose</level>
</log>
```

6. Restart `hostd` using the following command:

   ```
   service mgmt-vmware restart
   
   ```

7. Run the following commands to verify that the `snmpd` and `snmptrapd` are running successfully:

   ```
   - etc/initd/snmpd status
   - etc/initd/snmptrapd status
   
   If the status is displayed as stopped, start the daemons:
   ```

   ```
   - etc/initd/snmpd start
   - etc/initd/snmptrapd start
   ```

To monitor and receive the generated traps, enter the following commands:

```
- # snmpd -P
- # snmptrapd -P
```

---

**Updates to the Adding a Host Section on Page 129**

The note in the *Adding a Host* section should contain the following information regarding the Lockdown mode:

**NOTE** Lockdown Mode, which is available only in ESXi Embedded, is not available in ESX installations. Lockdown Mode disables remote access for the administrator after VirtualCenter Server takes control of the ESXi host. For more details, refer the section ESX Server 3i Lockdown Mode in *ESX Server 3i Configuration Guide*. 

---
Updates to the Importing a Virtual Appliance Procedure on Page 141

Step 6 of the To import a virtual appliance procedure states incorrect information. The name provided to the datacenter is case-insensitive.

Updates to the To Install or Upgrade VMware Tools on a Linux Guest from X with the RPM Installer Procedure on Page 158

Step 5 of the procedure To install or upgrade VMware Tools on a Linux guest from X with the RPM installer should include the following note:

NOTE During VMware Tools installation, a Linux guest operating system might display a message indicating that the package has not been signed. If this message appears, click Install Anyway to continue the installation.

Updates to the To Install or Upgrade VMware Tools on a Linux Guest with the tar Installer or RPM Installer Procedure on Page 160

Step 6 of the procedure To install or upgrade VMware Tools on a Linux guest with the tar installer or RPM installer should include the following note:

NOTE During VMware Tools installation, a Linux guest operating system might display a message indicating that the package has not been signed. If this message appears, click Install Anyway to continue the installation.

Updates to the VMware Tools Upgrades Information on Page 163

Step 7 of the To Manually Upgrade Tools procedure has a cross-reference to Table 10-1, which contains erroneous information. The table should be replaced with the following paragraph:

- Options for Linux are documented in the Linux installer for Linux Tools. Command-line options for Windows are documented in the MSI for Windows Tools and at Wikipedia (search for "Windows Installer").
Updates to the To Change the Memory Configuration Procedure on Page 183

Step 3 of the To change the memory configuration procedure states incorrect information about the range of memory supported. The correct range of memory supported is 128MB to 65532 MB.

Updates to the To Change the Serial Port Configuration Procedure on Page 184

The following note should precede the To change the serial port configuration procedure:

NOTE  Host serial device functionality is not available on ESXi hosts.

Updates to the Change the virtual processor or CPU configuration Procedure on Page 186

The note in To change the virtual processor or CPU configuration section containing information on the support for changing the number of processors in an imported virtual machine is incorrect. The correct information is

NOTE  Not all guest operating systems support SMP, and some that do require reinstallation if the number of CPUs changes.

Updates to the Windows Requirements for Guest Customization Section on Page 217

The following text should appear in the Windows Requirements for Guest Customization section:

See the VMware Infrastructure Compatibility Matrixes Guide for the list of supported operating systems for virtual image customization.
Updates for the Basic Administration Guide

Updates to the Linux Requirements for Guest Customization Section on Page 218

The following text should appear in the Linux Requirements for Guest Customization section:

See the VMware Infrastructure Compatibility Matrixes Guide for the list of supported operating systems for virtual image customization.

Also, the following requirement should be listed in this section:

- Perl is installed in the Linux guest operating system.

Updates to EVC Requirements Section on Page 238

In EVC Requirements section, the list of requirements should contain the following two additional items:

- All hosts in the cluster must have hardware virtualization (Intel-VT or AMD-V) enabled in the BIOS if it is available.
- All hosts in the cluster must have execute protection (XD on Intel processors and NX on AMD processors) enabled in the BIOS.

Updates to the Storage VMotion Remote Command-Line Syntax Section on Page 249

The content in the Storage VMotion Remote Command-Line Syntax section on initiating the migrations with Storage VMotion from the Remote Command-Line Interface is not proper. The content should be as follows:

You can initiate migrations with storage VMotion on both ESX Server 3i and ESX Server 3 hosts by running the svmotion command from the Remote Command-Line Interface (Remote CLI).

For more information on installing and using the Remote CLI, see the Remote Command-Line Interface Installation and Reference.
Updates to the Understanding Snapshots Section on Page 254

The **Understanding Snapshots** section does not include information on delta disks. The section should contain the following content:

To take a snapshot, the state of the virtual disk at the time of taking the snapshot must be preserved. When this occurs, the guest operating system cannot write to the VMDK file. The delta disk is an additional VMDK file where the guest is given write access.

**NOTE** To consolidate all snapshots into the base virtual machine, you might need extra disk space, as large as the base VMDK.

The delta disk represents the difference between the current state of the virtual disk and the state at the time of the previous snapshot. If more than one snapshots exist, delta disks might represent the difference (or delta) between each snapshot. Also, the guest can write to every single block of the virtual disk causing the delta disk to grow as large as the base VMDK of the virtual machine.

When a snapshot is deleted, if a user chooses to merge the changes between the snapshots to the previous disk-state, all the data from the delta disk that contains the information about the deleted snapshot is written to the parent disk. This might involve a large amount of disk I/O and might reduce the virtual machine performance until consolidation is complete.

If the user chooses to ignore the delta disks, delta consolidation is not required.

See VMware Knowledge Base system for more information on the iterative snapshot deletion behavior. See also [Delete All snapshot operation results in a Consolidate Helper snapshot when a datastore has insufficient disk space](KB article 1003302).

**NOTE** While snapshots provide a point-in-time image of the disk that backup solutions can use, snapshots should not be used for virtual machine backups.
Updates to the Interval Duration and Collection Frequency: Defaults Table on Page 286

In Table 18-1, the configurable value of the duration for which the statistics can be stored in the VirtualCenter database is incorrect. The following rows replace the respective rows in the table.

<table>
<thead>
<tr>
<th>Collection_interval</th>
<th>Interval_duration</th>
<th>Collection_frequency</th>
<th>Configurable attributes — possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>1 Day</td>
<td>5 minutes</td>
<td>Interval length (Days) — 1-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Collection frequency (Minutes) — 1, 2, 3, 5</td>
</tr>
<tr>
<td>Year</td>
<td>1 Year</td>
<td>1 Days</td>
<td>Interval length (Years) — 1-5</td>
</tr>
</tbody>
</table>

Updates to the How statistical data is stored in the database Section on Page 290

The How statistical data is stored in the database section contains incorrect information about the duration for which the statistics can be stored in the VirtualCenter database. The text should be as follows:

By default, statistics are stored in the VirtualCenter database for 1 year. However, you can increase this to 5 years. You should archive your statistical data outside of the VirtualCenter database to save it for more than 5 years.

Updates to the To Define the SMTP and Email Message Addressing Information Procedure on Page 319

In Step 3, the Sender Account example is incorrect. The email address is missing the at sign (@). The text should read:

- **Sender Account** – The email address of the sender, for example, mail_server@datacenter.com.
Updates to the To create an alarm Procedure on Page 323

In the Warning list item of Step 6, the details of the VM state options are incorrect. The content should read as follows:

The following VM State options are displayed in the Warning column: None, Powered Off, Powered On, and Suspended.

The Host State options correspond to the following activities: None, Connected, Disconnected, and Not responding.

The exiting state is considered a yellow color condition at the selected state.

Update to the Host Configuration Privileges Table on Page 337

In Table A-8, the description for the Change Settings privilege does not mention that the privilege allows setting the Lockdown Mode only on ESXi hosts. The row should appear as follows:

<table>
<thead>
<tr>
<th>Change Settings</th>
<th>Allows setting of lockdown mode on ESXi hosts only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User interface element:</td>
<td></td>
</tr>
<tr>
<td>1. Select the Host Configuration tab.</td>
<td></td>
</tr>
<tr>
<td>2. Click Security Profile.</td>
<td></td>
</tr>
<tr>
<td>3. Select Lockdown Mode and click Edit.</td>
<td></td>
</tr>
</tbody>
</table>

Update to the Installing the Microsoft Sysprep Tools Appendix on Page 353

The version of the VirtualCenter Server mentioned in the fourth paragraph in the Installing the Microsoft Sysprep Tools appendix is incorrect. The text should read as follows:

The guest operating system customization feature in VirtualCenter Server 2.5 takes full advantage of Windows Sysprep functionality.

Updates to the Memory Performance Metrics for Resource Pools on Page 366

The Memory Usage counter in Table C-8 displayed incorrect data and has been removed.